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Chapter 1

Overview

The following topics provide an overview of ArcSight Logger, including information on 
what’s new in this release; storage, receiver, and forwarder configuration; working with 
events; user management; and setup and maintenance considerations.

Introduction
ArcSight Logger is a log management solution that is optimized for extremely high event 
throughput, efficient long-term storage, and rapid data analysis. An event is a 
time-stamped text message, either a syslog message sent by a host or a line appended to 
a log file. Logger receives and stores events; supports search, retrieval, and reporting; and 
can optionally forward selected events.

Logger is available in two form factors: an appliance and software. The appliance-based 
solution is a hardened, dedicated, enterprise-class system that is optimized for extremely 
high event throughput, efficient long-term storage, and rapid data analysis. The 
software-based solution is similar in feature and functionality to the appliance-based 
solution, however, the software solution enables you to install ArcSight Logger on a 
supported platform of your choice. 

“Introduction” on page 17

“Logger Features” on page 19

“Deployment Scenarios” on page 22

“What’s New in Logger v5.2” on page 24
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1 Overview
This chapter presents an overview of Logger’s capabilities, with references to other parts of 
this document for more detail.

Figure 1-1 Logger web interface, Analyze tab

Logger stores time-stamped text messages, called events, at high sustained input rates. 
Logger compresses raw data, but can always retrieve unmodified data on demand, for 
forensics-quality litigation data.

Similar to ArcSight ESM, Logger leverages the ArcSight SmartConnector framework to 
collect events. Similar to ArcSight ESM, Logger can receive normalized CEF events from the 
SmartConnectors. The file-type Receivers configured on Logger only parse event time from 
an event.

Multiple Loggers can work together to scale up to support extremely high event volume. 
Loggers can be configured as a  network, with search queries distributed across all  
Loggers.

Syslog is a loose standard (characterized, not defined, in RFC 3164) for event messages. 
Although Logger is message-agnostic, it can do more with messages that adhere to the 
Common Event Format (CEF), an industry standard for the interoperability of event- or 
log-generating devices. (See Appendix A‚ Common Event Format‚ on page 509 for more 
information.) 

Events consist of a receipt time, event time, a source (host name or IP address), and an 
un-parsed message portion. Logger displays events in a tabular form, as shown in 
Figure 1-1, adding fields that describe how Logger received the event.

 “Peer Loggers” on page 215

 “Common Event Format” on page 509
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Logger Features
The following sections provide an overview of key Logger features, with links to relevant 
sections of this guide.

Storage Configuration
The Logger appliance includes onboard storage for events. Some Logger models include 
RAID 1 or RAID 5 storage systems. (See the Appliance Specifications document for more 
details. This document is available from the ArcSight Download Center at 
https://arcsight.subscribenet.com.) On Logger appliance models that support a Storage 
Area Network (SAN), you need to use the SAN for storage. Logger appliance can interact 
with Network Attached Storage (NAS) or with a Storage Area Network (SAN) using a SAN 
gateway, as shown in Figure 1-2. Using a Network File System (NFS) as primary storage for 
events on a Logger appliance is not recommended. 

On the software version of Logger, you need to have at least the minimum disk space 
mentioned in “Supported Platforms and Browsers” on page 35 to store events. SAN is not 
supported for storage on software Loggers. The disk space needs to be on the partition 
where the <install_dir> directory exists. Specifically, most of this space should be 
available for the <install_dir>/data/logger directory. Using NFS as primary storage 
for events on the software version of Logger is not recommended. 

Events are stored compressed. You can not configure the compression level. 

An NFS or a CIFS system can be used for archiving Logger data such as event archives, 
Saved Searches, exported filters and alerts, and configuration backup information on all 
Loggers. You can also configure the Logger to read event data or log files from a CIFS host.

The Storage Volume, either external or local, can be divided into multiple Storage Groups, 
each with a separate retention policy. Storage Groups must be created when Logger is first 
configured. New Storage Groups cannot be added later, however, a Storage Group’s size 
can be increased or decreased, and the retention policy defined for it can be changed.

 “Planning” on page 29

 “Initializing the Logger Appliance” on page 29

 “Storage” on page 165

Receiver Configuration
Logger receives events as syslog messages, encrypted SmartMessages, Common Event 
Format (CEF) messages, or by reading log files. Traditionally, syslog messages are sent 
using User Datagram Protocol (UDP), but Logger can receive syslog and CEF messages 
using the more reliable Transmission Control Protocol (TCP) as well. 

Logger can also read events from text log files on remote hosts. Log files can contain one 
event per line or event messages that span multiple lines separated by characters such as 
newline (\n) or a carriage return (\r). Each event must include a timestamp. Logger can be 
configured to poll remote folders for new files matching a filename pattern. Once the 
events in the new file have been read, Logger can delete the file, rename it, or simply 
remember that it has been read. Logger can read remote files on network drives using SCP, 
SFTP, or FTP protocol, or using a previously-established NFS or CIFS mount or, on some 
Logger appliance models and software Logger, a SAN.
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Logger may also receive events from an ESM Manager as CEF-formatted syslog messages. 
These events are forwarded to Logger through a special software component called an 
ArcSight Forwarding SmartConnector that converts the events into CEF-formatted syslog 
messages before sending them to Logger.

 “Receivers” on page 171

 “Installing SmartConnectors to Send Events to Logger” on page 56

 “Sending Events from ArcSight ESM to Logger” on page 59

Figure 1-2 Logger appliance has multiple network interface cards (NICs) so that it can 
receive events on one subnet and forward events on a different subnet. 

Analyzing Events
Events can be searched, yielding a table of events that match a particular query. Queries 
can be entered manually, or automatically created by clicking on terms in the event table. 
Queries can be based on plain English keywords (full-text search), predefined fields, or 
specified as regular expressions. Logger supports a flow-based search language that allows 
you to specify multiple search commands in a pipeline format.

By default, a Logger queries only its primary data store even if  Loggers are configured. 
However, you can configure it to distribute a query across  Loggers of your choice.

Queries can be saved as a Filter or as a Saved Search. Saved filters can be used to select 
events for forwarding or to query events again later. A Saved Search is used to export 
selected events or save results to a file, typically as a scheduled task.

 “Searching for Events on Logger” on page 128

 “Saving Queries (Saved Filters and Searches)” on page 143

 “Filters” on page 204

 “Saved Searches” on page 207

 “Peer Loggers” on page 215

Grouping Events
The combination of a source IP address and a Logger Receiver is called a Device. As events 
are received, Devices are automatically created for each IP/Receiver pair. Devices can also 
be manually created, anticipating future traffic. 
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Devices can be categorized by membership in one or more Device Groups. While an 
incoming event belongs to one and only one Device, it can be associated with more than 
one Device Group.

Storage Rules associate a Device Group with a Storage Group. Storage Rules are ordered 
by priority, and the first matching rule determines to which Storage Group an incoming 
event will be sent.

Device Groups, Devices, Storage Groups, and  Loggers can each be used to filter events 
using Search Constraints, which can be specified interactively on the Analyze page as well 
as when creating Filters or Saved Searches.

 “Devices” on page 155

 “Storage Rules” on page 167

 “Searching Peer Loggers (Distributed Search)” on page 129

Exporting
Logger appliance can export events that match the current query locally, to an NFS 
mount, a CIFS mount, a SAN (on select Logger appliance models), or to the browser as a 
file to be downloaded. Events from a software version of the Logger can be only 
exported locally to the Logger (to the <install_dir>/data/logger directory) or to 
the browser from which you connect to the Logger. The <install_dir>/data/logger 
directory can be mounted to an NFS or CIFS, or a SAN LUN. 

Events can be exported in Comma-Separated Values (CSV) format for easy processing by 
external applications or as a PDF file for generating a quick report. A PDF report includes a 
table of search results and any charts generated for the results. Both, raw and CEF events, 
can be included in the PDF exported report. 

Events in Common Event Format (CEF) have more columns defined, making the data more 
useful, but non-CEF events can be exported as well, if desired. The user can control which 
fields are exported.

Exports can be scheduled to run regularly by creating a Saved Search Job. First, a Saved 
Search is created, either manually or by saving a query on the Analyze page. A Saved 
Search can be based on an existing Filter. A Saved Search Job combines one or more Saved 
Searches and a schedule with export options.

 “Exporting Search Results” on page 136

 “Impact of Daylight Savings Time Change on Logger Operations” on page 351

 “Scheduled Saved Search” on page 209

Forwarder Configuration
Logger can send events (as they are received or past events) to other hosts using UDP or 
TCP, to an ArcSight Logger Streaming SmartConnector, or to an ArcSight ESM Manager. The 
events sent to a particular host can be filtered by a query that events must match. 
Outgoing syslog messages can be configured to either pass the original source IP and 
timestamp through, or use Logger's “send time” and IP address.

Syslog messages can be sent to an ArcSight ESM Manager using a syslog SmartConnector, 
but Logger can also send CEF events directly to a Manager using a built-in SmartConnector. 
Logger can act as a funnel, receiving events at very high volumes and sending fewer, 
filtered events on to an ESM Manager, as shown in Figure 1-3.
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 “Forwarders” on page 178

 “ESM Destinations” on page 184

User Management
User accounts can be created by the Logger administrator to distinguish between different 
users of the system. User accounts inherit privileges from the User Group to which they 
belong. User Groups can have an enforced event Filter applied to them, limiting the events 
that a specific user can see.

 “Users/Groups” on page 385

 “Change Password” on page 399

 “Search Group Filters” on page 206

Other Setup and Maintenance
Logger configuration settings, such as Receivers, Filters, Saved Search Jobs, and so on—
everything except events—can be backed up as a configuration backup file to any disk and 
later restored. 

Logs detailing Logger activity can be downloaded through the browser on demand, for 
debugging or other reasons. Other system information is available for viewing.

Logger appliance can be rebooted using controls in the browser user interface. For the 
software version of Logger , typically, Logger service and related processes need to be 
restarted. Follow instructions in “Starting and Stopping the Software Logger” on page 52 to 
start, stop, or restart Logger service on a software Logger.

Various other system settings can be modified. Some require a system reboot for the 
changes to take effect.

 “Configuration Backup and Restore” on page 219

 “Retrieve Logs” on page 238

 “Storage” on page 365

 “System Locale” on page 346

 “License & Update” on page 351

 “Network” on page 347

Deployment Scenarios
Typically, Logger is deployed inside the perimeter firewall with a high degree of physical 
security to prevent tampering with the collected event information. Logger does not require 
other ArcSight products. It receives and forwards syslog and log file events created by a 
wide variety of hardware and software network products. 

Logger also interoperates with ArcSight ESM as shown in the following figures. A typical 
use of Logger is to collect firewall or other data and forward a subset of the data to 
22 Administrator’s Guide Confidential



1 Overview
ArcSight ESM for real-time monitoring and correlation, as shown in Figure 1-3. Logger can 
store the raw firewall data for compliance or service level agreement purposes. 

 

Figure 1-3 Logger can act as a funnel, forwarding selected events to ArcSight ESM.

Figure 1-4 Logger can store events sent by ArcSight ESM.

In the following illustrations ArcSight Logger can be the Logger appliance or 
the software version of Logger that is installed on a supported platform of 
your choice.
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1 Overview
Figure 1-5 Logger can store and forward filtered events in a hierarchical ArcSight Manager 
deployment.

What’s New in Logger v5.2
Please see the release notes for this release that are available at the ArcSight Customer 
Support web site at http://www.arcsight.com/supportportal.
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Chapter 2

Installation and Initialization

This chapter describes how to install and initialize a Logger appliance and the software 
version of Logger. The installation process is specific to Logger type, therefore, the 
installation instructions are provided in two sections: 

 “Section 1: Installing the Logger Appliance” on page 25 

 “Section 2: Installing the Software Version of Logger” on page 35

This chapter also includes the following information, which is applicable to both Logger 
types:

 “Installing SmartConnectors to Send Events to Logger” on page 56

 “Sending Events from ArcSight ESM to Logger” on page 59

Section 1: Installing the Logger Appliance
Installing the Logger appliance includes these steps:

1 Installing the appliance, as described in “Installing the Logger Appliance” on page 25.

2 Setting an IP address, as described in “Setting an IP Address on the Appliance” on 
page 26

3 Initializing the appliance, as described in “Initializing the Logger Appliance” on 
page 29.

4 Configuring your Logger so it can be accessed remotely as described in “Configure 
Logger for Remote Access” on page 35.

Installing the Logger Appliance
The ArcSight Logger appliance package includes detailed rack installation instructions, 
which you can use to rack mount your appliance. Refer to the enclosed Getting Started 
with ArcSight Logger Appliance to configure an IP address on your Logger appliance, install 
a license file, and connect to it the first time using the IP address you configured. 

Safety Precautions
Read carefully through the instructions, cautions, and warnings that are included with the 
appliance shipment. 
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2 Installation and Initialization
Do not remove the top cover of the Logger appliance. Opening the appliance will void the 
warranty, and there is generally no reason for opening the appliance, which carries the risk 
of electrostatic discharge or even electrocution.

Do not operate Logger if the power cables are damaged, if liquids or foreign objects have 
entered the appliance, or if the appliance has been damaged by dropping or other physical 
shock, or if the device has been exposed to water.

Do not operate Logger in a wet environment. Do not modify power cables or plugs. Consult 
a licensed electrician or your power company if site modifications are necessary. Always 
follow national or local electrical wiring regulations.

When connecting or disconnecting power to hot-swappable power supplies, observe these 
guidelines:

 Install the power supply before connecting the power cable to the power supply.

 Unplug the power cable before removing the power supply.

 Disconnect power to Logger by unplugging both power cables from the power 
supplies.

Setting an IP Address on the Appliance

Before logging in to a Logger appliance for the first time, you need to configure at least 
one valid IP address. There are three ways to accomplish this:

 Attach a terminal to the serial port on Logger and use the Command Line Interface to 
change the default IP addresses; or

 Attach a monitor and keyboard to the rear panel connectors and use the Command 
Line Interface to change the default IP addresses; or

 Configure a host to be a subnet that matches the predefined Logger IP (192.168.35.*) 
and use a browser from that host to log in and change the default IP addresses.

Using a Browser to Set an IP Address
1 Open a modern, Flash-enabled browser. Specify Logger’s default IP address, like this:

https://192.168.35.35/

2 At the login screen, enter admin for user name and password for password. Logger 
reminds you to set up a Storage Volume. It is very important that you do not specify a 
Storage Volume or make other critical deployment decisions at this time.

3 Click the System Admin tab. 

4 On the sub-menu, click Platform (under Settings).

Power supplies used in the Logger appliance may produce high voltages and 
energy hazards, which can cause bodily harm. Unless you are instructed 
otherwise by ArcSight, only trained service technicians are authorized to 
remove the covers and access any of the components inside the Logger 
appliance.

The following instructions are also included in the Getting Started with 
ArcSight Logger Appliance document that is enclosed with Logger shipment.
26 Administrator’s Guide Confidential



2 Installation and Initialization
5 Click the Network tab and enter the desired host name, default gateway, IP 
address(es) and other information. Click Update Settings.

6 Click the Change Password sub-menu (under User/Groups). Enter the old password 
(‘password’), enter a new password and confirm it. Click Set Password.

7 On the sub-menu (under System Configuration), click System Reboot. Click Start 
Reboot Now. The setting changes take effect after Logger is rebooted.

Using the Command Line Interface to Configure IP Address
To use the Command Line Interface (CLI), attach a terminal to the serial port on Logger or 
attach a monitor and keyboard. The serial port expects a standard VT100-compatible 
terminal: 9600 bps, 8-bits, no parity, 1 stop bit (8N1), no flow control.

Figure 2-1 The ArcSight Platform Console sign-on. Note that the platform version will not 
match the current Logger application version.

To set an IP address using the CLI:

1 Connect a terminal to the serial port on Logger. Turn on Logger. Enter user name and 
password (initially, admin/password). CLI credentials are the same as for the web user 
interface. The terminal should display the ArcSight Platform Console prompt shown in 
Figure 2-1.

For security reasons, change the default password after the initialization is complete.

2 Enter set password <pwd> (replace <pwd> with your chosen password) to set 
the current user’s password.

3 Enter set ip eth0 192.168.35.35/<prefix>, replacing the IP address with 
the IP address desired and <prefix> with the number of bits in the subnet mask. (For 
example, /24 = 255.255.255.0.)

4 Enter set hostname <logger>, replacing <logger> with the fully-qualified 
domain name (FQDN) of the desired host.

5 Enter set dns <search_domain> <name_server>, replacing the 
<search_domain> with your domain and <name_server> with the hostname or IP 
address of your nameserver. 

6 Enter set defaultgw 192.168.35.2, replacing the IP address with your default 
gateway IP address.

7 The preceding changes take effect immediately. To confirm that the settings are 
correct for your environment, enter show config.

It is important that the host name is resolvable by DNS and that it 
resolves to the Logger’s IP address. Performance is significantly affected 
if DNS cannot resolve the host name.
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Other CLI Commands
The following commands are available at the CLI prompt:

Category Command Description

System 
Commands

exit Logout

halt Stop and power down the Logger appliance

reboot Reboot the Logger appliance

Admin show admin Show the default administrator user’s name

Config show config Show host name, IP address, DNS, and default 
gateway for this Logger

Date show date Show the currently configured date on the Logger

Default Gateway show defaultgw [nic] Display the default gateway for all or the specified 
network interface

set defaultgw <IP> 
[nic]

Set the default gateway for one or all network 
interfaces

DNS show dns Show the currently configured DNS servers on the 
Logger

set dns <dn1> 
[,<dn2>][,<dn3>] ns1 
[,ns2]

Set DNS name server(s). dn=search domain 
name, ns=nameserver

Hostname show hostname Show the currently configured hostname on the 
Logger

set hostname <host> Set Logger’s host name

IP show ip [nic] Show the IP addresses of all or the specified 
network interface

set ip <nic> <IP> 
[/prefix] [netmask]

Set Logger’s IP address for a specific network 
interface

Password set password Set the password the current user’s account

SSL Certificate show sslcert Show the currently loaded SSL certificate on 
Logger

reset sslcert Install and restart the HTTPS server with the 
default, self-signed certificate that Logger shipped 
with

restart sslcert Restart the HTTPS server

diag sslcert Display the SSL session information

Status show status Show the Logger configuration 
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Initializing the Logger Appliance
Logger initialization requires planning because there are several initial settings which 
cannot be changed once they are set. 

Planning

Storage Strategy
Logger events can be stored in these ways:

 Locally 

 Remotely on a Storage Area Network (SAN) on Logger appliance models that support 
SAN. SAN should be available before you bring the Logger online. Only one LUN can 
be used to store events. 

Using a Network File System (NFS) as primary storage for events on a Logger is not 
recommended. However, an NFS or a CIFS system can be used for archiving Logger data 
such as event archives, Saved Searches, exported filters and alerts, and configuration 
backup information on all Loggers.

You can also configure the Logger to read event data or log files from a CIFS host.

Retention Policy
Logger supports several Storage Groups, each of which can have a different retention 
policy. Retention policy is specified in terms of number of days that events are stored, or 
overall maximum size (in GB). Events from specific IP addresses can be routed to particular 
Storage Groups, making it possible to store all router events, for example, to a Storage 
Group with short retention, and business-critical host events to another Storage Group with 
a longer retention.

The Logger receipt time of an event is used to determine the starting time for its retention 
period.

Before initializing Logger, you should have an idea of your various retention policy needs, 
both initially and over the life span of the Logger installation. 

The previous figure illustrates the relationship between ArcSight components and retention 
policies. Devices, on the left, are grouped by Device Groups. Storage Groups implement 
different retention policies on the Storage Volume. Storage Rules, in the middle, create a 
mapping between Device Groups and Storage Groups. In the example shown, Device C is a 
member of both Device Group 1 and Device Group 2. Storage Rules are defined that send 
Device Group 1 events to Storage Group 1 and Device Group 2 events to Storage Group 2. 
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There is no ambiguity, however, because each Storage Rule has a unique priority value, 
and the lower value has the higher priority. In the example, events from Device C are 
stored in Storage Group 1 because that Storage Rule has a priority of 5, which is lower than 
the other matching Storage Rule, which has a priority of 15.

Initialization Sequence for Logger appliances
It is very important that you initialize Logger in the sequence shown here. Several of the 
settings described here cannot be changed once set, therefore, make sure you perform the 
the initialization steps carefully.

The following sequence ensures that resources are created and parameters are set in the 
proper order. 

1 License 

2 SAN (on selected Logger appliance models)

3 Storage Volume - establish where Logger stores event data

4 Storage Groups - apply retention policies to the Storage Volume

5 Time Settings

6 Index Fields and Full-text Indexing

7 Locale

8 Reboot - commit the changes made in previous steps

9 Receivers

10 Devices

11 Device Groups

12 Storage Rules

1 License 
Download valid license files for all your Logger appliances from your customer directory on 
the ArcSight Customer Support web site. Then, follow instructions in this section to apply 
the license file. 

An implicit Storage Rule, with lowest priority, maps all Devices to the Default 
Storage Group.

One-time initialization on a Logger appliance can only be changed by 
performing a factory reset (see Appendix D‚ Restoring Factory Settings‚ on 
page 529). Be sure you know how you want Logger storage set up before 
performing the first steps of the initialization sequence (up to rebooting).

When you connect to the Logger appliance for the first time, an End User 
License Agreement screen prompts you to read through the licensing 
information and accept the agreement. Once you accept, you can proceed 
further. 
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If a valid license file is not present on the Logger appliance, only the “ArcSight Appliance 
License & System Update” page and the “Change Password” page (accessible from the 
System Admin menu option) are available on it. You cannot use any of the Logger system 
administration or application functionality. 

Please note the following:

 There is no additional charge for the license files. 

 A license file contains the serial number of the appliance for which it was generated. 
Therefore, you need a separate license file for each of your Logger appliances. 

If you have multiple Logger appliances, make sure each appliance has a license file 
with its unique serial number installed. To determine a corresponding license file for a 
Logger, match the serial number in the license file's name to the serial number on your 
Logger appliance. 

To apply a license file on a Logger:

a Download the license file from the ArcSight software download site at 
https://arcsight.subscribenet.com to a computer from which you can connect to 
Logger. 

b From the computer to which you downloaded the update file, log in to the 
Logger's browser-based interface using an account with administrator (upgrade) 
privileges.

c Click the System Admin tab > License & Update. 

d Browse to the license file you downloaded earlier and click Upload Update.

Wait until a the user interface displays a message indicating that the upload was 
successful. You do not need to reboot the Logger after applying a license file. 

2 SAN 
Skip this step if you will use Logger’s built-in storage.

If you are using a SAN as your primary storage for a Logger appliance, the SAN must be up 
before initializing the Logger. Logger can attach to only one LUN (on SAN) at a time for 
primary storage. (Only certain Logger models support SANs.)

By default, the HBA card on your Logger has two ports. You can connect both of those 
ports to the same LUN for multipathing or use one port for primary storage and the other 
for an additional LUN for event archival, configuration backup, and export. 

When you multipath a LUN, you create two different network paths to it from Logger. Doing 
so reduces the possibility of a single point of failure causing the LUN to become 
unavailable. If you want to configure multipathing on Logger, you must configure 
it before attaching the LUN.

See “SAN” on page 368 for detailed information about connecting LUN and multipathing. 

If you are restoring multipath on an RMA or factory reset Logger, make sure you follow the 
guidelines described in “Restoring Multipath on RMA or Factory Reset Loggers” on 
page 372.

3 Storage Volume
Establish the Logger’s Storage Volume. See “Storage Volume” on page 169. Choose Local 
to use Logger’s built-in storage. OR choose SAN if your Logger appliance model supports 
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SAN. If you will use SAN on the Logger appliance, enter a folder path to the SAN. This 
folder path must already exist on the remote storage. 

You can configure up to a 5 TB volume on Logger’s that support SAN. To make use of this 
enhanced capacity, make sure you allocate a 5.4 TB LUN during initialization. The 
additional 0.4 TB need to be allocated to accommodate Logger system files.

You can choose to pre-allocate your Storage Volume to enhance performance. Performance 
is degraded if you don’t pre-allocate at least a portion of the storage volume, especially on 
remote volumes. ArcSight recommends 100% pre-allocation for both local and remote 
volumes. Pre-allocation is not needed if you are intializing the software version 
of Logger.

Even though 100% pre-allocation can take more time on remote volumes, doing so 
improves performance on your Logger and protects it from running out of disk space. 
Allocating lesser than 100% space may result in sub-optimal performance on the Logger.

4 Storage Groups
Logger can have a maximum of 6 storage groups—two that pre-exist on your Logger 
(Internal Storage Group and Default Storage Group) and four that you can create. As a 
result, you have five storage groups available for event storage and one for Logger’s 
internal events. Starting with Logger v5.2, the additional storage groups can be created at 
any time. 

The Default Storage Group and the Internal Storage Group are created automatically 
during the Logger initialization phase. You will need to configure these groupsYou cannot 
change the names of these groups. 

Once a Storage Group is created, it cannot be deleted however its size can be increased or 
decreased any time. If you are decreasing the size of the storage group and the new size is 
lesser than the currently used space on the storage group, you will need to delete data to 
achieve the new size. The Logger UI guides you in this situation to delete sufficient data. 
See “Storage Groups” on page 165 for the details of adding and resizing Storage Groups.

Each Storage Group can have a different retention policy. 

Maximum number of Storage Groups on Logger (including preexisting groups): 6
Storage Groups created by default: 2 (Default Storage Group and Internal Storage 
Group)
Number of Storage Groups available for event storage: 5
Number of Storage Groups available for Logger’s internal events: 1
Number of Storage Groups you can create: 4

5 Time Settings
Configure the system time manually. Follow instructions in “Time/NTP” on page 349. 

• Storage Volume can be extended but not reduced after initialization. For 
more information, see “Storage Volume Size Increase” on page 228.

• Even if your LUN is larger than 5.4 TB in size, you can only allocate a 
maximum of 5.4 TB and pre-allocate a maximum of 5TB.

• The size of a LUN cannot be changed after it has been set during Logger 
initialization. For more information, see “About Increasing Storage Volume 
Size on a SAN Logger” on page 228.
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Optionally, configure NTP time settings. Configuring an NTP server will ensure precise time 
stamping of events, which is a key log management function. ArcSight strongly 
recommends that you use Network Time Protocol (NTP) for system time. See “Time/NTP” 
on page 349 for more information.

6 Index Fields and Full-text Indexing
As shown in the following figure, during the initialization process, Logger prompts you to 
add a recommended set of fields to the index. You are not required to index event fields at 
this point, but ArcSight strongly recommends that you do so because indexing significantly 
improves search and reporting performance. When you add fields to the index, search 
queries yield significantly faster results. You might need to add additional fields to suit your 
needs. 

Additionally, full-text indexing is not enabled by default; to enable it, click Enable full text 
indexing. Once enabled, full-text indexing cannot be disabled. (For full-text indexing, 
each event is scanned and divided into keywords and stored on the Logger.) See “Indexing” 
on page 139 for more information. 

Once a field has been added, you cannot remove it or unindex it. 

Click Select Recommended Fields to highlight the set of fields ArcSight recommends 
that you add to the index. Then, click Add to add those fields to the index.

7 Locale
The Locale setting ensures that the user interface displays information such as date, time, 
numbers, and messages in the format and language appropriate for the selected country. 
For more information about setting up Locale on your Logger appliance, see “System 
Locale” on page 346.
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8 Reboot
After the storage, indexing, and locale settings have been created, reboot the system to 
commit changes before other resources can be created and Logger can begin processing 
events. See “Reboot” on page 347.

9 Receivers
Now that you have established a Storage and retention policy configuration for Logger, you 
can create Receivers to listen for events. Unlike the previous configuration choices in this 
Initialization Sequence, Receivers can be changed and deleted as needed in the future. 
Receivers can also be disabled and re-enabled later. For more information about setting up 
Receivers, see “Receivers” on page 171.

10 Devices
When at least one Receiver is enabled, Logger begins storing events. Using a process 
called auto-discovery, Logger automatically creates resources called Devices to keep track 
of source IP addresses and uses DNS to map them to hostnames. Eventually, a Device is 
created for each device from which Logger received events.

You can also create Devices preemptively, by entering the IP addresses that you expect to 
be sending events to Logger. You might do this if you don’t want to wait for autodiscovery, 
or if you want to control the initial naming of each Device. (Auto-discovered Devices are 
named for their host, or if the DNS lookup fails, for their IP address, and their Receiver.) For 
information about manually creating Devices, see “Devices” on page 155.

11 Device Groups
Device Groups are containers for Devices, in the same way folders (or directories) contain 
files. Device Groups are a way to give a name to a group of Devices. Each Device Group is 
associated with a particular Storage Group, which assigns the Device Group a retention 
policy.

Rather than just creating one Device Group for each retention policy, however, you might 
want to create more Device Groups as a way to categorize events. You can search for 
events that match a certain pattern and which belong to a particular Device Group. A given 
Device can be a member of several Device Groups, as well, which makes them broadly 
flexible.

You can change and delete Device Groups freely as your needs change. Setting up Device 
Groups initially is not critical; incoming events that are not assigned to a Device Group are 
automatically sent to the Default Storage Group. For the details of setting up Device 
Groups, see “Device Groups” on page 157.

12 Storage Rules
Events are stored in the Default Storage Group unless otherwise specified. Typically, 
Storage Rules send events from specified Device Groups to Storage Groups other than the 
Default Storage Group. Therefore, Storage Rules implement your secondary and tertiary 
retention policy. 

When Logger is rebooted, the storage, indexing, and locale settings become 
permanent. Storage Volume size can be extended, but not reduced after 
initialization. Additional storage groups can be added if a maximum of six 
groups do not exist on Logger, and only certain settings of non-default Storage 
Groups can be changed. For more information, see “Storage Volume Size 
Increase” on page 228. Additional fields can be added to the index, but not 
removed. Once the locale is set, it cannot be changed. 
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If you only implemented extra Storage Groups because ArcSight recommended that you do 
so (back in step 3), then you do not need to create any Storage Rules and you can skip this 
step. Events from all Devices will be sent to the Default Storage Group and use its specified 
retention policy. 

If you want to implement multiple retention policies, create Storage Rules that associate 
the appropriate Device Groups with the Storage Groups that implement the correct 
retention policy. See “Storage Rules” on page 167 for more information.

Storage Rules are tested in order; the first matching rule determines to which Storage 
Group an event is sent. This approach means that a single Device can belong to several 
Device Groups without ambiguity about which Storage Group it will end up in.

Configure Logger for Remote Access
ArcSight strongly recommends setting up and configuring your appliance for out-of-band 
remote access. Doing so ensures that you (and ArcSight Customer Support, with your 
permission and assistance) can remotely access your appliance's console for 
troubleshooting, maintenance, and power control. 

If your Logger appliance is an Lx4xx model, it is equipped with an HP ProLiant Integrated 
Lights-Out (iLO) Advanced remote management card. Follow the directions in the HP 
ProLiant Integrated Lights-Out User Guide to set up your appliance for remote access. The 
guide is available at http://www.hp.com/go/iLO.

If your Logger appliance is not an Lx4xx model, contact ArcSight Customer Support for 
assistance in setting up remote access for your appliance. 

Section 2: Installing the Software Version of Logger
The information in this section pertains to installing the software version of Logger.

Supported Platforms and Browsers
You can install the software version of Logger on a platform with the following 
specifications. For a detailed capacity planning guide, see the Capacity Planning for 
Software Version of Logger document that is available for download from the ArcSight 
Download Center at https://arcsight.subscribenet.com.

A VM installation of the operating systems listed in the table below is supported. ArcSight 
strongly recommends allocating 4 GB RAM per VM instance. Additionally, the sum of  
memory configurations of the active VMs on a VM server must not exceed the total physical 
memory on the server.

Specification Details

Certified Operating

Systems

• Red Hat Enterprise Linux (RHEL), version 5.5, 64-bit

• Oracle Enterprise Linux (OEL) 5.5, 64-bit

• CentOS, version 5.5, 64-bit

Other Supported Operat-
ing Systems

• Red Hat Enterprise Linux (RHEL), version 5.4, 64-bit
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Downloading the Software
The web site from where you can download the software version of Logger depends on 
your method of purchase. Use the following table to determine the web site from where 
you can download the software. 

You need to have a server with supported operating system and storage available to install 
the sofware Logger. A valid license is required to use the product. Once you have 
downloaded the software, you receive an email from ArcSight that contains the license file 
you will need to install the software. A license file is uniquely generated for each download; 
therefore, you cannot use the same license file to install multiple instances of software 
Logger. 

This section describes how licensing works on software version of Loggers, installing such a 
Logger for the first time, updating an expired license, and uninstalling the Logger.

CPU, Memory, Disk Space For Small Deployments 

(Only for ArcSight Logger—Downloadable Version)

• CPU: 1 or 2 x Intel Xeon Quad Core or equivalent 

• Memory: 4 - 12 GB (12 GB is recommended)

• Disk Space: 10 GB (minimum)

For Medium to Large Deployments

• CPU: 2 x Intel Xeon Quad Core or equivalent 

• Memory: 12 - 24 GB (24 GB is recommended)

• Disk Space: 65 GB (minimum)

NOTES:

• The disk space needs to be on the partition where you will install 
the Logger software. 

• Using NFS as primary storage for events on the software version 
of Logger is not recommended.

• The system on which you are installing the software version of 
Logger must not have more than two CPUs.

Browsers • Internet Explorer: Versions 8 and 9

• Firefox: Versions 3.6 and 5.0

An Adobe Flash Player plug-in is required on these browsers for 
some of the features, such as Histogram and charts, to work.

Other Applications For optimal performance, make sure no other applications are run-
ning on the system on which you install the software version of Log-
ger.

Purchased through... Download from...

ArcSight Sales group https://arcsight.subscribenet.com

ArcSight corporate web site 
(www.arcsight.com)

http://www.arcsight.com/products/products-logger/

Specification Details
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How Licensing Works on the Software Version of Logger
A license for the software version of Logger defines limits for the following:

 Data limit: A per day limit on the amount of incoming data. For example, 20 GB per 
day. The sum of the size of the original events is used to determine this value.

Even if this limit is exceeded, the software version of Logger continues to collect and 
store events; therefore, no events are lost. However, if this limit is exceeded 6 times 
(that is, any 6 days) in a 30-day sliding window, you cannot search or run reports on 
the collected events until the 30-day sliding window contains 5 or less data limit 
violations.

For example, you install the Logger software on January 1 with a data storage limit of 
20 GB and start collecting events. Your Logger receives more than 20 GB of event data 
on these dates: January 5th, 13th, 18th, 19th, and 20th. Because there are 5 
violations so far, you can search and report on the stored event data on January 21st. 
However, if there is another violation on January 30th, you cannot search or report on 
January 31st because the number of violations has exceeded the maximum allowed. 
(A search run on January 31st fails and the user interface displays a warning.) If there 
are no additional data storage-limit violations from January 31st to February 4th, the 
ability to search resumes on February 5th because the January 5th violation is now 
outside of the 30-day sliding window. 

 Aggregated storage limit: A limit on the aggregated storage—the sum of storage used 
to store incoming events and the storage consumed due to retention—used on the 
Logger. For example 80 GB. 

When a data limit violation occurs, the Search user interface displays a warning, as shown 
in the following figure.

You can also view the data limit violation information on the License Information page 
(Configuration > License Information). The License Information page lists the data 
stored on your software version of Logger on day-by-day basis in the last 30 days. It also 
indicates the days on which data limits were exceeded, as shown in the following figure. If 

If you are using ArcSight connectors to send events to the software 
version of Logger, make sure you are running connector version 
5.1.3.5870.0 or later on your connectors to ensure that event size is 
accurately accounted on the Logger. 
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the data-limit has been exceeded 6 times, you cannot search on Logger system and need 
to wait until the listed 30 days have 5 or less violations. 

Deployment Planning for the Software Version of Logger

Storage Strategy
Logger events can be stored locally.

Using a Network File System (NFS) as primary storage for events on a Logger is not 
recommended. However, an NFS or a CIFS system can be used for archiving Logger data 
such as event archives, Saved Searches, exported filters and alerts, and configuration 
backup information on all Loggers.

You can also configure the Logger to read event data or log files from a CIFS host.

Retention Policy
Logger supports several Storage Groups, each of which can have a different retention 
policy. Retention policy is specified in terms of number of days that events are stored, or 
overall maximum size (in GB). Events from specific IP addresses can be routed to particular 
Storage Groups, making it possible to store all router events, for example, to a Storage 
Group with short retention, and business-critical host events to another Storage Group with 
a longer retention.

If you exceed the data limit frequently, you should consider purchasing a 
license from ArcSight that suits your needs. Please contact your ArcSight 
sales representative to purchase a license. Once you obtain a new license, 
follow the instructions in “Applying or Updating a License on the Software 
Version of Logger” on page 54 to apply the new license on your Logger.
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The Logger receipt time of an event is used to determine the starting time for its retention 
period.

Before initializing Logger, you should have an idea of your various retention policy needs, 
both initially and over the life span of the Logger installation. 

The previous figure illustrates the relationship between ArcSight components and retention 
policies. Devices, on the left, are grouped by Device Groups. Storage Groups implement 
different retention policies on the Storage Volume. Storage Rules, in the middle, create a 
mapping between Device Groups and Storage Groups. In the example shown, Device C is a 
member of both Device Group 1 and Device Group 2. Storage Rules are defined that send 
Device Group 1 events to Storage Group 1 and Device Group 2 events to Storage Group 2. 
There is no ambiguity, however, because each Storage Rule has a unique priority value, 
and the lower value has the higher priority. In the example, events from Device C are 
stored in Storage Group 1 because that Storage Rule has a priority of 5, which is lower than 
the other matching Storage Rule, which has a priority of 15.

Installing and Configuring the Software Version of 
Logger 

Prerequisites for Installation
Make sure these prerequisites are met before you install the software version of Logger:

 You received a license file from ArcSight. The file is attached to an email that you 
received from ArcSight after downloading the Logger software. You will need this file 
for installation.

 You can be logged in as a root user or a non-root user on the system on which you are 
installing the software. However, a non-root user account is still required to complete 
the Logger installation as a root user. Therefore, make sure a non-root user account 
exists on the system on which you are installing Logger. 

 When you install the software as a root user, you can select the port on which Logger 
listens for secure web connections. However, when you install it as a non-root user, 
Logger can only listen for connections on port 9000. You cannot configure the port to 
a different value. Additionally, you can configure Logger to start as a service when you 
install as a root user. 

An implicit Storage Rule, with lowest priority, maps all Devices to the Default 
Storage Group.
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If you are upgrading from a version prior to 5.1, you cannot change the previous 
install to a root-user installation. You will need to use the previously configured port 
9000 for accessing software Logger. 

 The hostname of the machine on which you are installing Logger cannot be 
“localhost”. If it is, change the hostname before proceeding with the installation.

 You must not have an instance of MySQL or PostgreSQL installed on the Linux machine 
on which you will install Logger. If instances of these exists on that machine, uninstall 
them before proceeding with the installation. 

 Ensure that the umask setting in the /etc/bashrc file and your local .bashrc file 
has not been modified on the system which you are installing the Logger software. If 
this setting is modified, Logger might not function as expected. 

 If you want to use the GUI mode of installation (described in “Installation Modes” on 
page 40) and will be installing Logger software over an SSH connection, make sure 
that you have enabled X window forwarding using the -X option so that you can view 
the screens of the installation wizard. If you will be using PuTTY, you will also need an 
X client on the machine from which you are connecting to the Linux machine. 

Installation Modes
The software Logger can be installed in the following three modes:

 GUI—In this mode, a wizard steps you through the installation and configuration of 
software Logger.

 Console—In this mode, a command-line process steps you through the installation and 
configuration of software Logger. 

 Silent—In this mode, you provide the input required for installation and configuration 
through a file. Therefore, you do not need to interact with the installer to complete the 
installation and configuration. However, before you can use this mode, you must run 
the installation and configuration using one of the other modes to record the input in a 
file.

Installation Steps
This section describes all three modes of software Logger installation. 

Using the GUI Mode to Install Software Logger

To install the software version of Logger using the GUI mode:

1 Make sure the machine on which you will be installing the software Logger complies 
with the requirements listed in “Supported Platforms and Browsers” on page 35 and 
the prerequisites listed in “Prerequisites for Installation” on page 39 are met.

2 Run these commands from the directory where you copied the Logger software:

chmod +x ArcSight-logger-5.2.0.XXXX.0.bin

./ArcSight-logger-5.2.0.XXXX.0.bin

You can install software Logger as a root user or as a non-root user. See 
“Prerequisites for Installation” on page 39 for details and restrictions.
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The installation wizard launches, as shown in the following figure. Click Next.

3 On the next screen, read through the License Agreement details. Click I accept the 
terms of the License Agreement. Then, click Next.

Note: You need to scroll down to the end of the License Agreement details to enable 
the “I accept the terms of the License Agreement” button.

4 If a previous version of Logger is running on this machine, the following message is 
displayed. Click Continue to proceed with the installation or Quit to exit the 
installation process.

5 Specify or browse to a folder where you want to install Logger, as shown in the 
following figure. By default, /opt is specified. 

Do not install in the "/root" directory. Otherwise, users will not be able to 
connect to the Logger UI and will see the following error message:

"Error 403 Forbidden. You don't have permission to access / on 
this server"
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If sufficient space to install the software is not found at the location you specify for 
installation, the following error message is displayed. You need to either specify a 
different location or make sufficient space in the location you specified before 
installation can proceed.

6 Review the summary of installation information on the Pre-Installation Summary 
screen and click Install.

7 The Logger software begins to install, as shown in the following figure.

8 If you are logged in as a root user on the system on which you are installing 
Logger software, the following screen is displayed next. This screen enables you to 
specify a non-root user (that must exist on the system already) and configure a port 
on which Logger users will connect to it through the Logger UI. For example, you can 
enter 443, the standard HTTPS port, or any other that suits your needs. If any port 
except 443 is specified, your users will need to enter that port number in the URL they 
use to access the Logger UI. 

Enter the user name of the non-root user and HTTPS port number, and click Next. 
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9 Once the software is installed, the following screen is displayed. Click Next to begin 
Logger initialization.

10 Once initialization is complete, the following screen is displayed. Click Done to launch 
the Logger Configuration wizard.

Note: The Configuration wizard launches automatically. However, if it does not, use 
this command to start it:

<install_dir>/current/arcsight/logger/bin/arcsight loggersetup

11 In the next screen, click the Browse ( ) icon to locate the license file that you 
received from ArcSight. Click Next.
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12 Select the type of installation.

You can select from these choices.

 Minimal or Standard—If you choose either of these options, storage volume, 
storage groups, indexing, and receivers (to listen for events) are automatically 
configured for you during the installation process using the default values listed in 
the above table. (See “Best Practices for the Minimal Install” on page 56 for 
additional details about Minimal install.)

The following guidelines provide additional information for the above listed 
settings:

 Storage Volume: If needed, you can increase the storage volume size later if 
additional disk space is available.

 Storage Groups: Only two storage groups can be configured for the Minimal 
installation type. Once configured, the number of storage groups cannot be 
increased. Therefore, if you choose Minimal installation, ensure that two 
storage groups will be sufficient for your needs. 

 Indexing: All recommended fields are included in the index and full-text 
indexing is enabled. A complete list of fields is available in the Logger 
Administrator’s Guide.

 Receivers: A TCP and a UDP receiver is automatically configured and enabled. 
Make sure your events sources are configured to send events to these 
receivers on the ports that the configuration wizard displays after this step. 
You can add more receivers or modify the automatically configured ones later 
using the Logger user interface. 

 Custom—If you choose this option, you need to configure indexing, storage 
groups, and the storage volume size, as described in the next step. For this type 

Setting Minimal Standard

Minimum Disk 
Space Required

10 GB 65 GB

Storage Volume 10 GB 65 GB

Storage Groups 2 6

Indexing Full-text and field-based Full-text and field-based

Receivers 2 2
44 Administrator’s Guide Confidential



2 Installation and Initialization
of installation, the receivers are configured using the Logger UI after the 
installation is complete.

13 If you selected “Custom”:

a Enter the maximum size of the Storage Volume. Click Next.

The maximum size you enter can only be equal to or less than the aggregated 
storage size allowed by your license. 

b Add the storage groups to suit your needs. Click the Maximum Age (number of 
days to retain the event) and Maximum Size fields for each storage group you add 
and specify values. Click Next.

ArcSight recommends that you create the maximum allowed of four additional 
Storage Groups (in addition to the two that preexist—Default Storage Group and 
the Internal Storage Group) at this stage even if you do not need all of them 
because you cannot add storage groups later, although you can decrease or 
increase the size of a Storage Group at any time. Additionally, if you will not use 
all storage groups, keep the size of the spare groups to a minimum to optimize 
space for storage groups that you will use.

c If you want to enable full-text indexing, click “Enable full text index”. 

Tip: ArcSight strongly recommends that you enable indexing because indexing 
significantly improves search and reporting performance. When you add fields to 
the index, search queries yield significantly faster results.

Select the fields you want to index. You can drag and drop fields from the left 
column (Indexable Fields) to the right column (Selected Fields). You can also click 
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“Select Recommended Fields” to select the ArcSight recommended fields with one 
click and then drag them to the right column. Click Next.

14 Select the Locale for your Logger, as shown in the following figure. Click Next.

15 If you are logged in as a root user on the system on which you are installing 
Logger software, the following screen enables you to configure software Logger to run 
as a system service. By default, software Logger runs as a standalone application, 
which you need to launch manually after each system reboot. 

When you install software Logger as a root user, a service called arcsight_logger 
can be configured created and enabled at run levels 2, 3, 4, and 5. Additionally, a few 
libraries are added using ldconfig. For a complete list of those libraries, see 
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/etc/ld.so.conf.d/arcsight_logger.conf and 
<install_dir>/current/arcsight/install/ldconfig.out.

16 You have installed Logger. Click Start Logger Now. 

OR click Start Logger later and click Finish.

If you selected to start Logger later, you need to read the “Starting and Stopping the 
Software Logger” on page 52 information to understand how to start Logger later.

17 If you selected “Start Logger Now”, the following screen is displayed. 

You can click Finish to exit the wizard. Logger continues to start service and 
processes in the background. Once Logger service and processes have started up, the 
following screen is displayed.
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Follow the instructions on the above screen or use instructions in “Connecting to the 
Software Logger User Interface” on page 51 to connect to the Logger.

Using the Console Mode to Install Software Logger

To install the software version of Logger using the Console mode:

1 Make sure the machine on which you will be installing the software Logger complies 
with the requirements listed in “Supported Platforms and Browsers” on page 35 and 
the prerequisites listed in “Prerequisites for Installation” on page 39 are met.

2 Run these commands from the directory where you copied the Logger software:

chmod +x ArcSight-logger-5.2.0.XXXX.0.bin

./ArcSight-logger-5.2.0.XXXX.0.bin -i console

The installation wizard launches in command-line mode, as shown below. Press Enter 
to continue.

Introduction
------------

InstallAnywhere will guide you through the installation of 
ArcSight Logger 5.2.

It is strongly recommended that you quit all programs before 
continuing with
this installation.

Respond to each prompt to proceed to the next step in the 
installation.  If you
want to change something on a previous step, type 'back'.

You may cancel this installation at any time by typing 'quit'.

PRESS <ENTER> TO CONTINUE:
…..
Once at the license information is displayed, press Enter until you see the following 
information:

Select "I accept the terms of the License Agreement" below if 
you recognize
that you have read the terms of this Agreement and attachments 
and agree to be
bound by each of these terms.

DO YOU ACCEPT THE TERMS OF THIS LICENSE AGREEMENT? (Y/N):Y

The prompts that follow next are exactly similar to the ones described for the GUI 
mode install in “Using the GUI Mode to Install Software Logger” on page 40. Follow 
the instructions provided for the GUI mode install to complete the installation. 

You can install software Logger as a root user or as a non-root user. See 
“Prerequisites for Installation” on page 39 for details.
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Using the Silent Mode to Install Software Logger
Before you install software Logger in silent mode, you need to create two properties files 
that are required for the silent mode installation:

 A file to capture the installation properties

 A file to capture the configuration properties

Once you have generated the two files, you need to merge them into one file and use the 
resulting file for silent mode installations.

About Licenses for Silent Mode Installations
As for any Logger installation, each silent mode installation requires a unique license file. 
You must obtain licenses from ArcSight Customer Support and place them on the machines 
on which you will be installing Logger in silent mode, or ensure that the location where the 
license is placed is accessible from those machines. 

Generating the Silent Install Properties File
This procedure generates the two properties files first and later instructs you to combine 
them into one file. The resulting file is used for future silent installations.

1 Log in to the machine on which you can install software Logger to generate an 
installation properties file.

If you want the silent mode installations to be done as root user, make sure you are 
logged in as root in this step. Otherwise, log in as a non-root user.

2 Run this command:

./ArcSight-logger-5.2.0.XXXX.0.bin  -r <directory_location>

where <directory_location> is the location of the directory where the generated 
properties file will be placed.

The properties file is called installer.properties. You cannot specify or change 
this name.

3 Install Logger in GUI mode, as described in “Using the GUI Mode to Install Software 
Logger” on page 40. 

At Step 10 on page 43 of the installation procedure, do this:

a Click Previous instead of clicking Done to proceed further, as shown in the 
following figure.
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b Once you are at the previous step, click Cancel to stop the installation, as shown 
in the following figure.

4 Navigate to the directory location you specified for the installer.properties file 
earlier.

The following is an example of generated installer.properties file. 

5 Start the configuration wizard with the option to record configuration properties:

<install_dir>/current/arcsight/logger/bin/arcsight loggersetup 
-i recorderui

When prompted to enter a file name to capture the configuration properties, enter a 
meaningful name; for example, silentproperties.properties.

6 Step through the configuration wizard, as described starting at Step 10 on page 43 of 
the “Using the GUI Mode to Install Software Logger” on page 40.

7 Once the configuration properties file has been generated, append the contents of this 
file to the installer.properties file generated in the previous procedure, 
“Generating the Silent Install Properties File” on page 49, to create a combined file.

For example, you can use the cat command to concatenate both files:

cat installer.properties silentproperties.properties > 
combinedProperties.properties

8 Include the following property in the combined file:

ARCSIGHT_LOGGER_SETUP_PROPERTIES=/<directory>/<combined_propert
ies_file>

where <directory> is the path of the directory where the combined file is located.
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<combined_properties_file> is the file name of the combined file you created 
earlier.

Use the combined file for future Logger silent mode installations, as described in 
“Installing Software Logger in Silent Mode” on page 51.

Installing Software Logger in Silent Mode
To install the software version of Logger using the Silent mode:

1 Make sure the machine on which you will be installing the software Logger complies 
with the requirements listed in “Supported Platforms and Browsers” on page 35 and 
the prerequisites listed in “Prerequisites for Installation” on page 39 are met.

2 A non-root user account, “arcsight”, exists on the machine on which you are installing 
software Logger. This account is required even if you will be installing as a root user.

3 Copy the silent mode properties file you generated previously to the same location 
where you have copied the Logger software.

4 Edit the licensePanel.path property in the silent mode properties file to include 
the location of license file for this instance of installation. (A unique license file is 
required for each instance of installation.) 

OR

Set the licensePanel.path property to point to a file, such as 
software_logger_license.zip. Then, for each instance of the silent mode installation, 
copy the relevant license file to the location and rename it to 
software_logger_license.zip. Doing so will avoid the need to update the combined 
properties file for each installation.

5 Run these commands from the directory where you copied the Logger software:

chmod +x ArcSight-logger-5.2.0.XXXX.0.bin

./ArcSight-logger-5.2.0.XXXX.0.bin -i SILENT -f 
<combined_properties_file>

The rest of the installation and configuration proceed silently, without requiring any 
input from you.

Connecting to the Software Logger User Interface
Because the software Logger user interface uses SSL, make sure you connect to it using 
this URL:

https://<hostname or IP address>:<configured_port>

where hostname or IP address is of the system on which you installed Logger software.
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Once you use the URL specified above, the following Login screen is displayed.

Use the following default credentials if you are connecting for the first time:

Username: admin
Password: password

Starting and Stopping the Software Logger
The loggerd command enables you to start or stop the Logger software running on your 
machine. In addition, the command includes a number of subcommands that you can use 
to control other processes that run as part of the Logger software. If your Logger is 
installed to run as a system service, use the service command to start, stop, or check 
the status of a process on Logger.

<install_dir>/current/arcsight/logger/bin/loggerd 
{start|stop|restart|status|quit}

<install_dir>/current/arcsight/logger/bin/loggerd {start 
<process_name> | stop <process_name> | restart <process_name>}

/etc/init.d/service arcsight_logger {start | stop | status}

Change the credentials as soon as possible after connecting to your Logger 
for the first time.
52 Administrator’s Guide Confidential



2 Installation and Initialization
The following screenshot lists the processes that can be started, stopped, or restarted with 
loggerd. 

The following table describes the subcommands available with loggerd and their 
purpose.

Command Purpose

loggerd start Start all processes listed under the System and Process sections 
in the figure above. Use this command to launch Logger.

loggerd stop Stop processes listed under the Process section only. Use this 
command when you want to leave the Logger process running 
but all other processes stopped.

loggerd restart This command restarts processes listed under the Process 
section only.

Note: When the loggerd restart command is used to restart 
Logger service and process, the status message for the “aps” 
process displays this message:

Process ‘aps’ Execution failed. 

The status and message change to the expected message after 
a few seconds:

Process ‘aps’ running.

loggerd status Display the current status of all processes.

loggerd quit Stops all processes listed under the System and Process 
sections in the figure above. Use this command to stop 
Logger.

loggerd start 
<process_name>

Start the named process. For example, loggerd start apache

loggerd stop 
<process_name>

Stop the named process. For example, loggerd stop apache

loggerd restart 
<process_name>

Restart the named process. For example, 
loggerd restart apache
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Uninstalling the Software Logger 

To uninstall the software version of Logger, enter this command in the directory where you 
installed the software version of Logger: 

./UninstallerData/Uninstall_Arcsight_Logger_5.2

The uninstall wizard is launched. Click Uninstall to start uninstalling Logger.

Applying or Updating a License on the Software Version of 
Logger

To apply a license on the software version of Logger:

1 Save the license file you receive from ArcSight on a computer from which you access 
the Logger user interface through a browser.

2 Run this command:

<install_dir>/current/arcsight/logger/bin/arcsight loggersetup

The following Update License screen is displayed. If you are logged in as a root user, 
the following screen also provides an option to enable or disable Logger from starting 
as a system service. For more information about configuring Logger to start as a 
system service, see “Enabling or Disabling Logger as a System Service” on page 55.

3 Click the Browse ( ) icon to locate the license file that you received from ArcSight. 

Click OK.

If you will be uninstalling Logger software over an SSH connection, make 
sure that you have enabled X window forwarding using the -X option so that 
you can view the screens of the uninstall wizard. 

If you will be using PuTTY, you will also need an X client on the machine from 
which you are connecting to the Linux machine. 
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4 Click Finish. A message on the screen confirms that the license was applied, as shown 
in the following figure.

5 Restart the Logger service and related processes after applying the license. Use this 
command to restart the service and processes:

<install_dir>/current/arcsight/logger/bin/loggerd restart

Enabling or Disabling Logger as a System Service
If you want to disable Logger from starting as a system service, or if you want to enable it 
to start as a system service after it has been installed, follow these steps.

1 Make sure you are logged in as a root user on the system on which Logger is installed.

2 Run this command:

<install_dir>/current/arcsight/logger/bin/arcsight loggersetup

The following screen is displayed.

3 Select Change Logger system service settings and click Next.

4 If Logger is currently installed as a service, the next screen provides you the option to 
disable it. Conversely, if Logger is currently installed as a standalone application, you 
can configure it to run as a service. Click Finish and reboot the Logger for changes to 
take effect.
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Best Practices for the Minimal Install
In general, you should use the “Minimal” install for evaluation purposes or if you do not 
have a server with 65 GB of storage space available, which is the storage space required 
for a “Standard” install. To truly experience the power of Logger, ArcSight recommends 
installing software Logger using the “Standard” or “Custom” installation type. Doing so 
creates a storage system infrastructure on Logger that can handle large data storage 
needs, such as published reports, large amount of exported data, event archives, and so 
on. 

However, if you must install Logger using the “Minimal” installation type, remember that 
Logger does not manage disk space availability for published reports, exported data, or 
event archives. You must ensure that there is sufficient disk space available for these 
functions. A Logger installed using the “Minimal” installation type can quickly run out of 
space if you publish a large number (or large) reports, export a large amount of data, or 
archive events for a long period. 

Installing SmartConnectors to Send Events to Logger
ArcSight Logger is a storage solution optimized for extremely high event throughput. 
Logger stores time-stamped text messages, called events, at high sustained input rates. 
Unlike ArcSight SmartConnectors, Logger does not “normalize” events. Events consist of an 
event time, a receipt time, a source (host name or IP address), and an un-parsed message 
portion. Logger compresses raw data, but can also retrieve it in an unmodified form for 
forensics-quality litigation reporting.

Figure 2-2 ArcSight SmartConnectors interact in a variety of ways with Logger Receivers (R) 
and Forwarders (F).

Multiple Loggers can work together to support an extremely high event volume. ArcSight 
Logger can be configured as a network with queries distributed across all  Loggers.

Logger can be configured to receive and log all events from a device, and to forward 
filtered events on to a destination such as ArcSight ESM. Events can also be filtered by 
individual SmartConnectors. In such a “funnel,” a device that creates many security events 
(such as a firewall) might be read by a SmartConnector which filters events of interest (and 
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optionally aggregates events, as well) and sends them to a Logger Receiver. A Logger 
Forwarder then passes a subset of the received events downstream to ArcSight ESM.

For more information about filtering and aggregation by SmartConnectors, see the ArcSight 
SmartConnector User’s Guide.

Downloading SmartConnectors 
For Logger appliance and the Enterprise Version of software Logger, contact your ArcSight 
sales representative or ArcSight Customer Support for location to download 
SmartConnectors.

For the Downloadable Version of software Logger, a restricted set of ArcSight 
SmartConnectors are supported and available. You can download these SmartConnectors 
from the same location from which you downloaded Logger. The Configuration Guides for 
the supported SmartConnectors are included and available at the same web site. To learn 
more about ArcSight SmartConnectors, visit http://www.arcsight.com.

SmartMessage
SmartMessage is an ArcSight technology that provides an efficient secure channel for 
Common Event Format (CEF) events between ArcSight SmartConnectors and Logger. 
SmartConnectors can also send CEF messages in clear to Logger using syslog protocol. 

SmartMessage provides an end-to-end encrypted secure channel using SSL. One end is an 
ArcSight SmartConnector, receiving events from the many devices supported by ArcSight 
SmartConnectors. The other end is a SmartMessage Receiver on Logger.

Set up the SmartMessage Receiver on Logger first (see “Receivers” on page 171) and then 
configure the SmartConnector as described below.

To configure a SmartConnector to send events to Logger

1 Install the SmartConnector component normally, using the ArcSight SmartConnector 
User’s Guide as a reference. Specify Logger as the destination instead of ArcSight ESM 
or a CEF file.

ArcSight recommends installing SmartConnector v4.7.5 or later. If you do not 
have the current build, download the latest from the ArcSight website.

Older SmartConnectors will work with Logger, but may not support 
SmartMessage or FIPS.

The SmartMessage secure channel uses secure sockets layer (SSL) protocol 
to send encrypted events to Logger. This is similar to, but different from, the 
encrypted binary protocol used between SmartConnectors and ESM Manager.

To use SmartMessage to communicate between an ArcSight SmartConnector 
and a Logger appliance, configure the SmartConnector to use port 443. To 
communicate between an ArcSight SmartConnector and the software 
version of Logger using SmartMessage, configure the SmartConnector to 
use the port that you configured for the software Logger.
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If you have Downloadable Version of software Logger installed, which you downloaded 
from http://www.arcsight.com, refer to the Syslog SmartConnector documentation 
available at the web site from where you downloaded the Logger software. 

2 Specify the required parameters. Enter the Logger hostname or IP address and the 
name of the SmartMessage Receiver. To communicate with a Logger appliance, 
configure port 443. To communicate with the software version of Logger, configure the 
port you have configured for it. 

(For un-encrypted CEF syslog, enter the Logger hostname or IP address, the desired 
port, and choose UDP or TCP output.) These settings will need to match the Receiver 
you create in Logger to listen for events from this connector.

For more information about the Common Event Format (CEF), see “Common Event Format” 
on page 509.

Forwarding Logger Events to an ESM Manager
Logger can forward these types of events to an ESM Manager:

 Syslog events to an ArcSight Syslog SmartConnector that is connected to an ESM 
Manager.

 Common Event Format (CEF) events directly to an ESM Manager using Logger ESM 
Destinations. An ESM Destination appears as a SmartConnector to an ESM Console.

 Events received by file receivers where the type specified is not Other. Such events are 
forwarded using the ArcSight Streaming SmartConnector.

Configuring SmartConnectors to Send Events to Both 
Logger and an ESM Manager

You can configure a SmartConnector to send CEF syslog output to Logger and send events 
to an ArcSight ESM Manager at the same time.

1 Install the SmartConnector normally. Register the SmartConnector with a running ESM 
Manager and test that the SmartConnector is up and running.

2 Start the SmartConnector configuration program again using the 
$ARCSIGHT_HOME/current/bin/runagentsetup script (or arcsight 
agentsetup -w).

3 Select I want to add/remove/modify ArcSight Manager destinations, then 
choose Add new destination.

4 Choose Logger and specify the requested parameters. Restart the SmartConnector for 
changes to take effect.

Configuring SmartConnectors for Failover Destinations
SmartConnectors can be configured to send events to a secondary, failover, destination 
when a primary connection fails.

To configure a failover destination, follow these steps:

Use SmartConnector release 4.7.5 or later for SmartMessages. This 
version is also required for connectors to connect to Logger in FIPS 
mode. For CEF and Syslog, older SmartConnectors will work (build 4785 
or later).
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1 Configure the SmartConnector for the primary Logger as described above. The 
transport must be raw TCP in order to detect the transmission errors that trigger 
failover.

2 Edit the agent.properties file in the directory 
$ARCSIGHT_HOME/current/user/agent, where $ARCSIGHT_HOME is the root 
directory where the SmartConnector component was installed. Add this property:

transport.types=http,file,cefsyslog

Delete the transport.default.type property.

3 Start the SmartConnector configuration program again using the 
$ARCSIGHT_HOME/current/bin/runagentsetup script (or arcsight agentsetup -w).

4 Choose I want to add/remove/modify and, with the primary Logger selected, 
choose Modify. Then select Add failover destination.

5 Enter information for the secondary Logger. 

6 Restart the SmartConnector for the changes to take effect.

7 For more information about installing and configuring ArcSight SmartConnectors, refer 
to the ArcSight SmartConnector User's Guide, or specific SmartConnector 
Configuration Guides, available from ArcSight Customer Support.

Sending Events from ArcSight ESM to Logger
The ArcSight Forwarding SmartConnector can read events from an ESM Manager and 
forward them to Logger as CEF-formatted syslog messages.

To configure the ArcSight Forwarding SmartConnector to send events to Logger 

1 Install the SmartConnector component normally, but cancel the installation when the 
SmartConnector Wizard asks whether the target Manager uses a demo certificate (see 
Figure 2-3). Confirm that you want to exit, then click Done to dismiss the Install 
Wizard. This will install the SmartConnector, but leave it un-configured.

2 Create a file called agent.properties in the directory 
$ARCSIGHT_HOME/current/user/agent, where $ARCSIGHT_HOME is the root 
directory where the SmartConnector component was installed. This file should contain 
a single line:

transport.default.type=cefsyslog

The Forwarding SmartConnector is a separate installable file, named 
similar to this:

ArcSight-4.x.x.<build>.x-SuperConnector-<platform>.exe

Use build 4810 or later for compatibility with Logger.
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3 Start the SmartConnector configuration program again using the 
$ARCSIGHT_HOME/current/bin/runagentsetup script (or arcsight 
agentsetup -w).

Figure 2-3 When the first screen of the SmartConnector Configuration Wizard appears, 
asking about a demo certificate, click Cancel.

4 Specify the required parameters for CEF output. Enter the desired port for UDP or TCP 
output. These settings will need to match the Receiver you create in Logger to listen 
for events from ArcSight ESM.

Parameter Description

Ip/Host IP or host name of the Logger

Port 514 or another port that matches the Receiver

Protocol UDP or Raw TCP

ArcSight Source 
Manager Host Name

IP or host name of the source ArcSight ESM Manager

ArcSight Source 
Manager Port

8443 (default)

ArcSight Source 
Manager User Name

A user account on the source Manager will sufficient 
privileges to read events

ArcSight Source 
Manager Password

Password for the specified Manager user account

SmartConnector Name A name for the ESM to Logger connector (visible in the 
Manager)

SmartConnector 
Location

Notation of where this connector is installed

Device Location Notation of where the source Manager is installed

Comment Optional comments
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To configure the Forwarding SmartConnector to send CEF output to Logger and send 
events to another ArcSight ESM Manager at the same time, see “Configuring 
SmartConnectors to Send Events to Both Logger and an ESM Manager” on page 58.

For more information about the Common Event Format (CEF), see “Common Event Format” 
on page 509.
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Chapter 3

Using the User Interface

This chapter describes the user interface portion of the Logger web application. The user 
interface includes site navigation, and performance monitoring.This chapter includes:

The other tabs, Analyze, Reports, Configuration, and System Admin, are described in later 
chapters.

Connecting to the Logger User Interface
The Logger user interface is a web browser application using Secure Sockets Layer (SSL) 
encryption. Users must be authenticated with a name and password before they can use 
the interface. 

On the Logger appliance, enter the following URL from any of the supported browsers:

https://Hostname or IP address of Logger appliance

Figure 3-1 Users must login to authenticate themselves to Logger.

On the software version of Logger, make sure you connect using this URL:

https://<hostname or IP address>:<configured_port>

where hostname or IP address is of the system on which you installed Logger software.

Navigation: see “Connecting to the Logger User Interface” on page 63

Summary Dashboard: “Summary” on page 69

Dashboards: see “Dashboards” on page 70

Performance monitoring: see “The Default Monitor Dashboard” on page 77
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Once you use the URL specified above, the following Login screen is displayed.

Use the following default credentials if you are connecting for the first time:

Username: admin
Password: password

Browser Requirements
Logger works with most modern browsers, including Firefox and Internet Explorer. 
Javascript and cookies must be enabled. An Adobe Flash Player plug-in is required for 
Internet Explorer browsers that access the Logger user interface. Some redundant 
monitoring features will be unavailable if the Flash Player plug-in is not installed. The Flash 
Player plug-in is available for free at http://www.adobe.com/products/flashplayer/. 

See the Release Notes document to find out the browser versions supported for this 
release.

Change the credentials as soon as possible after connecting to your Logger 
for the first time.
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Navigating the User Interface
As shown in Figure 3-2, a consistent navigation and information band runs across the top 
of every page in the user interface.

Figure 3-2 Overall layout of the Logger interface.

Gauges at the top of the screen provide an indication of the throughput and CPU usage 
information available in more detail on the Monitor Dashboard (“Dashboards” on page 70). 
The range of the gauges can be changed on the Options page. The current logged-in user’s 
name is shown below the statistics. The gauge and logo bar can be collapsed to allow more 

room on the screen for search results and reports. Click the  icon to collapse the bar, and 

the  icon to expand it. 

The menu list in the upper right includes links for Help, Options, and Logout.

Help
Clicking the Help link on any page displays online help for the current page.

In addition to context-sensitive Help for the current page, you can also access the PDF 
version of this guide from the Help link. To access the guide, click the “PDF version of 
Logger Documentation” in the left panel of the Help window.
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Search Helper

Search Helper is a search-specific utility that provides the following:

 Search History—Displays the recently run queries on Logger, thus enabling you to 
select and reuse previously run queries without typing them again.

 Search Operator History—Displays the fields used previously with the search operator 
that is currently typed in the Search text box. The Search Operator History only 
displays if you have previously used the operator you have currently typed to perform 
searches on this Logger.

 Examples—Lists examples relevant to the latest query operator you have typed in the 
Search text box.

 Suggested Next Operators—List of operators that generally follow the currently typed 
query. For example, if you type logger |, the operators that often follow are rex, 
extract, or regex. You can select one of the listed operators to automatically 
append to the currently typed query in the Search text box. This list saves you from 
guessing the next possible operators and manually typing them in. 

 Help—Provides context-sensitive help for the last-listed operator in the query that is 

currently typed in the Search text box. Additionally, if you click the  icon, Logger 
online Help is launched.

 List of Fields and Operators—Depending on the current query in the Search text box, a 
complete list of fields that possibly match the field name you are typing or a list of 
operators that are available on Logger is displayed. This list enables you to select a 
field (or operator) from the list instead of typing it in, thus enabling you to quickly 
build a query expression. The field list only contains fields in the Logger schema, 
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metadata terms (_storageGroup, _deviceGroup, _peerLogger), and the regular 
expression term (|REGEX=). (See “Indexing” on page 139 for a complete list of fields.)

Search Helper is available by default and automatically displays relevant information based 
on the query currently entered in the Search text box. If you do not want the Search 
Helper to display this information automatically, click the “Auto-open is ON” link (in the 
Search Helper window). The link toggles to “Auto-open is OFF”. To access Search Helper on 
demand (once it has been turned off), click the down-arrow button to the right of the 
Search text box.

Options
The Options page, as shown in the following figure, allows you to set the range on the EPS 
In and EPS Out gauges. If the event rate exceeds the specified maximum, the range is 
automatically increased.

Additionally, the default start page (home page) for all users and specific start pages for 
individual users can be set on the Options page. These pages indicate which user interface 
page is displayed after a user logs in.
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Use the following table to figure out how to configure a specific start page.

Logout
Click the Logout link on any page to return to the Login screen. Logging out is good 
security practice, to eliminate the chance of unauthorized use of an unattended Logger 
session.

If you want to set... Configure the...

The same start page for all users Default start page for all users option to the 
desired value.

This is a global setting for your Logger. To override 
this setting, configure a different start page for 
specific users by using the Default start page for 
<username> option. 

When you set Default start page for all users 
option to Dashboards, the Monitor Dashboard is 
the default dashboard displayed for all users, 
unless the users have configured other 
dashboards as their defaults, as described in “To 
set a dashboard as default:” on page 74. 

A different start page for specific 
users 

Default start page for <username> option to 
the desired value.

This setting overrides the global Default start 
page for all users setting.

When this option is set to “Use default for all 
users”, the global default page (Default start 
page for all users) value is used for all users.

A specific dashboard for a 
specific user

OR

A specific dashboard for all users

Default start page for <username> option to 
Dashboards.

The Monitor Dashboard is the default dashboard 
displayed for all users. However, if you want to 
display a different dashboard for one or more 
users, set the desired dashboard as the default 
when logged in as those users. For details, see “To 
set a dashboard as default:” on page 74.
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Logger automatically logs you out after a user-configurable length of time (15 minutes by 
default). To change this length of time, see “Users/Groups” on page 385.

Summary
The Summary page is a global dashboard that provides summarized event information 
about your Logger in one screen. It enables you to gauge incoming events activity and the 
status of indexing. 

Specifically, it contains the following panels:

 Global Summary

The number of events indexed on your Logger since the last time it was 
rebooted/restarted.

 Receivers

The list of receivers configured on your Logger, the number of events received on each 
receiver since the last time the Logger was rebooted/restarted, and the timestamp of 
the last event received on each receiver.

 Devices

A Device is a named event source, comprising of an IP address (or hostname) and a 
Receiver name. 

The Devices panel lists devices configured on your Logger, the number of events 
received on each device since the last time the Logger was rebooted/restarted, and 
the timestamp of the last event received on each device.

Simply closing the browser window does not automatically log you out. Click 
the Logout link to prevent the possibility of a malicious user restarting the 
browser and resuming your Logger session.
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 Agent Severities

The list of severity levels of the incoming events from ArcSight SmartConnectors to 
your Logger, the number of events received of each severity level, and the timestamp 
of the last event received of each severity level.

 Agent Types

The list of ArcSight SmartConnectors sending events to your Logger, the number of 
events received from each SmartConnector since the last time the Logger was 
rebooted/restarted, and the timestamp of the last event received from each 
SmartConnector.

The Summary page is pre-designed to display the information described above. You cannot 
change or add other panels to it. If you need to display other information, you can create a 
custom Dashboard as described in “Dashboards” on page 70. The information displayed on 
the Summary page is for your local Logger only, and does not include information about 
peer Loggers even if peers are configured. 

Each panel displays up to 10 items. If there are more than 10 items, click the  icon to 

see the additional items, and  to go to the end of the list. Similarly, click  to go to the 

previous 10 items, and  to go to the first 10 items.

You can drill down to view the events by a specific resource—receiver, device, agent 
severity, or agent type. To do so, click on the resource to go to the Analyze screen. The 

Search box is automatically populated with the information you had clicked on the 
Summary page, and the Start and End fields are populated with the last time your Logger 
was rebooted/restarted and the current time, respectively. Click Go to run the query to 
search for events matching this criteria. You can further refine the search query to filter the 
search results to suit your needs. A drill-down on sourceType and sourceData fields is not 
supported.

Search Group filters that enforce privileges on storage groups are applied to the content 
displayed on the Summary page. However, Search Group filters that enforce privileges on 
device groups are not applied. Therefore, the Summary page includes counts of events in 
device groups to which a user does not have privileges. However, if the user tries to drill-
down to view events, search results in accordance with access privileges are returned as 
the search query is run on the Analyze page, which enforces all types of Search Group 
filters. Similarly, if a Search Group filter enforces privileges on both, storage groups and 
device groups, only the storage group enforcement is applied on the Summary page.

Dashboards
Dashboards are an all-in-one view of the Logger information of interest to you. You can 
assemble various search queries that match events of interest to you, status of Logger 
resources such as receivers, forwarders, storage, CPU, and disk, or a combination of both 
on a single dashboard for status at-a-glance. 

Each Dashboard contains one or more panels of these types: 

 Search Results
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The Search Results panels display events that match the query associated with the 
panel. 

 Monitor

The Monitor panels display the real-time and historical status of various Logger 
components such as receivers, forwarders, storage, CPU, and disk.

 Summary 

The Summary panels display summarized event information about your Logger—the 
number of events received of a specific resource or field type since the last time the 
Logger was rebooted/restarted, and the timestamp of the last event received for that 
resource or field type.

A dashboard can contain a mix of Search Results, Monitor, and Summary panels. There is 
no limit on the number of Monitor and Summary panels you add to a single dashboard, 
however, you can only add up to four Search Results panels for optimum performance. 

Each Search Results panel is associated with a saved search query. You can only associate 
saved search queries that contain an aggregation operator such as chart or top for this 
type of panel. The Search Results panel can be of two types: Search Results Chart and 
Search Results Table. The Search Results Chart panel displays search results in a chart 
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form, and the Search Results Table panel displays search results in a table form, as shown 
in the following figure.

You can drill-down to view the details of events displayed in the Search Results panels. 
Click the “View on Search Page” link to go to the Analyze (Search) page; the panel query is 
automatically run and the search results are displayed in the table below. 

By default, a Monitor dashboard exists on your Logger that displays the Summary panel, 
which show the status of CPU Usage, Event Flow, Receiver, Forwarder, and Storage Groups 
in a summarized view. The other panels available in this dashboard are: Platform, Network, 
Logger, Receivers, Forwarders, and Storage. These views are described in detail in “The 
Default Monitor Dashboard” on page 77. You cannot change or adjust any panels available 
in this dashboard, however you can add specific Monitor panels to a custom dashboard as 
described in this section. 

Besides adding Search Results panels to a custom dashboard, you can add Monitor and 
Summary panels to it. (See “Summary” on page 69 for more information about default 
Summary dashboard.) These panels provide the same information available through the 
default Monitor dashboard and the default Summary dashboard, however in a modular 
form that enables you to choose specific views. For example, if you want to view the EPS 
for the last 4 hours on all receivers, add the panel Type “Monitor Graph”, and select 
“(Logger) All EPS Out-All EPS In - 4 hour” as the Graph, or if you want to view the EPS on 
Forwarders in a table form, select the “Monitor (Forwarders)” panel Type. Similarly, if you 
want to view only the summary information for receivers on your Logger, add the panel of 
Type “Summary (Receivers)”. Besides the four Summary panels (Agent Severities, Agent 
Types, Receivers, and Devices), you can also create a user-defined Summary panel in 
which you can select any indexed, non-time field by which you want to categorize event 
summary. For example, If you want to add a Summary panel to display event summary 
categorized by “destinationAddress”, you can add a panel of Type “Summary (User 
Defined)” for this field if it is indexed on your Logger.

You can also drill-down on any of the resources listed in the Monitor and Summary panels 
you add to view events by a specific resource or field value on the Analyze (Search) page. 
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For example, you can click on a storage group in a Monitor panel to view its events in the 
last 24 hours, or you can click on an event name “Network Usage - Inbound” to view all 
events of that name in the last one hour. Additionally, you can access the Configuration 
page for any of the resources listed in the Monitor panels to configure them. For example, 
if you want to configure a receiver, click the Configure link on top of the Monitor (Receiver) 
panel.

The Monitor dashboard is displayed by default, unless you configure another dashboard as 
your default.

Dashboards that you create can be Private or Shared. The privacy settings only control 
view access to the dashboards. That is, the private dashboards are only visible to the user 
who created them, and the shared dashboards are visible to all users of Logger. 
Additionally:

 The “admin” user can see the private dashboards; however, he/she cannot edit or 
delete them. 

 The shared dashboards can be edited or deleted by the users who created them, and 
the admin user. 

A user accessing a shared dashboard must have privileges to view the information 
displayed in the dashboard; otherwise, the information to which they do not have the 
privileges is not displayed, and the associated panel displays a message that indicates the 
reason for the undisplayed information. 

Search Group filters that restrict privileges on device groups are not enforced on Summary 
panels. Therefore, Summary panels include counts of events in device groups to which a 
user does not have privileges. However, if the user tries to drill-down to view events, 
search results in accordance with access privileges are returned as the search query is run 
on the Analyze page, which enforces all types of Search Group filters. Similarly, if a Search 
Group filter enforces privileges on both, storage groups and device groups, only the 
storage group enforcement is applied on Summary panels.

Creating and Managing Dashboards
You need these privileges (in the Logger Rights group) to perform dashboard operations:

 “Use and view dashboards”—for using and viewing dashboards

 “Edit, save, and remove dashboards”—for editing, saving, and removing dashboards

The following steps outline the process of creating a dashboard:

1 Ensure that you have the privileges to create a dashboard.

2 Create a dashboard. See “To add a dashboard:” on page 73.

3 Add panels to the dashboard you created. See “To add a panel to a dashboard:” on 
page 75.

If you are adding a Search Results panel, the saved search must exist. If no saved 
searches exist, the Search Results panel option is not displayed.

To add a dashboard:

1 Click Dashboards from the top-level menu bar.

2 Click the Tools drop-down menu and select Create Dashboard.

3 Enter a meaningful name for the dashboard in the Name field.
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4 Select whether the dashboard Type is Private or Shared.

The private dashboards are only visible to the user who created them, and the shared 
dashboards are visible to all users of Logger.

5 Click Create.

The dashboard is created. You must add panels to the dashboard next, as described in 
“To add a panel to a dashboard:” on page 75.

To edit a dashboard: 

When you edit a dashboard, you can change its name or privacy setting—Private or 
Shared. When you make a dashboard Shared, all Logger users can see it; however, they 
will not see the information to which they do not have privileges. For example, if a user 
does not have privileges to a storage group and a panel in a Shared dashboard includes a 
query that accesses the events in that storage group, the panel will be blank when the user 
accesses the shared dashboard.

1 Click Dashboards from the top-level menu bar.

2 Click the Tools drop-down menu and select Edit Dashboard.

3 If you want to change the name of the dashboard, enter a new name in the Name 
field.

4 If you want to change the privacy setting of the dashboard, select the appropriate 
setting from the Type drop-down menu.

5 Click Save. 

To delete a dashboard:

1 Click Dashboards from the top-level menu bar.

2 Select the dashboard that you want to delete.

3 Click the Tools drop-down menu and select Delete Dashboard.

4 Click Yes to confirm your action in the confirmation message, or click No to exit 
without making a change.

To set a dashboard as default:

When you set a dashboard as default, it is the default dashboard screen that displays when 
you navigate to the Dashboards menu. This setting is user-specific, therefore, your default 
dashboard can be different from another user. 

For all Logger users, the Summary page (accessible from the Summary navigation option in 
the top-level menu bar) is the default home page. That is, when you log in, the Summary 
page is displayed first. However, you can configure Logger to display a specific dashboard 
as the default home page for you. To do so, first configure the option described in 
“Options” on page 67, then use the following procedure to select the dashboard you want 
to display by default.

1 Click Dashboards from the top-level menu bar.

2 Select the dashboard that you want to configure as default.

3 Click the Tools drop-down menu and select Select as Default. 

4 Click Yes to confirm your action in the confirmation message, or click No to exit 
without making a change.
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Adding and Managing Panels in a Dashboard
A dashboard can contain a mix of Search Results, Monitor, and Summary panels. There is 
no limit on the number of Monitor and Summary panels you add to a single dashboard, 
however, you can only add up to four Search Results panels for optimum performance. 

You can add the following types of panels:

 Search Results—Chart and Table

 Monitor—All four types available under the default Monitor dashboard

 Summary—All four types available under the default Summary dashboard and user-
defined Summary panels. 

To add a panel to a dashboard:

1 Click Dashboards from the top-level menu bar.

2 Select the dashboard to which you want to add the panel.

3 Click the Tools drop-down menu and select Add Panel.

4 Configure these parameters.

Parameter Description

Type Select the type of panel:

• Search Result Chart—Displays search results in a chart form

• Search Result Table—Displays search results in a table form

• Monitor Graph—Displays a graph of the selected resource

• Monitor Table (Forwarder)—Displays forwarder information 
in a table form

• Monitor Table (Receiver)—Displays receiver information in a 
table form

• Monitor Table (StorageGroup)—Displays storage group 
information in a table form

• Summary (Agent Severities)—Displays event summary 
categorized by agent severities configured on your Logger

• Summary (Agent Types)—Displays event summary 
categorized by receivers configured on your Logger

• Summary (Receivers)—Displays event summary categorized 
by receivers configured on your Logger

• Summary (Devices)—Displays event summary categorized 
by devices configured on your Logger

• Summary (User Defined)—Displays event summary 
categorized by the field you select when adding the panel

Note: If no saved search queries exist on your Logger, the 
“Saved Search” panel types are not available as selections in 
the drop-down menu.

Title Enter a meaningful name for the panel.

A default name is present in this field, however, you can change 
it.
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5 Click Add.

To edit a panel:

Once you add a panel to a dashboard, whether you can edit it depends on the type of 
panel. You can edit the Search Results panels and the user-defined Summary panels; the 
Monitor panels and some of the Summary panels are not editable.The following table lists 
the panels you can edit and what you can edit in them.

1 Click Dashboards from the top-level menu bar.

2 Select the dashboard that contains the panel you want to edit. 

3 If you are editing a user-defined Summary panel:

Graph Only applicable to Monitor Graph panels.

Select the type of graph you want the panel to display. Some of 
the available options are: CPU Usage - 4 hour, Platform Memory 
Usage - Daily, and Disk Read-Write - Weekly.

Saved Search Only applicable to Search panels.

Select the saved search query to use for searching events that 
will be displayed in the panel.

Chart Type Only applicable to Search Result Chart panels.

Type of chart to display matching events. You can select from:

Column, Bar, Pie, Area, Line, Stacked Column, Stacked Bar.

Default: Column

Chart Limit Only applicable to Search Result Chart panels.

Number of unique values to plot. Default: 10 

Field Name Only applicable to Summary (User Defined) panels.

The event field name by which the event summary on a 
Summary panel will be categorized. Default: agentSeverity

Action Description

All Panels

Delete Removes a panel from a dashboard.

Search Result Panels

Edit Panel Change Title, associated saved search, Chart Type, or Chart Limit

Edit Saved 
Search

Access the Edit Saved search page to edit the associated saved 
search query

View on 
Search Page

Runs the panel’s query on the Search Results page (Analyze > 
Search) and displays matching events on that page

Refresh Refreshes the current contents of the panel. 

Note: All other panel types are automatically refreshed; therefore, 
an explicit refresh is not required for them.

Summary Panels - User Defined

Edit Panel Change Title or field name by which events are categorized.

Parameter Description
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a Click the ( ) icon.

b Edit the title, field name, or both. 

4 If you are editing a Search Result panel:

a Click the (  ) icon. 

b Select Edit Panel if you want to edit the panel title, select a different saved 
search; or, if applicable, chart type or chart limit.

c Select Edit Saved Search if you want to access the Edit Saved Search page 
(under the Configuration menu option from the top-level menu bar) to edit the 
saved search query. 

5 Click Save.

To delete a panel from a dashboard:

You cannot delete panels from the default Monitor dashboard or the default Summary 
dashboard that you access from the Monitor and Summary menu options from the top-level 
menu bar. However, Monitor and Summary panels added to the dashboards you created 
under the Dashboards menu option can be deleted.

1 Click Dashboards from the top-level menu bar.

2 Select the dashboard that contains the panel you want to delete. 

3 Click the ( ) icon. 

4 Click Yes to confirm your action in the confirmation message, or click No to exit 
without making a change.

To change the layout of a dashboard:

You can only change the layout of the dashboards you create. The Monitor dashboard 
layout cannot be changed. 

1 Click Dashboards from the top-level menu bar.

2 Select the dashboard that contains the panel you want to rearrange. 

3 Click the Tools drop-down menu and select Change Layout. 

4 Point your cursor in the blue band that shows the panel title and drag the panel to a 
different position.

5 Click Save after you have rearranged the panels.

The Default Monitor Dashboard
The Monitor Dashboard is available on your Logger by default. It displays the real-time and 
historical status of Receivers, Forwarders, and Storage, CPU, and disk usage statistics. (On 
the software version of Logger, the CPU and disk usage statistics indicate the total use of 
these resources on the system, not just the use of these resources by the Logger process.) 

The Summary panel, which is the default panel, shows the status of CPU Usage, Event 
Flow, Receiver, Forwarder, and Storage Groups in a summarized view. The other Monitor 
panels available through a drop-down menu are: Platform, Network, Logger, Receivers, 
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Forwarders, and Storage. You cannot change or adjust any panels available in this 
dashboard. 

Figure 3-3 The Monitor dashboard displays summary information by default

All monitor pages, except Summary, include an additional drop-down menu for duration 
control. On these, choose a time span for historical data:

 4-hours

 Daily

 Weekly
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On the Summary page, click on a Receiver, Forwarder, or Storage Group name to jump to 
the Search page and include the selected resource in the query.

• The total space allocated for a storage group includes a certain amount 
that has been set aside to ensure that the group can receive new events 
when it is almost full. As a result, the percentage of used space for a 
storage group never reaches 100% (as displayed on the Monitor > 
Summary page). For software Loggers installed using the Minimal setting, 
the maximum % Used (On the Monitor > Summary page) for each 
storage group reaches up to 66.33%. (Two storage groups of 3 GB each; 
1 GB is set aside for new events in each group. After 2 GB of space has 
been used and the new events are being written to the last 1 GB, Logger 
automatically triggers retention and reclaims 1 GB of the used space. 
Thus, the % Used field for each storage group only reaches up to 
66.33%.)

• The “Session Inactivity Timeout” setting on the Authentication Settings 
page (System Admin > Users/Groups > Authentication) does not apply to 
the user interface pages accessed through the Monitor menu. That is, if a 
user is on any of the user interface pages accessed through the Monitor 
menu and the session has been inactive for the number of minutes 
specified in the “Session Inactivity Timeout” setting, the user’s session 
will not time out.
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Platform
The Platform monitor page, as shown in Figure 3-4, displays information about CPU usage, 
memory usage, bytes received and sent on the network, and raw disk reads and writes.

Figure 3-4 Monitor dashboard - Platform page

Network
The Network monitor page display a graph for each network interface card. (The number 
of network interface cards varies by the hardware model.) The graph displays the bytes 
transmitted, overlaid on the bytes received.
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Logger
The Logger monitor page, as shown in Figure 3-5, displays details of memory usage as well 
as information about searches performed.

Figure 3-5 Memory usage displayed on the Logger page of the Monitor dashboard

Receivers
The Receivers monitor page shows total Events per Second (EPS) received and displays 
values for each configured Receiver.

The list of Receivers includes all Receivers known to the system, including those that are 
disabled.

To create a new Receiver, or to enable or disable one, see “Receivers” on page 171.

Forwarders
The Forwarders monitor page shows total Events per Second (EPS) sent and displays 
values for each configured Forwarder.

The list of Forwarders includes all Forwarders known to the system, including those that 
are disabled.

To create a new Forwarder, or to enable or disable one, see “Forwarders” on page 178.

Storage
The Storage monitor page, shown in Figure 3-6, displays disk read and disk write 
information. The list of Storage Groups compares allocated and used space in each group. 
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Space is used in 1 GB chunks so a 5 GB Storage Group appears 20% used as soon as it is 
set up.

For more information about Storage Groups, see “Storage Groups” on page 165.

Figure 3-6 Monitor dashboard - Storage page
82 Administrator’s Guide Confidential



Chapter 4

Searching and Analyzing Events

This chapter describes how to search for specific events in Logger for analysis. First, the 
chapter discusses the methods available for search, how to query for events, how to save a 
defined query and the events that the query finds for future use. Next, the chapter 
describes how to set up alerts to get notified when events matching the criteria you 
specified are received.

The Need to Search Events
When you need to analyze events matching a specific criteria, include them in a report, or 
forward them to another system such as ArcSight ESM, you will need to search for them on 
the Logger. 

You need to create queries to search for events. Queries can be as simple as a term to 
match, such as “login” or an IP address; or they can be more complex, such as events that 
include multiple IP addresses, ports, and occurred between specific time ranges from 
devices that belong to a specific device group.

“The Need to Search Events” on page 83

“The Process of Searching Events” on page 84

“Elements of a Search Query” on page 84

“Syntax Reference for Query Expression” on page 116

“Using the Search Builder Tool” on page 120

“Search Analyzer” on page 124

“Regex Helper Tool” on page 126

“Searching for Events on Logger” on page 128

“Understanding the Search Results Display” on page 130

“Exporting Search Results” on page 136

“Indexing” on page 139

“Saving Queries (Saved Filters and Searches)” on page 143

“System Filters/Predefined Filters” on page 146

“Alerts” on page 148

“Live Event Viewer” on page 150
Confidential Administrator’s Guide 83



4 Searching and Analyzing Events
The Process of Searching Events
Searching through stored events is very simple and intuitive on Logger. It uses a flow-
based search language that allows you to specify multiple search commands in a pipeline 
format. In addition, you can customize the display of search results, view search results as 
charts, and so on. 

You enter the keywords or information you are searching for (referred as queries) in the 
Search text box, select the time range, and click Go, as shown in the previous figure. 
Logger searches for the data that matches the criteria you specified and displays the 
results on the same user interface page where you entered your query.

A query can be as simple as a keyword; for example, hostA.companyxyz.com. Or a 
complex query that includes boolean expressions of keywords and indexed fields, and 
regular expressions; for example:

_storageGroup IN ["Default Storage Group"] _deviceGroup IN 
["192.168.22.120 [TCPC]"] name="*[4924TestAlert]*" AND ("192.168.*" 
OR categoryBehavior CONTAINS Stop) | REGEX=":\d31" |  chart count 
by name

Additionally, a query can include constraints that limit the search to specific device groups 
and storage groups.

Logger offers several convenient ways to enter a search query—typing the query in the 
Search text box, using Logger’s Search Builder tool to create a query, or using a previously 
saved query (referred to as filter or saved search). When you type a query, the Search 
Helper facility provides suggestions and possible matches to quickly build a query 
expression. (See “Search Helper” on page 66 for more information.) 

Although a search query on Logger is as simple as entering a keyword to match, you will 
utilize the full potential of Logger’s search operation if you are familiar with all the elements 
of a query, as described in the next section, “Elements of a Search Query” on page 84.

Elements of a Search Query
A simple Logger search query consists of these elements:

 Query Expression

 Time range

 Field Set

An advanced Logger search query can also include constraints that limit the search to 
specific device groups, storage groups, and  Loggers.

Query Expression
A query expression is a set of conditions that are used to select or reject an event when a 
search is performed. The expression can specify a very simple term to match such as 
“login” or an IP address; or it can be more complex, such as events that include several IP 
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addresses, ports, and occurred between specific time ranges from devices that belong to a 
specific device group.

A query expression is what you specify in the Search text box on Logger and is specified in 
the following syntax.

Indexed Search | Search Operators

The query expression is evaluated from left to right in a pipeline fashion. First, events 
matching the specified indexed search expression are found. The search operator after the 
first pipe (“|”) character is then applied to the matched events followed by the next search 
operator, and so on to further refine the search results. 

Once you run a search query, search results (in tabular form and a histogram) are 
previewable, that is, immediately displayed on the user interface even if the query has not 
finished scanning all data. As additional events are matched, the search results table and 
the histogram are refreshed. Certain search operators such as head, tail, and so on 
however require a query to finish running before search results can be displayed.

Indexed Search is described in “Indexed Search” on page 85.

Search Operators are described in “Search Operators” on page 87.

Indexed Search
The Indexed search uses Logger’s indexing capability to quickly and efficiently search for 
relevant data, and enables you to specify keywords, indexed, and non-indexed fields 
in a boolean expression. 

Keywords

Keywords are words expressed in plain English. For example, failed, login, and so on. Make 
sure you understand and follow the requirements and guidelines listed in “Syntax 
Reference for Query Expression” on page 116. 

Multiple keywords can be specified in one query expression by using boolean operators 
between them. Boolean expressions can be nested; for example, (John OR Jane) AND 
Doe*. Although the boolean operators AND, OR, and NOT can be specified in upper-, 
lower-, or mixed case when used as an operator, ArcSight recommends that you use 
uppercase. To search for these words (upper-, lower-, or mixed case) in events, enclose 
them in double quotes (“”). For example, “and”, “OR”, and so on. 

Keyword search is case insensitive.

Indexed and Non-Indexed Fields

The Logger indexing capability allows for fields of events to be indexed. The Logger’s 
search operation and reports utilize these indexed fields to yield significant search and 
reporting performance gains.

Although you can add indexed and non-indexed fields to a search query, you will realize 
the search and reporting performance gains only if all fields in a query are 
indexed. (For more information and a list of fields you can index, see “Indexing” on 
page 139. For discussion on field-based query performance, see “Performance 
Optimizations for Indexed Fields in Search Queries” on page 125.)

Field search is case sensitive. Make sure you understand and follow other requirements 
and guidelines listed in “Syntax Reference for Query Expression” on page 116.
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You can specify multiple field conditions and also connect keywords to field conditions in a 
query expression; when doing so, connect them with boolean operators. For example, the 
following query searches for events with keyword “failed” (without double quotes) or 
events with “name” field set to “failed login” (lowercase only; without double quotes) and 
the message field not set to “success” (lowercase only; without double quotes):

failed OR (name=“failed login” AND message!=”success”)

A complete list of fields you can specify is available in “Indexing” on page 139 section. The 
operators you can use are listed in the following table. Multiple field conditions can be 
specified in one query expression by using the listed operators between them. The 
conditions can be nested; for example, (name=”John Doe” OR name=”Jane Doe”) 
AND message!=”success”.

Any literal operator in the following list can be specified in upper-, lower-, or mixed case. To 
search for these words as literals in events, enclose them in double quotes (“”). For 
example, message CONTAINS “Between”. 

If a query includes the boolean operator OR and the metadata identifiers 
(discussed in “Constraints” on page 114), the expression to be evaluated with 
OR must be enclosed in parentheses, as shown in this example:

(success OR fail) _storageGroup IN ["Default Storage Group"]

If the expression is not enclosed in parentheses, an error message is 
displayed on the user interface screen.

Field 
Operator

Example

String Operators

!= message!="failed login"

message!=failed*login (* means wildcard)

message!=failed\*login (* is literal in this case)

= message="failed login"

message="failed*login" (* means wildcard)

> These operators evaluate the condition lexicographically. For 
example, deviceHostName BETWEEN AM AND EU searches for all 
devices whose names start with AM, AMA, AMB, AN, AO, AP and so 
on, up to EU. Therefore, any device whose name starts with AK, AL, 
and so on is ignored. Similarly, devices with names EUA, EUB, FA, 
GB, and so on will be ignored.

<

>=

<=

BETWEEN

IN

STARTSWITH message STARTSWITH "failed"

ENDSWITH message ENDSWITH "login"

CONTAINS message CONTAINS "foobar"

Numeric / Timestamp Operators

= bytesIn = 32
86 Administrator’s Guide Confidential



4 Searching and Analyzing Events
Search Operators
The Search Operators enable you to further refine the data that matched the indexed 
search filter. 

Prior to Logger v5.2, you needed to use a special search operator—cef—to extract CEF 
fields from  CEF events that matched the indexed search filter (the query portion before the 
first pipeline in the query expression) before you could use other search operators to act 
upon those fields. However, starting with Logger v5.2, you do not need to explicitly extract 
the CEF fields and then apply other search operators to those fields. You can specify the 
event fields directly in queries. The CEF operator has been deprecated as of Logger v5.2. 

Another search operator, rex,is useful for syslog (raw) events or if you want to extract 
information from a specific point in an event, such as the 15th character in an event. 

!= destinationPort != 100

> bytesIn > 100

>= endTime >= "01/13/2009 07:07:21"

endTime >= “2009/13/01 00:00:00 PDT”

endTime >= “Sep 10 2009 00:00:00 PDT”

< startTime < "$now - 1d"

<= startTime <= "$now - 1d"

BETWEEN priority BETWEEN 1 AND 5

SQL Operator

IS sessionId IS NULL

sessionId IS NOT NULL

Boolean Operators

AND name="Data List" AND message="Hello" AND 1.2.3.4

OR (name="TestEvent" OR message="Hello") AND type=2 AND 1.2.4.3

NOT NOT name="test 123"

List Operator

IN priority IN [2,5,4,3]

destinationAddress IN ["10.0.20.40",  "209.128.98.147"]

_deviceGroup IN ["DM1"]

_storageGroup NOT IN ["Internal Event Storage Group”, “SG1"]

_peerLogger IN [“192.0.2.10”, “192.0.2.11”]

Field 
Operator

Example
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Other operators such as head, tail, top, rare, chart, sort, fields, and eval are 
applied to the CEF fields you specify or the information you extract using the rex operator. 

Search Operator Description and Examples

cef (Deprecated starting with Logger v5.2.)

Prior to Logger v5.2, you needed to use the cef operator to extract CEF fields 
from CEF events that matched the indexed search filter (the query portion 
before the first pipeline in the query expression) before you could use other 
search operators to act upon those fields. However, starting with Logger 
v5.2, you do not need to explicitly extract the CEF fields and then apply other 
search operators to those fields. You can specify the event fields directly in 
queries. 

Extracts values for specified fields from matching CEF events. If an event is 
non-CEF, the field value is set to NULL.

Usage: ...| cef <field1> <field2> <field3> ...

Notes:

• If multiple fields are specified, separate each field name with a white 
space or a comma. 

• To identify the name of a CEF field, use the Search Builder tool (click 
Advanced Search under the Search text box), which lists the names of all 
fields alphabetically.

• The extracted fields are displayed as additional columns in the All Fields 
view (of the System FieldSets). To view only the extracted columns, select 
User Defined Fieldsets from the System Fieldsets list.

Examples:

1. ...| cef categorySignificance agentType 

2. ...| cef deviceEventCategory name 

chart Displays search results in a chart form of the specified fields. 

Usage: 

...| chart <field> 

...| chart count by <field1> <field2> <field3> ...
[span [<time_field>]=<time_bucket>]

...| chart {{sum | avg | min | max | stdev} (<field>)}+ by 
<field1>, <field2>, <field3> ...[span [<time_field>]= 
<time_bucket>]

...| chart {<function> (<field>)} as <new_column_name> by <field> 
[span [<time_field>]=<time_bucket>]

Deprecated Usage: 

The following deprecated usage contains “_count”. The recommended usage, 
as shown above, is “count”.

...| chart _count by <field1> <field2> <field3> ...

where 

<field>, <field1>, <field2> are the names of the field that you want to 
chart. The fields can be either event fields available in the Logger schema or 
a user-defined fields created using the rex or eval operator prior in the 
query. 

<time> is the bucket size for grouping events. Use d for day, h for hour, m for 
minute, s for seconds. For example, 2h, 5d, 1m. (See Notes for details.) 

<function> is one of these: count, sum, avg (or mean), min, max, 
stdev

<new_column_name> is the name you want to assign to the column in which 
the function’s results are displayed. For example, Total. 
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chart 

chart 
(Aggregation 
functions)

Notes: 

• By default, a column chart is displayed. Other chart types you can select 
from: bar chart, line chart, pie chart, area chart, stacked column, or 
stacked bar. 

• To change the chart settings (including its type), click  to the upper 
right corner of the Result Chart frame of the screen. You can change these 
settings: 

- Title: Enter a meaningful title for the chart.

- Type: Column, Bar, Pie, Area, Line, Stacked column, Stacked Bar. The 
last two types create stacked charts in which multiple values are plotted 
in a stack form. These charts are an alternate way of representing multi-
series charts, which are described below.

- Display Limit: Number of unique values to plot. Default: 10 

If the configured Display Limit is less than the number of unique values 
for a query, the top values equal to the specified Display Limit are plotted. 
That is, if the Display Limit is 5 and 7 unique values are found, the top 5 
values will be plotted.

• All chart commands except “count by” accept only one field in the input. 
The specified field must contain numeric values.

• If multiple fields are specified, separate the field names with a white 
space or a comma.

• The chart <field> command does not aggregate field values. It simply 
lists and charts each occurrence of the values of the specified field. For 
example, chart sourcePort. However, when you use an aggregation 
function such as count by, sum, avg (or mean), and so on, an 
aggregation of the specified fields is performed and charted, as illustrated 
in “Example 1 for Chart Operator using the default chart setting (Column 
Chart), when multiple fields are specified. In this example, a count of 
unique groups of deviceEventCategory and name fields is displayed and 
plotted.” on page 92. 

Aggregation functions

• If an aggregation function such as count, sum, or avg is specified, a chart 
of the aggregated results is displayed along with the tabular results of the 
aggregation operation in a Results Table. For example, for the aggregation 
function sum(deviceCustomNumber1), the sum_deviceCustomNumber1 
column in the Results Table displays the sum of unique values of the 
deviceCustomNumber1 field. If this field had two unique values 1 and 20, 
occurring 2 times each, the sum_deviceCustomNumber1 column displays 
sum of those two values, as shown in the following figure:

Search Operator Description and Examples
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chart 
(Aggregation 
functions)

chart (Multi-
series charts)

• Aggregation functions can only be used on numeric fields.

• The mathematical operators avg and mean are identical.

• You can include multiple functions in the same chart command. When 
doing so, separate each function with a comma, as shown in this 
example:

...| chart count, sum(deviceCustomNumber3) by 
deviceEventClassId 

When you include multiple functions, one column per function is displayed 
in the search Results Table. The Results Chart, however, plots the chart 
for the field specified in the “by” clause.

• You can use the “as new_column_name” clause to name any column 
resulting from the aggregation functions, as shown in this example:

...| chart sum(deviceCustomNumber3) as TotalStorage, 
avg(deviceCustomNumber3) as AverageStorage by 
deviceCustomNumber3

• Once defined, the newly defined column can be used in the pipeline as 
any other field. For example,

...| chart sum(deviceCustomNumber3) as TotalStorage, 
avg(deviceCustomNumber3) as AverageStorage by 
deviceCustomNumber3 | eval UpdatedStorage = TotalStorage + 100

• When you export the search results of a chart operator, the newly defined 
column name (using the chart function as new_column_name 
command) is preserved.

Multi-series charts

• When you include multiple aggregation functions in a chart command, a 
multi-series chart is generated that plots the values of the specified 
aggregation functions along the Y-axis in a single chart. For the following 
query, unique groups of deviceEventClassId and deviceEventCategory are 
plotted along the X-axis, and the sum of deviceCustomNumber1 and 
average of deviceCustomNumber2 is plotted along the Y-axis, as shown in 
“Example 2 for a multi-series chart when multiple aggregation functions 
are specified in a chart command:” on page 93. 

...| chart sum(deviceCustomNumber1), avg(deviceCustomNumber2) 
by deviceEventClassId, deviceEventCategory

Multi-series charts can be represented in any of the chart settings 
described above except Pie charts. An example of a multi-series chart, 
represented as stacked column is shown in “Example 3 for multi-series 
chart, represented using Stacked Column chart setting:” on page 94.
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chart (span) Span operator

• In addition to grouping events by the Logger schema fields (or the ones 
defined by the rex or eval operators), the span operator provides an 
additional way to group events by a time field (such as EventTime or 
deviceReceiptTime) and a time bucket. In the following example, 
deviceReceiptTime is the time field and 5m (5 minutes) is the time 
bucket:

...| chart count by deviceEventCategory span 
(deviceReceiptTime) = 5m

If a time field is not specified for the span operator, EventTime is used as 
the default. For example, the following query uses EventTime by default:

...| chart count by deviceEventCategory span = 5m

By default, the chart command displays the first 10 unique values. If the 
span operator creates more than 10 unique groups, not all of them will be 
displayed. If you want to view all of the unique groups, increase the 

Display Limit value under Chart Settings. (Click  to the upper right 

corner of the Result Chart frame of the screen.)

Grouping with span is useful in situations when you want to find out the 
number of occurrences in a specific time span. For example, if you want 
to find out the total number of incoming bytes every 5 minutes on a 
device, you can specify a span of 5m, as shown in this example:

...| chart sum(deviceCustomNumber1) span=5m

The above example assumes that deviceCustomNumber1 field provides 
the incoming bytes information for these events. 

The span field can be used for grouping in conjunction with or without the 
event fields that exist in Logger schema or user-defined fields using the 
rex or eval operators. When a span field is specified in conjunction with 
an event field, the unique sets of all those fields is used for grouping. The 
following example uses deviceCustomNumber3 and deviceAddress in 
conjunction with span to find out the number of events (using 
deviceCustomNumber3) from a specific source (using deviceAddress) in 
one hour:

...| chart sum (deviceCustomNumber3) by deviceAddress span=1h

When span is included in a query, search results are grouped by the 
specified time bucket. For example, if span=5m, the search results will 
contain one row for each 5-minute span. If there are no events within a 
specific 5-minute span, that row will be empty. 

Additionally, the span operator assumes a 24-hour day, all year long. If 
span=1d or 24h, on the day of daylight savings time change, the event 
time indicated by the span_eventTime field in the search results will be 
different from the previous day by one hour. On the day when there are 
23 hours in a day (in March), the span bucket will still include events from 
the last 24 hours. Similarly, on the day when there are 25 hours in the 
day (in November), the span bucket will include events from the last 24 
hours. The following example illustrates the span_eventTime field when 
the span time bucket is 1d and the daylight savings times occurs on 
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chart (span 
contd.)

March 14th, 2011 and November 7, 2011: 

span_eventTime | avg_logins

3/11/2011 12am | 8

3/12/2011 12am | 10

3/13/2011 12am | 4

3/14/2011 1am   | 6

3/15/2011 1am   | 7

….

11/5/2011 1am   | 4

11/6/2011 1am   | 2

11/7/2011 12am | 5

11/8/2011 12am | 7

….

Example 1 for Chart Operator using the default chart setting (Column Chart), when 
multiple fields are specified. In this example, a count of unique groups of 
deviceEventCategory and name fields is displayed and plotted.

... | chart count by deviceEventCategory name
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Example 2 for a multi-series chart when multiple aggregation functions are specified in a 
chart command: 

... | chart sum(deviceCustomNumber1), avg(deviceCustomNumber1) by deviceEventClassId 
deviceEventCategory
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Example 3 for multi-series chart, represented using Stacked Column chart setting:

... | chart min(baseEventCount) sum(deviceCustomNumber1) AS Qiansum by bytesOut
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dedup Removes duplicate events from search results. That is, events that contain 
the same value in the specified field. The first matching event is kept, and the 
subsequent events with the same value in the specified field are removed.

Usage: ... | dedup [N] <field1>,<field2>, ... 
[keepevents=(true|false)] [keepempty=(true|false)] 

N is an optional number that specifies the number of duplicate events to 
keep. For example, “dedup 5 deviceEventClassId” will keep the first five 
events containing the same deviceEventClassId values for each 
deviceEventClassId, and remove the events that match after the first five 
have been kept. Default: 1.

field1, field2 is a field or a comma-separated field list whose values are 
compared to determine duplicate events. If a field list is specified, the values 
of the unique sets of all those fields are used to remove events. For example, 
if name and deviceCustomNumber1 are specified, and two events contain 
“Network Usage - Outbound” and “2347896”, only the first event is kept in 
the search results. 

keepevents specifies whether to set the fields specified in the field list to 
NULL or not. When this option is set to True, the values are set to NULL and 
events are not removed from search results. However, when this option is set 
to False, duplicate events are removed from the search results. Default: 
False. 

keepempty specifies whether to keep events in the search results whose 
specified fields contain NULL values. When this option is set to True, events 
with NULL values are kept, however if this option is set to False, events with 
NULL values are removed. Default: False. 

Examples:

1. To view events from unique devices:

... | dedup deviceAddress

2. To view unique deviceEventClassId events from unique devices:

... | dedup deviceEventClassId deviceAddress

3. To view the className in events with Java exceptions in the message field:

exception | <rex_expression> | dedup 5 className

In the above example, rex expression is not shown in detail however this 
expression extracts the class name in a field called className, which the 
dedup operator acts upon.
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eval Display events that match the resultant of the specified expression. The 
expression can be a mathematical, string, or boolean operation and is 
evaluated when the query is run. The resulting value of the expression is 
assigned to a field name (as specified in the expression). Once a new field 
has been defined by the eval operator in a query, this field can be used in the 
query for further refining the search results (see Example #3 below, in which 
a new field “Plus” is defined by the eval operator; this field is then used by 
the sort operator.)

Usage: | eval <expression>

<expression> is a mathematical, string, or boolean operation; for example, 
total_bytes=bytesIn + bytesOut. 

Note: Typically, a cef or rex operator (to extract fields from matching 
events) precedes the eval operator, as shown in the examples below. 
However, you can use the eval operator on a field that has been defined by a 
previous eval operator in a query.

Examples:

1. _storageGroup IN ["Default Storage Group"] | cef categoryBehavior | eval 
cat=if(categoryBehavior=="/Communicate", "communicate", 
"notCommunicate")

If the Category Behavior is “Communicate”, then assign the value 
“communicate” to a new field “cat”; otherwise, assign the value 
“notCommunicate” to it.

2. logger | cef msg name | eval fullname=name + "END" 

Append the word, “END”, at the end of extracted event name. For example, if 
event name is “Logger Internal Event”, after the eval operation it is “Logger 
Internal EventEND” and is assigned to a new field, “fullname”.

3. _storageGroup IN ["Default Storage Group"] | cef bytesIn bytesOut name 
| eval Plus=bytesIn +100 | sort Plus

Add 100 to the value of bytesIn and assign it to a new field, “Plus”. Then, sort 
the values assigned to “Plus” in ascending order.

Search Operator Description and Examples
96 Administrator’s Guide Confidential



4 Searching and Analyzing Events
extract Extract key value pairs from raw events. 

Usage: ...| extract [pairdelim=”<delimiters>”] 
[kvdelim=”<delimiters>”] [maxchars=<n>] 
fields=”key1,key2,key3...” 

pairdelim is a delimiter (or a list of delimiters) that separates one key-value 
pair from another key-value pair in an event. By default, semi colon, pipe, 
and comma (; | ,) are used. 

kvdelim is a delimiter (or a list of delimiters) that separates a key from its 
value. By default, “=”. 

maxchars is the maximum number of characters in an event that would be 
scanned for extracting key value pairs. By default, 10240. 

fields is a key (or a list of comma-separated keys) whose values you want 
to display in the search results. For example, if you want to display the Name 
Age, and Location values from this event:

Name:Jane | Age:30 | Location:LA

Then, extract the “Name”, “Age”, and “Location” keys and list them in the 
fields list.

Understanding how the operator works:

The key represents a field in the raw event and its value consists of the 
characters that appear after the key until the next key in the event. The 
following raw event is used to illustrate the concept:

[Thu Jul 30 01:20:06 2009] [error] [client 69.63.180.245] PHP 
Warning:  memcache_pconnect() [<a href='function.memcache-
pconnect'>function.memcache-pconnect</a>]: Can't connect 
to 10.4.31.4:11211

To extract the URL from the above event, you can define these key-pair 
delimiters, which separate the key-value pairs in the event:

- Greater than sign (“>”) 

- Square bracket (“[“)

And, define this key delimiter, which separates the key from its value: 

- Equal to sign (“=”)

Thus, the following command will extract the URL

... | extract pairdelim=”>\[“ kvdelim=”=” fields=”<a href”

The key value pairs in the event will be: [<a href='function.memcache-
pconnect'>

The key in the event will be: <a href

The extracted URL will be: 'function.memcache-pconnect'

Notes:

• This operator only works on raw events. That is, you cannot extract key 
value pairs from CEF events or the fields defined by the rex operator.

• You can specify the pairdelim and kvdelim delimiters in the extract 
operator command to extract keys and their values. However, if you want 
to determine the key names that these delimiters will generate, use the 
keys operator as described in “keys” on page 99. The keys operator can 
only be used to determine keys; you cannot pipe those keys in the 
extract operator. That is, ...| keys | extract fields=field1 is 
incorrect. 

• The keys specified in the fields list can be used further in the pipeline 
operations. For example, ...| extract pairdelim=”|” kvdelim=”:” 
fields=”count” | top count
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extract • If none of the specified pairdelim characters exist in an event, the event 
is not parsed into key value pairs. The whole event is skipped. Similarly, if 
the specified kvdelim does not exist, values are not separated from the 
keys. 

• To specify double quotes (“) as the delimiter, enter it within the pair of 
double quotes with backslash(\) as the escape character. For example, 
“=\”|”. Similarly, use two backslashes to treat a backslash character 
literally. For example, “\\”.

Example: 

... | extract pairdelim=”|” kvdelim=”:” fields=”Name,Age,Location”

The above command extracts values from events in this format:

Name:Jane | Age:30 | Location:LA

fields Include or exclude specified fields from search results. 

Usage: ... | fields ([(+ | -)] <field>)+

+ includes only the specified field or fields in the search results. This is the 
default.

- excludes only the specified field or fields from the search results.

Notes: 

• Typically, the <field> list contains event fields available in the Logger 
schema or user-defined fields created using the rex operator prior in the 
query, as shown in the examples below. However, fields might also be 
defined by other operators such as the eval operator. 

• The + and - can be used in the same expression when multiple fields are 
specified. For example, | fields + name - agentType

• A complete field name must be specified for this operator; wildcard 
characters in a field name are not supported.

• When this operator is included in a query, select User Defined Fieldsets 
from the System Fieldsets list to view the search results.

Examples: 

1. ... | fields - agentType + categorySignificance

2. ... | fields - name

head Displays the first <N> lines of the search results. 

Usage: ... | head [<N>]

<N> is the number of lines to display. Default: 10, if <N> is not specified.

Note: 

When this operator is included in a query, the search results are not 
previewable. That is, the query must finish running before search results are 
displayed.

Example: ... | head
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keys Identifies keys in raw events based on the specified delimiters. 

Usage: ... | keys [pairdelim=”<delimiters>”] 
[kvdelim=”<delimiters>”] [limit=<n>]

pairdelim is a delimiter (or a list of delimiters) that separates one key-value 
pair from another key-value pair in an event. By default, semi colon, pipe, 
and comma (; | ,) are used. 

kvdelim is a delimiter (or a list of delimiters) that separates a key from its 
value. By default, “=”. 

limit is the maximum number of key value pairs to find. There is no default 
or maximum number for this parameter. 

Notes:

• This operator only works on raw events. That is, you cannot identify key 
value pairs from CEF events or fields defined by the rex operator.

• Although this operator is not required to determine keys, it is 
recommended that you use it to first determine the keys whose values 
you want to obtain using the extract operator. This operator returns 
aggregated results. Therefore, the search results list the keys found in the 
matching events and their counts. 

• The keys operator can only be used to determine keys; you cannot pipe 
those keys in the extract operator. That is, | keys | extract 
fields=field1 is incorrect. 

• If a key value is blank (or null), it is ignored and not counted toward the 
number of hits. For example, for the following event data:

Date=3/24/2011 | Drink=Lemonade

Date=3/23/2011 | Drink=

Date=3/22/2011 | Drink=Coffee

Search Query: keys pairdelim="|" kvdelim="="

Search Result: Date, 3 hits and Drink, 2 hits

• If none of the specified pairdelim characters exist in an event, the event 
is not parsed into key value pairs. The whole event is skipped. Similarly, if 
the specified kvdelim does not exist, values are not separated from the 
keys. 

• To specify double quotes (“) as the delimiter, enter it within the pair of 
double quotes with backslash(\) as the escape character. For example, 
“=\”|”. Similarly, use two backslashes to treat a backslash character 
literally. For example, “\\”.

Examples: 

1. ...| keys pairdelim="|" kvdelim="="

Identifies keys (Date and Drink) in event of this format: 
Date=3/24/2011 | Drink=Lemonade.

2. ...| keys pairdelim=”,“ kvdelim=”>=” 

Identifies keys (Path and IPAddress) in the event of this format: 
Path>c:\usr\log, IPAddress=1.1.1.1
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rare List the search results in a tabular form of the least common values for the 
specified field. That is, the values are listed from the lowest count value to 
the highest.

When multiple fields are specified, the count of unique sets of all those fields 
is listed from the lowest to highest count.

Usage: ...| rare <field1> <field2> <field3> ...

Notes: 

• Typically, the <field> list contains event fields available in the Logger 
schema or user-defined fields created using the rex or eval operators 
prior in the query, as shown in the examples below. However, fields might 
also be defined by other operators such as the eval operator. 

• A chart of the search results is automatically generated when this 
operator is included in a query.

• If multiple fields are specified, separate the field names with a white 
space or a comma.

Example: ... | rare deviceEventCategory

regex Select events that match the specified regular expression. 

Usages: 

...| regex <regular_expression>

OR

...| regex <field> (=|!=) <regular_expression>

Note: 

• Regular expression pattern matching is case insensitive.

• The first usage (without a field name) is applied to the raw event. While 
the second usage (with a field name), is applied to a specific field. 

• If you use the second usage (as shown above and in the Example #2 
below), either specify an event field that is available in the Logger schema 
or a user-defined field created using the rex or eval operators. 

Examples: 

1. ... | regex “failure”

2. ... | regex deviceEventCategory !=”fan”
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rename Rename the specified field name. 

Usage: ...| rename <field> as <new_name>

<field> is the name of an event field that is available in the Logger schema or 
a user-defined field created using the rex or eval operator.

<new_name> is the new name you want to assign to the field.

Notes:

• An additional column is added to the search results for each renamed 
field. The field with the original name continues to be displayed in the 
search results in addition to the renamed field. For example, if you 
rename deviceEventCategory to Categor”, two columns are displayed in 
the search results: deviceEventCategory and Category.

• You can include the wildcard character, *, in a field name. However, you 
must enclose the field that contains a wildcard character in double quotes 
(“ ”). For example:

...| rename “*IPAddress” as “*Address”

OR

...| rename “*IPAddress” as Address

• If a field name includes a special character (such as _, a space, #, and so 
on), it should be included in double quotes (“ ”) in the rename operator 
expression. For example:

...| rename src_ip as “Source IP Address”

• If the resulting field of a rename operation includes a special character, it 
must be enclosed in double quotes (“ ”) whenever you use it in the 
pipeline operator expression. For example,

...| rename src_ip as “Source IP Address” | top “Source IP Address”

• The internal field names (that start with “_raw”) cannot be renamed.

• The renamed fields are valid only for the duration of the query.

• The resulting field of a rename operation is case sensitive. When using 
such a field in a search operation, make sure that you the same case that 
was used to define the field.

• When you export the search results of a search query that contains the 
rename expression, the resulting file contains the renamed fields. 

Examples:

1. ...| rename src_ip as IPAddress

2. ...| rename src_ip as “Source IP Address”
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replace Replace the specified string in the specified fields with the specified new 
string.

Usage: ...| replace <orig_str> with <new_str> [in <field_list>]

<orig_str> is the original string you want to replace. (See Notes for more 
details.)

<new_str> is the new string you want to replace with. (See Notes for more 
details.)

<field_list> is the optional, however highly recommended. See Notes for 
details.

Notes:

• Even though the field list is optional for this command, ArcSight strongly 
recommends that you specify the fields on which the replace operator 
should act in this command.

• If you skip the field list, the replace operator acts on the fields that have 
been either explicitly defined using the cef, rex, and eval operators 
preceding the replace command, or any fields that were used in other 
operator commands that preceded the replace operator command. For 
example, the replace command acts on deviceEventCategory in all of 
the following cases and replaces all instances of “EPS” with “Events”:

...| replace *EPS* with *Events* in deviceEventCategory

...| cef deviceEventCategory | replace *EPS* with *Events*

...| top deviceEventCategory | replace *EPS* with *Events*

• An additional column of the same name is added to the search results for 
each field in which string is replaced. The column with the original value 
continues to be displayed in the search results in addition to the column 
with replaced values. For example, if you replace “err” with “Error” in the 
“message” column, an additional “message” column is added to the 
search results that contains the modified value. 

• If you want to replace the entire string, specify it in full (as it appears in 
the event). For example, “192.168.35.3”. 

If you want to replace a part of the string, include wildcard character (*) 
for the part that is not going to change. 

For example, if the original string (the string you want to replace) is 
“192.168*”, only the 192.168 part in an event is replaced. The remaining 
string is preserved. As a result, if an event contains 192.168.35.3, only 
the first two bytes are replaced. The rest (35.3) will be preserved. 
Similarly, if the event contains 192.168.DestIP, DestIP will be preserved. 
However, if the event contains the string 192.168, it will not be replaced. 

• If both, the original and the new strings contain wildcard characters, the 
number of wildcard characters in the original string must match the 
number of wildcard characters in the new string.

...| replace “*.168.*” with “*.XXX.*

• If the original or the new string includes a special character such as / or ?, 
enclose the string in double quotes (“ ”):
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...| replace “/Monitor” with Error 

• You can replace multiple values for multiple fields in a single operation by 
separating each expression with a comma (,). Note that you must specify 
the field list after specifying the “with” expression for all values you want 
to replace, as shown in the following example:

...| replace "Arc*" with HP, "cpu:100" with EPS in deviceVendor, 
deviceEventClassId

• The original string is case-insensitive. Therefore, the string “err” will 
replace an event that contains “Err”.

Examples: 

1. ...| replace *a* with *b* 

Replaces any occurrence of “a” with “b” but the characters preceding “a” and 
succeeding it are preserved.

2. ...| replace *a* with b in name

Replace any occurrence of “a” with “b” without retaining any characters 
preceding or succeeding “a”.
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rex Extract (or capture) a value based on the specified regular expression or 
extract and substitute a value based on the specified “sed” expression. The 
value can be from a previously specified field in the query or a raw event 
message. 

Usage: ... | rex <regular_expression containing a field name>

Usage: ... | rex field = <field> mode=sed “s/<string to be 
substituted>/<substitution value>”

Understanding how extraction works:

When the value is extracted based on a regular expression, the extracted 
value is assigned to a field name, which is specified as part of the regular 
expression. The syntax for defining the field name is ?<fieldname>, where 
fieldname is a string of alphanumeric characters. Using an underscore (“_”) is 
not recommended. 

We use the following event to illustrate the power of rex. 

[Thu Jul 30 01:20:06 2009] [error] [client 69.63.180.245] PHP 
Warning: Can't connect to 10.4.31.4:11211 

If you want to extract any IP address from the above event and assign it to a 
field called “IP_Address”, you can simply specify the following rex expression:

| rex "(?<IPAddress>\d{1,3}\.\d{1,3}\.\d{1,3}\.\d{1,3})"

However, if you wanted to extract the IP address after the word “client” from 
the following event and assign it to a field called “SourceIP”, you will need to 
specify a start and end point for IP address extraction so that the second IP 
address in the event is not captured. The starting point in this event can be 
“[client” and the end point can be “]”. Thus, the rex expression will be:

| rex “\[client (?<SourceIP>[^\]]*)”

In this rex expression ?<SourceIP> is the field name defined to capture IP 
address and “client ” specifies the text or point in the event AFTER which data 
will be extracted. The [^\]]* expression will match every character that is not 
a closing right bracket, therefore, for our example event, the expression will 
match until the end of the first IP address and not the second IP address that 
appears after the word “to”.

Understanding how substitution works:

When the rex operator is used in sed mode, you can substitute the values of 
extracted fields with the values you specify. For example, if you are 
generating a report of events that contain credit card numbers, you might 
want to substitute the credit card numbers to obfuscate the real numbers. 

The substitution only occurs in the search results. The actual event is not 
changed. 

In the following example, the credit card numbers in the CCN field are 
substituted with “xxxx”, thus obfuscating sensitive data:

| rex field=CCN mode=sed “s/*/XXXX/g”

The “/g” at the end of the command indicates a global replace, that is, all 
occurrences of the specified pattern will be replaced in all matching events. If 
“/g” is omitted, only the first occurrence of the specified pattern in each event 
is replaced. 

Multiple substitutions can be performed in a single command, as shown in the 
following example. In this example, the word “Authentication” is substituted 
with “xxxx” globally (for all matching events), the first byte of the agent 
address that start with “192” is substituted with “xxxx” and an IP address 
that starts with “10” is substituted with “xxxx”.

| rex field=msg mode=sed "s/Authentication/xxxx/g" | rex 
field=agentAddress mode=sed "s/192/xxxx/g" | rex field=dst mode=sed 
"s/10.*/xxxx/g"

Search Operator Description and Examples
104 Administrator’s Guide Confidential



4 Searching and Analyzing Events
rex (contd.) Notes:

• A detailed tutorial on the rex operator is available at Appendix C‚ Using 
the Rex Operator‚ on page 523. 

• A Regex Helper tool is available for formulating regular expressions of 
fields in which you are interested. The Regex Helper parses an event into 
fields. Then, you select the fields that you want to include in the rex 
expression. The regular expression for those fields is automatically 
inserted in the Search box. For detailed information on the Regex Helper 
tool, see “Regex Helper Tool” on page 126.

• The extracted values are displayed as additional columns in the All Fields 
view (of the System FieldSets). To view only the extracted columns, select 
User Defined Fieldsets from the System Fieldsets list. In the above 
example, an additional column with heading “SourceIP” is added to the All 
Fields view; IP address values extracted from events are listed in this 
column.

• If you want to use other search operators such as fields, sort, chart, and 
so on to refine your search results, you must first use this operator to 
extract those fields.

Examples:

The following example extracts name and social security number from an 
event that contains data in name:John ssn:123-45-6789 format and assigns 
them to Name and SSN fields:

... | rex "name: (?<Name>.*) ssn: (?<SSN>.*)" 

The following example extracts URLs from events and displays the top 10 of 
the extracted URLs:

... | rex "http://(?<URL>[^ ]*)" | top URL

The following example substitutes the last four digits of social security 
numbers extracted in the first event with XXXX:

... | rex field=SSN mode=sed "s/-\d{4}/-XXXX/g" 
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sort Sort search results as specified by the sort criteria.

Usage: ... | sort [<N>] ((+ | -) field)+

+ Sort the results by specified fields in ascending order. This is the default.

- Sort the results by specified fields in descending order. 

<N> Keep the top N results, where N can be a number between 1 and 
10,000. Default: 10,000.

Notes: 

• Typically, the <field> list contains event fields available in the Logger 
schema or user-defined fields created using the rex operator prior in the 
query, as shown in the examples below. However, fields might also be 
defined by other operators such as the eval operator. 

• Sorting is based on the data type of the specified field. 

• When multiple fields are specified for a sort operation, the first field is 
used to sort the data. If there are multiple same values after the first sort, 
the second field is used to sort within the same values, followed by third 
field, and so on. For example, in the example below, first the matching 
events are sorted by “cat” (device event category). If multiple events 
have the same “cat”, those events are further sorted by “eventId”.

• When multiple fields are specified, you can specify a different sort order 
for each field. For example, 
| sort + deviceEventCategory - eventId

• If multiple fields are specified, separate the field names with a white 
space or a comma.

• Sorting is case-sensitive. Therefore, “Error:105” will precede “error:105” 
in the sorted list (when sorted in ascending order).

• When a sort operator is included in a query, only the top 10,000 matches 
are displayed. This is a known limitation of this release and will be 
addressed in a future Logger release.

• When this operator is included in a query, the search results are not 
previewable. That is, the query must finish running before search results 
are displayed.

Example: ... | sort deviceEventCategory eventId

tail Displays the last <N> lines of the search results. 

Usage: ...| tail [<N>]

<N> is the number of lines to display. Default: 10, if <N> is not specified.

Note: 

• When this operator is included in a query, the search results are not 
previewable. That is, the query must finish running before search results 
are displayed. 

Example: ... | tail 5

Search Operator Description and Examples
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top List the search results in a tabular form of the most common values for the 
specified field. That is, the values are listed from the highest count value to 
the lowest.

Usage: ...| top [<n>] <field1> <field2> <field3> ...

<n> limits the matches to the top n values for the specified fields. Default: 
10, if <N> is not specified.

Notes: 

• The fields can be either event fields available in the Logger schema or 
user-defined fields created using the rex or eval operators prior in the 
query. If multiple fields are specified, separate the field names with a 
white space or a comma.

• When multiple fields are specified, the count of unique sets of all those 
fields is listed from the highest to lowest count.

• A chart of the search results is automatically generated when this 
operator is included in a query.

• To limit the matches to the top n values for the specified fields, specify a 
value for n. For example, ...| top 5 deviceEventCategory

Examples: 

1. ... | top deviceEventCategory

2. ... | top 5 categories

Search Operator Description and Examples
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transaction Group events that have the same values in the specified fields.

Usage: ... | transaction <field1> <field2>... 
[maxevents=<number>] [maxspan=<number>[s|m|h|d]] 
[maxpause=<number>[s|m|h|d]] [startswith=<reg_exp>] 
[endswith=<reg_exp>]

field1, field2 is a field or a comma-separated field list whose values are 
compared to determine events to group. If a field list is specified, the values 
of the unique sets of all those fields are used to determine events to group. 
For example, if host and portNum are specified, and two events contain 
“hostA” and “8080”, the events are grouped in a transaction. 

maxevents specifies the maximum number of events that can be part of a 
single transaction. For example, if you specify 5, after 5 matching events 
have been found, additional events are not included in the transaction. 
Default: 1000

maxspan specifies the limit on the duration of the transaction. That is, the 
difference in time between the first event and all other events in a transaction 
will never be more than the specified maxspan limit.  For example, if you 
specify maxspan=30s, the event time of all events within the transaction will 
be at most 30 seconds more than the event time of the first event in the 
transaction. Default: Unlimited

maxpause specifies the length of time by which consecutive events in a 
transaction can be apart. That is, this option ensures that events in a single 
transaction are never more than the maxpause value from the previous event 
in the transaction. Default: Unlimited

startswith specifies a regular expression that is used to recognize the 
beginning of a transaction. For example, if a transaction operator includes 
startswith="user [L|l]ogin", all events are scanned for this regular 
expression. When an event matches the regular expression, a transaction is 
created, and subsequent events with matching fields are added to the 
transaction. Note that the regular expression is applied to the raw event, not 
to a field in an event. 

endswith specifies a regular expression that is used to recognize the end of 
an existing transaction. That is, an existing transaction is completed when an 
event matches the specified “endswith” regular expression.  For example, if a 
transaction operator includes endswith="[L|l]ogout",  any event being added 
to a transaction is checked, and if the regular expression matches the event, 
the transaction is completed. Note that the regular expression is applied to 
the raw event, not to a field in an event. 

Note:

Several of the above options specify “conditions to end” a transaction. 
Therefore, when multiple “end conditions” are specified in a transaction 
operator, the first end condition that occurs will end the transaction even if 
the other conditions have not been satisfied yet. For example, if maxspan is 
reached but maxevents has not been reached, or if the endswith regular 
expression is matched but maxevents has not been reached. 

Understanding how the transaction operator works:

A transaction is a set of events that contain the same values in the specified 
fields. The events may be further filtered based on the options described 
above, such as maxspan, maxpause, and so on. In addition to grouping 
events, the transaction operator adds these fields to each event: 
transactionid, duration, and eventcount. These fields are displayed in the 
Search Results as separate columns.

A transactionid is assigned to each transaction when the transaction 
completes. Transaction IDs are integers, assigned starting from 1 for the 
transactions (set of events) found in the current query. All events in the same 
transaction will have the same transaction ID.

Search Operator Description and Examples
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Time Range
An event is timestamped with the Logger receipt time when it is received on the Logger. A 
search query uses this time to search for matching events. A search operation 
requires you to specify the time range within which events would be searched. You can 
select from many predefined time ranges or define a custom time range to suit your needs. 

Predefined time range: When you select a predefined time range such as “Last 2 Hours” 
or “Today”, a time range window is created that moves with the current time. For example, 
if you select “Last 2 Hours” at 2:00:00 p.m. on July 13th, events from 12:00:00 to 2:00:00 
p.m. on July 13th will be searched. If you refresh your search results at 5:00:00 p.m. on 
the same day, the time window is recalculated. Therefore, events that match the specified 
criteria and occurred between 3:00:00 and 5:00:00 p.m. on July 13th are displayed.

transaction 
(contd.)

If an event does not belong to any transaction found in the current query, it is 
assigned the transaction ID 0. For example, in a transaction operator with a 
startswith regular expression, if the first event in the pipeline does not 
match the regular expression, that event is not part of the transaction, and is 
assigned transaction ID 0. 

The duration is the time in milliseconds of the duration of a transaction, which 
is the difference between the event time of the last event in the transaction 
and the first event in the transaction. The duration field for all events in a 
transaction is set to the duration value of the transaction.

The eventcount displays the number of events in a transaction. 

Examples: 

1. To view source addresses accessed within a 5-minute duration:

... | transaction sourceAddress maxspan=5m

2. To group source addresses by source ports and view 5 events per group:

...| transaction sourceAddress sourcePort maxevents=5

3. To group users and URLs they accessed within a 10-minute duration:

... | transaction username startswith=”http://” maxspan=10m 

4. To view login transactions from the same session ID and source address in 
a 1-hour duration:

... | transaction sessionID sourceAddress maxspan=1h startswith="user 
[L|l]ogin"

where Display events that match the criteria specified in the “where” expression.

Usage: ...| where <expression>

<expression> can be any valid field-based query expression, as described in 
“Indexed and Non-Indexed Fields” on page 85.

Notes: 

• <expression> can only be a valid field-based query expression. 
Arithmetic expressions or functions are not supported.

• When the where operator is included in a query, the query performance 
can be significantly impacted. This is a known issue and will be addressed 
in a future release of Logger.

Examples: 

1. ... | where eventId is NULL

2. ... | where eventId=10006093313 OR deviceVersion CONTAINS 
"4.0.6.4924.1"

3. ... | where eventId >=10005985569 OR categories="/Agent/Started"

Search Operator Description and Examples
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Custom time range: You can specify a time range in a 24-hour format to suit your needs. 
For example, a custom time range is:

Start: 8/13/2008 13:36:30

End: 8/13/2008 22:36:30

By default, the end time for a custom time range is the current time on your Logger and 
the start time is two hours before the current time.

You can also use variables to specify custom time ranges. For example, a dynamic date 
range might start at $Now - 2h (two hours ago) and end at $Now (the current time). The 
dynamic search mode searches relative to the time when the search is run. Scheduled 
search operations use this mechanism to search through newer event data each time they 
are run. The “Dynamic” field in the user interface enables you to specify the dynamic time, 
as shown in the following figure:

Following is a typical example of a dynamic search that limits results to the last two hours 
of activity:

Start: $Now - 2h
End: $Now

The syntax for dynamic search is:

<current_period> [ +/- <units>]

Where <current_period>, such as $Now, either stands alone or is followed by either a plus 
(‘+’) or minus (‘-’) and a number of units, such as 2h for two hours. The <current_period> 
always starts with a ‘$’ and consists of a word, case-sensitive, with no spaces, as shown in 
Table 4-1 on page 110. The <units> portion, if given, consists of an integer and a single, 
case-sensitive letter, as shown in Table 4-2 on page 111.

Table 4-1 Current Period

Period Description

$Now The current minute

$Today Midnight (the beginning of the first minute) of the current day

$CurrentWeek Midnight of the previous Monday (or same as $Today if today is 
Monday)

$CurrentMonth Midnight on the first day of the current month

$CurrentYear Midnight on the first day of the current year
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Table 4-2 Units

Field Set
A field set determines the fields that are displayed in the search results for each event that 
matched a search query. Logger provides a number of predefined field sets, as listed in the 

following table. To view the fields includes in each of the predefined field sets, click the  

(Customize Fieldset) icon. When you run the first search operation in a new browser 
window, you might not be able to select the field sets as they are hidden. The field sets list 
is displayed after you have run the first search operation.

When you use a search operator that defines a new field, such as rex, rename, or eval, a 
new column for each field is added to the currently selected display. These newly defined 
fields are displayed by default. The field set, User Defined Fields, enables you to view only 
the newly defined fields. 

Prior to v5.2, you could only view the raw events if you clicked the  icon in Search 
Results; the raw event would be displayed in an unformatted text form. Starting with 
Logger v5.2, a new predefined field set, Raw Event, is available. This field set displays the 

Unit Description

m (lowercase) Minutes do not confuse with ‘M’, meaning months)

h Hours

d Days

w Weeks

M (uppercase) Months (do not confuse with ‘m’, meaning minutes)

Field Set Description

All Fields To view a list of fields that are included for each field set 
type, select the field set from the drop-down list and hover 
your mouse pointer on the Fields: label.

Note: Only fields available for matched events are 
displayed in a Search Results display (or the exported file). 
Therefore, even if you select the All Fields fieldset, you 
might not see all fields displayed in the search results. 

User Defined Fields

Minimal Fields

Syslog Standard

Categories

Base Event Fields

Raw Event
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whole raw syslog event in a column called rawEvent, as shown in the following figure. The 
event is formatted to fit in the column. 

You must enable the Search Option, “Populate rawEvent field for syslog events”, to see the 
raw events in the rawEvent column. See “Tuning Advanced Search Options” on page 213 
for more information.

Although the Raw Event field is most applicable for syslog events, you can also display the 
raw event associated with CEF events in the rawEvent column. To do so, make sure the 
connector that is sending the events to the Logger populates the rawEvent field with the 
raw event.

You can also create your own field sets by selecting “Customize...” from the “Fields:” drop-
down menu. The Logger user interface offers a simple and intuitive interface to select and 
move event fields you want to include in a field set, as shown in the following figure. 

Use these buttons to create and edit a custom field set.
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A wildcard field (“*”) is available in the Fields list when you create a custom field set. This 
field includes all fields available in an event that are not individually listed in the custom 
field set definition. For example, for the following custom field set definition, the search 
results will list the fields before the asterisk (“*”) first, followed by any other fields in an 
event. Lastly, the deviceEventClassId and Name fields will be listed.

You can either save the custom field sets you create or use them for the current session. 
When saving a custom field set, you can specify a field set as the default for this Logger. If 
you do so, it is the default field set for all users on that system. 

If you save a custom field set, it appears under the Shared Fieldsets category and is 
visible and available to the other users of your Logger, as shown in the following figure. 
Once a field set is saved, you can edit and delete it. 

If you do not save the custom field set, it is temporarily labeled as “Custom (not saved)” 
and is not visible to other users. Once you log out of the current session, the temporary 
field set is deleted. You can only create one temporary custom field set at a time. 

Field set selection is specific to a Logger user’s interface. For example, UserA and UserB are 
connected to the same Logger and are using the default, All Fields, field set for search 
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results display. UserA changes his selection to a custom field set. This change will only 
impact UserA’s display; UserB will continue to see the search results in the All Fields format. 

For information about deleting custom field sets, see “Viewing and Deleting Field Sets” on 
page 214.

A new field ,*user (shown below), in field sets controls the display of fields defined by 
search operators (rex, rename, or eval). When *user is included in the Selected Fields list 
of a custom field set, the newly defined fields are displayed.

Constraints
Constraints enable you to limit a query to events from one or more of the following:

 Devices in a particular device group

 Stored in particular storage groups

 On specific  Loggers

For example, you might want to search for events for devices in the SMR-1 and SMR-2 
device groups on the local Logger only.

Using constraints can speed up a search operation as they limit the scope of data that 
needs to be searched. Follow these guidelines when specifying constraints:

 Use the following operators to specify constraints in a search query expression:

Field sets are not included in the saved filter definition.

Metadata 
Identifier

Example

_deviceGroup _deviceGroup IN ["DM1", “HostA”] where DM1 is a device 
group, while HostA is a device.

Note: Use this to also specify individual devices, as shown in 
the example above.

_storageGroup _storageGroup IN ["Internal Event Storage Group”, “SG1"]

_peerLogger _peerLogger IN [“192.0.2.10”, “192.0.2.11”]
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 If a query includes the boolean operator OR and the metadata identifiers (discussed in 
“Constraints” on page 114), the expression to be evaluated with OR must be enclosed 
in parentheses, as shown in this example:

(success OR fail) _storageGroup IN ["Default Storage Group"]

If the expression to be evaluated with OR is not enclosed in parentheses, an error 
message is displayed on the user interface screen.

 When specifying multiple groups in a constraint, ensure that the group names are 
enclosed in a square bracket; for example, _storageGroups IN [“SGA”, 
“SGB”].

 You can apply constraints to a search query in these ways:

 Typing the constraint in the Search text box

Use Logger’s Search Helper to enter a constraint in the Search text box. Once you 
type “_s” (for storage group), “_d” (for device group), or “_p” (for Logger) in the 
Search text box, Logger automatically provides a drop-down list of relevant terms 
and operators from which you can select.

 Using the Search Builder tool as you can select the constraints in it, as shown in 
the following figure. (To access the Search Builder tool, click Advanced to the 
right of the Search text box where you type query expression.) For more 
information about the Search Buider, see “Using the Search Builder Tool” on 
page 120.

If a search query contains constraints and a regular expression, make 
sure that the constraints are specified before the regular expression. 
For example, _peerLogger IN ["10.10.10.10"] name contains 
abc | REGEX=”:\d31”
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Syntax Reference for Query Expression
You must understand and follow specific requirements for creating query expressions so 
that you create valid and accurate expressions. The following table lists those 

requirements.

Behavior Full Text (Keyword)
Field Search 
(Indexed) 

Regular 
Expression

Syntax keyword1 
boolean_operator 
keyword2 
boolean_operator 
keyword3...

field_name operator 
field_value

(List of fields in the 
“Indexing” on 
page 139 section.)

(List of operators in 
the “Indexed and Non-
Indexed Fields” on 
page 85 section.)

|REGEX=”<REGEX1>” 
| 
REGEX=”<REGEX2>”|
..
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Operators Upper-, lower-, or mixed 
case boolean operators—
AND, OR, NOT. If an 
operator is not specified, 
AND is used.

To search for literal operator 
AND, OR, NOT, in an event, 
enclose them in double 
quotes.

Example: “AND”, “or”, “Not”

Note: If a query includes 
the boolean operator OR 
and the metadata identifiers 
(discussed in “Constraints” 
on page 114), the 
expression to be evaluated 
with OR must be enclosed in 
parentheses, as shown in 
this example:

(success OR fail) 
_storageGroup IN 
["Default Storage 
Group"]

Use any operator 
listed in the “Indexed 
and Non-Indexed 
Fields” on page 85 
section.

• Unless a value is 
enclosed between 
double quotes, a 
space between 
value is 
interpreted as an 
AND. For example, 
name=John Doe is 
interpreted as 
John AND Doe.

• If an operator is 
not specified 
between multiple 
field expressions, 
AND is used.

• To search for literal 
operator, enclose 
the operator in 
double quotes. 
Examples:

message 
STARTSWITH=”NOT”

message=”LOGIN 
DID NOT SUCCEED”

• If a query includes 
the boolean 
operator OR and 
the metadata 
identifiers 
(discussed in 
“Constraints” on 
page 114), the 
expression to be 
evaluated with OR 
must be enclosed 
in parentheses, as 
shown in this 
example:

(success OR 
fail) 
_storageGroup IN 
["Default 
Storage Group"]

| and the operators 
described in “Time 
Range” on page 109. 

Use this operator to 
AND multiple regular 
expressions in one 
query expression.

Behavior Full Text (Keyword)
Field Search 
(Indexed) 

Regular 
Expression
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Nesting 
(including 
parenthetical 
clauses, such as 
(a OR b) AND c

Allowed

• Use boolean operators 
to connect and nest 
keywords.

• Metadata identifiers 
(_storageGroup, 
_deviceGroup, and 
_peerLogger), but can 
only appear at the top 
level in a query 
expression). If the query 
contains a regular 
expression, the 
metadata identifiers 
need to precede the 
regular expression.

Allowed

• Use any operator 
listed in the 
“Indexed and Non-
Indexed Fields” on 
page 85 section to 
connect and nest 
field search 
expressions.

• Metadata 
identifiers 
(_storageGroup, 
_deviceGroup, and 
_peerLogger), but 
can only appear at 
the top level in a 
query expression

Multiple regular 
expression can be 
specified in one 
query using this 
syntax: 
|REGEX=”<REGEX1
>” 
|REGEX=”<REGEX2
>”|...

Case sensitivity Insensitive

(Cannot be changed.)

Sensitive*

(Can be changed 
using Tuning options. 
See “Tuning Advanced 
Search Options” on 
page 213.)

Insensitive*

(Can be changed 
using Tuning 
options. See “Tuning 
Advanced Search 
Options” on 
page 213.)

Wildcard * 

Cannot be the leading 
character; only a suffix or in 
between a keyword.

Examples:

• *log is invalid

• log* is valid

• lo*g* is valid

*

Can appear anywhere 
in the value.

Note: Logger v3.0 GA 
and SP1 did not 
support the use of 
wildcard character.

Examples:

name=*log (searches 
for ablog, blog, and so 
on.)

name=”\*log” 

name=\*log

(both search for *log)

*

Can appear 
anywhere.

Exact 
Match/Search 
string includes 
an operator or a 
special character

Enclose keyword in double 
quotes; Otherwise, keyword 
treated as keyword*.

Example:

log (matches log, logging, 
logger, and so on)

“log” (matches only log)

Note: See the list of special 
characters that cannot be 
searched even when 
enclosed in double quotes, 
later in this table.

Enclose value in 
double quotes

Example: 

message=”failed 
login”

No special 
requirement. 

Behavior Full Text (Keyword)
Field Search 
(Indexed) 

Regular 
Expression
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Escape character \

Use to escape \. You cannot 
escape any other character.

\

Use to escape \, “, and 
*.

Examples: 

• name=log\\ger 
(matches log\ger)

• name = logger\* 
(matches logger*)

\

Use to escape any 
special character.

Example:

To search for a term 
with the character 
"[":

|REGEX="logger\["

Escaping 
wildcard 
character

Cannot search for *

Example:

log\* is invalid

Can search for * by 
escaping the character

name=log\* is valid

Can search for * by 
escaping the 
character

Space

Tab

Newline

,

;

(

)

[

]

{

}

“

|

*

>

<

!

Cannot search for these 
characters.

Examples:

“John Doe” is invalid

No restrictions.

Enclose special 
character in double 
quotes. Escape the 
wildcard character and 
double quotes. 

Example:

name=”John\* \”Doe” 
(matches John* “Doe)

No restrictions.

Special regular 
expression 
characters such as (, 
), [ ,], {, }, ", |, and 
* need to be 
escaped.

Behavior Full Text (Keyword)
Field Search 
(Indexed) 

Regular 
Expression
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Using the Search Builder Tool
The Logger Search Builder tool is a boolean-logic conditions editor that enables you to 
quickly and accurately build search queries. The tool provides a visual representation of the 
conditions you are including in a query. You can specify keywords, field-based conditions, 

=

.

:

/

\

@

-

?

#

$

&

_

%

You can search for these 
characters in a keyword. 
However, enclose the 
keyword in double quotes.

Example: “John=”

You can search for 
these characters. 
Enclose value in 
double quotes if value 
contains any of these 
characters. 

Example: 
name=”John=”

• Cannot contain ̂  
in the beginning 
and $ at the end 
as a matching 
character unless 
the regular 
expression you 
specify must look 
for an event that 
contains only the 
pattern you are 
specifying; for 
example,|REGEX
="^test$" will 
search for events 
containing the 
word “test” 
(without quotes) 
only.

• Special regular 
expression 
characters such 
as \ and ? need 
to be escaped.

Time format, 
when searching 
for a specific 
timestamp

No specific format. The 
query needs to contain the 
exact timestamp string. For 
example, “10:34:35”.

Note: The string cannot 
contain spaces. For 
example, “Oct 19” is invalid.

Use this format to 
specify a timestamp in 
a query (including 
double quotes):

“mm/dd/yyyy 
hh:mm:ss”

OR

“yyyy/mm/dd 
hh:mm:ss timezone”

OR

“MMM dd yyyy 
hh:mm:ss timezone”

where mm—month
dd—day
yyyy—year
hh—hour
mm—minutes
ss—seconds
timezone—EDT, CDT, 
MDT, PDT.
MMM—First three 
letters of a month’s 
name; for example, 
Jan, Feb, Mar, Sep, 
Oct, and so on.

No restrictions.

Behavior Full Text (Keyword)
Field Search 
(Indexed) 

Regular 
Expression
120 Administrator’s Guide Confidential



4 Searching and Analyzing Events
and regular expressions using this tool. In addition, the tool enables you to specify search 
constraints such as device groups and storage groups (see “Constraints” on page 114). 
This section describes how to use the tool.

Accessing Search Builder
To display the Search Builder tool, click Advanced Search, below the Search text box, as 
shown in the following figure. 

The Search Builder tool is displayed, as follows:

To build a new search query in the Search Builder tool:

1 Select the boolean operator that applies to the condition you are adding from the top 
of Search Builder. You can select these operators:

2 If you want to load a system or saved filter, or a saved search, click the icon. Select 
the filter or the saved search from the displayed list and click Load+Close. 

For more information, see “Saving Queries (Saved Filters and Searches)” on page 143 
and “System Filters/Predefined Filters” on page 146.

Operator Meaning

AND

OR

NOT
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3 To add a keyword (full-text search) or field condition:

a Locate the field you want to add under the Name column.

To specify a keyword (full-text search), use the fullText field under the Name 
column, as shown in the following figure.

b Click the Operator column associated with the field, select the operator from the 
displayed list, and press Enter. 

Only operators applicable to a field are displayed in the list.

c In the Condition column associated with the field, enter a value and press Enter.

4 Repeat Step 1 through Step 3 until you have added all the conditions.

5 If your search query will also include a regular expression, type it in the Regex field.

6 If you want to constrain your search query to specific device groups, storage groups, 
and  Loggers, click the  icon next to the constraint category. Select the relevant 

groups and  Loggers. (To select multiple groups, hold the Ctrl-key down.)

You can specify devices or device groups in the Device Groups constraint.

The  Logger constraint category is displayed only if  Loggers are configured on your 
Logger. 

If multiple values are selected for a constraint, those values are OR’ed together. For 
example, if you specify Device Group A, B, C, the query will find events in Device 
Group A, B, or C. 

7 Click Go.

The query is automatically displayed in the Search text box and is ready to be run.

• You cannot specify a range of IP addresses. Therefore, to search 
for multiple IP addresses in a range, use the CONTAINS operator 
and wildcard characters in the Condition column; for example, 
enter “192.0.2.*”.

• To edit a condiition, right click on the condition for a drop-down 
menu that enables you to edit, cut, copy, or delete the condition.
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OR

Click the  icon to save the query (referred as Saved Filter or a Saved Search) for a 
later use. For more information about saving queries, see “Saving Queries (Saved 
Filters and Searches)” on page 143.

Nested Conditions
You can create search queries with nested conditions in Search Builder. To do so, click the 
operator under which you want to nest the next condition and add the condition as 
described in “Accessing Search Builder” on page 121. 

Alternate Views for Query Building in Search Builder
By default, a tree view representation of the conditions is displayed, as shown in the 
previous figures in this section. You can change the view to a color-block scheme and also 
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adjust whether the fields you select are displayed in the lower part of the screen or to the 
right of where conditions are displayed, as shown in the following figure.

To change views, click Display in the Search Builder tool and select the view of your 
choice.

Search Analyzer
A query’s performance is dependent on many factors such as load on the system, size of 
data to be searched, indexed or non-indexed fields included in the query, the complexity of 
a query (a large number of conditions, wildcard characters, nesting), and so on. 

The Search Analyzer tool analyzes a query to determine if any of the fields included in the 
query are non-indexed for the time range specified and thus impact the query’s 
performance. 

You can run this tool as needed; for example, if a query runs slower than expected. You 
can use Search Analyzer on a query after you have run it or while building a query using 
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the Search Builder. Click the  icon to access the Search Analyzer tool, as shown in the 
following figure.

Performance Optimizations for Indexed Fields in Search Queries
Even though a search query includes indexed fields, you might not realize the performance 
gain you expect in these situations:

 When you include indexed and non-indexed fields in a query. Therefore, ArcSight 
recommends that you identify the fields that you will most commonly use in queries 
and index all those fields. 

 When you perform search on data in a time range in which a currently indexed field 
(included in the query) was non-indexed. 

For example, you index the “port” field on August 13th at 2:00 p.m. You run a search 
on August 14th at 1:00 p.m. to find events that include port 80 and occurred between 
August 11th and August 12th. The “port” field was not indexed between August 11th 
and the 12th; therefore, the query runs slower.

 When you include a field in your search query that Logger is in the process of 
indexing. Therefore, allow some time between adding a field to the index and using it 
in a search query. 

 When a query that includes indexed field is performed on archived events, the query 
runs slower than when the data was not archived. This occurs because the index data 
on Logger is not archived with events.
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Regex Helper Tool
The Regex Helper tool enables you to create regular expressions that can be used with the 
rex pipeline operator to extract fields of interest from an event. (For information about 
rex, see “Search Operators” on page 87 or Appendix C‚ Using the Rex Operator‚ on page 
523.) This tool not only simplifies the task of creating regular expressions for the rex 
operator but also makes it efficient and error free.

The tool, which is only available for non-CEF events, parses a raw syslog event into fields 
and displays them as a list. You select the fields that you want to include in the rex 
expression of a query. The selected fields are automatically inserted in a search query as a 
rex expression.

To use the tool, you need to perform the following steps. These steps are also depicted in 
the figure that follows the steps.

1 Enter a search query that finds events of interest to you. (For information about 
running a search, see “Searching for Events on Logger” on page 128.)

2 Identify a syslog event that you want to analyze further. For example, in the shown 
figure, event #1 is the event we will analyze further. 

3 Click the  icon (in the left-most column) for the identified event to expand it and 
display its raw event.

4 Click the  icon (next to the word RAW) to launch the Regex Helper tool.

5 Select the fields that you want to extract.

6 Click OK.
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The rex expressions pertaining to the selected fields are automatically entered in the 
Search query box, as shown in the following figure. In the previous example, the client and 
server IP addresses need to be extracted from events. Therefore, IPAddress_1 and 
IPAddress_2 fields were selected in the Regex Helper tool. (The Regex Helper tool assigns 
incremental labels if a data type appears more than once in an event. For example, IP 
addresses are assigned IPAddress_1, IPAddress_2, IPAddress_3, and so on labels.)

Once the two IP addresses are selected and you click OK, the rex expression that includes 
the regular expression for those IP addresses is displayed in the Search text box, as shown 
in the following example.

From this point, you can include additional pipeline operators in this query to create charts, 
identify the top five IP addresses, and so on. In the following example, the above query is 
modified to identify the top IP addresses. 
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Searching for Events on Logger 
A user needs to belong to a Logger Search Group with the “Search for events” user right 
set to Yes to perform local searches and “Search for events on remote peers” user right set 
to Yes to perform  searches.

To search for events on Logger:

1 Click Analyze > Search. 

2 Specify a query expression in the Search text box using one or more of the following 
methods.

Note: Refer to “Query Expression” on page 84 for a list of exceptions and invalid 
characters before you create a query expression.

a Type the query expression in the Search text box. For information about building a 
query expression, including lists of applicable operators, see “Elements of a 
Search Query” on page 84. 

When you type a query, Logger’s Search Helper enables you to quickly build a 
query expression by automatically providing suggestions, possible matches, and 
applicable operators. See “Search Helper” on page 66 for more information. 

Use these guidelines to include various elements in a search query:

 For a complete list of fields in Logger schema, see “Indexing” on page 139.

 Metadata terms (_storageGroup, _deviceGroup, _peerLogger)

Type “_s” (for storage group), “_d” (for device group), or “_p” (for Logger) in 
the Search text box to obtain a drop-down list of constraint terms and 
operators.

 Regular expression term (|REGEX=) 

Note: If your query expression includes multiple device groups and storage 
groups to which search should be constrained, make sure that the group names 
are enclosed in a square bracket; for example, _storageGroups IN [“SGA”, 
“SGB”]. 

b Click Advanced to use the Search Builder tool. (See “Using the Search Builder 
Tool” on page 120 for more information.) Also, use this option to specify device 
groups, storage groups, and  Loggers to which search should be limited.

c Click the  icon to load a saved filter, a system filter, or a saved search. Select 
the filter or the saved search from the displayed list and click Load+Close.

For more information, see “Saving Queries (Saved Filters and Searches)” on 
page 143 and “System Filters/Predefined Filters” on page 146.
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3 Use the following default values or change them suit your needs:

a Local Logger: By default the query is run on the local Logger only. If you want to 
run the query on the  Loggers as well, uncheck the “Local Only” field located to 
the right of the Go! button.

b Time Range: By default, the query is run on the data received in the last two 
hours on the Logger. Click the drop-down list to select another predefined time 
range or specify a custom time range. For more information about time ranges, 
see “Time Range” on page 109.

c Field Set: By default, all fields (All Fields) are displayed in the search results. 
However, you can select another predefined field set or specify a customized field 
set. For more information about field sets, see “Field Set” on page 111.

4 Click Go.

The search results are displayed in the bottom section of same screen in which you ran 
the search. For more information about how search results are displayed and various 
controls available within the user interface to use those results, see “Understanding 
the Search Results Display” on page 130.

You can also save the search you ran as a saved filter or saved search. Click the  
icon to do so. For more information about a saved filter or a saved search, see “Saving 
Queries (Saved Filters and Searches)” on page 143.

Advanced Search Options
The advanced search options enable you to tune search operations to suit your 
environment. The options are discussed in “Tuning Advanced Search Options” on 
page 213.

Searching Peer Loggers (Distributed Search)
When you run a search query, by default, only your local Logger is searched for matching 
events. However, when specifying a query, you can select an option to run the search on 
the peer Loggers. You can also select the  Loggers to which the search should be 
constrained, as described in “Searching for Events on Logger” on page 128. 

Follow these guidelines for searching across peers:

 Loggers can run different versions. However, these are the only supported paths for 
running a search across peers:

 v5.x software Logger to v5.x software

 v5.x software Logger to v5.x appliance

 v4.5 software Logger to v5.x appliance 

 v4.5 appliance to v5.x appliance

 v5.x appliance to v5.x appliance

 If you need to run a search using the pipeline operators across peers, make sure the 
peers are running Logger v5.1 or later. For information about pipeline operators, see 
“Search Operators” on page 87.

 If  Loggers do not have identical storage or device group names, a search query 
operation skips searching for events for those groups on those peers. 

 If you added custom schema fields to your Logger schema, those fields must exist on 
all peers. Otherwise, a search query containing those fields will not run (when run 
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across peers) and return an error. See “Adding or Importing Schema Fields” on 
page 232.

 A user needs to belong to these user groups with the listed permissions set to perform  
searches and view their search results:

 Logger Search Group with “Search for events on remote peers” user right set 
(checked). 

 Logger Rights Group with the “View registered peers” user rights set (checked).

 When a  Logger becomes unavailable during a search operation, the one of the 
following errors might be displayed:

[ Logger IP address] Error: Get Query Statistics
[ Logger IP address] Error: Remote exception ( does not 
authorize the request. Please check if remote  has  relationship 
with your logger)
These error messages can occur when the  Logger cannot be reached. Restore the  
relationship and run the search again. 

The above listed error messages might still display for the search operation that was in 
progress even after the  relationship is restored. However, ignore those messages as 
these go away when you run a new distributed search.

Tuning Search Performance
Search performance depends on many factors and will vary from query to query. Some of 
factors that can impact search performance are listed below. To optimize search 
performance, ensure that you follow these recommendations:

 Enable full-text and field-based indexing. When events are indexed, Logger can 
quickly and efficiently search for relevant data.

 The amount of time it takes to search depends on the size of the data set that needs 
to be searched through, the complexity of the query, and whether the search is 
distributed across peers. To limit the data set, ensure that time range within which the 
events must be searched does not result in a query that needs to scan multi-millions of 
events. Additionally, limiting search to specific storage groups typically results in better 
search performance than when the storage groups are not specified.

 Reduce other load on the system when your query needs to run, such as scheduled 
jobs, large number of incoming events, multiple reports being run. 

Understanding the Search Results Display
After you have initiated a search, the search results are displayed in the bottom section of 
the same screen in which you ran the search. 

While the search is in progress, the Go! button changes to Cancel—click Cancel to 
terminate the search early. When a query is running, search results are displayed as 
matching events are found. Therefore, when you click Cancel, any matching events found 
so far are displayed as the search results. This facility might be helpful in cases when the 
query needs to scan a large data set, but the search results displayed so far display the 
events you were looking for. You can further process the displayed (partial) results; for 
example, export the results, use the histogram to drill-down the results, or click on any text 
in the Search Results to add it to the query for further drill-down of the search results. 
(Note: If a query includes chartable operators such as chart, rare, or top, and the query is 
terminated early, a chart of the partial results is not displayed. Additionally, if a query 
includes the head, tail, or sort operators, partial results are not generated.)
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A search operation can take time when millions of events need to be searched. When the 
first screen of events that match the specified conditions is available, Logger automatically 
pauses the search and displays the matched events. By default, 25 events are displayed on 
one screen. Event data is categorized by field name with each field displayed as a separate 
column, as shown in the following figure. For example, time when the event was received 
on the Logger (Event Time) is displayed under Time (Event Time). Each event is also 
available in its raw form and can be viewed by clicking the  icon in the leftmost column. 
To see all raw events, click All at the bottom of the Search Results display. To collapse raw 
events, click None. The column width for each column is adjustable.

To see the next screen of events, click ; or  to go to the last page. Once you are past 

the first screen of events, you can click  to go back to the previous screen; or  to go to 
the first page.

The Search Results page displays a histogram that provides a graphical representation of 
the events that match a search query. The distribution is based on the time range specified 
in the query. That is, the X-axis represents event time and Y-axis represents the number of 
matching events, as shown in the following figure. You can randomly drill-down to events 
in a specific time period by clicking the histogram bar representing the time period.

Additionally, the number of events scanned and number of events matching the query and 
the time it took to run the search is displayed.

Events are shown in table form, one row per event. Terms that match your query are 
highlighted in blue to make it easy to see why an event matched the query. To view the 
raw event of a listed event, click the  icon to the left of the matching event. You can 
also view the Syslog raw events in a formatted column called rawEvent if you have enabled 
the “Populate rawEvent field for syslog events” option on the Search Options page, as 
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discussed in “Tuning Advanced Search Options” on page 213. Also, see “Field Set” on 
page 111 to learn more about the rawEvent field.

As you roll the mouse over other terms in the events table, they highlight in green. The 
user interface allows you to drill-down into the displayed search results by clicking a green-
highlighted term to add it to the current query. For example, if you search for “login” and 
roll over the word “fail” in the search results, “fail” will highlight in green. Click the word 
“fail” to change the query to “login AND fail.” You can also highlight and copy text from any 
displayed column. This feature is handy when you need to copy an IP address or a URL. 
(Highlight the term by scrolling over it. Then, right-click your mouse to display the Copy 
option.) You can select any indexed or non-indexed fields from the search results. Search 
results are sorted by receipt time. 

Starting with Logger v5.2, a Field Summary panel is displayed on the left side of the 
matched events. This section lists the fields that occur in matching events and the number 
of unique values for each in those events. For more information about Field Summary, see 
“Understanding Field Summary” on page 134.

Viewing Search Results using Field Sets
By default, the Search Results are displayed using the All Fields field set, which displays all 
fields contained in an event. Once you select another field set, it becomes your default 
view until you change it the next time. For a detailed discussion about field sets, see “Field 
Set” on page 111.

If you view the Search Results using the Raw Event field set, remember these guidelines:

 Even though the rawEvent column displays the raw event, this column is not added to 
the Logger database and is not indexed. Therefore, you can only run a keyword (full-
text) or regular expression to search on the event.

 You can use the Regex Helper tool to identify strings from the raw syslog events in the 
rawEvent column that you want to add to a query. (You cannot use the Regex Helper 
for CEF events displayed in the rawEvent column.) See “Regex Helper Tool” on 
page 126 for details about the Regex Helper tool.

Using the Histogram
Use the following guidelines to effectively and efficiently use histograms:

 Histogram of the matching events is generated automatically. You cannot disable it, 

however, you can click   to the upper-right corner of the histogram to hide it. To 

display a hidden histogram, click the  icon.

 Histogram is based on the Logger receipt time of the events (similar to search queries 
that also use the Logger receipt time to search for events).

 The time distribution on the X-axis is determined automatically. 

 You can mouse-over any histogram bar to view the number of matching events and 
the date and time period that the bar represents.

 You can drill-down to events in a specific time period by clicking the bar on the 
histogram that represents that time period. The selected section is highlighted and the 
events matching that time period are listed below the histogram. The histogram 
continues to display the distribution of all of the matching events, as shown in the 
following figure. For example, if you select a bar that represents 11,004 events on 
2/22/2010 from 12:25:49 a.m. to 12:26:49 a.m. in the following histogram, the details 
of those events are listed below the histogram; however, the histogram displays all 
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time units and the associated bars. You can also select multiple consecutive bars on 
the histogram to view matching events in all of the selected time units. To deselect a 
selected bar, click it. 

 A histogram is progressively built and displayed as events match a search query. If the 
search query needs to scan a large amount of data or a large time period, the 
histogram displayed initially might refresh multiple times while the query is running. To 
view the complete (and final) histogram of a search query, wait until the query has 
finished running (that is, the screen does not display the circular “waiting” icon 
anymore).

 The time range on the X-axis might not match the time range specified in the search 
query because the start and end times on the X-axis are determined by the event 
times of the first and last matching events of the search query.

 The first one million matching events are plotted on the histogram. If a search query 
matches more than one million events, an informational message is displayed on the 
screen. 

If you need to use the histogram view for event analysis for a search query that 
matches more than one million events, ArcSight suggests that you adjust the time 
range specified in your search query such than less than one million are matched to 
obtain a complete and meaningful histogram or use a pipeline operator such as top, 
head, or chart to further refine search results such that the total number of hits is 
under one million events.

Multi-line Data Display
An event message might span multiple lines separated by characters such as newline (\n) 
or carriage return (\r). For example, 
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0x0000: 0000 0100 0000 0000 0000 0000 0000 0000 ................ 
0x0010: 0000 0000 0000 0000 0000 0000 0000 0000 ................ 
0x0020: 0000 0000 0000 0000 0000 0000 0000  .............. 

Logger v4.x user interface displays such a message in the expected multi-line format and 
does not remove the line separators and collapse the message into one line, as shown in 
the following figure.

Auto Updating Search Results
The Auto Update feature executes the search over specified intervals, updating the search 
results if new events match the query. Depending on your needs, you can auto update the 
search results every:

 30 seconds

 60 seconds

 2 minutes

 5 minutes (default)

 15 minutes

You can enable this option for a search operation before or after running it. Once you 
enable this option, the setting persists for all search operations until you explicitly disable 
it.

To auto update search results:

1 Click Analyze > Search.

2 Check the Auto Update box and select the refresh interval if different from the 
default, 5 minutes.

Understanding Field Summary
When a query is run, the Field Summary panel lists the CEF and non-CEF fields that occur 
in matching events and the number of unique values for each in those events. This panel is 
only displayed for queries that do not generate charts. If a peer search is performed, the 
summarized fields values include counts from peer Loggers.
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The Field Summary panel contains two sections: Selected Fields and Discovered Fields. The 
Selected Fields section lists the CEF fields, while the Discovered Fields section lists the non-
CEF fields discovered in raw events (described later in this section). By default, the 
Selected Fields list contains these fields: deviceEventClassId, deviceProduct, deviceVendor, 
deviceVersion, and name; you can edit this list to suit your needs, as described in “To 
change the default Selected Fields list:” on page 136. For both lists, by default, the top 10 
values for each field are listed.

The Field Summary feature can automatically discover non-CEF fields from a raw event if 
the Discover Fields checkbox (next to the Local Only checkbox on top of the “Search:” text 
box) is checked. To auto discover fields, the raw event must contain data in the 
"key=value" format, and none of these characters can be the first character of the “value”: 
comma, space, tab and semicolon. For each “key=value” pair found in a raw event, a new 
field of the name "key" is created. The Field Summary includes a summary of the values for 
all the new fields under the Discovered Fields section. The discovered fields are assigned 
the type “String” by default. The auto-discovery capability works only if at least 2,500 of 
the first 10,000 matching events contain "key=value" pairs. If this threshold is not met, 
auto discovery is automatically turned off. However, this threshold does not apply if there 
are less than 10,000 matching events; in that case, fields are discovered regardless.

You can drill-down on any of the listed fields or a specific value of the listed fields. For 
example, you might want to view all events containing deviceEventClassId (specific field) 
or you might want to view events of deviceEventClassId “storagegroup:100” (specific value 
of a field). 
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For fields whose values are of type String, you can view all events, view the top 10, or 
create charts of the matching events. For fields whose values are of type Numeric, you can 
perform mathematical operations such as average, min, and max. 

Every time you run a query or drill-down on a specific field or value, a new query using the 
newly selected criteria is run and the Field Summary list is updated. 

You can search for a specific field or filter the listed fields by specifying a filter criteria in the 
Filter text box located at the top of the Field Summary panel, as shown in the following 
figure. 

For example, if you want to see fields that begin with “device”, enter “device” in the Filter 

text box. To go back to the default list, click the  icon. You can sort the field list by 
Name or Count. To do so, select the sort criteria from the “Sort By:” drop-down menu. 

To change the default Selected Fields list:

1 Define or update an existing custom field set to include fields you want the Selected 
Fields list to contain. See “Field Set” on page 111 for information on creating custom 
field sets.

2 Select the custom field set you defined to view search results. 

After running a search query, if you select a different field set, the Field Summary 
panel displays the following message:

The Field Summary is out of sync with the Events table.

This message indicates that the fields listed in the Field Summary panel do not match 
the ones specified in the newly selected field set. To display the fields specified in the 
new field set, click Update now.

Exporting Search Results
You can export search results in these formats:

 PDF—Useful in generating a quick report of the search results. The report includes a 
table of search results and any charts generated for the results. Both, raw and CEF 
events, can be included in the exported report.

 Comma-separated values (CSV) file—Useful for further analysis with other software 
applications. The report includes a table of search results. Charts cannot be included in 
this format.
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Data for the following time fields is exported in human-readable format: 
deviceReceiptTime, startTime, endTime, agentReceiptTime. For example, 2011/03/21 
20:22:09 PDT. 

The following is an example of a quick report generated in PDF format. The chart is 
displayed first, followed by a table of matched events (not shown in this example). All 
generated charts (including stacked charts) can be exported. 

To export search results:

1 Run a search query.

2 Click Export Results in the top right-hand side of the search results screen. 

3 Select from the following export options.

Option Description

Save to local 
disk

The file is saved to a local system from which you are accessing 
Logger or is it sent to the browser for viewing or saving.

Export to 
remote loca-
tion

On a Logger appliance, the file is written to an NFS mount, a 
CIFS mount, or a SAN system.

On the software version of Logger, data is always stored in 
the /opt/data/logger directory. This directory can reside 
locally on the system running the Logger software, or on a 
remote storage system such as NFS or CIFS.

Save to Log-
ger

The file is written to the Logger’s local storage.
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File Format CSV, for comma-separated values file.

PDF, for a report-style file that contains search results as charts 
and in tables. Charts are only included in the PDF file if the 
search query contains an operator that creates charts, such as 
chart, top, and so on.

Export file 
name 

(Available only when the “Export to remote location” option is 
selected)

Specify the name of the file to which events will be exported. 

If a file of the specified name does not exist, it is created. If a 
file of the specified name exists and the Overwrite box is not 
checked, an error is generated. If the Overwrite box is checked, 
the existing file is overwritten.

Title (Optional, available only when the File Format is “PDF”) 

A meaningful name that appears on top of the PDF file. If no 
title is specified, “Untitled” is included. 

Fields A list of event fields that will be included in the exported file.

By default, all fields are included. 

You can enter fields or edit the displayed fields by deselecting 
All Fields. 

Chart Type 
(for PDF only)

(Available only when a chart is available in search results)

Type of chart to include in the PDF file. You can select from:

Column, Bar, Pie, Area, Line, Stacked Column, Stacked Bar.

Note: If the Chart Type is different from the chart displayed on 
the Search Results screen, the value selected for this option 
overrides the one shown in the screen. Therefore, the exported 
PDF contains the chart you specify for this option and not the 
one shown on the screen.

Chart Result 
Limit (for PDF 
only)

(Available only when a chart is available in search results)

Number of unique values to plot. Default: 10 

If the configured Chart Result Limit is less than the number of 
unique values for a query, the top values equal to the Chart 
Result Limit are plotted. That is, if the Chart Result Limit is 5 
and 7 unique values are found, the top 5 values will be plotted.

Include Sum-
mary

Include an event count in the exported search results.

Option Description
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4 Click Export.

Scheduling an Export Operation
The time it takes to export search results is proportional to the number of events being 
exported. Therefore, for a large number of events, ArcSight recommends that you schedule 
the export operation to be performed at a later time by saving the query and time 
parameters as a Saved Search, and then scheduling a Saved Search Job. For more 
information about Saved Search Jobs, see “Scheduled Saved Search” on page 209.

Indexing 
Logger’s storage technology enables indexing of events in these ways:

 Full-text indexing—Each event is tokenized and indexed. See “Full-text Indexing 
(Keyword Indexing)” on page 139.

 Field-based indexing—Event fields are indexed based on a predetermined schema. See 
“Field-based Indexing” on page 140.

A Logger can have both types of indexing enabled at the same time.

How indexing works
Once you enable indexing on Logger, it starts scanning events automatically and indexing 
them according to the indexing method you have enabled. You can have both methods—
full-text and field-based—enabled at the same time. Once indexing is enabled on Logger, it 
cannot be disabled.

Events are indexed from the point at which you enable indexing. An event is timestamped 
with the Logger receipt time when it is received on the Logger. Logger uses the receipt 
time of an event and the time when a field was added to the index (for field-based 
indexing) and when full-text indexing was enabled (for full-text indexing) to determine 
whether that event will be indexed. If the receipt time of the event is equal to or later than 
the time when the field was added to the index (for field-based indexing) and when full-
text indexing was enabled (for full-text indexing), the event is indexed; otherwise, it is not.

The following events are not indexed:

 Existing non-indexed events on a Logger that is upgraded to v4.0. 

 Events received on a Logger before indexing was initiated on it. 

 Events that are archived.

Full-text Indexing (Keyword Indexing)
For full-text indexing, each event is scanned and divided into keywords and stored on the 
Logger. Full-text indexing is not enabled by default; you are prompted to enable it at 
initialization time (described at “Initializing the Logger Appliance” on page 29). Once you 
do so, Logger automatically indexes incoming events from that point on. 

Include Only 
CEF Events

Only include CEF events in the exported search results. 

Include Base 
Events

Include base events in the exported search results.

Option Description
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If you do not enable full-text indexing at initialization time, you can do so at any time on 
the Search Optimization page (Configuration > Search Optimization). Once enabled, 
full-text indexing cannot be disabled. For details about enabling full-text indexing, see 
“Enabling Indexing” on page 142.

Field-based Indexing
The field-based indexing capability allows for fields of events to be indexed. The fields are 
based on a predetermined schema. The Logger’s reports and the field search method 
utilize these indexed fields to yield significant search and reporting performance gains.

Field-based indexing is not enabled by default; therefore, no fields exist in the index by 
default on new Logger; however, it is automatically enabled once you add at least one field 
to an index. 

Although you can add fields to an index at any time, you are presented with a list of 
recommended fields during the initialization sequence of Logger (described at “Initializing 
the Logger Appliance” on page 29). Once you index those fields, indexing is enabled at 
initialization time. You can add more fields to an index at any time. Once a field has been 
added, you cannot remove it. 

Once you enable indexing on a Logger, Logger starts indexing the event metadata fields— 
event time, Logger receipt time, and device address—for every event in addition to the 
fields you added to the index. The event metadata fields are also referred to as the 
“internal” fields and are in addition to the fields you can add through the Logger’s user 
interface.

The following fields are available for indexing. The fields that ArcSight recommends to you 
to add during Logger initialization are indicated in bold font. In addition to the following 
fields, the requestUrl field is available for search queries. However, this field cannot be 
indexed. 

• ArcSight strongly recommends that you index fields that you will be using 
in search and report queries. Additionally, ArcSight recommends that you 
index the recommended fields at the initialization time to optimize search 
performance. 

• The requestUrl field is available for search and report queries; however, 
this field cannot be indexed. 

Indexable Fields

agentAddress deviceCustomDate2 flexDate1

agentHostName deviceCustomDate2Label flexDate1Label

agentNtDomain deviceCustomNumber1 filePath

agentSeverity deviceCustomNumber1Label flexNumber1

agentType deviceCustomNumber2 flexNumber1Label

agentZone deviceCustomNumber2Label flexNumber2

agentZoneName deviceCustomNumber3 flexNumber2Label

agentZoneResource deviceCustomNumber3Label flexString1

agentZoneURI deviceCustomString1 flexString1Label
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Guidelines for Field-based Indexing
Make sure you are familiar with these guidelines before you index any fields:

 Events are indexed by any fields you add to the index and the default event metadata 
fields—event time, Logger receipt time, and device address. 

applicationProtocol deviceCustomString1Label flexString2

baseEventCount deviceCustomString2 flexString2Label

bytesIn deviceCustomString2Label message

bytesOut deviceCustomString3 name

categoryBehavior deviceCustomString3Label priority

categoryDeviceGroup deviceCustomString4 requestClientApplication

categoryObject deviceCustomString4Label requestContext

categoryOutcome deviceCustomString5 requestMethod

categorySignificance deviceCustomString5Label requestUrlFilename

categoryTechnique deviceCustomString6 requestUrlQuery

customerName deviceCustomString6Label sessionId

destinationAddress deviceEventCategory sourceAddress

destinationDnsDomain deviceEventClassId sourceHostName

destinationHostName deviceExternalId sourceMacAddress

destinationMacAddress deviceHostName sourceNtDomain

destinationNtDomain deviceInboundInterface sourcePort

destinationPort deviceOutboundInterface sourceProcessName

destinationProcessName deviceProduct sourceServiceName

destinationServiceName deviceReceiptTime sourceTranslatedAddress

destinationTranslatedAddress deviceSeverity sourceUserId

destinationUserPrivileges deviceVendor sourceUserName

destinationUserId deviceVersion sourceUserPrivileges

destinationUserName deviceZone sourceZone

destinationZone deviceZoneName sourceZoneName

destinationZoneName deviceZoneResource sourcezoneResource

destinationZoneResource deviceZoneURI sourceZoneURI

destinationZoneURI endTime startTime

deviceAction eventId transportProtocol

deviceAddress externalId type

deviceCustomDate1 fileName vulnerabilityExternalID

deviceCustomDate1Label VulnerabilityURI

Indexable Fields
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 You can index up to 123 fields on Logger. This number includes the custom schema 
fields you may have added to your Logger. 

 Once a field has been added to the index, it cannot be unindexed.

 Only users belonging to a System Admin Group can add fields to index.

 After you add a field to the index, Logger might not immediately start indexing on that 
field. Therefore, allow some time between adding a field and using it in the search 
query. If Logger is in the process of indexing on a field and you use that field to run a 
search query, the search performance for that operation will be slower than expected.

 Once you initiate indexing on your Logger, it starts indexing events it receives from 
that point on. Any existing events are not indexed.

 If an event field contains data of unexpected type (for example, a string when an 
integer is expected), the data is ignored. Therefore, search for that data value will not 
yield any results. For example, if the port field contains a value 8080A (alphanumeric) 
instead of 8080 (numeric), the alphanumeric value is ignored.

 For faster report generation, ALL fields of a report (including the fields being displayed 
in the report) need to be indexed. That is, in addition to the fields in the WHERE 
clause of the query, the fields in the SELECT clause also need to be indexed. 

 For optimal search performance, make sure that event fields on ALL peers are indexed 
for the time range specified in a query. If an event field is indexed on a Logger but not 
on its peers for a specific time range, a distributed search will run slower on the  
Loggers. However, it will run at optimal speed on the local Logger. Therefore, the 
search performance in such a setup will be slow. 

 Although the requestUrl field is available for search and report queries, it cannot be 
indexed. Including this field in such queries will result in the query running slower than 
a search performed on indexed data.

Enabling Indexing
If you did not enable indexing on Logger at initialization time (described at “Initializing the 
Logger Appliance” on page 29), you can do so using these instructions.
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To enable indexing:

1 Click Configuration > Search Optimization > Search Indexes.

2 To enable full-text indexing:

a Click Enable full text indexing.

3 To enable field-based indexing:

a Select the fields from the Indexable Fields list.

To select multiple fields at the same time, hold the Ctrl key down and click on the 
fields.

b Click Add.

Saving Queries (Saved Filters and Searches) 
If you need to run the same search query regularly, you can save it in these ways:

 As a filter

A Filter saves the query expression, but does not save the time range or the field set 
information. 

 As a saved search

A saved search saves the query expression and the time range that you specified. 

For information about Saved Search Alerts, see “Creating and Managing Saved Search 
Alerts” on page 194.
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Saving a Query
To save a query:

1 Define a query as described in “Searching for Events on Logger” on page 128 or 
“Using the Search Builder Tool” on page 120.

2 Click the Save icon ( ) and enter a name for the query in the Name field, as shown in 
the following figure.

3 In the Save as field, select whether you want to save this query as a filter, as a saved 
search, or as a Dashboard panel.

If you select to save as a Saved Search, you can either keep the saved query as 
Saved Search or change it to a Scheduled Alert by specifying a schedule based on 
which the query runs periodically and generates alerts. 

If you choose to schedule the Saved Search, you can either specify the schedule in 
the following screens or skip it for now.

If the search query includes an aggregation operator such as chart or top, a third 
option to save the query for a Dashboard panel is also displayed. If you select this 
option, you need to enter the following parameters.

Parameter Description

Title Enter a meaningful name for the panel that will be added to the 
Dashboard.
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4 Click Save.

Using a Saved Filter or a Saved Search
To use a saved filter (or a saved search):

1 Click Analyze > Search.

2 Click the Load a Saved Filter icon ( ) to view a list of all the saved filters and saved 
searches to display the Load Filter/Saved Search interface, as shown in the following 
figure.

Saved search Select an existing saved search from the drop-down box that 
will be overwritten with this query.

OR

Select “New saved search” to create a new saved search query. 
Enter the new name in the text box. 

Dashboard Select an existing Dashboard from the drop-down box to which 
the Search Results panel will be added. 

OR

Select “New dashboard” to add the Search Results panel to a 
new Dashboard. Enter the name of the new Dashboard in the 
“Dashboard Name” field.

Panel type Select the type of panel:

• Chart—Displays search results in a chart form

• Table—Displays search results in a table form

• Chart and Table—Adds two panels, one for displaying search 
results in the chart form and the other for displaying search 
results in the table form

Chart type Type of chart to display matching events. You can select from:

Column, Bar, Pie, Area, Line, Stacked Column, Stacked Bar.

Default: Column

Chart limit Only applicable to Search Result Chart panels.

Number of unique values to plot. Default: 10 

Parameter Description
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The Load Filter/Saved Search interface enables you to quickly locate the saved filters 
and the saved search queries. Click on any of the column names to sort information. 
To view details of a filter or a saved search, click its row. Details are displayed in the 
textbox below. 

3 To reload a filter, select the filter or saved search you want to use and click 
Load+Close. The filter rows display the search query. 

To reload a saved query, click the Saved Searches tab, select a search, and click 
Load+Close.

System Filters/Predefined Filters
Your Logger ships with a number of predefined filters, also known as system filters. These 
filters define queries for commonly searched events. For example, unsuccessful login 
attempts or the number of events by source. Filter queries are available as Unified queries 
and as Regular Expression queries. Unified queries can be used for searching and reporting 
while Regular Expression queries are for defining alerts and forwarders. 

The following is a list of all the system filters. 

• Even though the Category - System Alert filters (listed in the last section 
of the following table) are displayed on the user interface of the software 
version of Logger, these filters do not apply to it. 

• To effectively use the Firewall or UNIX Server use case filters (listed in the 
following table), define device groups that include the firewall devices or 
UNIX servers that you are interested in and then constrain your search to 
those device groups. If you do not create device groups specific to device 
types, the search results would match all Deny, Drop, or Permit events 
from all devices instead of only the firewall devices. Similarly, the “Unix-
IO Errors and Warnings” filter would include IO errors and warnings from 
all devices and not only the UNIX servers. 

Category Unified Query Filters Regular Expression Query Filters

Login 
Status use 
case

All Logins All Logins (Non-CEF)

All Logins (CEF format)

Unsuccessful Logins Unsuccessful Logins (Non-CEF)

Unsuccessful Logins (CEF format)

Successful Logins Successful Logins (Non-CEF)

Successful Logins (CEF format)

Failed Logins

Configurat
ion

Configuration Changes System configuration changes (CEF format)

Events 
use case

High and Very High Severity Events High and Very High Severity CEF events

Event Counts by Source

Event Counts by Destination

All CEF events

Intrusion 
use case

Malicious Code Malicious Code (CEF format)
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Firewall 
use case

Deny (Firewall Deny)

Drop (Firewall Drop)

Permit (Firewall Permit)

Network 
use case

DHCP Lease Events

Port Links Up and Down

Protocol Links Up and Down

Connector 
System 
Status use 
case

CPU Utilization by Connector Host

Disk Utilization by Connector Host

Memory Utilization by Connector 
Host

UNIX 
Server use 
case

CRON related events

IO Errors and Warnings

PAM and Sudo Messages

Password Changes

SAMBA Events

SSH Authentications

User and Group Additions

User and Group Deletions

Windows 
Events 
use case

Account Added to Global Group

Audit Policy Change

Change Password Attempt

Global Group Created

Logon Bad User Name or Password

Logon Local User

Logon Remote User

Logon Unexpected Failure

New Process Creation

Pre-Authentication Failure

Special Privileges Assigned to New 
Logon

User Account Changed

User Account Password Set

Windows Events (CEF)

Category Unified Query Filters Regular Expression Query Filters
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Using a System Filter
To use a predefined system filter, follow instructions in “Using a Saved Filter or a Saved 
Search” on page 145.

Alerts
You can configure your Logger to alert you by e-mail, an SNMP trap, or a Syslog message 
when a new event that matches a specific query is received or when a specified number of 
matches occur within a given time threshold.

Only regular expressions can be used in queries specified for alerts. 

Starting with v4.5, audit events for alerts are only written to the Internal Storage group 
and not forwarded to ESM by default. If you need to forward these audit events to ESM, 
please contact ArcSight Customer Support for assistance. Please note that this change only 
applies to audit events generated for alerts; other audit events are unaffected.

System 
Alerts

System Alerts: The following filters search for specific internal alert events, which are 
written in CEF format to a special Internal Storage Group. These filters are 
available for both search methods. In addition to the following filters, you can 
define your own alerts based on the system health events listed in “System Health 
Events” on page 400.

NOTE: Although these filters are displayed on the software version of Logger, these 
do not apply to it. 

CPU Utilization Above 90 Percent CPU Utilization Above 90 Percent

CPU Utilization Above 95 Percent CPU Utilization Above 95 Percent

Disk Failure Disk Failure

Root Partition Below 10 Percent Root Partition Below 10 Percent

Root Partition Below 5 Percent Root Partition Below 5 Percent

Device Configuration Changes Device Configuration Changes

Filter Configuration Changes Filter Configuration Changes

High CPU Temperature High CPU Temperature

Bad Fan

Power Supply Failure Power Supply Failure

RAID Status Battery Failure RAID Status Battery Failure

RAID Status Disk Failure RAID Status Disk Failure

Storage Configuration Changes Storage Configuration Changes

Storage Group Usage Above 90% Storage Group Usage Above 90%

Storage Group Usage Above 95% Storage Group Usage Above 95%

Zero Events Incoming Zero Events Incoming

Zero Events Outgoing Zero Events Outgoing

Category Unified Query Filters Regular Expression Query Filters
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Viewing Alerts
In addition to receiving an alert through the methods mentioned above, you can also view 
them through the user interface.

The Alert sub-tab under the Analyze tab presents a user interface that is similar to Search. 
From this page, you view Alerts and the base events that triggered them, as shown in the 
following figure. 

When you create Alerts (see “Alerts” on page 188), you name them, and you can choose to 
view only events associated with a particular Alert. The default is All Alerts.

To view Alerts, choose a predefined time range, such as “Last 2 hours” or “Today,” or 
choose “Custom Time Range” to reveal additional fields for specifying a time range 
manually. This aspect works like Search. Refer to “Time Range” on page 109 for more 
detail.

Receiving Alerts for Events
To receive alerts:

1 Configure the Logger’s SMTP with the desired e-mail address destination (see “Static 
Routes” on page 349) or create an SNMP Destination (see “SNMP Destinations” on 
page 200) or Syslog Destination (see “Syslog Destinations” on page 201).

2 Create a query to find the events of interest; save the query as a Filter. (See “Saving 
Queries (Saved Filters and Searches)” on page 143.) 

Number of destinations per alert:

• E-mail: Multiple, each separated by a comma.

• SNMP: One

• Syslog: One 
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3 Create an Alert that uses the new Filter and specify match count and threshold (see 
“Alerts” on page 188.) Enable the new Alert. 

Base Event Fields
Events that are labeled ‘Action Engine’ are Alert events. Other events are base events--that 
is, the events which triggered the Alert.

Go, Export, and Auto Update Options
The Go and Export Results buttons and the Auto Update option accomplish the same 
tasks in both the Search and Alert pages. For more information, see “Searching for Events 
on Logger” on page 128, “Understanding the Search Results Display” on page 130, 
“Viewing Alerts” on page 149, and “Advanced Search Options” on page 129.

Live Event Viewer
The Live Event Viewer provides real-time view of the incoming events that match the 
criteria you specify. This functionality is useful in environments where the need to view an 
event quickly is important; for example, a financial institution might be interested in 
viewing a specific transaction type as soon as it occurs. Because the latency between the 
events arriving at Logger and the display time is quite less, events might not have been 
indexed on Logger before being displayed.

The Live Event Viewer composes of two tabs—Search Composer and Search Results. The 
Search Composer is for defining the search criteria and the Search Results tab displays the 
matching events in real time. 
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The following figure shows the Search Composer. If more than one filter is specified, the 
resulting query uses the AND operator to combine them. For example, if the first filter 
searches for “failure” and the second filter excludes “admin”, the resulting query is “failure 
AND NOT admin”.

The Search Results tab provides the Play, Pause, Stop, Clear, and Export buttons that 
enable you to control the display in a manner similar to any electronic device, as shown in 
the following figure.

The following list highlights the features of Search Results display:

 Events are displayed in the raw event format and not in the columnar, table form as 
displayed in the Search Results page (Analyze > Search) when you run a search query.

 A user can launch a maximum of one Live Event Viewer. And, there can be a maximum 
of five Live Event Viewers running on Logger at any time. 

 The regular expression search method is used to identify matching events. Therefore, 
you can specify regular expressions as the search term in the Search Composer.

 Buffer Size defines the maximum number of events displayed in the Viewer. By default, 
the Buffer Size is 1000, however, it can be set to any number between the range of 20 
and 5000. 
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 By default, the search is run for 15 minutes and then stopped to preserve system 
resources. If you need to run the search for longer than 15 minutes, click the  icon 
next to the countdown timer to reset the timer to 15 minutes. 

 When you click Pause, the Search Results display is frozen. However, the search 
operation continues in the background and the new matching events are buffered until 
a maximum of 1000 events have been buffered or the search timer, which continues to 
count down even when the Search Results display is frozen, reaches 00:00. 

If the timer has not reached 00:00, you can click Play to resume the paused search 
operation. When you click Play, the buffered events are displayed. The newly found 
events are appended to the previously found events on the Search Results display 
screen. 

 When you click Stop, the search for matching events and the count down of the search 
timer stop. When you click Play, the search is started afresh—the currently displayed 
events are cleared from the Search Results screen, the search timer is reset to 15 
minutes, and the search starts again.

 You must stop the search operation to export the matching events. 

To launch a Live Event Viewer:

1 Click Analyze > Live Event Viewer from the top-level menu bar.

2 In the Search Composer tab, enter the search terms or click the ( ) icon to select a 
saved filter. 

You can enter search terms that the event must contain (Search For:) or terms that 
the events must not contain (Exclude From Search:). Click the “Search For:” field to 
display a drop-down list from which you can select “Exclude From Search:”.

If more than one filter is specified, the AND operator is used to combine them in the 
resulting search query.

To add additional filters, click the ( ) icon.

To remove a filter line, click the ( ) icon.

To remove all filters, click the ( ) icon.

3 Enter constraints to limit your search to specific device groups, devices, or storage 

groups in the “Where do you want to look?” section. Click the ( ) icon to display a 
list from which you can choose the constraints. 

4 Click Start. 

The search results are automatically displayed in the Search Results display screen. 

To update the Live Event Viewer query:

1 In the Search Composer tab of the Live Event Viewer, update the search terms. 

2 Click Stop first, then Start to start search using the new search terms.

Live Event Viewer is a resource-intensive application that can impact the 
overall performance of your Logger if run for a long period of time. Therefore, 
use this feature selectively and for short periods of time.
152 Administrator’s Guide Confidential



4 Searching and Analyzing Events
To export Search Results display:

1 Make sure you have stopped the Live Event Viewer. To do so, click the ( ) icon in the 
Search Results display window.

2 Click the ( ) icon to open the Export Options window.

3 Follow Step 3 onward in “To export search results:” on page 137 to export the 
displayed search results.
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Chapter 5

Configuration

This chapter describes the Configuration tab, in which you create and manage Receivers, 
Forwarders, Devices, Device Groups, and Filters.

Receivers, Devices, and other resources created by one user are visible to all other users, 
although subject to user group privileges. Resources are shared by all sessions.

In this chapter:

Devices
The Devices section manages both Devices and named collections of Devices called Device 
Groups.

Devices
A Device is a named event source, comprising of an IP address (or hostname) and a 
Receiver name. Two Receivers can receive events from the same IP address, so IP address 
alone is insufficient to identify a Device. Event source is the device that directly sends the 
event to Logger. When an event is sent through a SmartConnector, the event source is the 

“Devices” on page 155

“Event Archives” on page 158

“Storage” on page 165

“Event Input/Output” on page 171

“Alerts” on page 188

“Scheduled Tasks” on page 203

“Filters” on page 204

“Saved Searches” on page 207

“Search Optimization” on page 212

“Peer Loggers” on page 215

“Configuration Backup and Restore” on page 219

“System Maintenance” on page 222

“License Information” on page 237

“Retrieve Logs” on page 238

“Exporting and Importing Content” on page 238
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system on which the SmartConnector is running and not the device that sent the event to 
the SmartConnector.

Devices can be added to Device Groups, and Device Groups can be referenced in filters and 
queries. Receivers perform autodiscovery by automatically creating a Device for each 
source IP address. Devices created by autodiscovery are named for their hostname, or if 
the hostname cannot be determined, their IP address.

Figure 5-1 shows the Devices page, which displays all defined Devices and includes 
controls to add, edit, or delete them.

Figure 5-1 Devices page

Maximum number of devices that can be defined on Logger: No limit.

To pre-define a Device

Autodiscovery creates Devices automatically, but you can also pre-define them manually.

1 Click the Configuration > Settings tab, click Devices in the sub-menu, then click 
the Devices tab. A display similar to that shown in Figure 5-1 appears.

2 Click Add. 

3 Enter a name, an IP address, and select a Receiver for the new Device.

4 Click Save to add the new Device, or Cancel to abandon it.

To edit a Device

One reason for editing a Device is to replace the default name created by autodiscovery 
(the IP address or hostname) with a more meaningful one.

1 Click the Configuration > Settings tab, click Devices in the sub-menu, then click 
the Devices tab. A display similar to that shown in Figure 5-1 appears.

2 Locate the Device to be edited and click the edit icon ( ) on that row.

3 Change the Name or IP address for the Device.

4 Click Save to update the Device Group, or Cancel to abandon your changes.

Even though there is no limit on the number of devices (IP address of event 
source + receiver) you can create on Logger, there is limit on the number of 
source devices (event sources) from which your Logger can receive events. 
The limit on maximum number of source devices is imposed by the license 
you obtained when you purchased your Logger. 
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To delete a Device

1 Click the Configuration > Settings tab, click Devices in the sub-menu, then click 
the Devices tab. A display similar to that shown in Figure 5-1 appears.

2 Locate the Device to be deleted and click the delete icon ( ) on that row. Deleting a 
Device does not block the source IP address from sending events. If new events are 
received, autodiscovery recreates the Device.

3 Confirm the deletion by clicking OK, or click Cancel to retain the Device.

Device Groups
Device Groups allow you to categorize named source IP addresses called Devices. The 
Device Groups page, shown in Figure 5-2, lists all Device Groups with edit and delete icons 
and includes the ability to create new Device Groups. 

Maximum number of device groups that can be created on Logger: No limit.

To create a Device Group

1 Click the Configuration > Settings tab, click Devices in the sub-menu, then click 
the Device Groups tab. A display similar to that shown in Figure 5-2 appears.

2 Click Add. 

3 Enter a name for the new Device Group. Click to select devices from the list. Press and 
hold the Ctrl key when clicking to add additional Devices to the selection. To select a 
range of Devices, click to select the first device, then press and hold the Shift key 
while clicking the last device.

Device groups can be associated with storage rules that define in which 
storage group events from a specific devices are stored. Doing so enables you 
to retain event data from different sources for a different lengths of times 
(because you can define different retention policies on different storage 
groups). For more information about storage rules, see “Storage Rules” on 
page 167. 
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4 Click Save to create the new Device Group, or Cancel to abandon it.

Figure 5-2 Device Groups page

To edit a Device Group

1 Click the Configuration > Settings tab, click Devices in the sub-menu, then click 
the Device Groups tab. A display similar to that shown in Figure 5-2 appears.

2 Locate the Device Group to be edited and click the edit icon ( ) on that row.

3 Change the Name or add or remove Devices from the selection. Ctrl-Click devices that 
are not selected to select them, or Ctrl-Click selected devices to remove them from the 
selection.

4 Click Save to update the Device Group, or Cancel to abandon your changes.

To delete a Device Group

1 Click the Configuration > Settings tab, click Devices in the sub-menu, then click 
the Device Groups tab. A display similar to that shown in Figure 5-2 appears.

2 Locate the Device Group to be deleted and click the delete icon ( ) on that row. 
Deleting a Device Group does not affect the set of Devices.

3 Confirm the deletion by clicking OK, or click Cancel to retain the Device Group.

Event Archives
Event Archives enable you to save the events for any day in the past, not including the 
current day. Archive Storage Settings must be configured before Event Archives can be 
created. Archive Storage Settings specify the location to which event archives will be 
written. 

For Logger appliances, the location needs to be an NFS mount, CIFS mount, or SAN, 
which is configured using the Logger user interface. For the software Loggers, the 
location is a directory (either local or a mount point that you have already established on 
the machine on which the Logger software is installed). 
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Starting with Logger v5.1, events in each storage group are archived separately. That is, 
one archive file is created for each storage group, for each day. In addition, you can bulk 
archive events—that is, specify a range of dates to archive events in a single archive 
operation. 

Archiving events from each storage group to a separate archive location enables you to 
keep data in specific storage groups longer than others. You need to specify these locations 
when you configure the Archive Storage Settings before archiving any events, as shown in 
the following figure. 

For Logger appliances, the path you specify in the Archive Path field is appended to the 
path specified in the Mount Location. On a software Logger, you need to enter a complete 
path where the archive file will be written in the Archive Path field. This path could be a 
local directory or a mount point that is already established on the machine on which the 
Logger software is installed. The Mount Location field is not available on a software Logger. 

Logger uses the receipt time of an event to determine its archival day. For example, an 
event with timestamp of 11:55:00 p.m. on December 7 is received at 12:01:00 a.m on 
December 8 on the Logger. This event is archived in the archive file created for December 
8th and not December 7th. When an archive operation occurs, one archive file per storage 
group is created at the location specified in Archive Storage Settings. Each archive file 
contains events from 12:00:00 a.m. to 11:59:59 p.m. for a single storage group of any 
given day. When you specify a range of dates, one archive file per storage group, for each 
specified day is created.

You can archive events in two ways: manually and scheduled. When archiving events 
manually, you specify the start and end dates of the event archive, and the storage groups 
that should be archived. This operation occurs one-time, for the specified date range. 

The above figure is from a Logger appliance. The Mount Location field is not 
available on a software Logger. 
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When scheduling event archives, you specify the time at which the archive operation 
should occur everyday and select the storage groups that should be included. 

When Logger starts archiving, it proceeds sequentially through the various storage groups, 
as listed on the Daily Task Settings page (for scheduled archives) or the Add Event Archives 
page (for manual archives). 

Once the events have been archived, they are not deleted from the local storage until the 
events (and their related indexing information) age out due to the configured retention 
policy. These events continue to be included in search operations until they age out. 

Once events that have been archived are deleted from Logger's local storage, they are not 
included in search operations. To include such events in search operations, you must load 
the archive in which those events exist back to the Logger. When an Event Archive is 
loaded, its events are included in searches, but the archive itself remains on the remote 
storage. 

When events are archived, index information for those events is not archived. Therefore, 
when event archives are loaded, indices are not available. As a result, a search query that 
runs on archived events (that have been loaded on Logger) is slower than when the data 
was not archived because the index data for the archived data is not available. 

Guidelines for Archiving Events
 If you need to archive a large number of events (in the order of tens of GB), ArcSight 

recommends that you archive during the off-peak hours to prevent impacting the 
performance of your Logger.

 Starting with v5.1, multiple archiving operations such as loading, unloading, archiving, 
and deletion of archives can occur simultaneously. Therefore, you can initiate the 
loading of an existing archive, while an archive operation is in progress.

 Only one manual archive job can run at a time. However, a scheduled archiving 
operation can run in parallel with a manual job.

 You cannot re-archive the events that have been archived already. If you try to do so, 
the Logger reports an error.

 Do not move the archived files from their archive location. The archives that have been 
moved from the originally archived location cannot be loaded on to the Logger. If you 
need to delete the archives, use the Logger user interface to do so. 

 If an archive job fails, you need to initiate it manually. To do so, delete the failed 
archive and archive it manually. To get notified of a failed archive, configure an alert 
for this audit event: Event Archive Failed. For more information about this event, see 
“Logger Application Events” on page 545. For more information about configuring 
alerts, see “Alerts” on page 188. 

 If a Logger appliance goes down while an archive operation is in progress, you need to 
re-initiate the archive operation for only the storage groups that were not archived 
when the operation failed. The status of such storage groups is marked “Failed” in the 
Status column on the Event Archives page. For example, you archive the event data of 
12/1/10, which consists of events from four storage groups “Default”, “Internal”, 
“Short-Term”, and “Long-Term”. The appliance goes down after the events from the 
“Default” and “Internal” groups have been successfully archived, and the events from 
“Short-Term” are being archived. The status of the “Short-Term” storage group on the 

You cannot set event archives to start at 1 a.m. for scheduled archives. This 
restriction is by design to account for the Daylight Savings Time (DST) 
changes.
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Event Archives page will display “Failed”, while the status of the “Default” and 
“Internal” groups will display “Archived”. (The status of the “Long-Term” storage group 
will not be displayed.) In this case, you need to manually re-initiate the archive for the 
“Short-Term” and “Long-Term” storage groups.

 You can cancel an in-progress archive operation that was manually initiated at any 
time using the Cancel link that displays on top of the Event Archives page. 

 If you are upgrading from v5.0 Patch 2 or earlier, you need to note the following 
changes:

 The existing event archives cannot be converted to make use of the storage-
group level granularity that v5.1 or later releases offer. However, any data 
archived after you upgrade to v5.1 or later, will be archived using the storage-
group level granularity. Therefore, after upgrading to v5.1 or later, specify the 
archive locations for each storage group on the Archive Storage Settings page. By 
default, the location you had configured before the upgrade is used for all storage 
groups. 

 Starting with v5.1, the archive locations specified on the Archive Storage Settings 
page can be changed anytime unlike the one-time configuration that was possible 
prior to this release. 

 If you change the archive location, the archives that were created on the 
previously configured location cannot be moved to the new location. 

 The Logger user interface for Event Archives was updated to display relevant 
information for the archiving changes introduced in v5.1. For example, prior to 
v5.1, only the name and date of the archive was displayed. However, starting with 
v5.1, the name, date, and storage group name are displayed—the name of the 
storage group to which the archives pertains is displayed as a separate column on 
the Event Archives page, as shown in the following figure. 

Archiving Events
To save events for a particular day, you need to add an Event Archive. The table in the 
Event Archives tab shows the current archives and their status. A one-time configuration 
for the archive storage location must be established on your Logger before you can add an 

In the above example, the status of the “Long-Term” storage group is not 
displayed on the Event Archives page after the failure occurs because 
archival of this group was never initiated during that archive operation. 

If an archive operation fails, make sure you determine the storage 
groups that could not be archived and re-initiate the archival for all of 
those groups manually. 
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event archive. To establish an archive storage location, see “Archive Storage Settings” on 
page 163. 

To add an Event Archive

1 Click Configuration from the top-level menu bar.

2 Click Event Archives in the left panel. 

3 Click Add in the Event Archives tab, in the right panel.

4 Enter a meaningful name in the Name field for the new Event Archive and specify the 
Start and End dates in the format m/dd/yy, where m is month number, dd is the day of 
the month (with a leading zero if necessary), and yy is the two-digit year number. 

When the Start and End dates are different, one archive file per storage group, for 
each specified day is created. For example, if you specify the following Start and End 
dates:

Start Date: 2/12/10

End Date: 2/13/10

And, you select two storage groups—Internal Event and Default. Then, four archive 
files will be created as a result of this archive operation—two files per storage group 
for the specified two days.

The Event Archives table (under the Event Archives tab) lists the archives by an alias in 
this format: <archive_name>[<yyyy-m-dd>][<storage_group_name>].

5 Select the names of storage groups that need to be included in the archive.

6 Click Save to start archiving events, or Cancel to quit.

To delete an Event Archive

1 Click Configuration from the top-level menu bar.

An archive storage location must be established on the Logger before you can 
archive its events. See “Archive Storage Settings” on page 163 for more 
information.

You can cancel an in-progress archive operation at any time using the Cancel 
link that displays on top of the Event Archives page.
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2 Click Event Archives in the left panel.

3 Click the checkboxes in the left-most column to select the event archives that you 
want to delete. 

4 Click Remove from the top of the screen to delete the selected archives. 

5 Confirm the deletion by clicking OK, or click Cancel to retain the Event Archive.

Scheduled Event Archive
You can schedule a daily event archive and specify what hour of the day it should run. 
Scheduled event archives that have finished running appear on the archive list on the 
Event Archives tab. Only one scheduled event archive can run at a time; however, it can 
run in parallel with a manually scheduled archive.

Make sure you are familiar with the information in “Impact of Daylight Savings Time 
Change on Logger Operations” on page 351 before you schedule an event archive.

To schedule a daily event archive

1 Click Configuration from the top-level menu bar.

2 Click Event Archives in the left panel.

3 Click the Daily Task Settings tab in the right panel.

4 Select a time from the “Time For Daily Archive to Start” list. Scheduled archives must 
start on the hour, and midnight and 1:00 AM are not on the list to allow your Logger to 
receive all of the previous day’s events.

5 Select the storage groups whose events should be included in the scheduled archive. 

6 Click Save to schedule daily event archive, or click on another tab or sub-menu to 
cancel.

Archive Storage Settings
On the Logger appliance, Event Archives are saved to a specific NFS or CIFS mount 
point, or SAN. For the software Logger, event archives are saved to the specified 
directory, which can be a path to a local directory or to a mount point on the machine on 
which the software Logger is installed. To establish a mount point, see your system’s 
operating system documentation.

To perform Archive Storage Setting setup

1 If you are using the Logger appliance, create the NFS or CIFS mount point. (See 
“Storage” on page 365 and “Remote File Systems” on page 365.)

If you are using the software version of Logger and intend to use an NFS or CIFS 
mount point, ensure that the external storage point is mounted on the machine on 
which Logger is installed. See your system’s operating system documentation for more 
information.

2 Click Configuration from the top-level menu bar.

3 Click Event Archives in the left panel.

Starting with v5.1, the archive locations specified on the Archive Storage 
Settings page can be changed anytime unlike the one-time configuration that 
was possible prior to this release.
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4 Click the Archive Storage Settings tab in the right panel.

5 Specify a mount location and an archive path for each storage group. You can specify 
a different path for each storage group, thus enabling the Logger to archive events to 
a different location for each storage group. 

For Logger appliances, choose the name of an NFS mount, CIFS mount, or SAN mount 
point for the Mount Location field. This drop-down list contains the names you 
specified when creating the NFS, CIFS, or SAN mount points (System Admin > 
NFS/CIFS/SAN). 

For software Loggers, the Mount Location field does not exist. You need to enter a 
complete path where the archive file will be written in the Archive Path field. This path 
could be a local directory or a mount point that is already established on the machine 
on which the Logger software is installed. 

The above figure shows a screen from the Logger appliance. On a software Logger, 
the Mount Location field is not available.

6 Click Save.

Loading and Unloading Archives
Archived events must be loaded back on Logger before they can be included in a search 
operation. When an Event Archive is loaded, its events are included in searches, but the 
archive itself remains on the remote storage. When an Event Archive is unloaded, it is 
available for loading, but its events are not included in searches. You can unload a loaded 
archive if you no longer need to include it in your search operations.

You must configure settings for all storage groups on the following page 
even if you don’t intend to archive all of them. 
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To load or unload an Event Archive

1 Click Configuration from the top-level menu bar.

2 Click Event Archives in the left panel.

3 Click the checkboxes in the left-most column to select the event archives that you 
want to load or unload. 

4 Click Load or Unload from the top of the screen to load or unload the selected 
archives. 

Storage
Different storage groups support the implementation of multiple retention policies. Each 
group can have a different policy, and storage rules determine which storage group is used 
for events from specific Device Groups. See “Retention Policy” on page 29. The Storage 
section has three tabs: Storage Groups, Storage Rules, and Storage Volume.

Storage Groups
Storage Groups support multiple retention policies by defining a maximum size (Maximum 
Size) and number of days (Maximum Age) to retain events. Once events are older than the 
specified Maximum Age or there are more events than the storage group will hold (as 
specified by Maximum Size), the oldest events are deleted at the next retention cycle. The 
retention process triggers periodically on Logger, therefore, events might not be deleted 
immediately when events gets older than Maximum Age or the storage group size exceeds 
the Maximum Size limits. 

A maximum of six storage groups can exist on Logger. A Default Storage Group and an 
Internal Storage Group are created automatically during the Logger initialization phase. 
Therefore, you can create up to four additional storage groups. Starting with Logger v5.2, 
the additional storage groups (up to a maximum of six) can be created at any time. 

Once a Storage Group is created, it cannot be deleted however its size can be increased or 
decreased any time. If you are decreasing the size of the storage group and the new size is 
lesser than the currently used space on the storage group, you will need to delete data to 
achieve the new size. Logger UI guides you in this situation to delete sufficient data. See 

Logger can have a maximum of 6 storage groups—two that pre-exist on your 
Logger (Internal Storage Group and Default Storage Group) and four that you 
can create. As a result, now you have five storage groups available for event 
storage and one for Logger’s internal events. 

ArcSight recommends that you create the maximum allowed four additional 
Storage Groups (in addition to the two that preexist—Default Storage Group 
and the Internal Storage Group) during Logger Initialization (as discussed in “4 
Storage Groups” on page 32) even if you do not need all of them because you 
cannot add storage groups after the Logger has been initialized, 
although you can decrease or increase the size of a Storage Group later. 
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“To edit (including resizing) a Storage Group” on page 166 to change the size of a Storage 
group. 

Figure 5-3 Storage Groups page

To add a Storage Group

1 Click Configuration from the top-level menu bar.

2 Click Storage in the left panel. 

3 Click Add in the Storage Groups tab in the right panel.

4 Enter the following values:

5 Click Save to store the changes, or Cancel to quit.

Once the Logger has been set up (initialized), the Storage Groups page, as shown in 
Figure 5-3, does not allow deleting Storage Groups. You must follow instructions in “Adding 
Storage Groups” on page 230 to add additional storage groups. 

To edit (including resizing) a Storage Group

1 Click Configuration from the top-level menu bar.

2 Click Storage in the left panel. 

3 Identify the Storage Group you want to modify and click the edit icon ( ) for it.

4 Change the desired parameters such as the name of the storage group, or increase or 
decrease Maximum Age or Maximum size. 

Note: The name of the Default Storage Group cannot be modified.

If you are reducing the size of the storage group and the new size is smaller 
than the value indicated by the Current Size field on the Edit Storage Group page, 

If you are adding a storage group after your Logger has been initialized, 
follow instructions in “Adding Storage Groups” on page 230.

Parameter Description

Name Choose a name for the Storage Group

Maximum Age Specify the number of days to retain events. Events older 
than this number of days will be deleted.

Maximum Size Enter a maximum event data size, in GB.
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Logger displays the following message, indicating that reducing storage group size in 
this situation will require you to delete existing data.

If you choose to delete data to reduce the storage group size, follow these steps:

a Set the Maximum Age value to the number indicated in the above message. Doing 
so, triggers deletion of events.

b Refresh the Edit Storage Group screen. When the “Current Size” value is less than 
or equal to the storage group size you want to set, go to the next step. Otherwise, 
keep refreshing the screen periodically.

Note: The “Current Size” value changes as data is deleted, which can take some 
time. Therefore, you need to wait before proceeding to the next step. 

c Set the Maximum Size value to suit your needs.

d If you wish, restore the Maximum Age setting (that you changed in Step b) to the 
original value.

If you choose not to delete data, go to the next step to exit the procedure.

5 Click Save to store the changes, or Cancel to quit.

Storage Rules
Storage Rules create a mapping between Device Groups and Storage Groups. Doing so 
enables you to store events from specific sources to a specific storage group. Additionally, 
you can configure these storage groups with different retention policies, and thus retain 
event data based on the source of incoming events. For example, all events from firewall 
devices can be subject to a short retention period. To accomplish this, manually assign the 
firewall devices to a Device Group and then create a Storage Rule that maps the Device 
Group to a Storage Group with the desired short retention period. 

If there is sufficient space to reduce the storage group size, you can 
change it without modifying the Maximum Age value (to modify the 
retention policy to delete data). 

Events that are not subject to any Storage Rule are sent to the Default 
Storage Group.
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To add a Storage Rule

Before you add a storage rule, make sure that the storage group to which you want to 
store the events and the device group that contains the devices whose events you want to 
store exist. (You cannot create additional storage groups after a Logger has been 
initialized. However, you can create additional device groups, as described in “Device 
Groups” on page 157.)

Logger allows you to create up to 40 storage rules. If you create additional rules, an error 
might be generated. 

1 Click the Configuration > Settings tab, click Storage in the sub-menu, and click 
the Storage Rules tab.

2 Click Add and enter the following parameters: The page shown in Figure 5-4 is 
displayed.

3 Click Save to add the new Storage Rule, or Cancel to quit.

Figure 5-4 Storage Rules page

To edit or reorder a Storage Rule

1 Click the Configuration > Settings tab, click Storage in the sub-menu, and click 
the Storage Rules tab.

2 Find the Storage Rule to be edited in the table.

Parameter Description

Storage Group Select a Storage Group from the drop-down list. The Storage 
Groups must already be set up before any Storage Rules are 
added. 

You can only add storage groups at the time of Logger 
initialization.

Device Groups Select one or more Device Groups to associate with the 
specified Storage Group. You may associate several Device 
Groups with a single Storage Group.

Priority An integer that indicates the new rule’s priority. The number 
must be unique for each Storage Rule. The smaller the number, 
the higher the rule’s priority.
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3 Click the Edit icon ( ). Change the information in the form--for example, change the 
priority value to reposition the Storage Rule in the table--and click Save.

To delete a Storage Rule

1 Click the Configuration > Settings tab, click Storage in the sub-menu, and click 
the Storage Rules tab.

2 Find the Storage Rule to be deleted in the table.

3 Click the Delete icon ( ). Confirm the delete.

Storage Volume
Storage Volume settings allows you to specify where Logger will store events. Logger can 
store events locally (on the storage provided with Logger), on a Network File System, or a 
Storage Area Network (SAN). This decision must be made when the Logger is first 
initialized. Although a Network File System (NFS) can be used as primary storage for 
events on a Logger, this configuration is not recommended because the performance is 
sub-optimal. Additionally, SAN is not supported for software Loggers. 

An NFS or a CIFS system can be used for archiving Logger data such as event archives, 
Saved Searches, exported filters and alerts, and configuration backup information on all 
Loggers.

To specify storage volume settings

1 Click Configuration from the top-level menu bar. 

2 Click Storage in the left panel.

3 Click Storage Volume in the right panel. If a storage volume is not established 
already on the Logger, the following page is displayed. 

• A storage volume is automatically established with default values for a 
“Typical” installation of the software version of Logger. For a “Custom” 
installation, you need to establish the storage volume using the procedure 
described in this section.

• Storage volume can be extended after initialization, however its size 
cannot be reduced. For more information, see “Storage Volume Size 
Increase” on page 228.

The options displayed on the following page depend on the type of 
Logger—appliance or software. Additionally, the following page is only 
displayed on the software version of Logger if you chose to Custom 
install it. 

The following screen shot is from a Logger appliance. The table that 
describes the options on this page categorizes the options displayed for 
Logger appliance and the software version of Logger.
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4 Enter the following values:

Parameter Description

Only for the Logger appliance:

Mount Location Choose Local if you want to store events on Logger or the 
mount name of a remote file system. (To set up a remote 
file system mount, see “Storage” on page 365.) 

Note: Use of a Network File System (NFS) as primary 
storage for Logger events is not recommended. However, 
an NFS system can be used for archiving Logger data.

Path For Logger appliance, if mount Location is not Local, 
specify the root folder on the remote file system in which to 
store event data. If mount location is Local, event data is 
stored to the /opt/data/logger directory on the 
appliance. 

Maximum Size Enter the storage volume size, in GB. 

Pre-allocation 
Amount

The percentage of the volume to pre-allocate (0-100). 
ArcSight recommends 100% for both local and remote 
volumes. 

Note: Even though 100% pre-allocation can take a long 
time on remote volumes, doing so improves performance 
on your Logger and protects it from running out of disk 
space. Allocating lesser than 100% space may result in 
sub-optimal performance on the Logger.

Only for the software version of Logger:

Path For the software version of Logger, the path is pre-
configured to the <install_directory>/data/logger 
directory and cannot be changed. 
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5 Click Save.

To increase the size of a storage volume:

See “Storage Volume Size Increase” on page 228.

Event Input/Output
Use the Event Input/Output section to manage the Receivers and Forwarders that listen for 
and capture events and send them to other destinations, including ArcSight ESM.

Receivers
Receivers are created to receive events from files and on the network. Receiver types 
include UDP, TCP, SmartMessage, and two types of file follower, File Transfer and File 
Receiver:

 UDP. UDP receivers listen for User Datagram Protocol messages, such as Syslog 
format datagrams.

 TCP. TCP receivers listen for Transmission Control Protocol messages. Syslog 
messages can also be sent using TCP.

 CEF UDP. UDP receiver that receives events in Common Event Format.

 CEF TCP. TCP receiver that receives events in Common Event Format.

 File Transfer. File Transfer receivers read remote log files using scp, sftp or ftp 
protocol. These receivers can read single- or multi-line log files. 

The SCP and SFTP protocols (for setting up File Transfer Receivers) are not FIPS 
compliant. For a FIPS-compliant configuration, configure the File Transfer receivers to 
use FTP.

 File Receiver. File Receiver-type receivers read log files from a network file system 
(NFS), CIFS, or Storage Area Network (SAN). These receivers can read single- or 
multi-line log files.

 SmartMessage Receiver. SmartMessage receivers listen for encrypted messages 
from ArcSight SmartConnectors.

About Multi-line File Receivers
A multi-line file receiver is a type of file or file transfer receiver that can read multi-line log 
files. This receiver is useful in reading events that span more than one line, such as 
exceptions in a server log. To create this type of receiver, create a file or file transfer 
receiver and specify a regular expression (in the Event Start field) to determine the start of 
a new event in the log file—each new event starts at the point where the regular 
expression is matched to the characters in the log file. 

A multi-line file receiver is useful in finding exceptions in a server log. In such logs, the 
entire stack trace can be treated as one event instead of each line as a single event. 

Maximum Size Enter the storage volume size, in GB. 

For the software version Logger, the maximum size is 
determined by the lower value of the following:

• Limit specified in the Logger license. (See “License 
Information” on page 237 for this information.)

• The storage volume partition size on the system on 
which Logger software is installed.

Parameter Description
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For example, in the following log file, each event starts with a timestamp embedded within 
square brackets ([ ]); therefore, you can use this regular expression to identify each event:

^[\d+\d+\d+ \d+:\d+:\d+,\d+].* 

Creating a receiver is a three-step process:

1 Create a named receiver of a certain type. Receiver type cannot be changed after the 
receiver is created. New receivers are initially disabled. See “To create a receiver” on 
page 173 for more information.

2 Add type-specific parameters. Receiver parameters are documented in Table 5-1, 
“Receiver Parameters,” on page 174. 

3 Enable the new receiver.

Maximum number of receivers that can be created on Logger: The number is 
limited by system resources—memory, CPU, disk input/output and possibly network 
bandwidth. 

Figure 5-5 Receivers page

Wait a few minutes after enabling a receiver before disabling it. Likewise, wait 
before enabling a receiver that has just been disabled. Background tasks 
initiated by enabling or disabling a receiver can produce unexpected results if 
they are interrupted.

TCP Receivers interpret line break characters, such as \r or \n, as the end of 
the event. If the input event contains embedded \r or \n characters, the 
event will be treated as more than one event.
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To create a receiver

1 Click Configuration from the top-level menu bar.

2 Click Event Input/Output (left panel) > Receivers tab (right panel). 

3 Click Add.

4 Enter a name for the new receiver and choose UDP, TCP, File Transfer, File Receiver, 
SmartMessage, CEF UDP, or CEF TCP type.

If you are creating a multi-line receiver, select File Transfer or File Receiver, depending 
on the protocol you want to use for reading the log file.

5 Click Next to edit receiver parameters listed in Table 5-1 on page 174.

If you are creating a multi-line receiver, enter a regular expression in the Event Start 
field to determine the start of a new event in the log file, as shown in the following 
figure.

6 Click Save.

7 New receivers are initially disabled. Click the disabled icon ( ) to enable the new 
receiver.

To edit a receiver

1 Click Configuration from the top-level menu bar.

2 Click Event Input/Output (left panel) > Receivers tab (right panel). 

3 Find the receiver to be edited in the table.

Before creating a Receiver of type File Receiver:

• For the Logger appliance, set up a Network File System mount. See 
“Storage” on page 165. 

• For the software version of Logger, the file system from which the log files 
will be read needs to be mounted on the system on which you have 
installed Logger. 

Create a Receiver of type SmartMessage before configuring the 
SmartConnector that will send to it. Once the Receiver is created, configure 
the SmartConnector as described in “Installing SmartConnectors to Send 
Events to Logger” on page 56 and specify:

• Logger IP or hostname

• Port 443 (port must be 443) for Logger appliance; for software Logger, 
port you configured during its installation

• Receiver name

If the Receiver name changes on the Logger, it must be changed in the 
SmartConnector.
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4 Click the Edit icon ( ). Change the information in the form and click Save.

To delete a receiver

1 Click Configuration from the top-level menu bar.

2 Click Event Input/Output (left panel) > Receivers tab (right panel). 

3 Find the receiver to be deleted in the table.

4 Click the Delete icon ( ). Confirm the delete.

Table 5-1 Receiver Parameters

Parameter Receiver Types Description

Name All The name of the Receiver, used for reporting and status 
monitoring. SmartMessage receiver names are used to 
configure the ArcSight SmartConnector.

Type The Type of a Receiver cannot be changed after the 
receiver is created.

UDP

TCP

CEF UDP

CEF TCP

File Transfer (scp/sftp/ftp)

File Receiver (Remote File System)

SmartMessage

Protocol File Transfer Select SCP, SFTP or FTP protocol.

IP/Host All except File 
Receiver and 
SmartMessage

Select one of the Logger’s network connections for the 
Receiver to listen to, or select All to listen on both 
network connections.

Note: If localhost (127.0.0.1) appears in the list, it 
means that the Logger hostname has not been 
configured. To configure hostname, see “Network” on 
page 347.

Character Encoding All except File 
Transfer

Select a character encoding, such as US-ASCII, Big5, or 
EUC-KR, from the pulldown list. CEF UDP, CEF TCP, and 
SmartMessage receivers must use US-ASCII or UTF-8 
encoding.

Port UDP, TCP,
File Transfer

For the Logger appliance:

The default port is 514. (For SmartMessage receivers, 
configure the SmartConnector for port 443.)

For the software version of Logger:

If you installed software Logger as a root user, you can 
use any available port.

If you installed software Logger as a non-root user, you 
can only use a port greater than 1024. Ports lesser than 
1024 cannot be configured. Default 8514.

User File Transfer A user on the host with privileges to view and read the 
source log files. If the protocol is FTP, you can specify 
the special user, “anonymous.”
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Password File Transfer The password of the specified User. The password must 
not be empty, even in the case of anonymous FTP 
(although in this case, the password will be ignored.)

FilePath File Transfer The path and the name of the log file(s) to be read. You 
can use wild cards like ? and * (for example, “*.log” or 
“Log-??.txt”) in the path name and the file name. 
Separate directories with forward slashes (‘/’).

Separate multiple file specifications with commas.

Example: /tmp/SyslogData/syslog.log.gz, 
/security/logs/*/, /security/ 
log?/admin/special/

Schedule File Transfer If no schedule is specified, the File Transfer will occur 
just once.

Choose Everyday or Days of Week from the first 
pulldown menu. 

If Everyday, select Hour of Day or Every from the 
second pulldown menu. Enter the hours (1-23) in the 
text box.

If Days of Week, enter the days (day 1 is Sunday) in the 
text box. Then choose Hour of Day or Every from the 
second pulldown menu. Enter the hours (1-23) in the 
second text box.

For example, to read log files every day at 2 a.m., select 
Everyday in the first pulldown menu, then choose Hour 
of Day from the second pulldown menu and enter 2 in 
the text box. To read the log files every day at 2 a.m. 
and 3 p.m., enter 2,15 in the text box.

For another example, to read log files Tuesdays and 
Thursdays at 10 p.m., select Days of Week from the first 
pulldown menu and enter 3,5 for days. Then choose 
Hour of Day from the second pulldown menu and enter 
22 in the text box.

Make sure you are familiar with the information in 
“Impact of Daylight Savings Time Change on Logger 
Operations” on page 351 before you schedule a file 
transfer.

Zip Format File Transfer Choose gzip, zip, or none.

RFS Names File Receiver For the Logger appliance:

Select from the pulldown list of NFS or CIFS mount 
names. The list also includes attached SANs on Logger 
models that support SAN. 

To mount NFS volumes, see “Storage” on page 365. To 
mount CIFS shares, see “Remote File Systems” on 
page 365. 

For more information about SAN, see “SAN” on 
page 368.

For the software version of Logger:

You can only choose “Local” and then specify the 
directory on your Logger where the remote file system 
is mounted in the “Folder” field. 

To mount a remote file system on the system on which 
you have installed Logger, see its operating system’s 
documentation.

Parameter Receiver Types Description
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Source Type File Receiver, File 
Transfer

Select from the pulldown list of log file types, including:

Apache HTTP Server Access

Apache HTTP Server Error

Juniper Steel-Belted Radius

Microsoft DHCP Log

IBM DB2 Audit

Wildcard File Receiver Regular expression describing the log files to read. 
Note: This is a regular expression, not a typical file 
wildcard like “*.*”

Example: .*\.process (all files ending with .process). 
The wildcard for Symantec Anti-Virus log files would be 
\d{8}.log.

The default is .*, meaning all files.

Mode File Receiver Mode is one of: 

Delete - delete the log file once it has been processed

Rename - rename the log file once it has been 
processed. The file is named by appending the Rename 
Extension.

Persist - Logger remembers which files have been 
processed and only processes them once.

Rename Extension File Receiver 
(Mode=Rename)

The suffix to append to log files that have been 
processed.

Character Encoding File Receiver Select the type of character encoding from the drop-
down list.

Delay after seen File Receiver or 
File Transfer

Number of seconds to wait after a source file is first 
seen until it is processed. This allows the entire file to be 
copied to Logger or (in the case of File Receiver) copied 
to the remote file system, before processing begins.

The default is 10 seconds.

Note: For File Transfer Receivers, this parameter should 
be set to a larger value if large files are expected. The 
default, 10 seconds, does not allow enough time for a 
large file, such as 1 GB.

Date/time locale File Receiver or 
File Transfer

Select a locale from the pulldown list, such as English 
(United States), Chinese (Hong Kong), Chinese 
(Taiwan), and so on.

Date/time zone File Receiver or 
File Transfer

Required if the timestamp in the log file does not specify 
a time zone. This parameter is ignored if either 
Date/time format or Date/time location regex are blank.

The default is the time zone configured on the Logger 
(System Admin > Settings > Platform > Time/NTP) . 

Parameter Receiver Types Description
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Date and Time Specification
To specify the date and time format so that it can be parsed from a file (File Receiver or File 
Transfer receivers), refer to Table 5-3 on page 178.

Internally, Logger uses a common Java method called SimpleDateFormat that you may be 
familiar with. Sophisticated uses of SimpleDateFormat, as described in Java sources, will 
work with Logger. Pattern letters are usually repeated, as their number determines the 
exact presentation:

The examples in Table 5-2 on page 177 show how date and time patterns are interpreted 
in the U.S. locale. The given date and time are 2001-07-04 12:08:56 local time in the U.S. 
Pacific Time time zone.

Table 5-2 Date/time examples

Date/time location 
regular expression

File Receiver or 
File Transfer

A regular expression describing which characters 
represent the timestamp in the log file. For example:

.*\[(.*?)\].*

This regular expression specifies that the timestamp is 
found inside the first set of square brackets on each 
line. The first capturing group (the part of the regex in 
parentheses) is that part that is then parsed using the 
Date/time format.

The default is ‘’ (no timestamp in log file).

Date/time format File Receiver or 
File Transfer

Required if the log file contains timestamps in the same 
format for each event. If not specified (or if the 
Date/time location regex is blank), each event in the file 
will be stamped with the date that the file itself was first 
seen by Logger (not its file system timestamp).

See Step Table 5-3 for a list of format specifiers.

The default is ‘’ (no timestamp in log file).

Event Start (regex) File Receiver or 
File Transfer

A regular expression that specifies the start of a new 
event in a log file. Specify this expression to enable the 
receiver to read multi-line log files. Each new event 
starts at the point where the regular expression is 
matched to the characters in the log file. For example,

^\[\d+-\d+-\d+ \d+:\d+,\d+].*

This regular expression matches timestamps such as:

[2010-12-06 13:09:46,818]

When this field is left blank (‘’), each line in the log file is 
treated as a single event. 

The default is ‘’ (each line in the log file is a single 
event).

Source Date and Time Pattern

2001.07.04 AD at 12:08:56 PDT yyyy.MM.dd G 'at' HH:mm:ss z

Wed, Jul 4, '01 EEE, MMM d, ''yy

12:08 PM h:mm a

12 o'clock PM, Pacific Daylight Time hh 'o''clock' a, zzzz

Parameter Receiver Types Description
Confidential Administrator’s Guide 177



5 Configuration
Table 5-3 Date/time format specification

Forwarders
Forwarders send all events, or events which match a particular filter, on to a particular 
host. The ability to define a different filter for each Forwarder allows Logger to divide traffic 
among several destinations. For example, because Logger can handle much higher event 
rates than ArcSight ESM, Logger might be used to forward events to a number of ESM 
Managers. Forwarder filters make it possible to split the flow between the Managers, using 
one Forwarder for each Manager. Additionally, forwarding enables you to send a subset of 
events to other destinations for further processing while maintaining all events on Logger 
for long-term storage. 

0:08 PM, PDT K:mm a, z

02001.July.04 AD 12:08 PM yyyyy.MMMMM.dd GGG hh:mm aaa

Wed, 4 Jul 2001 12:08:56 -0700 EEE, d MMM yyyy HH:mm:ss Z

010704120856-0700 yyMMddHHmmssZ

2001-07-04T12:08:56.235-0700 yyyy-MM-dd'T'HH:mm:ss.SSSZ

Symbol Meaning Presentation Examples

G Era designator (Text) AD

y Year (Number) 2006 or 06

M Month in year (1-12) (Number) July or Jul or 07

w Week in year (1-52) (Number) 39

W Week in month (1-5) (Number) 2

D Day in year (1-366) (Number) 129

d Day in month (1-31) (Number) 10

E Day in week (Text) Tuesday or Tue

a Am/pm marker (Text) AM or PM

H Hour in day (0-23) (Number) 0

k Hour in day (1-24) (Number) 24

K Hour in am/pm (0-11) (Number) 0

h Hour in am/pm (1-12) (Number) 12

m Minute in hour (0-59) (Number) 30

s Second in minute (0-59) (Number) 55

S Millisecond (0-999) (Number) 978

z Time zone (Text) Pacific Standard Time, or PST, or 
GMT-08:00

Z Time zone (RFC 822) -0800 (indicating PST)

Source Date and Time Pattern
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The forwarding filter is a query that searches for matching events, optionally within a time 
range. You can create two types of forwarder filters—continous and time-range bound. 

A continuous filter constantly evaluates the incoming events and forwards the matching 
ones to the specified destination. 

A time-range bound filter uses a time range in addition to the specified condition to 
determine whether an event should be forwarded to the destination. If the event falls 
within the specified time range and matches the specified condition, it is forwarded; 
otherwise, it is not. The Logger receipt time of an event is used to determine whether an 
event will be forwarded to a destination when a fowarder filter specifies a time range by 
which events are evaluated for forwarding. Once a forwarder has forwarded all events 
within a time range, it does not forward any more events. 

The $now value, if specified in a time range, is not treated as a variable. Instead, the time 
when the forwarder was created or updated is assigned to $now. For example, if the time 
when forwarder was created was 1:45 p.m. and the time range specified in the forwarder is 
10 a.m. to $now, all events between 10 a.m. and 1:45 p.m. will be forwarded. After events 
within that time range have been forwarded, no additional events will be forwarded. 

A Forwarder only forwards events from the Logger that it is configured on; it cannot 
forward events from peer Loggers.

A Forwarder’s operation can be paused and resumed at any point in time. When a 
Forwarder resumes operation, forwarding resumes from the last checkpoint that was 
established before the forwarding operation was paused. 

You can also disable and re-enable a Forwarder. When you re-enable a Forwarder, all 
previously established checkpoints are removed and forwarding starts over again as per 
the Forwarder configuration-Forwarders with continuous filters start from the current time, 
while Forwarders with time-range bound filters start from beginning of the configured time 
range. 

Forwarder types include UDP, TCP, Connector Forwarder, and ArcSight ESM Forwarder:

 UDP. UDP Forwarders forward events as User Datagram Protocol messages, such as 
Syslog format datagrams.

 TCP. TCP Forwarders forward events as Transmission Control Protocol messages.

 Connector Forwarder. The Connector Forwarder sends events to the ArcSight 
Logger Streaming Connector.

 ArcSight ESM. The ArcSight ESM Forwarder sends Common Event Format (CEF) 
events to an ESM Destination. The built-in connector on Logger is used to forward 
these events to ESM. 

As a best practice, do not add more than 10 Forwarders on a Logger. Even though each 
additional Forwarder improves the forwarding rate, the relation is not proportional. In high 
EPS situations or situations where other resource-intensive features are running in parallel 
(alerts, reports, and several search operations) and the forwarding filter is complex, adding 
too many Forwarders may reduce performance because Forwarders have to compete for 
the same Logger resources besides competing for the same built-in connector for 
forwarding.

Prior to Logger v5.2, you could only specify a regular expression query for the filter. 
However, starting with v5.2, you can also specify indexed search queries (known as Unified 
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Queries). Doing so enables you to take advantage of the indexing technology to quickly 
and efficiently search for events to forward. 

To create a Forwarder

1 Click Configuration from the top-level menu bar.

2 Click Event Input/Output in the left panel.

3 In the Forwarders tab, click Add to display the following form.

4 Enter a name for the new forwarder and choose the forwarder type appropriate for 
your need: UDP Forwarder, TCP Forwarder, Connector Forwarder, or ArcSight ESM 
(CEF) Forwarder type. 

5 Select the type of forwarding filter you will specify for this forwarder—Unified or 
Regular Expression. Select “Unified” if you want to specify an indexed search query or 
“Regular Expression” to specify a regular expression query.

6 Click Next.

7 Enter additional, type-specific information as described in Table 5-4, “Forwarder 
Parameters,” on page 180. Click Save.

8 New forwarders are initially disabled. Click the disabled icon ( ) to enable the new 
forwarder.

Table 5-4 Forwarder Parameters

Unified query-based Forwarders forward events once they have been 
indexed. Therefore, these forwarders can exhibit "bursty" behavior because 
indexing occurs in batches on Logger. You might notice the bursty behavior in 
the EPS out gauge (on top of the Logger interface screen)—the gauge will 
display high EPS level as a burst of data is forwarded and then drop back to 
normal level. 

Parameter Forwarder Types Description

Name All The name that you entered in the previous screen is 
displayed automatically. If you want to change the name, 
make the change on this screen. 
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Query All Enter the query that will be used to filter events that the 
forwarder will forward. Or select a filter from the Filter list 
below. 

Forwarder queries can be constrained by Device Groups 
and Storage Groups, but not by Peers. 

If you selected Unified Query in the previous screen, 
enter an indexed search query—that includes full-text and 
field-based indexed fields. You can click the Advanced 
Search link to access the Search Builder tool to build an 
indexed query. (See “Accessing Search Builder” on 
page 121 for more information.) 

The unified query you specify must follow these guidelines, 
or you will not be able to save the query and thus the 
forwarder:

• Queries in the following format are valid; all other 
formats are not allowed.

(full-text terms | field search)* | regex 

That is, the query must only contain full-text (keyword) 
and field-based query elements; it cannot contain any 
aggregation search operators, or operators that process 
the searched data further to refine the search. For 
example, chart, sort, eval, top, and so on. 

Therefore, this is a valid query: 
failed message CONTAINS “failed device” 

However, this is an invalid query: 
failed message CONTAINS “failed device” | sort 
deviceEventCategory

The query can contain the regex operator after a 
pipeline character (|). Therefore, this is a valid query for 
a forwarder: 
failed message CONTAINS “failed device” | regex 
deviceEventCategory =”fan”

• All search terms (except the “regex” portion) in a query 
must be indexed. If a query contains full-text (keyword) 
terms, full-text indexing must be enabled. Similarly, if 
the query contains a field, field-based indexing must be 
enabled and the specified field must be indexed.

If you selected Regular Expression in the previous 
screen, specify a regular expression in this text box. See 
“Searching for Events on Logger” on page 128. 

Filters All Instead of specifying a unified query, you can select a filter 
from the Filters list. The Filters list contains all saved filters 
and the predefined system filters on your Logger. Select a 
filter that meets the validity guidelines described in “Query” 
on page 181. Otherwise, the user interface will display an 
error when you save the Forwarder definition. You can only 
select one unified query filter per forwarder.

Similarly, when creating a regular expression based filter, 
select a filter from this list. You can select multiple filters 
for a regular expression based forwarder. 

Parameter Forwarder Types Description
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Filter by time 
range

All If you are creating a continuous filter, which continuosly 
evaluates incoming events and forwards the matching 
ones, skip this parameter. In this case, the query is run 
continuously and forwarding continues until you explicitly 
pause it.

If you are creating a time range bound filter, check this box 
to specify a time range of events that the forwarder will 
forward. If you enter a time range, the forwarder sends 
events that are within that time range and stops. 

When you check this box, the Start and End dates and Time 
fields are displayed.

Start must be earlier than End. Specifying a time in the 
future changes that field to the current time. For example, 
specifying a Start of the current day at 7 a.m. and an End 
of current day at 7 p.m. will produce events with 
timestamps from 7 a.m. to the time the filter is saved (that 
is, earlier than 7 p.m.).

The $now value, if specified in a time range, is not treated 
as a variable. Instead, the time when the forwarder was 
created or updated is assigned to $now. For example, if the 
time when forwarder was created was 1:45 p.m. and the 
time range specified in the forwarder is 10 a.m. to $now, all 
events between 10 a.m. and 1:45 p.m. will be forwarded. 
After events within that time range have been forwarded, 
no additional events will be forwarded.

Source Type Connector Select from the pulldown list of log file types, including:

Apache HTTP Server Access

Apache HTTP Server Error

Juniper Steel-Belted Radius

Microsoft DHCP Log

IBM DB2 Audit

Note: Source Type must be the same in Receiver, 
Forwarder, and SmartConnector. See “Forwarding Log File 
Events to ESM” on page 188.

Preserve 
Syslog 
Timestamp

UDP, TCP Set to true to preserve the syslog timestamp. The default is 
true--the timestamp is the original receipt time of the 
event. 

If set to false, original timestamp is replaced with Logger’s 
receipt time.

Preserve 
Original Syslog 
Sender

UDP, TCP Set to true to send the event as-is, without inserting 
Logger’s IP address in the hostname (or equivalent) field of 
the syslog event. The default is true. 

If set to false, Logger’s information is inserted in the 
hostname (or equivalent) field of the syslog event.

IP/Host UDP, TCP, 
Connector

The IP address or host name of the destination that will 
receive forwarded events.

Note: You cannot configure a Logger Forwarder to send 
data to the same Logger on which it is configured.

Port UDP, TCP, 
Connector

The port on the destination to which the forwarder will 
forward events.

The default port is 514.

Parameter Forwarder Types Description
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To edit a Forwarder

1 Click Configuration from the top-level menu bar.

2 Click Event Input/Output in the left panel.

3 In the Forwarders tab, locate the forwarder you want to edit and click the Edit icon 

( ). The following screen shows the Edit Forwarder screen for a regular expression 
based Forwarder. The Edit Forwarder screen for a Unified Query Forwarder lists the 
Unified Query based filters and the Query text box only allows you to specify one 
query.

Figure 5-6 Specifying Query Terms, Filters, and other Forwarder parameters.

4 Edit the information in the form, as described in Table 5-4 on page 180, and click 
Save.

5 If the forwarder is enabled, click to disable it. Then, click the disabled icon ( ) to re-
enable the forwarder and commit the changes.

To delete a Forwarder

1 Click Configuration from the top-level menu bar.

2 Click Event Input/Output in the left panel.

3 Locate the forwarder to be deleted in the table.

4 Click the Delete icon ( ). Confirm the delete.

Connection 
Retry Timeout

TCP, Connector, 
ESM

The time, in seconds, to wait before retrying a connection. 
The default is 5 seconds.

ESM 
Destination

ESM The ESM Destination for the target Manager. (See “ESM 
Destinations” on page 184.)

Parameter Forwarder Types Description
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To pause a Forwarder

1 Click Configuration from the top-level menu bar.

2 Click Event Input/Output in the left panel.

3 Locate the forwarder to be paused from the list of forwarders.

4 Click the Pause icon ( ). 

To resume a Forwarder

1 Click Configuration from the top-level menu bar.

2 Click Event Input/Output in the left panel.

3 Locate the forwarder whose operation you want to resume. 

4 Click the Resume icon ( ).

To disable a Forwarder

1 Click Configuration from the top-level menu bar.

2 Click Event Input/Output in the left panel.

3 Locate the Forwarder that you want to disable. 

4 Click the ( ) icon.

To enable or re-enable a Forwarder

1 Click Configuration from the top-level menu bar.

2 Click Event Input/Output in the left panel.

3 Locate the Forwarder that you want to enable or re-enable. 

4 Click the ( ) icon.

ESM Destinations
ESM Destinations establish a connection to an ArcSight ESM Manager so that you can 
forward events (and alerts) from the Logger to the Manager using Logger’s built-in 
SmartConnector. The SmartConnector sends CEF events (see “Common Event Format” on 
page 509) that are not normalized or categorized.

Wait a few minutes to disable a Forwarder that was just enabled. Likewise, 
wait before enabling a forwarder that has just been disabled. Background 
tasks initiated by enabling or disabling a forwarder can produce unexpected 
results if they are interrupted.
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Maximum number of ESM destinations that can be configured: As many allowable 
on the SmartConnectors you are using.

To setup Logger to forward events to an ArcSight ESM Manager

1 Copy the server SSL certificate file from an ESM Console or other component that is 
already communicating with the target Manager, and upload the certificate file to 
Logger, as described “Uploading a Certificate to the Logger” on page 187. 

If your Logger operates in FIPS mode, a valid and current (non-expired) server 
SSL certificate file from the ESM Manager is required on the Logger; otherwise, the 
forwarder will not forward events to it.

Note: Starting with Logger v4.0, you cannot import the cacerts file, which is a 
repository of trusted certificates, to the Logger. Instead, you need to import specific 
SSL certificate files. 

2 Create an ESM Destination, as described in “To create an ESM Destination” on 
page 185.

3 Create an ESM Forwarder that refers to this ESM Destination. (See “Forwarders” on 
page 178).

Figure 5-7 ESM Destinations page

To create an ESM Destination

Note: Make sure you have loaded the certificate file for ESM Manager as described in 
“Uploading a Certificate to the Logger” on page 187 before adding it as a destination on 

Do not use basic aggregation for Logger’s built-in SmartConnector because it 
is resource intensive. (Basic aggregation is set using the Enable Aggregation 
(in seconds) field from the ESM Console.) Instead, follow these steps on the 
ESM Console to configure field-based aggregation: 

1 Ensure that Processor > Enable Aggregation (in seconds) is set to 
“Disabled” (to disable basic aggregation).

2 Right-click the connector and select inspect/edit/.

For additional details about configuring field-based aggregation, refer to the 
ArcSight SmartConnector User’s Guide.
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the Logger. If the certificate file does not exist on the Logger, you will not be able to create 
an ESM destination. 

1 Click Configuration from the top-level menu bar.

2 Click Event Input/Output in the left panel.

Click Alerts in the left panel if you are creating an ESM destination for forwarding 
Alerts.

3 In the ESM Destinations tab, click Add. The page shown in Figure 5-7 is displayed.

4 Enter the following parameters:

5 Click Save.

To delete an ESM Destination

1 Click Configuration from the top-level menu bar.

2 Click Event Input/Output in the left panel.

The ESM Destinations tab located under Event Input/Output and Alerts in 
the left panel is the same and contains all ESM destinations configured 
on a Logger. The tab is accessible from two UI locations to ease 
configuration.

Parameter Description

Name The name for this ESM Destination.

Connector Name The SmartConnector name.

Connector Location The physical location of the SmartConnector machine. If 
you do not want to specify a location, enter “None.”

Logger Location The physical location of the Logger. If you do not want to 
specify a location, enter “None.”

IP or Host The ESM Manager to which the Forwarder will direct events.

Note: Make sure the name or IP address you specify in this 
field is exactly the name or IP address configured on the 
ESM Manager. If the two names or IP addresses do not 
match, you will not be able to set up an ESM destination 
successfully.

Port Typically 8443.

User Name The name of an existing User of the ESM Manager with 
administrator privileges.

Password The password for the Login user.

If you receive the following error when adding a new ESM destination, make 
sure the host name you specified in the IP or Host field exactly matches the 
name configured on the ESM Manager. 

There was a problem:  Failed to add destination

Additionally, if the ESM Manager is configured using a host name instead of IP 
address, make sure you add the ESM Manager host name and IP address in 
the Logger’s hosts file (System Admin > Network > Hosts).
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Click Alerts in the left panel if you are deleting an ESM destination for forwarding 
Alerts.

3 In the ESM Destinations tab, locate the ESM Destination to be deleted and click the 

delete icon ( ) on that row. 

4 Confirm the deletion by clicking OK, or click Cancel to retain the ESM Destination.

Uploading a Certificate to the Logger

You need to upload a valid server SSL certificate file for the ESM Manager that you are 
establishing as a Logger destination for forwarding events and alerts. 

If your Manager does not have FIPS 140-2 mode enabled, you can obtain a 
certificate file for your Manager in these ways: 

 From the Manager’s keystore

 From the ESM Console’s truststore

 From the truststore of one of the SmartConnectors that communicates with the 
Manager 

Use the keytoolgui utility to export a Manager’s certificate as described in the “Using 
Keytoolgui to Export Certificate” procedure in the ArcSight ESM Administrator’s Guide. For 
detailed information about keystore, truststore, their locations on the Manager, ESM 
Console, and the SmartConnectors, see the ArcSight ESM Administrator’s Guide.

Once you have exported a certificate for your Manager, copy it to the machine from which 
you connect to your Logger. 

If your Manager has FIPS 140-2 mode enabled, run this command to export the 
Manager’s certificate from the Manager’s <ARCSIGHT_HOME>/bin directory:

arcsight runcertutil -L -n managerkey -r -d 
<ARCSIGHT_HOME>/config/jetty/nssdb -o 
<absolute_path_to_manager.cert>

This command generates the manager.cert file, the Manager’s certificate, in the 
location that you specified in the above command.

To upload a certificate file for an ESM Destination

1 Make sure you have copied the Manager certificate to the machine from which you 
connect to your Logger.

2 Click Configuration from the top-level menu bar.

3 Click Event Input/Output in the left panel.

The ESM Destinations tab located under Event Input/Output and Alerts in 
the left panel is the same and contains all ESM destinations configured 
on a Logger. The tab is accessible from two UI locations to ease 
configuration.

By default, the manager.cert file will be exported to your <ARCSIGHT_HOME> 
directory if you do not specify the absolute path to manager.cert file 
destination.
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Click Alerts in the left panel if you are creating an ESM destination for forwarding 
Alerts.

4 In the Certificates tab, click Add to display the following screen.

5 Enter an alias for the certificate file. This name is used to easily identify a certificate 
file. For example, arcsight_esm_manager1_cert.

6 Click Browse to locate the Manager certificate file you copied. 

7 Check the “Overwrite Certificate” box if you want this certificate to overwrite an 
existing certificate with the same alias. 

8 Click Save.

Forwarding Log File Events to ESM
Logger can read events from a log file and forward those events to an ArcSight Logger 
Streaming SmartConnector that sends the events on to ArcSight ESM. Unlike other events 
that Logger receives, such as syslog, SmartMessage, or CEF, log file events must be parsed 
to determine event timestamp. 

To forward log file events to ESM, configure the Receiver, Forwarder, and SmartConnector 
to accept the same Source Type (as described in “Receiver Parameters” on page 174).

Figure 5-8 Configure the Receiver, Forwarder, and SmartConnector with the same Source 
Type to use Logger to forward log file events to ArcSight ESM.

Alerts
Alerts respond to events or specified event patterns with optional notification. Event 
patterns are specified events that occur above a particular frequency (a threshold number 
of events in a specified time period). 
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Alerts can be generated for internal events such as storage capacity warnings or, on some 
Logger appliance models, CPU temperature warnings, or for user-determined event 
patterns such as an alert is generated when five events from a specific device contain the 
word “unauthorized” within a five minute interval. 

An alert is triggered if a specified number of matches occur within the specified threshold 
(time interval in seconds). When an alert triggers, an alert event is logged on the Logger 
and a notification is sent through previously configured destinations—e-mail addresses, 
SNMP server, Syslog server, and ESM Manager.

Logger provides two types of alerts:

 Real time alerts

 Saved Search Alerts

The following table compares the two types of alerts. 

Real Time Alerts Saved Search Alerts

No limit on the number of alerts that are 
defined.

A maximum of five alerts can be enabled 
at any time.

Any number of alerts can be defined. All 
defined alerts are enabled and effective, 
however, a maximum of 50 alerts can run 
concurrently. 

No limit on the number of configured e-
mail destinations; however, you can only 
set one SNMP, one Syslog, and one ESM 
destination.

No limit on the number of configured e-
mail destinations; however, you can only 
set one SNMP, one Syslog, and one ESM 
destination.

Only regular expression queries can be 
specified for these alerts.

Queries for these alerts are defined using 
the flow-based search language that 
allows you to specify multiple search 
commands in a pipeline format, including 
regular expressions. Aggregation 
operators such as chart and top cannot 
be included in the search query.

Alerts are triggered in real time. That is, 
when specified number of matches occur 
within the specified threshold, an alert is 
immediately triggered. 

These alerts are triggered at scheduled 
intervals. That is, when a specified 
number of matches occur within the 
specified threshold, an alert is triggered 
at the next scheduled time interval.
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When an alert is triggered, Logger creates an alert event containing the trigger event. This 
alert event is also sent to the specified destinations if any are configured. Audit events for 
alerts are only written to the Internal Storage group and not forwarded to ESM by default. 
If you need to forward the audit events generated for alerts to ESM, please contact 
ArcSight Customer Support for assistance. 

By default, only alerts to e-mail destinations include all matched events that triggered the 
alert. You can configure your Logger to include matched events for SNMP, Syslog, and ESM 
destinations as well. However, such a configuration is only possible through the command-
line interface of the Logger; therefore, please contact ArcSight Customer Support for 
instructions. 

An e-mail message for an alert contains:

 The trigger alert information

 The matched events

The following is an example of the trigger alert information:

Alert event match count [1], threshold [10] sec 

To define a real time alert, you specify a 
query, match count, threshold, and one 
or more destinations.

A time range is not associated with the 
queries defined for these alerts. 
Therefore, whenever the specified 
number of matches occur within the 
specified threshold, an alert is triggered. 

To define a Saved Search Alert, you 
specify a Saved Search (which is a query 
with a time range), match count, 
threshold, and one or more destinations.

A time range (within which events should 
be searched) is specified for the query 
associated with these alerts. Therefore, 
specified number of matches within the 
specified threshold (in minutes) must 
occur within the specified time range. You 
can also use dynamic time range (for 
example, $Now-1d, $Now, and so on).

For example, if a Saved Search query has 
these start and end times:

Start Time: 5/11/2010 10:38:04

End Time: 5/12/2010 10:38:04

And, the number of matches and 
threshold are the following:

Match Count: 5

Threshold: 3600

Then, 5 events should occur in one hour 
anytime between May 11th, 2010 
10:38:04 a.m. and May 12th, 2010 
10:38:04 for this alert to be triggered. 

To maintain an optimal size of an alert event, the event does not contain 
event IDs of all the triggering events if a match count of 101 or higher is 
specified. As a result, the baseEventCount field  in the event does not 
reflect the true number of matching events for such alert events. Triggering 
events are truncated in multiples of 100. Therefore, if you specify a match 
count of 101, only one event is included in the alert event and the 
baseEventCount field value is 1. Similarly, if you specify a match count of 
720, only 20 events are included and the baseEventCount field value is 20.

Real Time Alerts Saved Search Alerts
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And the matched event: 

Event Time [Tue Nov 11 16:46:49 PST 2008]

Event Receipt Time [Tue Nov 11 16:46:50 PST 2008]

Event Device Address [192.168.35.50]

Event Content [Dec 11 10:31:20 localhost 
CEF:0|NetScreen|Firewall/VPN||traffic:1|Permit|Low| eventId=590 
msg=start_time\="2004-07-28 15:25:02" duration\=15 policy_id\=0 
service\=SSH proto\=6 src zone\=Trust dst zone\=Untrust 
action\=Permit sent\=656 rcvd\=680 src\=10.0.111.46 
dst\=10.0.113.50 src_port\=54759 dst_port\=22 translated 
ip\=192.91.254.2 port\=54759 app=SSH proto=TCP in=680 out=656 
categorySignificance=/Normal categoryBehavior=/Access 
categoryDeviceGroup=/Firewall categoryOutcome=/Success 
categoryObject=/Host/Application/Service art=1165861874880 
cat=Traffic Log deviceSeverity=notification act=Permit 
rt=1165861874880 shost=n111-h046.qa.arcsight.com src=10.0.111.46 
sourceZoneURI=/All Zones/System Zones/Private Address 
Space/RFC1918: 10.0.0.0-10.255.255.255 
sourceTranslatedAddress=192.91.254.2 sourceTranslatedZoneURI=/All 
Zones/System Zones/Public Address Space/192.0.3.0-192.167.255.255 
spt=54759 sourceTranslatedPort=54759 dst=10.0.113.50 
destinationZoneURI=/All Zones/System Zones/Private Address 
Space/RFC1918: 10.0.0.0-10.255.255.255 dp]

If you configure your Logger to include matched events for alerts sent to SNMP and Syslog 
destinations, make sure you are familiar with this information:

 Unlike an e-mail alert, a trigger alert is sent separately from the alert that contains the 
matched (base) events that triggered the alert. The trigger event includes the event 
IDs of all the matched events, as shown in the following example:

 Non-CEF events do not contain event IDs. If you need to associate such base events 
with their trigger alert, send such events to Logger through a connector.

 Logger supports SNMP v2.0. 

 All SNMP alerts are sent as SNMP traps; therefore, trigger alerts and their associated 
matched (base) events are received as SNMP traps on an SNMP destination.

 SNMP uses UDP to send packets. As a result, the order in which alerts arrive at an 
SNMP destination is not guaranteed. Use the event IDs in the trigger alert to identify 
its associated base events.

Similarly, when Syslog events are sent using UDP, the order in which the trigger alert 
and matched events arrive is not guaranteed.
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Configuring and Managing Real Time Alerts
This section describes ways to configure and manage real time alerts.

Creating a Real Time Alert
To create an Alert, you will need to specify a query or filter, event aggregation values 
(Match Count and Threshold, described below), and (optional) one or more notification 
destinations. If the new Alert will send notification using an SNMP, Syslog, or ESM 
destination, set up those destinations before creating the Alert. To configure the e-mail 
destination, see “Static Routes” on page 349. See also “SNMP Destinations” on page 200, 
“Syslog Destinations” on page 201, and “ESM Destinations” on page 184.

When you create an alert, it is in disabled state. You can enable it using instructions in “To 
Enable or Disable a Real Time Alert” on page 193.

1 Click Configuration from the top-level menu bar. 

2 Click Alerts in the left panel.

3 Click Add. The page shown in Figure 5-9 on page 193 is displayed.

4 Enter a name for the new Alert, specify a query or select an available Filter from the 
list. Events that match this query are candidates for the Alert. Alphanumeric characters 
and spaces are acceptable, however, some special characters such as % and & are 
not. 

You can only specify regular expression queries for real time Alerts. However, 
a query expression for a scheduled saved alert can contain multiple search commands 
in a pipeline format, including regular expressions. Aggregation operators such as 
chart and top cannot be included in the search query. For more information about 
specifying a regular expression query, see “The Need to Search Events” on page 83.

5 Enter Match Count and Threshold values. If the number of candidate events equals or 
exceeds the Match Count within the Threshold number of seconds, the Alert will be 
triggered. 

If you want to be notified when any event matches the filter (for example, for an 
internal event such as High CPU Temperature), enter a Match Count of 1 and a 
Threshold of 1.

To test the validity of an alert query, use the Search user interface. Enter 
the query in the Search text box in the following format:

Real time Alert: |regex ”regex expression”

Scheduled saved alert: _deviceGroup IN ["192.168.22.120 [TCPC]"] 
name="*[4924TestAlert]*" AND ("192.168.*" OR categoryBehavior 
CONTAINS Stop)

If the query is valid, cut and paste the regular expression between the 
double quotes (“ ”)in the Query text box on the Add Alert page.

To maintain an optimal size of an alert event, the event does not contain 
event IDs of all the triggering events if a match count of 101 or higher 
is specified. As a result, the baseEventCount field  in the event does 
not reflect the true number of matching events for such alert events. 
Triggering events are truncated in multiples of 100. Therefore, if you 
specify a match count of 101, only one event is included in the alert 
event and the baseEventCount field value is 1. Similarly, if you specify a 
match count of 720, only 20 events are included and the baseEventCount 
field value is 20.
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6 Enter notification destinations. Enter any combination of:

 One or more e-mail addresses, separated by commas

 An SNMP Destination

 A Syslog Destination

 An ESM Manager

7 Click Save.

Figure 5-9 Add Alert dialog

To Enable or Disable a Real Time Alert

1 Click Configuration from the top-level menu bar.

2 Click Alerts in the left panel. 

3 Locate the Alert to be disabled or enabled. Click the associated icon (  or ) to 
enable or disable the Alert.

To Edit a Real Time Alert

1 Click Configuration from the top-level menu bar.

2 Click Alerts in the left panel. 

3 Locate the Alert that you want to edit.

A maximum of five alerts can be enabled at one time. To enable an additional

alert, you will need to disable a currently enabled alert.
Confidential Administrator’s Guide 193



5 Configuration
4 Click the Edit icon ( ). A screen similar to that shown in Figure 5-9 on page 193 
appears. Remember that only alphanumeric characters can be used in an Alert name.

To Remove a Real Time Alert

1 Click Configuration from the top-level menu bar.

2 Click Alerts in the left panel. 

3 Locate the Alert to be removed and click the remove icon ( ) on that row. 

4 Confirm the deletion by clicking OK, or click Cancel to retain the Alert.

To view Real Time Alerts

1 Click Configuration from the top-level menu bar.

2 Click Alerts in the left panel. The Alerts list is displayed, as shown in Figure 5-10.

Figure 5-10 Alert list

Creating and Managing Saved Search Alerts
Saved Search Alerts are based on the search queries that you have saved on Logger. For 
detailed information about Saved Search queries, see “Saved Searches” on page 207. For 
each Saved Search Alert, you configure a match count, threshold, destination, and a 
schedule at which the alert will be triggered (if specified number of matches occur within 
the specified threshold).

Creating a Saved Search Alert
You can create a Saved Search Alert in two ways:

 From the search results page (Analyze > Search) 

 From the Scheduled Searches page (Configuration > Saved Search > Scheduled 
Searches)

To ensure system performance, a maximum of 200 alerts are allowed per 
saved search alert job. Therefore, if a saved search alert job triggers more 
than 200 alerts, only the first 200 alerts are sent out for that job iteration; 
the rest are not sent. Additionally, the job is aborted so it does not trigger 
more alerts for that iteration and the status for that job is marked “Failed” in 
the Finished Tasks tab (Configuration > Scheduled Tasks > Finished Tasks). 
The job runs as scheduled at the next scheduled interval and alerts are sent 
out until the maximum limit is reached. 

This limit does not exist on the real-time alerts.
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To create a Saved Search Alert from the search results page

1 Run a search, as described in “Searching for Events on Logger” on page 128.

2 Click the Save icon ( ) and enter the following settings.

3 Click Save.

If you checked the “Schedule it” setting in the previous step, you are prompted to 
choose if you want to edit the schedule, as follows. If you click OK, the Edit Scheduled 
Search page is displayed, as shown in the next step. If you click Cancel, the search is 
saved as a Saved Search but it is not scheduled to run.

Parameter Description

Name A name for the query you are saving.

Save as Whether to save the query as a filter or as a Saved Search.

To save the query as a Saved Search Alert, select “Saved 
search”.

Schedule it Whether to schedule the alert right now or later.

Click to schedule now, or leave blank to schedule later.

Schedule type Whether the query is being saved as a scheduled search or as a 
scheduled alert. 

Scheduled searches run on a predetermined schedule and 
export results to a prespecified location. Scheduled alerts run a 
search on a predetermined schedule and generate an alert if the 
specified number of events within the specified threshold are 
found.

Overwrite If a query with the same name exists, whether that query 
should be overwritten. 

If you check this setting and a query with the same name 
exists, the existing query is overwritten with the one you are 
currently saving. If you do not check this setting, a warning 
message is displayed that prompts you to enter another name 
for the query.
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4 If you checked the Schedule it setting previously, the Edit Scheduled Search page is 
displayed. This page enables you to define a schedule for the Saved Search job and 
alert options.

Parameter Description

Schedule Choose Everyday or Days of Week from the first pulldown 
menu. 

If Everyday:

• EITHER select Hour of Day to specify the hour of the day in 
24-hour format 

• OR select Every to specify the number of hours or minutes 
after which a Saved Search is performed. Select from the 
pulldown on the right side of Every to specify Hours or 
Minutes. By default, the number of hours and number of 
minutes is set to 15.

If Days of Week, enter the days (day 1 is Sunday) in the text 
box. Then choose Hour of Day or Every from the second 
pulldown menu. Enter the hours (1-23) in the second text box.

For example, to perform the Saved Search every day at 2 a.m., 
select Everyday in the first pulldown menu, then choose Hour of 
Day from the second pulldown menu and enter 2 in the text 
box. To perform the Saved Search every day at 2 a.m. and 3 
p.m., enter 2,15 in the text box.

For another example, to perform the Saved Search Tuesdays 
and Thursdays at 10 p.m., select Days of Week from the first 
pulldown menu and enter 3,5 for days. Then choose Hour of 
Day from the second pulldown menu and enter 22 in the text 
box.
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To create a Saved Search Alert from the Scheduled Searches page

1 Click Configuration from the top-level menu bar.

2 Click Saved Search in the left panel. 

3 Click Scheduled Searches in the right panel.

4 Click Add.

Saved 
Searches

Select from the list of Saved Searches. If a Saved Search to suit 
your needs does not exist in the list, click the Saved Searches 
tab (to the left of Scheduled Searches tab) to define it. For more 
information about defining a Saved Search query, see “Saved 
Searches” on page 207.

Job Type Select Alert for a Saved Search Alert.

Alert Options

Match count Number of events that should be matched in Threshold number 
of seconds for an alert to be triggered. 

Threshold 
(sec)

Number of seconds within which the “Match count” events 
should be matched for an alert to be triggered.

Notification destinations are optional. If none is specified, a notification is not 
sent.

Email 
address(es)

(Optional) A comma-separated list of email addresses to which 
the alert will be sent

SNMP 
destination

(Optional) An SNMP destination to which the alert will be sent

Syslog 
destination

(Optional) A syslog server address to which the alert will be 
sent

ESM 
destination

(Optional) An ESM Manager address to which the alert will be 
sent
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5 Enter the following information.

Parameter Description

Name A name for the Saved Search you are saving.
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6 Click Save.

Schedule Choose Everyday or Days of Week from the first pulldown 
menu. 

If Everyday:

• EITHER select Hour of Day to specify the hour of the day in 
24-hour format 

• OR select Every to specify the number of hours or minutes 
after which a Saved Search is performed. Select from the 
pulldown on the right side of Every to specify Hours or 
Minutes. By default, the number of hours and number of 
minutes is set to 15.

If Days of Week, enter the days (day 1 is Sunday) in the text 
box. Then choose Hour of Day or Every from the second 
pulldown menu. Enter the hours (1-23) in the second text box.

For example, to perform the Saved Search every day at 2 a.m., 
select Everyday in the first pulldown menu, then choose Hour of 
Day from the second pulldown menu and enter 2 in the text 
box. To perform the Saved Search every day at 2 a.m. and 3 
p.m., enter 2,15 in the text box.

For another example, to perform the Saved Search Tuesdays 
and Thursdays at 10 p.m., select Days of Week from the first 
pulldown menu and enter 3,5 for days. Then choose Hour of 
Day from the second pulldown menu and enter 22 in the text 
box.

Saved 
Searches

Select from the list of Saved Searches. If a Saved Search to suit 
your needs does not exist in the list, click the Saved Searches 
tab (to the left of Scheduled Searches tab) to define it. For more 
information about defining a Saved Search query, see “Saved 
Searches” on page 207.

Note: You can only select one Saved Search for each Alert you 
configure.

Job Type Select Alert for a Saved Search Alert.

Alert Options

Match count Number of events that should be matched in Threshold number 
of seconds for an alert to be triggered. 

Threshold 
(sec)

Number of seconds within which the “Match count” events 
should be matched for an alert to be triggered.

Notification destinations are optional. If none is specified, a notification is not 
sent.

Email 
address(es)

(Optional) A comma-separated list of email addresses to which 
the alert will be sent

SNMP 
destination

(Optional) An SNMP destination to which the alert will be sent

Syslog 
destination

(Optional) A syslog server address to which the alert will be 
sent

ESM 
destination

(Optional) An ESM Manager address to which the alert will be 
sent

Parameter Description
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7 Once a Saved Search Alert is created, you need to enable it. See “To Enable or Disable 
a Saved Search Alert” on page 200.

To Enable or Disable a Saved Search Alert

1 Click Configuration from the top-level menu bar.

2 Click Saved Search in the left panel. 

3 Click Scheduled Searches in the right panel.

4 Identify the Saved Search Alert that you want to enable. 

5 Click the associated icon (  or ) to enable or disable the alert.

To edit a Saved Search Alert

1 Click Configuration from the top-level menu bar.

2 Click Saved Search in the left panel. 

3 Click Scheduled Searches in the right panel.

4 Locate the Saved Search Alert that you want to edit.

5 Click the Edit icon ( ) and edit the information. For details about the settings, see 
“To create a Saved Search Alert from the Scheduled Searches page” on page 197.

6 Click Save.

To remove a Saved Search Alert

1 Click Configuration from the top-level menu bar.

2 Click Saved Search in the left panel. 

3 Click Scheduled Searches in the right panel.

4 Identify the Saved Search Alert that you want to remove. 

5 Click the remove icon ( ). 

6 Click OK to confirm the removal, or click Cancel to keep the alert.

To view Saved Search Alerts

1 Click Configuration from the top-level menu bar.

2 Click Saved Search in the left panel. 

3 Click Scheduled Searches in the right panel. 

A list of the currently configured Saved Search Alerts is displayed.

SNMP Destinations
SNMP Destinations describe how Alert notifications should be sent using Simple Network 
Management Protocol (SNMP). Set up SNMP Destinations before creating Alerts that will 
use them.

To Add an SNMP Destination

1 Click Configuration from the top-level menu bar.

2 Click Alerts in the left panel. 
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3 Click the SNMP Destinations tab in the right panel.

4 Click the Add button.

5 Enter parameters:

6 Click Save to create the new SNMP Destination.

To Remove an SNMP Destination

1 Click Configuration from the top-level menu bar.

2 Click Alerts in the left panel. 

3 Click the SNMP Destinations tab in the right panel.

4 Locate the SNMP Destination to be removed and click the remove icon ( ) on that 
row. 

5 Confirm the deletion by clicking OK, or click Cancel to retain the SNMP Destination.

Syslog Destinations
Syslog Destinations describe how Alert notifications should be sent using the comparatively 
simple Syslog protocol. Set up Syslog Destinations before creating Alerts that will use them.

To Add a Syslog Destination

1 Click Configuration from the top-level menu bar.

2 Click Alerts in the left panel. 

3 Click the Syslog Destinations tab in the right panel.

4 Click the Add button.

5 Enter parameters:

Parameter Description

SNMP Destination Name A name for this destination.

Connector Name The SmartConnector name.

Connector Location The physical location of the SmartConnector 
machine. If you do not want to specify a 
location, enter “None”.

Logger Location Optional comment describing Logger’s physical 
location.

SNMP Host Host name or IP address.

SNMP Port 162, by default.

Community Name SNMP community name.

Parameter Description

Name A name for this destination.

Type UDP or TCP Syslog. This choice cannot be 
edited later.
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6 Click Next. Enter the secondary parameters:

7 Click Save to create the new Syslog Destination

To Edit a Syslog Destination

1 Click Configuration from the top-level menu bar.

2 Click Alerts in the left panel. 

3 Click the Syslog Destinations tab in the right panel.

4 Click the Edit icon ( ). You can edit the parameters of the Syslog Destination except 
its type.

5 Click Save to make the changes, or Cancel to return to the Syslog Destination table.

To Remove a Syslog Destination

1 Click Configuration from the top-level menu bar.

2 Click Alerts in the left panel. 

3 Click the Syslog Destinations tab in the right panel.

4 Locate the Syslog Destination to be removed and click the remove icon ( ) on that 
row. 

5 Confirm the deletion by clicking OK, or click Cancel to retain the Syslog Destination.

ESM Destinations
ESM Destinations describe how Alert notifications should be sent to an ArcSight ESM 
Manager. Set up ESM Destinations before creating Alerts that will use them. If an ESM 
Manager uses a signed SSL certificate, you will need to load it on the Logger. 

To setup Logger to send alerts to an ArcSight ESM Manager

1 If the ESM Manager uses a certificate, copy the server SSL certificate file from an ESM 
Console or other component that is already communicating with the target Manager, 
and upload the certificate file to Logger, as described “Uploading a Certificate to the 
Logger” on page 187. 

Note: Starting with Logger v4.0, you cannot import the cacerts file, which is a 
repository of trusted certificates, to the Logger. Instead, you need to import specific 
SSL certificate files. 

Parameter Description

Name The name for the destination.

Type This is the value you entered in the previous 
screen. This value cannot be changed.

Ip/Host Host name or IP address.

Port Port (default is 514).

Connection Retry Timeout (Only for TCP Syslog Destinations) The time, in 
seconds, to wait before retrying a connection. 
The default is 5 seconds.
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2 Create an ESM Destination, as described in “To create an ESM Destination” on 
page 185.

Export
See “Exporting and Importing Content” on page 238.

Scheduled Tasks
Scheduled Tasks displays jobs that are programmed to happen automatically. Job types 
include Configuration Backup, file transfers, Event Archive, and Saved Searches. The 
Scheduled Tasks section has three tabs: Scheduled Tasks, Currently Running Tasks, and 
Finished Tasks.

Make sure you are familiar with the information in “Impact of Daylight Savings Time 
Change on Logger Operations” on page 351 that can impact a scheduled task.

Maximum number of scheduled tasks that can be defined on Logger: No limit.

Scheduled Tasks
The Scheduled Tasks page, shown in Figure 5-11, displays the list of scheduled jobs. 
Scheduled Tasks can be deleted until the jobs are performed. A drop-down list at the top of 
the page lets you show All Scheduled Tasks or only tasks of a specific type.

To view Scheduled Tasks

1 Click the Configuration > Scheduled Tasks.

2 Filter the list by selecting a specific type of Scheduled Task from the drop-down list, or 
select All. 

Figure 5-11 Scheduled Tasks page

To add a Scheduled Task

Scheduled Tasks can be created for:

 Saved Search (See “Scheduled Saved Search” on page 209)

 File Receivers and File Transfer Receivers (See “Receivers” on page 171)

 Event Archive (See “Archiving Events” on page 161)

 Configuration Backup (See “Configuration Backup and Restore” on page 219)

To delete a Scheduled Task

1 Click the Configuration > Settings tab, click Scheduled Tasks in the sub-menu, 
then click the Scheduled Tasks tab.
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2 Locate the Scheduled Task to be deleted and click the delete icon ( ) on that row. 

3 Confirm the deletion by clicking OK, or click Cancel to retain the Scheduled Task.

Currently Running Tasks
The Currently Running Tasks page displays the Scheduled Tasks that are running at the 
present time. The table shows task name, type, and the date and time that the task 
started.

To view Currently Running Tasks

1 Click the Configuration > Settings tab, click Scheduled Tasks in the sub-menu, 
then click the Currently Running Tasks tab.

2 Filter the list by selecting a specific type of Scheduled Task from the drop-down list, or 
select All. 

Finished Tasks
The Finished Tasks page acts like a log of all Scheduled Task runs, with the most recently 
finished tasks on top.

To view Finished Tasks

1 Click the Configuration > Settings tab, click Scheduled Tasks in the sub-menu, 
then click the Finished Tasks tab.

2 Filter the list by selecting a specific type of Scheduled Task from the drop-down list, or 
select All. 

Filters
The Filters section has three tabs: Filters, Search Group Filters, and Export.

Filters
The Filters page provides a convenient place to manage filters. There are two types of 
filters: 

 Shared

A shared filter is visible to all Logger users. Once created, any Logger user can use it 
to search for events. The query you specify for a shared filter can be a Unified query 
(that uses keywords, indexed, and non-indexed fields) or a Regex query (that specifies 
a regular expression). Creating Regex Query shared filters are useful for creating real 
time alerts, which accept only regex queries. 

 Search Group

Search group filters provide an access control mechanism to limit the events that users 
in a particular user group can see. Search Group filters can also be used to limit the 
events processed by a category of reports (see “Using Report Category Filters” on 
page 339). The query for these filters can only contain regular expressions. Only users 
with administrative privileges can create these filters. 

A set of pre-defined filters, also known as system filters, exist on your Logger as well. For 
more information about system filters, see “System Filters/Predefined Filters” on page 146.

To create a filter

1 Click Configuration from the top-level menu bar.
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2 Click Filters in the left panel. 

3 Click the Filters tab in the right panel to create a shared filter. OR click the Search 
Group Filters tab to create a search group filter. (See “Filters” on page 204 for 
information about shared and search group filters.)

4 Click Add to display the following page.

5 Enter a name for the new filter in the Name field.

Filter names are case-sensitive.

6 If you are creating a shared filter, select Unified or Regex Query.

For Search Group filters, select Search Group. Note that non-administrator users 
cannot create Search Group filters. 

7 Click Next.

8 If you selected Unified or Regex Query method in the previous step, enter the query 
for the new filter.

For Unified queries:

When you type a query, Logger’s Search Helper enables you to quickly build a query 
expression by automatically providing suggestions, possible matches, and applicable 
operators. See “Search Helper” on page 66 for more information. 

OR

Click Advanced Search to use the Search Builder Tool to create the query. For details 
about using the Search Builder Tool, see “Using the Search Builder Tool” on page 120.

For Regex queries:

Enter the regular expression in the Query text box. 

9 Click Save.

To create a filter by copying an existing filter

1 Click the Configuration tab, click Filters in the sub-menu, then click the Filters tab.

2 Locate the filter to copy from the list of filters on the Filters page. Click the copy icon 

( ).

A new filter with the name “Copy of <filtername>” is created.

3 Change the name of the filter and edit the query for the new filter if necessary. 

4 Click Save.

To edit a filter

1 Click the Configuration tab, click Filters in the sub-menu, then click the Filters tab.

2 Find the filter to be edited in the table.

3 Click the Edit icon ( ). Change the information in the form and click Save.

If you created a Search Group filter, make sure that you associate it to a 
user group, as described in “Search Group Filters” on page 206.
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To delete a filter

1 Click the Configuration tab, then click Filters in the sub-menu.

2 Find the filter to be deleted in the table.

3 Click the Delete icon ( ). Confirm the delete.

Search Group Filters
Search Group Filters can be used to restrict events in the following two ways:

 Restrict the events processed by a Report Category—A Search Group Filter can 
be associated directly with a Report Category. This association provides a way to 
restrict the events processed by all the reports in a Report Category. 

When a Search Group filter is used to restrict the events processed by a Report 
Category, you do not need configure the Search Group in the Search Group Filters 
page as described below. After creating the filter (of type Search Group), you can go 
directly to the Reports Category Filters page of the Report tab and select the filter for 
the Report Category. For more information, see “Using Report Category Filters” on 
page 339.

 Restrict the events visible by members of a user group—A Search Group Filter 
can be associated with a user group (of type Logger Search). This association means 
that all members of the user group only see events which match the Search Group 
Filter. User groups (described in more detail later in this chapter) provide a way of 
assigning privileges to a specified set of users. 

The Search Group Filters page is used to manage the association of User Groups with 
Search Group Filters.  

Figure 5-12 Search Group Filters Page

Users who belong to a User Group that does not have a Search Group 
Filter will see all events.

In the Search Group Filters page (shown in Figure 5-12), the User Group of 
type Search Group is listed in the left column and the associated filter is listed 
in the middle column.
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To create, edit, or delete Search Group Filters, see “Filters” on page 204. To create, edit, or 
delete User Groups, see “Users/Groups” on page 385. 

To associate a Search Group Filter with a User Group

1 If the User Group that you want to associate with the Search Group Filter does not 
exist, create a new User Group of type Search Group. For instructions, see 
“Users/Groups” on page 385.

2 If the Search Group Filter you want to associate with the User Group does not exist, 
create a filter of type Search Group. For instructions, see “To create a filter” on 
page 204. When creating the filter, from the Type pull-down menu select the Search 
Group option.

3 Click the Configuration tab, click Filters in the sub-menu, then click the Search 
Group Filters tab. The page shown in Figure 5-12 is displayed.

4 Find the User Group to which to apply a Search Group Filter. Click the edit icon ( ). 

5 Select a filter from the pulldown list. (Only Search Group type filters are listed.) 

6 Click Save.

Export
See “Exporting and Importing Content” on page 238.

Saved Searches
A Saved Search, like a saved Filter, recalls a specific query. A Saved Search includes a time 
range, unlike a saved Filter, which supports the creation of scheduled event reporting. Also, 
a saved filter does not include the field set information that determines the fields that are 
displayed for each event in the search results.

For information about Saved Search Alerts, see “Alerts” on page 188.

You can schedule a saved search to run at a specific interval. For more information, see 
“Scheduled Saved Search” on page 209.

Make sure you are familiar with the information in “Impact of Daylight Savings Time 
Change on Logger Operations” on page 351 before adding a Saved Search.

Saved Searches
The Saved Searches tab displays all Saved Searches and supports Adding, Editing, and 
Deleting Saved Searches.

To add a Saved Search

1 Click the Configuration > Saved Search.

Only users that are members of a System Admin group can assign Search 
Group Filters. For more information, see “Users/Groups” on page 385.
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2 Click Add and enter the following parameters:

3 Click Save to add the new Saved Search, or Cancel to quit.

Figure 5-13 Saved Search page

To edit a Saved Search

1 Click the Configuration > Saved Search.

2 Find the Saved Search to be edited in the table.

3 Click the Edit icon ( ). Change the information in the form and click Save.

To delete a Saved Search

1 Click the Configuration > Saved Search.

2 Find the Saved Search to be deleted in the table.

3 Click the Delete icon ( ). Confirm the delete.

Parameter Description

Name A name for this Saved Search. This name will be used for 
exported output files, with the Saved Search date and time 
appended.

Start Time Absolute date and time of earliest possible event. Or check 
Dynamic to specify the start time relative to the time when the 
Saved Search job is run.

End Time Absolute or Dynamic date and time of latest possible event, as 
described above.

Query Terms Enter the query in the text field or select one or more Filters 
from the list below the text field.

When you type a query, Logger’s Search Helper enables you to 
quickly build a query expression by automatically providing 
suggestions, possible matches, and applicable operators. See 
“Search Helper” on page 66 for more information. 

Local Search Check this box to limit the Saved Search to the local Logger 
box. If the Local Search box is left unchecked, the Saved Search 
will include all Peer Loggers as well as the local Logger.
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Scheduled Saved Search
A scheduled Saved Search schedules a Saved Search to be run at a later time. Before you 
schedule a Saved Search, you must have created or saved at least one Saved Search. A 
scheduled Saved Search can be also configured to generate an alert. For more information 
about scheduled Saved Search Alerts, see “Creating a Saved Search Alert” on page 194.

The results of a scheduled Saved Search are written to a file, as described in “Saved Search 
Files” on page 212.

To add a scheduled Saved Search

1 Click Configuration from the top-level menu bar.

2 Click Saved Search in the left panel. 

3 Click Scheduled Searches in the right panel.

4 Click Add.The screen shown in Figure 5-14 is displayed.

Figure 5-14 Saved Search Jobs page

5 Enter the following parameters:

Parameter Description

Name A name for this Scheduled Saved Search Job.
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Schedule Choose Everyday or Days of Week from the first pulldown 
menu. 

If Everyday, select Hour of Day or Every from the second 
pulldown menu. Enter the hours (1-23) in the text box.

If Days of Week, enter the days (day 1 is Sunday) in the text 
box. Then choose Hour of Day or Every from the second 
pulldown menu. Enter the hours (1-23) in the second text box.

For example, to perform the Saved Search every day at 2 a.m., 
select Everyday in the first pulldown menu, then choose Hour of 
Day from the second pulldown menu and enter 2 in the text 
box. To perform the Saved Search every day at 2 a.m. and 3 
p.m., enter 2,15 in the text box.

For another example, to perform the Saved Search Tuesdays 
and Thursdays at 10 p.m., select Days of Week from the first 
pulldown menu and enter 3,5 for days. Then choose Hour of 
Day from the second pulldown menu and enter 22 in the text 
box.

Saved 
Searches

Select from the list of Saved Searches. If a Saved Search to suit 
your needs does not exist in the list, click the Saved Searches 
tab (to the left of Scheduled Searches tab) to define it. For more 
information about defining a Saved Search query, see “Saved 
Searches” on page 207. When multiple Saved Searches are 
specified in one scheduled saved search job, the resulting file 
contains the number of hits for each Saved Search and not the 
actual events. 

Job Type Select Search for a scheduled Saved Search.

Export Options For the Logger appliance:

Select from one of these options:

• Export to remote location—The file is written to an NFS 
mount, a CIFS mount, or a SAN system.

• Save to Logger—The file is saved to the Logger’s onboard 
disk. If the file is saved locally, use the Saved Search Files 
(“Saved Search Files” on page 212) feature to access those 
files.

For the software version of Logger:

The only applicable option is “Save to Logger”, which is 
preselected for you.

File Format CSV, for comma-separated values file.

PDF, for a report-style file that contains search results as charts 
and in tables. You must specify a title for the report in the Title 
field. If the search query contains an operator that creates 
charts such as chart, top, and so on, charts are included in the 
PDF file. In that case, you can also set the Chart Type and Chart 
Result Limit fields. These fields are described later in this table. 

Parameter Description
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6 Click Save to add the new scheduled Saved Search, or Cancel to quit.

To edit a scheduled Saved Search 

1 Click Configuration from the top-level menu bar.

2 Click Saved Search in the left panel. 

3 Click Scheduled Searches in the right panel.

4 Locate the Saved Search Job to be edited and click the edit icon ( ) on that row.

5 Change the parameters of the Saved Search Job.

6 Click Save to update the Saved Search Job, or Cancel to abandon your changes.

Export 
Directory 
Name

For the Logger appliance, select the directory where the 
search results will be exported from the pulldown menu. 

For the software version of Logger, enter the directory path 
in this field, which can be a path to a local directory or to a 
mount point on the machine on which the software version of 
Logger is installed.

If a directory of the specified name does not exist, it is created. 
If a directory of the specified name exists and the Overwrite box 
is not checked, an error is generated. If the Overwrite box is 
checked, the existing directory contents are overwritten.

Title (Optional) A meaningful name that appears on top of the PDF 
file. If no title is specified, “Untitled” is included. 

Fields A list of event fields that will be included in the exported file.

By default, all fields are included. 

You can enter fields or edit the displayed fields by deselecting 
All Fields. 

Chart Type 
(for PDF only)

(If the search query includes an operator that creates a chart, 
this field is meaningful; otherwise, it is ignored.)

Type of chart to include in the PDF file. You can select from:

Column, Bar, Pie, Area, Line, Stacked Column, Stacked Bar.

Note: If the Chart Type is different from the chart displayed on 
the Search Results screen, the value selected for this option 
overrides the one shown in the screen. Therefore, the exported 
PDF contains the chart you specify for this option and not the 
one shown on the screen.

Chart Result 
Limit (for PDF 
only)

(If the search query includes an operator that creates a chart, 
this field is meaningful; otherwise, it is ignored.)

Number of unique values to plot. Default: 10 

If the configured Chart Result Limit is less than the number of 
unique values for a query, the top values equal to the Chart 
Result Limit are plotted. That is, if the Chart Result Limit is 5 
and 7 unique values are found, the top 5 values will be plotted.

Include 
Summary

Check this box to include an event count with the Saved Search, 
or a total when more than one Saved Search is specified.

Include Non-
CEF Events

Check this box to include all events. Uncheck the box to include 
only CEF (see “Common Event Format” on page 509) events in 
the output.

Parameter Description
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To delete a scheduled Saved Search

1 Click Configuration from the top-level menu bar.

2 Click Saved Search in the left panel. 

3 Click Scheduled Searches in the right panel.

4 Locate the Saved Search Job to be deleted and click the delete icon ( ) on that row.

5 Confirm the deletion by clicking OK, or click Cancel to retain the Saved Search Job.

Saved Search Files
Access Saved Search results that were Saved to Logger with the Saved Search Files 
command. Saved Search Files can be retrieved (streamed to the browser) or deleted.

Figure 5-15 Saved Search Files page

Search Optimization
The search optimization option enable you to:

 Add search indexes for field query search operations

 Tune advanced search options

 Delete custom field sets

 View added custom schema fields

Add Search Indexes
See “Indexing” on page 139 for more information.
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Tuning Advanced Search Options

The following table lists the advanced search options you can view and configure. These 
options support i18n choices. If you change any of these options, you will need to reboot 
your Logger for those changes to take affect. 

Option Description

Case sensitive Defaults: Yes, for field query; No, for regular expression.

Full-text search (keyword search) is case insensitive. You cannot 
change its case senstivity.

When this option is set to No, searching for “login” will find “login,” 
“Login,” and “LOGIN”.

Note: Case-sensitive search only applies to the local Logger. Peer 
loggers will continue to use case-insensitive search.

Set this option to Yes to increase local query performance. 

Unicode case 
sensitive

Default: No

Set to Yes if non-English events should be compared in a case-
sensitive way.

This option only applies to the regular expression search method. 

Note: ArcSight strongly recommends that you do not change this 
option.

Check for 
canonical 
equality

Default: No

Set to Yes if non-English events should be compared using locale-
specific algorithms.

This option only applies to the regular expression search method.

Note: ArcSight strongly recommends that you do not change this 
option.
Confidential Administrator’s Guide 213



5 Configuration
To change any of the above options, click Configuration > Search Optimization > 
Search Options tab.

Viewing and Deleting Field Sets
You can view the field sets you have created and the predefined field sets under the 
Fieldsets tab (Configuration > Search Optimization > Fieldsets). You can also delete the 
field sets you created.

To delete a custom field set:

1 Click Configuration from the top-level menu bar.

2 Click Search Optimization from the left panel.

3 In the Fieldsets tab, identify the field set you want to delete and click the delete (  
icon.

4 Confirm the deletion.

Viewing Custom Schema Fields
You can view the custom schema fields under the Custom Fields tab (Configuration > 
Search Optimization > Custom Fields). 

This page lists all custom schema fields that have been saved. You can only view the 
alphabetical list of fields, but cannot edit or delete them. 

For detailed information about custom schema fields, see “Adding or Importing Schema 
Fields” on page 232.

Populate 
rawEvent field 
for syslog 
events

Default: No

Set to Yes if you want to view raw events in a formatted column 
called rawEvent using the Raw Event field set. 

This option applies to syslog events only. If you want to view the raw 
events associated with CEF events, you do not need to configure this 
setting. Instead, configure the connector that is sending events to 
Logger to populate the rawEvent field with the raw event. 

Note: Even though the rawEvent column displays the raw event, 
this column is not added to the Logger database and is not indexed. 
Therefore, you can only run a keyword (full-text) or regular 
expression search on the event. 

• You need to have the “Edit, save, and remove fieldsets” privilege to delete 
a custom field set.

• You can only delete the field sets you create, and not the predefined ones 
available on Logger.

Option Description
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Peer Loggers
A Logger can establish peer relationships with one or more Loggers to enable distributed 
event searches. 

When two Loggers peer with each other, one Logger initiates the relationship. The initiator 
Logger sends the credentials to authenticate itself to the other Logger, called the remote 
Logger from hereon. If the authentication succeeds, a peer relationship is established 
between the two Loggers. (The remote Logger must have the credentials for the initiator 
Logger configured on it for authentication to succeed.) 

Adding a peer on a Logger is a bi-directional process. That is, when Logger A adds peer 
access for Logger B, Logger B automatically adds peer access for Logger A. Similarly, if you 
delete the peer access for B on A, the peer access for A is automatically deleted on B.

Peer Loggers can authenticate using any of these methods:

 User name and password 

A user name configured on the Logger is used for authentication

 Peer Authorization ID and Code

Authorization ID and Code generated on a remote Logger are used by the initiator 
Logger to peer with it. The generated ID and Code are specific to the initiator Logger 
because the IP address of the initiator is used to generate the ID and code, and can be 
used only for peering from the initiator. Therefore, this method is more secure than 
using user name and password.

Guidelines
You should be aware of these guidelines when peering Loggers. 

 You can peer a Logger to one or more remote Loggers. 

 Peer Loggers can run different versions. A Logger appliance can peer with a software 
version of Logger. However, a v5.x software Logger cannot peer with a Logger 
(appliance or software) running v4.x. These are the supported paths for peering 
Loggers:

 v5.x software Logger to v5.x software

 v5.x software Logger to v5.x appliance

 v4.5 software Logger to v5.x appliance 

 v4.5 appliance to v5.x appliance

 v5.x appliance to v5.x appliance

 The time and date on the system on with the software Logger is installed must be set 
correctly with respect to its timezone to peer with other Loggers. ArcSight 
recommends that you configure the Logger system to synchronize its time with an NTP 
server regularly. 

On a Logger using local or RADIUS authentication, you can use either 
authentication method, although peer authorization ID and code are 
recommended for reasons described below. However, if you are using SSL 
Client Authentication (CAC) on your Logger, authorization ID and code is 
the only way to authenticate a peer. You cannot use a user name and 
password.

FIPS-enabled Loggers are not limited to a specific authentication method. 
Therefore, you can use any listed below.
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 If the remote Logger is configured for SSL Client authentiction (CAC), you must 
configure an authorization ID and code on the initiator Logger. 

There are no special authentication requirements for FIPS-enabled Loggers. Such 
Loggers can use any of the allowed authentication methods.

 Peer loggers cannot be edited, however you can delete and readd a peer.

 If you are running distributed searches (searches across peers), follow these additional 
guidelines:

 If you need to run a search using the search operators across peers, make sure 
the peers are running Logger v5.1 or later. For information about search 
operators, see “Search Operators” on page 87.

 A user must belong to the Logger Search User Group with “Search for events on 
remote peers” privilege set to Yes and the Logger Rights Group with "View 
registered peers" privilege set to Yes. See “Searching Peer Loggers (Distributed 
Search)” on page 129.

 Users performing search operations on peers have the same privileges on the 
peer that they have on the Logger they are logged in. 

 For example, UserA is restricted by a search group filter to only search for events 
in which deviceVendor is set to “Cisco”. When UserA performs a search operation 
across LoggerA’s peers, the same constraint (to search events where 
deviceVendor = “Cisco”) is applied on all peers. 

 If you are running distributed reports (reports across peers), see “Selecting Device 
Groups, Storage Groups, Devices, or Peers” on page 281.

 If user name and password are used for authenticating to a remote peer Logger, the 
credentials are only used one-time, during the peering relationship set up. After a 
relationship has been established, the credentials are not saved (on the Peer Loggers 
page) and the peers do not authenticate periodically. Therefore, if the user name or 
password used to establish a relationship is changed at a later date or the user name 
is deleted, peering relationship is not broken. However, if you delete the peering 
relationship or it breaks for other reasons, you will need to enter the updated 
credentials to re-establish the relationship. 

The following example illustrates the steps you need to follow to set up peering between 
two Loggers.

Logger A Logger B

1 Select the Logger that will initiate the establishment of the peering relationship.

In this example, Logger A will initiate the relationship. 

2 If Logger B is configured to use user name and password authentication, go to 
Step 3.

If Logger B is configured to use SSL Client Authentication (CAC), go to Step 4.

3 Set up a user name and password 
that Logger A will use to authenticate 
itself when peering with this Logger, 
as described in “Users/Groups” on 
page 385.

4 Generate an Authorization ID and 
Code that Logger A will use for 
authenticating to Logger B, as 
described in “To generate 
Authorization ID and Code for 
configuring a peer relationship” on 
page 218.
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To add a peer Logger

1 Click Configuration from the top-level menu bar.

2 Click Peer Loggers from the left panel.

3 Click Add and enter the following parameters.

5 Add Logger B’s information, as 
described in “To add a peer Logger” 
on page 217:

If Logger B uses user name and 
password, use the user name and 
password you configured in Step 3.

If Logger B uses SSL Client 
Authentication, use the Authorization 
ID and Code you generated in Step 4.

Parameter Description

Peer Host Name The remote Logger’s hostname or IP address.

Peer Port 443, by default for Logger appliance and pre-v5.0 software 
Loggers. 

Port you configured when installing software Logger. See 
“Guidelines” on page 215.

Peer Login 
Credentials

Peer Authorization 
Credentials

Select Peer Login Credentials for password-based 
authentication with the remote Logger.

Select Peer Authorization Credentials for SSL client 
authentication with the remote Logger. (See “SSL Client 
Authentication (CAC Authentication)” on page 378.)

If the peer-relationship initiating Logger has version 3.0.x 
installed and the other Logger is running v4.0 GA with SSL 
Client Authentication enabled, enter the generated 
Authorization ID in the User Name field and the Code in the 
Password field on the v3.0.x Logger.

Logger A Logger B
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4 Click Save to add the new Logger, or Cancel to quit.

To generate Authorization ID and Code for configuring a peer relationship

Use the following procedure to generate the authorization ID and code on the Logger to 
which you are establishing a peer relationship. (Logger B in the example described earlier 
in this section.) This ID and Code is then configured on the Logger that initiates the peer 
relationship. (Logger A in the earlier example.) 

1 Click Configuration from the top-level menu bar.

2 Click Peer Loggers from the left panel.

3 In the Peer Authorizations tab, click Add.

4 Enter the hostname for the peer Logger and the port (if using a non-default port).

5 Click Save.

The authorization ID and authorization Code are displayed. Cut and paste this 
information when adding a peer Logger that is configured to use SSL client 
authentication.

To delete a peer Logger

1 Click Configuration from the top-level menu bar.

2 Click Peer Loggers from the left panel.

3 Locate the Peer to be deleted and click the delete icon ( ) on that row. 

If you selected Peer Login Credentials...

Peer User Name The user name to use when connecting to the remote 
Logger.

Peer Password The password for the user on the remote Logger.

If you selected Peer Authorization Credentials...

Peer Authorization 
ID

Enter the authorization ID of the other Logger to which this 
Logger is initiating a peering relationship. (See “To 
generate Authorization ID and Code for configuring a peer 
relationship” on page 218 for more information.)

Peer Authorization 
Code

Enter the authorization code of the other Logger to which 
this Logger is initiating a peering relationship. (See “To 
generate Authorization ID and Code for configuring a peer 
relationship” on page 218 for more information.)

These fields need to be updated in rare circumstances. For more 
information, read the description of each field in this table.

External IP 
Address

In most cases, the value in this field matches the IP 
address you use to connect to this Logger from your 
browser, and you do not need to do anything. 

However, if the IP address does not match (for example, 
when the Logger is behind a VPN concentrator), change the 
value to match the IP address with which you connect to 
this Logger. 

Local Port Make sure the value of this field is set to 443.

Parameter Description
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4 Confirm the deletion by clicking OK, or click Cancel to retain the Peer.

To view peers of a Logger

A list of remote Loggers that a Logger peers with is displayed on the Peer Loggers page 
(Configuration > Peer Loggers).

Configuration Backup and Restore
By default, Logger does not back up any content. However, you can configure it to backup 
the following content to a remote system:

 All non-event data 

 Reports content only

You can back up this content on ad-hoc basis or schedule it to run periodically. The content 
is saved to the backup location in a single .tar.gz format file. 

The following table lists the information included in the backup when you back up all non-
event data and reports-only data.

You can use the backed up content to:

 Restore a Logger that is not functioning as expected or that has been reset to its 
factory defaults

 Copy content from one Logger to another

All non-event data backup includes... Reports-only backup includes...

System Information

Logs

Global Settings

User and Group Information

All Configuration Settings 

Existing Filters and Saved Searches

Logger Monitor settings

The following Reports content:

• Queries, Reports, Parameters, 
Parameter Value Groups, Dashboard 

• Templates

The following Report content only:

• Queries, Reports, Parameters, 
Parameter Value Groups, Dashboard 

• Templates

When you restore content to a Logger, the existing content on it is deleted.
Confidential Administrator’s Guide 219



5 Configuration
Running a Configuration Backup (Ad-hoc or Scheduled)

To run a configuration backup or to edit the configuration backup settings:

1 Click the Configuration > Configuration Backup.

2 Click the ( ) icon and enter the following parameters

Parameter Description

Protocol SCP 

Port The port on which the Logger should connect to the remote system

Ip/Host The IP address or hostname of the remote system

User A user on the remote system with write privileges on the backup 
folder (specified in Remote Directory, below)

Password Password for the user

Note: The password cannot contain these characters: % = ; " ' <>

Remote 
Directory

The folder on the remote system in which to save the configuration 
backup files

Backup 
Content

Whether to backup all non-event data or only the report content

Select All for all non-event data or Report Content Only for only 
the report content.
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3 Click Save.

If you chose to run the backup One Time Only, it is run right away. Otherwise, it is 
scheduled to run at the specified time.

Restoring from a Configuration Backup
Make sure you are familiar with these guidelines before you restore a backup file on 
Logger:

 When you restore content to a Logger, the existing content on it is deleted. 

Logger restores the settings specific to your environment that were current at the time 
the backup was taken. Any configuration settings that were updated between the time 
of the backup and the time of the restore are lost.

 You can only restore from configuration or report content using a backup file if the 
Logger appliance model and the version running on it is the same as the one used to 
create the backup file.

For the software version of Logger, the operating system and Logger version running 
on the machine to which you are restoring should be the same as the one used to 
create the backup file. 

To restore from a configuration backup:

1 Click the Configuration > Configuration Backup.

2 Click Restore.

3 Click Browse to locate the backup file.

4 Click Submit to start the restore process.

Editing Configuration Backup Settings
See “Running a Configuration Backup (Ad-hoc or Scheduled)” on page 220.

Schedule If you check One Time Only, other fields are hidden and the 
Configuration Backup occurs just once (ad-hoc), when you click 
Save.

Choose Everyday or Days of Week from the first pulldown menu. 

If Everyday, select Hour of Day or Every from the second pulldown 
menu. Enter the hours (1-23) in the text box.

If Days of Week, enter the days (day 1 is Sunday) in the text box. 
Then choose Hour of Day or Every from the second pulldown menu. 
Enter the hours (1-23) in the second text box.

For example, to backup every day at 2 a.m., select Everyday in the 
first pulldown menu, then choose Hour of Day from the second 
pulldown menu and enter 2 in the text box. To backup every day at 2 
a.m. and 3 p.m., enter 2,15 in the text box.

For another example, to backup Tuesdays and Thursdays at 10 p.m., 
select Days of Week from the first pulldown menu and enter 3,5 for 
days. Then choose Hour of Day from the second pulldown menu and 
enter 22 in the text box.

Make sure you are familiar with the information in “Impact of 
Daylight Savings Time Change on Logger Operations” on page 351.

Parameter Description
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System Maintenance
Certain operations on Logger, such as database defragmentation, extending the storage 
volume size, adding storage groups, and adding additional schema fields, require that 
Logger be in a maintenance state—a state in which operations related to data on the 
Logger are not running. Maintenance mode enables you to place the Logger in such a 
state. When a Logger is in maintenance mode:

 Events are not processed

 Reports are not generated

 Search cannot run

 Scheduled jobs do not run

Logger users who will be performing operations that require it to be in maintenance mode 
must have the “Enable Maintenance Mode” privilege checked (System Admin > User 
Management > Groups tab > System Admin Group).

When a Logger is in maintenance mode, users with the “Enable Maintenance Mode” 
privilege can login but see this UI message:

All other users cannot login. The login screen displays this message:

Entering Maintenance Mode
You cannot place a Logger in maintenance mode directly. A Logger can enter maintenance 
mode only when you perform an operation that requires it to be in that mode. For example, 
when defragmenting database, the user interface prompts you to enter Logger in 
maintenance mode, as illustrated in “Database Defragmentation” on page 223. 

Exiting Maintenance Mode
To exit maintenance mode, reboot the Logger. 
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Checking Status of a Maintenance Operation
You can check the status of a maintenance operation on the Maintenance Results page. To 
access the Maintenance Results page (as shown in the example below), click 
Configuration > System Maintenance > Maintenance Results. 

Database Defragmentation
Logger’s database can get fragmented over time. Frequent retention tasks can exacerbate 
this issue. The following symptoms are observed on a Logger when the database is 
fragmented:

 Slow search and reporting

For example, even a search operation over the last two minutes of data is slow. 

 Long pauses in the receiver and forwarder operations

You can defragment a Logger that exhibits the above listed symptoms. Make sure that you 
have read the following guidelines before starting the defragmentation process.

Guidelines for Database Defragmentation
 Ascertain that the Logger symptoms are not due to issues related to network 

infrastructure such as network latency or unexpected load on the Logger.

 The Logger system needs to be placed in maintenance mode before defragmentation 
can begin. As a result, most processes on the Logger are stopped—no events are 
processed or scheduled jobs run, and most user interface operations are unavailable. 
For more information about maintenance mode, see “System Maintenance” on 
page 222. 

 A minimum amount of free disk space is required on your system to run database 
defragmentation. The utility automatically checks for the required free space and 
displays a message if sufficient disk space is not found. 

 Although you can defragment as needed, if you are using this utility too often (such as 
on a system that was defragmented over the last few days), contact ArcSight 
Customer Support for guidance.

 If the defragmentation process fails at any point, the Logger returns to the same state 
that it was in before you started defragmentation. You can safely reboot the Logger 
appliance and restart the process from the beginning. For the software Logger, 
restart the Logger process as described in “Process Status” on page 352.
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Defragmenting a Logger

To defragment a Logger:

1 Click Configuration > System Maintenance.

2 Click Database Defragmentation.

3 Click Enter Maintenance so that the Logger can enter maintenance mode.

For more information about maintenance mode, see “System Maintenance” on 
page 222.

4 A minimum amount of free storage is required for the database defragmentation 
process to proceed. Therefore, Logger performs a check to determine free storage 
when entering maintenance mode.

If required amount of free storage is found and Logger successfully enters 
maintenance mode, the following screen is displayed. Click Begin Defragmentation 
to start the defragmentation process. 

• You can perform this process only if you have the “Enable Maintenance 
Mode” privilege set to Yes (System Admin > User/Groups > Manage 
Groups > System Admin Group).

• If the defragmentation process fails at any point, reboot the Logger 
appliance and restart the process from the beginning. For the software 
Logger, restart the Logger process as described in “Process Status” on 
page 352.

On the software Logger, the following Database Defragmentation screens 
instruct you to click restart to resume normal operation when Logger is in 
maintenance mode. When you click restart, only the Logger service and its 
related processes are started on the machine on which the software 
Logger is installed.
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Figure 5-16 Begin Database Defragmentation

The defragmentation process starts. A progress indicator shows the status of 
defragmentation, as shown in the example below. ArcSight recommends that you do 
not attempt any operation on the Logger until defragmentation has completed.

Once defragmentation is complete, the Logger reboots automatically, thus exiting 
maintenance mode.

If the required storage is not found, Logger prompts you to free sufficient space, 
as shown in the following example:

The “Manual Deletion” option (shown in the following figure) is not 
displayed on L7100 Loggers as it is not applicable to those platforms.
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Figure 5-17 Required storage for Database Defragmentation is not available

You can choose from one of the following options:

 Manual Deletion

A text file is automatically created on your Logger that lists the files you can safely 
delete, as shown in the following figure. 

The files are listed in descending order of size in the text file. You can delete 
sufficient number of files to free up storage. However, do not delete the files 
before contacting ArcSight Customer support for instructions and guidance. 

Follow these steps to proceed:

i Leave the message screen without taking any action.

ii Contact ArcSight Customer Support for instructions on deleting files listed in 
the text file.

iii After deleting sufficient number of files, resume the Database 
Defragmentation process from the message screen in Step i on page 226. To 
resume, click Recheck to check whether sufficient storage is now available 
for defragmentation to proceed.

If sufficient storage is found, the screen in Figure 5-16 on page 225 is 
displayed. Click Begin Defragmentation to proceed further.
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If sufficient storage is still not found, the screen in Figure 5-17 on page 226 is 
displayed. Choose from the listed options to create additional space. See “You 
can choose from one of the following options:” on page 226 for more 
information.

 Delete Database Indices

Logger automatically deletes a sufficient number of database indices, starting 
with the largest index, to free up the required amount of storage. If sufficient 
space becomes available after deleting database indices, defragmentation 
proceeds further automatically.

However, if sufficient storage is not available even after dropping database 
indices, the following screen is displayed. 

Follow these steps to proceed:

i Click Manual Deletion.

A text file is created on your Logger that lists the files you can safely delete. 
The files are listed in descending order of size in a text file. 

ii Click Reboot.

Logger exits the maintenance mode.

iii Contact ArcSight Customer Support for instructions on manually deleting the 
files. 

If you need to exit the defragmentation process without 
creating sufficient storage, click Reboot.

The Manual Deletion option (shown in the following figure) is not 
displayed on L7100 Loggers as it is not applicable to those 
platforms.
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You can delete sufficient number of files to free up storage. 

iv After deleting the files, restart the defragmentation process from Step 1 on 
page 224. 

 Reboot

The database defragmentation process is aborted and Logger returns to the state 
it was in before you started the defragmentation utility. 

Storage Volume Size Increase
You can extend the storage volume size you established during initialization at any time. 
Once extended, the volume size cannot be reduced. The Logger interface guides you about 

current and the maximum value to which you can increase the size. 

About Increasing Storage Volume Size on a SAN Logger
Logger cannot detect a resized LUN. Therefore, if you change the LUN size after it has 
been mounted on a Logger, the new size is not recognized by Logger. As a result, you can 
only increase the size of a storage volume to the LUN size that was initially mounted on the 
Logger. Currently, Logger supports up to a 5.4 TB LUN.

The following examples illustrate storage volume increase on a SAN Logger.

To increase the size of a storage volume:

If the defragmentation process fails or is aborted at any time, 
Logger must recover those indices. Although the recovery process is 
automatic, it can take at least a few hours to complete. You will not 
lose any data during this process.

For the “Storage Volume Size Increase” operation to show as an option under 
the System Maintenance operations (Configuration > System Maintenance), 
you need to belong to the System Admin group (with “Enable Maintenance 
Mode” privilege enabled) and the Logger Rights group. 

Initial LUN 
Size

LUN Resized
Current Storage 
Volume Size

Storage Volume Size 
Increase Allowed

4 TB No 1 TB Yes

4 TB No 4 TB No

4 TB 5 TB 1 TB Yes, only up to 4 TB

2 TB 4 TB 1 TB Yes, only up to 2 TB
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1 Click Configuration > System Maintenance.

2 Click Storage Volume Size Increase.

3 Click Enter Maintenance so that the Logger can enter maintenance mode.

For more information about maintenance mode, see “System Maintenance” on 
page 222.

4 While entering the maintenance mode, Logger performs a check to determine if the 
storage volume size can be increased and by what amount. 

If the storage volume can be increased, a message similar to the following is 
displayed. Enter the new size and click OK.

On the software Logger, the following Storage Volume Size Increase 
screens instruct you to click restart to resume normal operation when 
Logger is in maintenance mode. When you click restart, only the Logger 
service and its related processes are started on the machine on which the 
software Logger is installed.
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If sufficient space is not found to increase the storage volume, the following message 
is displayed. Click Reboot to restart the Logger and exit the maintenance mode. 

Adding Storage Groups
In addition to the two storage groups that exist on your Logger by default, you can add up 
to four additional storage groups. Prior to Logger v5.2, the additional storage groups had 
to be added at Logger initialization time. You could not add them later, once Logger was 
initialized. 

Starting with Logger v5.2, you can add storage groups at any time if the following 
conditions are met: 

 The maximum allowed six storage groups do not exist on your Logger already.

 The storage volume contains spare storage space that can be allocated to the storage 
groups you will add.

The Logger must be in maintenance mode when adding storage groups. When you add a 
storage group, Logger automatically checks to ensure that the storage group size you 
specified is greater than the minimum size required (5 GB) and less than the amount of 
space available in the storage volume. 

Once you have added storage groups and rebooted your Logger to exit the maintenance 
mode, remember to configure the Archive Storage Settings for the groups you just added 
so that event archives are created for them. 

To add a storage group:

1 Click Configuration > System Maintenance.

If you do not have sufficient space in the storage volume to add another 
storage group and the existing groups have free space, consider reducing the 
size of existing storage groups to make space available for the storage groups 
you want to add. OR increase the size of your existing storage volume, as 
described in “Storage Volume Size Increase” on page 228.

If you installed software Logger in Minimal mode, which adds two storage 
groups by default, you can add additional groups if sufficient storage volume 
is available. 
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2 Click Add Storage Groups.

A maximum of six storage groups can exist on Logger. Therefore, you can add up to 
four storage groups in addition to the two that exist by default on Logger. 

If the maximum number of allowed storage groups do not exist on Logger, a screen 
prompts you to enter maintenance mode, as described in the next step.

If all six storage groups exist on Logger or sufficient space does not exist in the 
storage volume to add additional group, a message is displayed on your screen and 
the Logger cannot enter maintenance mode. 

3 Click Enter Maintenance so that the Logger can enter maintenance mode.

For more information about maintenance mode, see “System Maintenance” on 
page 222.

4 Once Logger enters maintenance mode, the following Add Storage Groups page is 
displayed. 

This screen also lists information about the existing storage groups and the amount of 
space remaining in the storage volume.

5 Enter the following information.

6 Click Add.

The storage group is added to your Logger. If your Logger has not reached the 
maximum allowed six storage groups, you can click Add to add more storage groups. 
However, if the maximum number has been reached, the Add button is not displayed. 
OR if you do not want to add more storage group, go to the next step.

7 Reboot your Logger appliance for changes to take effect and for the appliance to exit 
the maintenance mode. 

Parameter Description

Name Choose a name for the Storage Group

Maximum Age 
(Days)

Specify the number of days to retain events. Events older 
than this number of days are deleted.

Maximum Size 
(GB)

Enter a maximum event data size, in GB.
Confidential Administrator’s Guide 231



5 Configuration
Restart the software Logger for changes to take effect and exit the maintenance 
mode.

Adding or Importing Schema Fields
The Logger schema contains a predefined set of fields. A field-based query can only 
contain these fields. Additionally, you can index only these fields for faster search 
operations. Prior to Logger v5.2, if your log analysis needs required you to search on a field 
that is currently not present in the Logger schema, you did not have a way of adding it to 
the schema yourself. 

Starting with Logger v5.2, you can add additional fields to the Logger schema. That is, you 
can insert fields in your Logger schema that are relevant to the events you collect on your 
Logger, thus enabling you to search and report using these fields. Additionally, you can 
index the fields you add so that the search and report queries that use these fields run 
faster. For example, a financial institution might want to add credit card numbers or social 
security numbers to the schema.

You can add up to 100 custom schema fields on Logger. You can also import custom fields 
from a peer Logger. However, the total number of added and imported fields cannot exceed 
the maximum allowed 100 fields. 

You can index up to 123 fields on Logger. Therefore, the number of custom schema fields 
you can index will depend on the number of default fields you currently have indexed on 
your Logger. 

The events that contain custom fields must be in CEF format (key-value pairs) for Logger to 
process them. Therefore, you will need to either use a SmartConnector that generates 
additional data or define an ArcSight FlexConnector to collect and parse events containing 
custom fields from the event source, convert them into CEF format, and forward them to 
the Logger. Logger can only process events from FlexConnectors that use CEF version 0.1. 
Therefore, make sure you use a connector build 5.0.0.5560 or later to write your 
FlexConnector. For details about designing FlexConnectors, see the ArcSight FlexConnector 
Developer’s Guide.

You need to be in maintenance mode to add or import custom schema fields. The process 
of adding or importing schema fields involves an add or import operation followed by a 
save operation. The add or import operation adds the specified fields but does not write 
them to the Logger schema. You can edit or delete the added or imported fields at this 
point. Once you save these fields, the fields are written to the schema. From this point on, 

Logger cannot process the additional fields data received in CEF version 0 
from a FlexConnector, and assumes a NULL value for such fields when they 
are present in a CEF version 0 event. As a result, you cannot search on these 
fields or index them. However, these fields are displayed in the UI display 
when you select “*” in the fieldset because the interface displays information 
contained in the raw event. Therefore, if Logger receives 
“ad.callnumber=5678”, the Logger UI will display a column, ad.callnumber, 
with value 5678. However, a search on “5678” will not return this event in the 
search results. 
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these fields cannot be edited or deleted. Therefore, carefully review the fields you are 

adding to the schema before saving them. 

You need to specify the following information to add a custom schema field:

 Display name

A meaningful name for the field. This name is displayed as the column header name 
for the field and is the one you specify in a search query. For example, 
SocialSecurityNumber.

 Type

The type of data this field will contain. The available options are Double, BigInt, 
DateTime, Text.

The following table describes each data type.

 Length

This field is only relevant when the Type specified is Text. This field specifies the 
maximum number of characters allowed in the value of the field when the data type is 
Text.

 Field name

The field name that you want to add to the Logger schema. Typically, this is an 
abbreviated version of the Display name. For example, SSN. 

Importing Schema Fields from Peers
If your Logger is a peer of another Logger, you can import the custom fields added to the 
peer’s schema. You specify the peer from which you want to import fields in the user 
interface screen. Fields can be imported if the following conditions are met:

 A field of the same Display name and Field name does not exist on the Logger to 
which you are importing schema fields. If conflicting fields exist, they are still imported 
but are flagged in the user interface screen. You cannot save the imported fields to 
schema until you resolve the conflicts. 

For the “Add Fields” operation to show as an option under the System 
Maintenance operations (Configuration > System Maintenance), you need to 
belong to the System Admin group (with “Enable Maintenance Mode” 
privilege enabled) and the Logger Rights group. 

Type Description

Double Use to store decimal numbers or fractions. Numbers 
from -1.79769313486231570E+308 through 
-4.94065645841246544E-324 for negative values and 
4.94065645841246544E-324 through 
1.79769313486231570E+308 for positive values.

BigInt Use to store whole numbers. Numbers from 
-2^63 (-9,223,372,036,854,775,808) through 
2^63-1 (9,223,372,036,854,775,807)

DateTime Use to store both dates and time or only dates.

Text Use to store any characters. You can store a maximum 
of 65535 characters per field. 
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 A maximum of 100 custom fields has not been reached on the importing Logger. If 
there are more fields than can be imported, only the first N until the allowed maximum 
is reached will be imported. 

The custom schema fields contained in a search query must exist on all peers on which the 
query is run. Otherwise, the query will not run and return an error.

To add or import custom schema fields:

1 Click Configuration > System Maintenance.

2 Click Add Fields (100 additional fields can be added).

You can add a maximum of 100 custom fields to Logger schema. The number in the 
“Add Fields” link reflects the number of custom fields you can add. This number 
decreases as you add fields to Logger schema. 

3 Click Enter Maintenance so that the Logger can enter maintenance mode.

For more information about maintenance mode, see “System Maintenance” on 
page 222.

4 Once Logger enters maintenance mode, the following Add Fields page is displayed. 

To manually add fields:

a Click “Add a New Field”, if it is not selected.

b Enter a meaningful name in the Display Name field. 

This name is the one you specify in a search query and is displayed as the column 
header name for the field in search results. For example, SocialSecurityNumber. 
This name is not added to the Logger schema. Follow these guidelines when 
specifying a display name:

 The name can contain up to 100 characters. 

 The name can contain alphanumeric characters, hyphens (“-”), and 
underscores (“_”). However, a hyphen (“-”) or an underscore ("_") cannot be 
the first character in the name. Additionally, the name cannot begin with 
“arc_”.

 The name must be unique; that is, another field (custom or predefined) of 
the same display name must not already exist on the Logger. 

 Only ASCII characters are allowed. That is, no native Chinese or Japanese 
characters are accepted in this field. 

c Select a data type for the field from the Type drop-down menu. 
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The available options are Double, BigInt, DateTime, Text. See “Type” on page 233 
for more information. 

d In the Length field, enter the maximum number of characters allowed in the value 
of the field when the data type is Text. This field is only available when the Type 
specified is Text. You can specify from 1 to 255 characters in this field.

e Enter a name in the Field name field. 

This is the name that will be added to the Logger schema. Typically, this is an 
abbreviated version of the Display name. For example, SSN. Follow these 
guidelines when specifying a Field name:

 This is a required field.

 The name can contain up to 40 characters and can contain alphanumeric, 
hyphen (“-”), and underscore (“_”) characters. Underscore ("_") is used as an 
escape character for the actual field name. Therefore, the underscore ("_") 
you specify in the field name is converted to a double underscore ("__") in 
the actual field name.

 The name must be unique; that is, a custom field of the same Field name 
must not already exist on the Logger. 

 Only ASCII characters are allowed. That is, no native Chinese or Japanese 
characters are accepted in this field. 

Once you enter a name in this field, a prefix and a suffix is automatically added to 
it, and the resulting name is displayed in the Actual Field Name field, as shown in 
the following figure. This field displays the way the field name you entered earlier 
will be stored on Logger. The prefix, "ad." signifies "additional data" and the suffix 
signifies the data type of the field. The Actual Field Name field is a non-editable 
field and is displayed on the user interface only for your reference.

f Click OK.

The field you added is displayed in the upper section of the Add Fields form, as 
shown in the following figure. This field is not saved yet (in “Ready to Save” state) 
and you can edit or delete it. Once you click Save, the field is added to the 
schema and cannot be changed or deleted. 

g Follow Step a through Step f to add additional fields.
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h Review the added fields and make any edits ( )or deletions ( ), if 
necessary.

i Click Save to commit the added fields and write them to your Logger’s schema. 

To import fields from a peer:

a Click “Import Fields From Peers”.

b Select the peer from which you want to import the fields from the Peer Host Name 
drop-down list.

c Click OK in the bottom right corner of the screen. 

If there are no conflicting fields, all fields from the peer are imported successfully. 

If there are conflicts, the conflicting fields are displayed ahead of the ones that 
were imported successfully. The Status column describes the reason for the 
conflict. You must fix the listed issues before you can save these fields to the 

schema. Use the edit ( )or delete ( ) icon to make changes or delete the 
added fields. 

If there are more fields than can be imported, only the first N until the allowed 
maximum (100) is reached will be imported. 

d Click Save to commit the added fields and write them to your Logger’s schema. 

• The next step commits the added fields to Logger’s schema. This 
process is irreversible; that is, once the fields are written to 
Logger’s schema, they cannot be edited or deleted. 

• If you exit this process without saving, the fields you were adding 
are not remembered and your changes are lost. 

The imported fields are not committed to Logger’s schema yet. The 
next step commits them. This process is irreversible; that is, once the 
fields are written to Logger’s schema, they cannot be edited or 
deleted. 

If you exit this process without saving, the fields you were adding are 
not remembered and your changes are lost. 
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To view custom schema fields:

See “Viewing Custom Schema Fields” on page 214.

License Information
This user interface page is only available on the software version of Loggers and 
not on Logger appliances because on appliances, generally, a data storage limit 
is not imposed.

The License Information page (Configuration > License Information) provides 
information about the currently applied license on your software Logger, as shown in the 
following figure.

The Data Volume Restrictions page lists the data stored on your software version of Logger 
on day-by-day basis in the last 30 days. It also indicates the days on which data limits were 
exceeded, as shown in the following figure. If the data-limit has been exceeded 6 times, 
you cannot search on Logger system and need to wait until the listed 30 days have 5 or 
less violations.
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Retrieve Logs
Logger records some audit and debug information, including details of any issues that 
occur. These system logs (not be confused with the event logs that Logger was designed to 
process), are like the “black box” on an airliner. If something goes wrong, the logs can be 
helpful. Figure 4-8 shows a typical example of a .zip archive of log files.

ArcSight Customer Support may ask you to retrieve logs as part of an incident 
investigation. If so, follow the steps below and upload the resulting .zip file to ArcSight 
Support.

To retrieve Logger system logs

1 Click the Configuration > Retrieve Logs. 

The page shown in Figure 5-18 appears.

2 When the Summary Status is Completed, click Download to retrieve the system log 
files are compressed into a single zip file.

Figure 5-18 Retrieve Logs provides snapshot status.

Exporting and Importing Content
You can export and import content (alerts and filters) from one Logger to another. Doing so 
is useful in these situations:

 The exported content serves as a backup for the Logger content. If your Logger 
becomes unavailable or is reset to its factory defaults, you can quickly restore its 
content by importing the saved content.

 When multiple Loggers with the same content need to be installed in your network, 
you need to configure only one Logger. Subsequent Loggers can be deployed by 
importing the first Logger’s content on them, thus reducing deployment time. 

 When you want to add content to the existing content on a Logger.

Using the Export function, you save the content from a Logger to a storage location on 
your network or to the local disk of the computer from which you connect to the Logger. 
When you need to use that content for any of the situations described previously, simply 
import the saved content. 
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Starting with Logger v4.0, saving content to the local disk is the default option. If you want 
to export to a remote location, you need to uncheck the “Save to local disk” option in the 
user interface to display the remote location options.

Guidelines for Exporting and Importing
Make sure you are familiar with these guidelines before exporting or importing content:

Exporting Guidelines
 The exported content is in XML format in a gzip file. For example, allfilters.xml.gz.

 The folder on the remote file system to which you are exporting Logger content needs 
to exist before you can export content to it. 

 The information exported for an alert includes the query associated with the alert, 
match count, threshold, and status. It does not include e-mail, SNMP, and syslog 
destination information.

 The alert destinations (SNMP, Syslog, and SMTP servers) information is not exported; 
therefore, you will need to set this information for alerts you import.

Importing Guidelines
 Existing content on a Logger is not deleted when new content is imported. The new 

content is added to the existing content.

 If an alert contains a filter, the filter is automatically created on the importing Logger. 
Such a filter is prefixed with “fwd” in the name. For example, “fwd-23456790”.

 If an alert with the same name exists on the importing system, the alert being 
imported is named AlertName[import]. Similarly, an imported filter is named 
FilterName[import]. 

If an alert with the name AlertName[import] exists on the importing Logger(from a 
previous import procedure), the alert being imported is named 
AlertName[import][import]. Similarly, a filter is named FilterName[import][import].

 You will need to set the alert destinations (SNMP, Syslog, and SMTP servers) for alerts 
you import because this information is not included in the exported content. 
Confidential Administrator’s Guide 239



5 Configuration
Exporting Content

To export Alerts or Filters:

1 Click Configuration > Alerts (or Filters, for filters) > Export tab.

2 Select the Alerts or Filters to export in the Choose Items to Export field. 

To select one alert (or filter), click its name.

To select multiple alerts (or filters), hold the Ctrl key down and click the names.

3 To save the exported content on the local disk of the computer from which you 
connect to the Logger, go to Step 7.

To export the content to a remote storage system, uncheck the “Save to local disk” 
field.

4 Select the location to which you want to export the content in the Mount Location 
field.

If the location you want is not in the drop-down list, you need to add it. For 
information about adding a network storage location, see “Storage” on page 365.

5 In the “Remote file path and name field”, enter the folder location in which the 
exported contents file will be created at the Mount Location you specified in the 
previous step.

The folder location you specify in this step needs to exist on the Mount Location. It is 
not created by the Logger. 

6 Click Overwrite if file exists if you want to overwrite a file with the same name as 
the exported contents file in the folder location that you specified in the previous step.

7 Click Export.
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Importing Content

To import Alerts or Filters:

1 Click Configuration > Content Import.

2 Select the content type that you are importing in the “Import item type” field.

You can choose from Alerts or Filters.

3 Click Browse to locate the file.

The file needs to exist on a local or remote drive accessible to the system whose 
browser you are using to access Logger’s user interface.

4 Click Import.
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Chapter 6

Reporting

This chapter describes Logger reporting features.

Reports are captured views or summaries of events which you can view from the Logger 
Reports tab or export for sharing in a variety of file formats. Reporting is an essential tool 
for communicating the state of your network security to internal and external stakeholders. 

The Reports Home Page
To get to the Reports home page from elsewhere in the Logger UI, click the Reports link 
on top of the page. Also, if you click Dashboard on the left panel menu from within 
Reports, the Reports Home page is displayed. The Dashboard Viewer opens and if a 

“The Reports Home Page” on page 243

“Explorers” on page 245

“Categories” on page 251

“Dashboards” on page 257

“Widgets” on page 263

“Running, Viewing, and Publishing Reports” on page 276

“Designing Reports” on page 288

“Scheduling Reports” on page 334

“Deploying a Report Bundle” on page 337

“Report Server Administration” on page 338

“Backup and Restore of Report Content” on page 340

“iPackager” on page 340
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dashboard is configured to display, the Reports Home page shows the selected 
Dashboard view.

If there is no Dashboard display configured and selected, the Reports home page shows an 
empty Dashboard Viewer.

On top of the Reports home page there are links for Dashboard Viewer, Dashboard 
Preferences, Widget Designer, Recent Reports, Classic Viewer, Classic Designer, and Classic 
Preferences.

The Dashboard Viewer page allows you to view your dashboards. On the upper right 
corner of the Dashboard Viewer page there are buttons that you can use to add a widget to 
the dashboard, save edit, and subscribe the dashboard. 

The Dashboard Preferences link allows you to specify a default dashboard to display as 
your Reports home page and also to display multiple dashboards as tabs in the Reports 
home page.

The Widget Designer page allows you to create a widget displaying either a report or a 
web link. You can place the widget in the dashboard from the Dashboard Viewer page.

The Recent Reports link shows the report execution status that lists the status of 
currently running, recently run, or accessed reports. By default, all reports except the 
completed scheduled reports are displayed, however, you can restrict the list by defining 
filter criteria. The Execution Type column under the Report Execution Status drop down 
indicates whether the report was run in the background or was run using quick run. A 
report run on ad-hoc basis is listed on the Report Execution Status page for 24 hours, 
however reports run in the background are listed for a longer period of time. You can select 
a report to run a report using different field values as well as re-run a report using the 
same values used in the original run.

Dashboards created in pre-v5.2 Logger can be viewed and edited from the Classic 
Viewer, Classic Designer, and Classic Preferences links.

See “Using Dashboards created in pre-v5.2 Logger” on page 266 for information on how to 
view or edit dashboards created in pre-v5.2 Loggers.

Do not use these links to create new dashboards. Use the Dashboard Viewer 
link to create new Dashboards. See “Designing Dashboards” on page 259 for 
details.
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For information about designing and selecting dashboard views, see “Dashboards” on 
page 257.

To get started by creating a dashboard to show as your default Reports Home page, see 
“Dashboards” on page 257, and “Designing Dashboards” on page 259.

To get started by running and viewing reports, see “Running, Viewing, and Publishing 
Reports” on page 276 and “Scheduling Reports” on page 334.

You can schedule any report to run once at a later date or on a specified frequency (such 
as daily or weekly). Monthly reports cannot be scheduled currently. For more on this, see 
“Scheduling Reports” on page 334.

You can run, publish, and save the results of any type of report. For information on these 
common reporting tasks available on all reports, see “Running, Viewing, and Publishing 
Reports” on page 276 and “Task Options on Available Reports” on page 278.)

The left pane of the Reports home page provides links that make it easy to navigate to a 
report, design a new report and links for report administration.

The various explorer links listed under Navigation in the left panel allow you to navigate 
to a report, query, or parameter. The links listed under Design allow you to create a new 
report and create, view and configure any object of the Reporting feature. The links listed 
under Administration allow you to do administrative tasks with reports.

Explorers
Use the explorers listed under the Navigation heading in the left pane to navigate to a 
desired report, query, parameter, dashboard, or dashboard widget that already exists in 
Logger. You can run a report, publish it, and customize it from the Report explorer. You can 
create and edit a query or parameter object from its respective explorer. You can select 
multiple objects in any of the explorers and perform actions such as set access rights on all 
of them, copy, cut, paste or delete actions on all of them. The following explorers are 
available.

Category Explorer
Reports and report objects, such as queries and parameters can be organized and grouped 
based on their function. Such functional groups are called Categories. For example, a 
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report pertaining to a database can be stored under the Database category. The Category 
Explorer brings together all categorized reports and report objects in one central location. 

The Category Explorer comes with some pre-defined, commonly used categories. You can 
add custom categories based on your requirements. You can use the Category Explorer to 
get an overview of all reports, published reports only, queries, parameters, dashboards, 
and dashboard widgets that were saved in a particular category.

When you click the Category Explorer link, a Repository pane appears to the right of the 
navigation pane listing all the available categories. Navigate to a report or another object 
by clicking on the category to expand it. Click on any object stored in that category and 
another pane will open up to the right of it listing the contents stored under it. For 
example, to get to a report from the Category Explorer, click the Category Explorer link, 
click the category link in the Repository pane to expand it, click Reports under the category, 
and click on the report of your choice and select an action to be performed (such as run 
report) on the report by clicking on one of the buttons in the right menu bar. See “List of 
Buttons in the Explorers” on page 249 for a description of the menu bar buttons.

See the section on List of Buttons in the Explorers for an explanation of each button 
available from the explorer.

Report Explorer
The Report Explorer is the central location for viewing (publishing), running, or editing a 
report. However, you cannot create a new report from the Report Explorer. 
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To create a new report, click the New Report link under the Design section in the left 
pane. The Report Explorer lists the various pre-defined categories. Clicking on any of the 
category opens another pane to its right which displays all the reports that have been 
stored in that category. Clicking on one of the buttons in the right menu bar. See “List of 
Buttons in the Explorers” on page 249 for a description of the menu bar buttons.

See the section on List of Buttons in the Explorers for an explanation of each button 
available from the explorer.

Query Explorer
Queries are made up of query objects or parameters. These query objects can be grouped 
in categories as well. When you click on the Query Explorer link, it opens a list of some pre-
defined query objects that have not been categorized and the various pre-defined 
categories under which you can store any newly created objects. 

You can use the Query Explorer to create new queries, view the properties for saved 
queries and edit the saved queries’ properties.

See the section on List of Buttons in the Explorers for an explanation of each button 
available from the explorer.
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Parameter Explorer
If you click the Parameter Explorer link, it opens a panel that lists the predefined categories 
under which you can store newly created parameters and some pre-defined parameters 
that have not been categorized. 

You can use the Parameter Explorer to create new parameters, view the properties for 
existing parameters and edit the existing parameters’ properties.

See the section on List of Buttons in the Explorers for an explanation of each button 
available from the explorer.

Favorites Explorer
For quick access, you can mark any report, query, parameter, dashboard, or dashboard 
widget as a favorite. Anything you mark as a favorite will be listed in the Favorites Explorer. 
However, objects listed in the Favorites Explorer cannot be organized into categories. 

Any action that you can perform on an object from its own explorer can also be done to it 
from the Favorites Explorer too. For example, a report can be run, saved, and published 
from the Report Explorer. If you have marked the report as a Favorite, you can run, save, 
and publish it from the Favorites Explorer too.

See the section on List of Buttons in the Explorers for an explanation of each button 
available from the explorer.
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List of Buttons in the Explorers
The following table lists all buttons that are available in the button bars in the various 
explorers. Not all buttons will be available from all explorers. The buttons will appear only 
when you click on the object. For instance, if you click on a report in the Reports pane of 
an explorer, all report-related buttons will appear in the button bar to the right of the 
Reports pane.:

Buttons
Available in 
Explorer...

Used for...

All Explorers Add to Favorites

Any category, report, query, or parameter 
can be marked as a favorite. The Favorites 
Explorer lists all objects marked as favorites.

Favorites Explorer Delete From Favorites

Any object that appears in the Favorites 
folder can be removed from there by clicking 
this button.

Category Explorer

Parameter Explorer

Create Parameter Object

A new parameter can be created by clicking 
on this button. New parameters can be 
created from within the Category Explorer or 
the Parameter Explorer.

Category Explorer

Query Explorer

Create Query Object

A new query can be created by clicking on 
this button. New queries can be created from 
within the Category Explorer or the Query 
Explorer.

All Explorers Delete

Use this button to delete an object.

All Explorers Refresh

Use this button to refresh an Explorer page.

All Explorers Properties

Use this button to view object properties 
such as report properties, query properties, 
or parameter properties.

Category Explorer

Reports Explorer

Query Explorer

Advanced Properties

Category Explorer

Parameter Explorer

Query Explorer

Edit <Object> Details

Object can be a query, parameter or a 
dashboard widget

In the case of reports, it stands for 
Customize Reports

All Explorers Copy <Object>

Object can be a report, query, parameter, 
dashboard, or a dashboard widget
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All Explorers Cut <Object>

Object can be a report, query, parameter, 
dashboard, or a dashboard widget

Category Explorer

Report Explorer

Favorites Explorer 

Quick Run with Default Options

Runs the report using default data filtering 
configuration, which was set at report deploy 
time.

Provides options to change start and end 
time parameters, storage groups, and 
devices included in the scope of the report 
run.

See also “To run and view a report” on 
page 279 and “Quick Run with default 
options / Run In Background Report 
Parameters” on page 279

Category Explorer

Report Explorer

Favorites Explorer 

Run in Background

Use this option to run reports that take long 
time to generate or the ones that are not 
required online immediately. 

See also “To run and view a report” on 
page 279 and “Quick Run with default 
options / Run In Background Report 
Parameters” on page 279

Category Explorer

Report Explorer

Favorites Explorer 

Run Report

Provides options to modify the data filter 
criteria used by the report query for this run.

You can specify a maximum number of rows 
to include in the report, and perform various 
comparison and logical operations on event 
fields.

See also “To run and view a report” on 
page 279 and “Run Report Parameters” on 
page 282.

Parameter Explorer

Category Explorer

Favorites Explorer 

Parameter Value Groups

Category Explorer

Report Explorer

Favorites Explorer 

Open Listing Page

This button opens a page which displays 
reports (Adhoc reports, standard report and 
linked reports). You can view list of reports 
under selected category and take actions on 
a selected report. The complete path where 
report resides is shown in Report Listing.

Category Explorer

Report Explorer

Favorites Explorer 

Copy Report as Link

Buttons
Available in 
Explorer...

Used for...
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Categories
Reports, queries, and parameters can be organized and stored under categories for ease of 
access. You can create your own categories or edit the existing categories’ properties by 
clicking on the Report Categories link in the left pane of the Reports Home page.

System Defined Categories
The following categories are system-defined (pre-defined) and ready for use. They are 
based on common areas of use.

 Anti-Virus

 Configuration Monitoring

 Cross Device

Category Explorer

Report Explorer

Favorites Explorer 

Customize Report

Category Explorer

Report Explorer

Favorites Explorer 

Download Report

Category Explorer

Report Explorer

Favorites Explorer 

List Published Output

Click List Published Output to view the list of 
published outputs of this report. The list page 
also displays the user name who generated 
(published) the report, time and expiry time 
of the report. From this page, you can view 
report output as well as user comments on 
the report.

Category Explorer

Report Explorer

Favorites Explorer 

View Descriptions

Category Explorer

Report Explorer

Favorites Explorer 

Create Dashboard Widget

Category Explorer

Favorites Explorer 

View Dashboard

Buttons
Available in 
Explorer...

Used for...
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 Database

 Default Reports

 Firewall

 Identity Management

 IDS-IPS

 Intrusion Monitoring

 Network

 Network Monitoring

 Operating System

 SANS Top 5

 VPN

Anti-Virus
Use this category to store reports, queries, parameters, dashboards, and dashboard 
widgets that provide information on anti-virus activity, such as the anti-virus update status, 
virus activity by hour, and top infected systems.

For a complete list of reports, click the Anti-Virus category under Reports column in the 
Report Explorer.

Configuration Monitoring
Logger provides reports that address configuration monitoring. To access these reports, 
click the Configuration Monitoring category in the Reports column in the Reports 
Explorer.

For information how to run, view, and publish these reports, see “Running, Viewing, and 
Publishing Reports” on page 276.

Cross Device Reports
These reports provide information on functions that apply to multiple kinds of devices, such 
as failed login attempts, bandwidth usage by hosts, and accounts created by user, and so 
on. 

For a complete list of reports, click the Cross Device category under the Reports column 
in the Reports Explorer.

Database Reports
These reports provide information on database errors and warnings.

Default Reports
The user generated reports are placed in this category.

Firewall Reports
These reports provide information on firewall activity, such as denied connections by port, 
address, and hour. 

Identity Management Reports
This report provides information on the number of connections per user as reported by the 
Identity Management devices in your network. 
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IDS-IPS Reports
These reports provides information on activity involving Intrusion Detection and Prevention 
Systems, such as alert count by device, port, severity, top alert destinations, worm infected 
systems, and so on. 

Intrusion Monitoring Reports
Logger provides reports that address intrusion monitoring. To access these reports, click 
the Reports Explorer link and click the Intrusion Monitoring category in the Reports 
column.

For example, reports are provided to track password changes, firewall configuration events, 
firewall traffic, top attackers traversing firewalls, and so forth.

For information how to run, view, and publish these reports, see “Running, Viewing, and 
Publishing Reports” on page 276.

Network Reports
These reports provide information on activity involving network infrastructure, including 
interface status, device errors, SNMP authentication failures, and so on. 

Network Monitoring Reports
Network Monitoring reports describe activities on Virtual Private Networks:

 Top VPN Accesses by User

 Top VPN Event Destinations and Sources

 Top VPN Events

 VPN Connection Attempts

 VPN Connection Failures

Operating System Reports
These reports provide information on activity involving operating systems, such as login 
errors per user, user and user group creation and modification events. 

SANS Top 5 Reports
Logger provides reports that address the “SANS Top 5 log reports” scenarios, all pre-built 
and available to run on-demand or schedule for a specified frequency. To access these 
reports, click the Report Explorer link in the left panel and click on SANS Top 5 category 
under the Reports column.

For information on how to run, view, and publish these reports, see “Running, Viewing, and 
Publishing Reports” on page 276.

The SANS Institute is a cooperative training, certification, and research organization with a 
focus on developing solutions for securing information against a variety of potential 
threats. SANS facilitates and supports a collaborative effort of a large number of security 
practitioners in various industries and sectors around the world to share experience, 
solutions, and resources related to information security. (“SANS” stands for “SysAdmin, 
Audit, Network, Security”; more information is available on their Web site at 
http://www.sans.org/.)

The “SANS Top 5” represents the current set of “most critical” log reports for a wide cross-
section of the security community.
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Here is a quote from the SANS Web site about the strategy and focus of the “SANS Top 5 
Essential Log Reports”:

“The goal is to include reports that have the highest likelihood of identifying suspect 
activity, while generating the lowest number of false positive report entries. The log 
reports may not always clearly indicate the extent of an intrusion, but will at least give 
sufficient information to the appropriate administrator that suspect activity has been 
detected and requires further investigation.”

The “SANS top 5” log reports cover the following five scenarios:

 Attempts to gain access through existing accounts

 Failed file or resource access attempts

 Unauthorized changes to users, groups and services

 Systems most vulnerable to attack

 Suspicious or unauthorized network traffic patterns

For a complete description of the SANS Top 5 log reports, see 
http://www.sans.org/resources/top5_logreports.pdf or look for associated topics in SANS 
“resources” on their Web site.

The Logger “SANS Top 5 Reports” offered to address these threat scenarios are:

 SANS Top 5 - 1 Number of Failed Logins

 SANS Top 5 - 1 Top Users with Failed Logins

 SANS Top 5 - 2 Failed Resource Access by Users and Drilldown

 SANS Top 5 - 2 Failed Resource Access Events and Drilldown

 SANS Top 5 - 3 Password Changes

 SANS Top 5 - 3 User Account Creations, Deletions, and Modifications

 SANS Top 5 - 4 Vulnerability Scanner Logs by Host or by Vulnerability

 SANS Top 5 - 5 Alerts from IDS

 SANS Top 5 - 5 IDS Signature Destinations and Source

 SANS Top 5 - 5 Top 10 Talkers

 SANS Top 5 - 5 Top 10 Types of Traffic

 SANS Top 5 - 5 Top Destination and Target IPs

VPN Reports
These reports provide information on activity involving VPN connections, including 
authentication errors, connection information such as counts, accepted and denied by 
address, and so on. 

The SANS Top 5 list is meant to be reviewed on a regular basis. ArcSight can 
send updates for customers to deploy as new reports are required to meet 
new challenges presented by the dynamic threat-security environment in 
which networks are deployed.

More Reports may be available for download as report packages on the 
Customer Support Web site. (For information about deploying report 
packages, see “Deploying a Report Bundle” on page 337.)
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Solution Reports
If any solution packages are installed on the Logger, they appear under this report group. 
Solution packages address specific compliance requirements or scenarios and are installed 
separately. Solutions Reports are available as add-on packages to Logger for specific 
compliance requirements or scenarios.

For information on deploying Solutions Packages, see “Deploying a Report Bundle” on 
page 337. Once deployed, these solution reports are listed in categories under the Solution 
Reports report group. To access these reports (once they are deployed), click Reports | 
Solutions Reports | <report category name> on the left menu, where <report category 
name> is the solution name, for example: PCI. 

Adding a New Category
The Category Explorer comes with some system defined commonly used categories. 

You can add a custom defined category too. To do so:

1 Click the Report Categories link under the Administration heading in the left pane.

2 Click the Add New Category  button located on top of the box that displays all 
existing categories.

3 Define the properties for the new category and click the Save button.

More Solution Reports may be available for download as report packages on 
the Customer Support Web site. (For information about deploying report 
packages, see “Deploying a Report Bundle” on page 337.)

Property Used for...

Public Setting this as Public makes the category available 
to everyone

Private Setting this as Private make the category available 
to you only

Hidden Check the Hidden checkbox, if you do not want to 
display this category in any of the dialogs and pages 
(except in the Reports Explorer). Mark a category as 
hidden to stop users from directly accessing the 
objects and reports stored in it.

Category Menu Name Name of the Category
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4 You can optionally add a report to that category. To do so, double-click any category to 

open it and click the Add New Report  button. Define the following properties in 
the Properties box:

Category ID Category ID should be unique across all the 
categories. By default, the Category ID is auto-
generated by the system. To specify the Category ID 
manually, uncheck the System Generated checkbox 
and specify the category ID.

System Generated To specify the Category ID manually, uncheck the 
System Generated checkbox and specify the 
category ID.

Delete Cascade You can delete a category only if it is empty. To delete 
a category including its contents, check the Delete 
Cascade checkbox.

Once set, Category ID and scope (Public / Private options) cannot be 
changed.

Property Used for...

Public Setting this as Public makes the report available to 
everyone

Private Setting this as Private make the report available to you only

Hidden Check the Hidden checkbox, if you do not want to display 
this report in any of the dialogs and pages (except in the 
Reports Explorer). Mark a report as hidden to stop users 
from directly accessing it.

Report File An existing data file from which a report is generated

Report Name The Report Name has to be unique within a category

Report ID A unique ID for the report that is auto-generated by the 
system by default when you run and publish the report. To 
manually enter an ID of your choice, uncheck the System 
Generated checkbox and enter an ID in the Report ID field.

Design Mode Text in Design Mode indicates if the report was designed 
using Studio (Web Studio or Desktop Studio) or Adhoc 
Report Wizard.

Deployment Type A report deployed as Read Only cannot be modified and 
uploaded with same name. A report deployed as Custom can 
be modified and uploaded with the same name.

Output Format Output Formats in which this report can be generated. 
Formats not selected here will not be available for this 
report.

System 
Generated

To specify a Report ID manually, uncheck the System 
Generated checkbox and specify the Report ID.

Property Used for...
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Deleting an Existing Category
You can delete a category only if it is empty. To delete an empty category, select the 

category in the Category Explorer and click the Delete  button in the vertical button 
bar to delete the selected category.

To delete a category including its contents, click the Report Categories link in the left 
pane, select the category, check the Delete Cascade checkbox and click the Delete 

Selected Category  button.

Placing a System Defined Query or Parameter into a 
Category

You can place a pre-defined query or parameter into a category. Use the cut/paste feature 
to do so because cutting and pasting it will preserve its ID. To cut and paste a 
query/parameter:

1 Click the Query Explorer or Parameter Explorer link (depending on what you want 
to place in the category) in the left pane.

1 Click on the pre-defined query/parameter you want to move.

2 Click the Cut Query Object/Cut Parameter Object  button on the side button 
bar.

3 Click the category name under which you would like to place this query/parameter.

4 Click the Paste  button on the side button bar.

You can schedule any report to run once at a later date or on a specified frequency (such 
as daily or weekly). Monthly reports cannot be scheduled currently. For more on this, see 
“Scheduling Reports” on page 334.

You can run, publish, and save the results of any type of report. For information on these 
common reporting tasks available on all reports, see “Running, Viewing, and Publishing 
Reports” on page 276 and “Task Options on Available Reports” on page 278.)

Dashboards
Dashboards display reporting data to provide a quick view of the latest information about 
network events. You can assemble various reports and external links onto a dashboard. 
However, you must place each report or link into its own widget and then place the widget 
in the dashboard. A dashboard can contain multiple widgets.

 If you attempt to delete a category that is not empty, and Delete Cascade 
check box is clear, a message "Failed to delete the category" will appear on top 
left of the page.

Do not copy and paste a query or parameter to place it in a category. Doing 
so will give the query/parameter a new ID and render it unusable to reports 
or other existing objects that are using it.
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Placing reports on a dashboard gives you access to the most recently published results for 
those reports. Keep in mind, reports must be run and published in order for the results to 
be accessible on a dashboard viewer. If you schedule a report to run, publish, and save for 
a reasonable retention period (for example, one month), then those results will always be 
available for dashboard views.

For example, you can add one or more reports to a dashboard, and configure reports to 
auto-refresh (get results) on a specified interval (for example, every hour). The dashboard 
will access the latest published reports results, in this case, every hour. If you have also 
scheduled the reports to run and publish every hour, your dashboard will get up-to-date 
results. This eliminates the need to manually run and view each report once per hour in 
order to get the same information updates. 

The general steps to get started with using dashboards are as follows:

1 Create a new dashboard. See “Creating a New Dashboard” on page 259 for details on 
this.

2 Create one widget for every report or web link you want to display on the dashboard. 
See “Creating a new widget” on page 263 for details on this.

3 Add the widgets to the dashboard. See “Placing Widgets in a Dashboard” on page 266 
for more details on this.

4 Optionally, you can configure the dashboard to appear as a tab in the Dashboard 
Viewer. See “Viewing an Existing Dashboard in a Tab in the Dashboard Viewer” on 
page 261 for more details on this.

Viewing the Dashboard
The Dashboard Viewer is the home page for Reports. If no dashboard is configured and 
selected for display, the default Reports home page shows an empty Dashboard Viewer. If 
a dashboard is configured and selected for display, it is shown on the Dashboard Viewer 
page, and serves as the Reports Home page. If you are viewing other pages within the 
Reports tab, click Dashboard on the left panel to return to the Dashboard Viewer (Reports 
Home page).

The Dashboard Viewer page displays the various items placed on the dashboard. If the 
dashboard includes reports, reports will show current data from recently run reports.

To view or edit Dashboards created in pre-v5.2 Logger releases see “Using 
Dashboards created in pre-v5.2 Logger” on page 266.
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Figure 6-1 Dashboard View with Health Monitor and Reports

Designing Dashboards
Use the Dashboard Viewer page to create a new dashboard, name it, add items to it, 
and design the layout. You can design and save multiple dashboards, but only one at a 
time can be set as the default Dashboard Viewer for the Reports home page. Other 
dashboards can be saved for later use. Each dashboard can include multiple items (reports, 
use cases, and Web links).

To access the Dashboard Viewer, click the Dashboard link in the left pane.

What items can a dashboard include?
The following information is available for placement on a dashboard. However, each report 
or Web Link must be placed inside a widget and the widget in turn gets placed into the 
dashboard. A dashboard can contain one or more widgets containing either of the 
following:

 Reports; any report can be included. The dashboard will show the latest published 
version of the report. Reports must be published in order for the report data to be 
accessible to users on the Dashboard View. If no published results are available for a 
report on a dashboard, the Dashboard View will display a message indicating this. 
When the report is published, a refresh of the Dashboard view will display the report.

 External Links; that is, any URL(s) that you want on-screen as a part of a particular 
Dashboard View

Creating a New Dashboard
The high-level steps to create a dashboard are described here. A detailed explanation of 
each of these steps is provided in the topics that follow. The Reports home page opens 
with the Dashboard Viewer open. To add a new dashboard:

1 Click the New Dashboard  button located on the extreme right on any 
Dashboard tab.

This opens a new empty dashboard tab with the name “Untitled”. 

Reports must be run and published first in order for the results to be 
accessible on a dashboard viewer. There are no options available to run 
reports from the Dashboard Viewer. You can only view saved or published 
reports.

You can set a dashboard to auto-refresh at a certain interval, but auto-
refreshing a dashboard simply updates the dashboard display with the most 
recently published results; it does not run the report. We suggest using the 
dashboard refresh interval in conjunction with scheduled reports to ensure 
that report results are always published and retained long enough to be 
available to dashboards. For more information, see “Designing Dashboards” 
on page 259 and “Scheduling Reports” on page 334.

To run a report manually, click the Report Explorer in the left pane, click the 
category in which the report is stored, select the report and click the Run 
Report, Quick Run with Default Options, or Run in Background button. For 
more information on running and publishing reports, see “Running, Viewing, 
and Publishing Reports” on page 276.
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2 To place items onto the dashboard, add widgets by clicking the Add Widget  
button located in the upper right corner. Select a widget and click-and-drag it onto the 
dashboard.

3 For each item (widget) placed, specify Widget Properties, as needed.

4 Click Save to save the dashboard.

Dashboard Buttons
The Dashboard Properties are described in the following table.

Table 6-1 Dashboard Properties Description

By default, a scroll bar is not available in the Dashboard for external links. To 
include a scroll bar, set the “Show Scrollbar” property to “Yes” in the Widget 
Properties section of “External Links” under Dashboard Items. 

Once saved, new dashboards become available in the Dashboard 
Preferences list of “Available Dashboard(s)”.

See “Dashboards” on page 257 for information on how to display the new 
dashboard you just created or set the default display to a different 
dashboard.

Button Description

Adds a new Widget

Opens up a page to edit the dashboard properties

Full screen view. Shows the dashboard in a separate 
detached window.

Opens a new empty tab in the Dashboard Viewer where you 
can create a new dashboard.

Refresh Now. Refreshes the dashboard

Remove tab. Dashboards are displayed in tabs in the 
Dashboard Viewer. Clicking this button will delete a tab 
from the Dashboard Viewer but will not delete it from its 
saved location. But if you check the “Remove this 
dashboard from saved location” checkbox it will delete the 
Dashboard from the saved location too in addition to 
removing the dashboards tab from the Dashboard Viewer.

Save Dashboard. Saves an existing dashboard that has 
been modified.
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Viewing an Existing Dashboard in a Tab in the Dashboard 
Viewer

You can open multiple dashboards as tabs in the Dashboard Viewer. To do so:

1 Click the Dashboard Preferences link on top of the Dashboard Viewer page.

2 In the Available Dashboards box, navigate to the dashboard that you want to display 
in a tab.

3 Click the right-facing arrow  in between the two boxes. The dashboard name 
appears in the Selected Dashboard box.

4 Click the Save button.

5 Click the Dashboard link in the left panel to display the Dashboard Viewer. You should 
now see a tab displaying the dashboard you selected.

Save Dashboard As. Saves the dashboard in your specified 
location.

Subscribe Dashboard

The set or subset of dashboards shown under Available Dashboard(s) is 
based on your user group status and the selection status of Show All 
Owners' checkbox.

For example, it is likely that a user with Administrative status will be able 
to see more or all dashboards than a user with fewer privileges.

Also, if you limit the view to only your dashboards, the list will not include 
dashboards designed by other users.

• To access dashboards from all the users (designers), click 
(checkmark) the Show All Owners' checkbox.

• To view only your dashboards, click (uncheck) this checkbox.

Button Description
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Removing an Existing Tab from the Dashboard Viewer
To remove an existing tab from the Dashboard Viewer without deleting the dashboard from 

its saved location, click the Remove Tab  button on the far right of the tab.

To remove an existing tab from the Dashboard Viewer and delete the dashboard from its 

saved location, click the Remove Tab  button on the far right of the tab. In the 
Remove Tab dialog, check the Remove this dashboard from saved location checkbox 
and click OK.

Deleting a Dashboard
You can delete an existing dashboard from the Category Explorer or from the Dashboard 
Viewer.

To delete it from the Category Explorer, click on Dashboards in the Repository column 

then click on the dashboard to select it and click the Delete  button.

To delete the dashboard from the Dashboard Viewer, click the Remove Tab  button on 
the far right of the tab. In the Remove Tab dialog, check the Remove this dashboard 
from saved location checkbox and click OK.

Editing an existing Dashboard

To modify an existing dashboard, click the Edit Dashboard  button in the Dashboard 
Viewer page. Its current configuration is displayed in the Properties, Layout and 
Information area, and you can modify then save settings as needed.

To auto-refresh a dashboard at a regular interval, check the Auto-refresh every check-
box and specify time in terms of minutes in Min(s). This will automatically refresh the 
dashboard after the set number of minutes. Check the Prompt on First Run checkbox to 
display the Input Parameter Form which shows the values of the Dashboard parameters 
before reports are run from the dashboard for the first time after they have been displayed 
on the dashboard. 

The Layout area allows you to select number of panes you want the dashboard to have.

The Information area displays Description, Scope and Location where the dashboard is 
saved.
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Selecting a default Dashboard View for the Reports home 
page

If you have multiple dashboards open in tabs in the Dashboard Viewer, you can set one of 
the dashboards to display as the default dashboard for the Reports home page. To do so:

1 Click the Dashboard Preferences link on top of the Dashboard Viewer page.

2 In the Selected Dashboards box, click the radio button against the dashboard that you 
would like to display as the default dashboard in the Reports home page. Click the up 
arrow (possibly multiple times) until that dashboard shows up at the top of the list.

3 Click the Save button.

4 Click the Dashboard link in the left pane and your selected dashboard will show as the 
default tab (the first tab).

The Dashboard Preferences page has the following fields:

Widgets
After a new dashboard is created, you will need to add one or more widgets to it to get it 
to display your reports or web links. Each dashboard item must be placed in its own widget 
for display on the dashboard. A widget is designed in the Widget Designer. A widget can be 
placed on multiple dashboards.

The Widget Designer
Clicking on the Widget Designer link located above the Dashboard Viewer opens the 
Widget Designer page. The Widget Designer allows you to create a new widget, save a 
widget, edit a widget, or delete a widget. You can place a report or a web link (an external 
link) into a widget. Each widget can contain only one object.

Creating a new widget
To create a new widget, click the Widget Designer link located above the Dashboard 
Viewer. On the Widget Designer page, you can choose what you want to place in the 
widget, a report or a web link.

Field Description

Show All Owners’ To display all dashboards made by all the users in the 
Available Dashboard(s) box, check the Show All Owners' 
checkbox

Available Dashboards This box shows a list of all dashboards that are available for 
display in the Dashboard Viewer

Selected Dashboards Move the dashboards you want to display in the Dashboard 
Viewer from the Available Dashboards list to the Selected 
Dashboards box. Dashboards appearing in this box will be 
displayed as tabs in the Dashboard Viewer
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Placing a Report

If you choose to place a Report, keep in mind that you can only add reports that have 
already been run and published. 

To get last published instance of: 

 A report: You need not make any selection in the Report field, By Job or In Category. 

 A specific report: Navigate to the report in the Report field. You can leave the By Job 
and In Category fields blank. 

 A report executed by a specific job: Navigate to the job in the By Job field. You can 
leave the Report field and the In Category field blank. 

 A report deployed in a specific category and executed by a specific job: From the In 
Category field, navigate to a category and navigate to a job in the By Job field. 

 Any of the reports from the jobs you own: You own the jobs that you created or were 
created on your behalf. Check the Look in User's All Jobs checkbox. 

 Any of the reports deployed in your default category: Check the User's Working 
Folder checkbox.

You will need to specify the following widget properties for a report.

Keep in mind that there are no options available to run reports from a 
Dashboard view; only to view results of previously saved, published reports. 
A refresh or auto-refresh on a dashboard simply updates the dashboard 
display with the most recently published results; it does not run the report.

Therefore, reports on dashboards must be run, saved, and published in order 
for the report data to be viewable on the Dashboard view.

If a report on a dashboard has not been saved or published, its widget will 
display an error message on the Dashboard view the report data is not 
available to the dashboard.

Label Description

Widget Name Enter a name for the new widget to be created

Report Format Select the format in which you would like the report displayed.

Toolbar Select whether you want a toolbar displayed and whether you want 
it displayed on all pages if this is a multi-page report.
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Placing a Web Link
Click the Web Link radio button on the Widget Designer page to place a web link in the 
widget. You will need to specify the following properties:

Instance 
Navigation

Sets whether to include a report navigation feature on the 
dashboard.

• Click Yes to provide a drop-down menu that allows Dashboard 
users to select a saved report and view it.

• Click No if you do not want to provide this feature on the 
dashboard.

Auto Refresh Set it to yes, if you want the report to refresh automatically after a 
certain interval. You must set the Refresh Interval parameter if you 
set Auto Refresh to Yes.

Refresh 
Interval

This is the time in minutes. Refresh will take place at the end of 
specified number of minutes. For example, if you want the report 
results to refresh every 15 minutes, set the Refresh Interval to 15.

Width Select the width of the widget in pixels. You can select only whole 
numbers (no decimals allowed)

Height Select the height of the widget in pixels. You can select only whole 
numbers (no decimals allowed)

Label Description

URL Specify the URL for the external link of the page that you want to 
display in the widget

Show Scrollbar Select whether you want a scroll bar in the widget. By default the 
scrollbar is visible.

Auto Refresh By default the web page will be automatically refreshed. Select No if 
you want to turn this feature off.

Refresh 
Interval

This is the time in minutes. Refresh will take place at the end of 
specified number of minutes. For example, if you want the web page 
to refresh every 15 minutes, set the Refresh Interval to 15.

Width Select the width of the widget in pixels. You can select only whole 
numbers (no decimals allowed)

Height Select the height of the widget in pixels. You can select only whole 
numbers (no decimals allowed)

Label Description
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Deleting a Widget
To delete a widget, open the widget in the Widget Designer and click the Delete button on 
top of the Widget Designer page. When a dashboard uses a widget that is deleted, an error 
message will be displayed in that widget of the dashboard, which will keep the user 
informed that the widget has been deleted.

Editing an Existing Widget
Click the Widget Designer link to open it. Click the Open button on top of the Widget 
Designer page and select the widget that you want to edit. After editing it, click the Save 
button.

Placing Widgets in a Dashboard
Reports and Web Link (external link) objects are available to be placed on a dashboard. 
However, these objects must first be placed in a widget and then the widget can be added 
to the dashboard.

1 Click the Add Widget  button on the upper right corner of the empty dashboard 
page.

2 Navigate to the widget you want to place on the dashboard and click-and-drag it to the 
dashboard.

3 Continue to add more widgets by following the above two steps.

Moving an Existing Widget within a Dashboard
To move an existing widget on a dashboard, hover your mouse over the top boundary of 
the widget. The widget name bar will drop down. Click the widget name bar and drag it to 
move the widget to the desired location on the dashboard.

Using Dashboards created in pre-v5.2 Logger

Viewing the Dashboard
To view the dashboard, click the Classic Viewer link on top of the Reports page. If no 
dashboard is configured and selected for display, the default Reports home page shows the 
My Reports page that lists the status of recently run or accessed reports. 

• This section is applicable to existing pre-v5.2 dashboards only. To create, 
edit or view new dashboards, follow the instructions in “Dashboards” on 
page 257.

• The ability to use and edit the pre-v5.2 Dashboards is available for 
backward compatibility only.
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The Classic Viewer page displays the contents of various items placed on the dashboard 
during the dashboard’s design time. If the dashboard includes reports, reports will show 
current data from recently run reports.

Designing Dashboards
Use the Classic Designer page to edit the dashboard and add items to it, and change the 
layout. Each dashboard can include multiple items (reports, use cases, and Web links).

What items can a dashboard include?
The following information is available for placement on a dashboard:

 Reports; any report can be included. The dashboard will show the latest published 
version of the report. Reports must be published in order for the report data to be 
accessible to users on the Dashboard View. If no published results are available for a 
report on a dashboard, the Dashboard View will display a message indicating this. 
When the report is published, a refresh of the Dashboard view will display the report.

 Common Use Cases, including a Report List, Saved Report List, Health Monitor, 
Recent Run Report List, Quick Job List, Schedule History, and Audit Log.

These are provided as dashboard elements so that users access a use case without 
leaving the Dashboard View page.

 External Links; that is, any URL(s) that you want on-screen as a part of a particular 
Dashboard View

Creating a New Dashboard
Do not use the Classic Designer page to create new dashboards. New dashboards should 
be created using the Dashboard Viewer link. See “Dashboards” on page 257 for more 
information.

Placing items onto the existing dashboard 
To place an item on the dashboard click the Classic Preferences link. In the Widgets 
provided in the Layout area, click-and-drag an item from the Dashboard Items list on the 

left into an empty widget to the right. Alternatively, click  next to the dashboard item 
you want to place the item on an empty widget.

You can also click-and-drag an item onto a currently occupied widget if you want to 
replace an item in a widget with a different one.

Reports must be run and published first in order for the results to be 
accessible on a dashboard view. There are no options available to run reports 
from the Dashboard view. On a Dashboard view, you can view saved or 
published reports but not run them.

A refresh or auto-refresh on a dashboard simply updates the dashboard 
display with the most recently published results; it does not run the report. 
We suggest using the dashboard refresh interval in conjunction with 
scheduled reports to ensure that report results are always published and 
retained long enough to be available to dashboards.

To get a new widget, click  (Divide Widget Horizontally) or  (Divide 
Widget Vertically) on a widget to split it into two widgets. The original 
widget remains a new empty widget is placed on the dashboard layout.
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For each item (widget) placed, specify Widget Properties, as needed.

Dashboard Properties

Figure 6-2 Reports Dashboard Properties

The Dashboard Properties are described in the following table.

Table 6-2 Dashboard Properties Description

Creating Widgets
Each dashboard item must be placed in its own widget for display on the dashboard. 
Create a new widget using the Widget Designer link.

To get a new widget

To get a new widget, click  (Divide Widget Horizontally) or  (Divide Widget Vertically) 
on a widget to split it into two widgets. The original widget remains a new empty widget is 
placed on the dashboard layout.

To remove a widget

To remove a widget, click the Remove Widget button located on the top right corner on the 
widget you want to remove. 

Placing Dashboard Items on the Layout
Click the Classic Designer link on the Reports page. Reports, use cases, and external link 
objects are available under “Dashboard Items” (to the left of the Layout area).

Figure 6-3 Dashboard Items

To place a dashboard item, click to expand the menu for the type of item you want, click-
and-drag an item onto a widget in the Layout area, and specify widget properties as 

By default, a scroll bar is not available in the Dashboard for external links. To 
include a scroll bar, set the “Show Scrollbar” property to “Yes” in the Widget 
Properties section of “External Links” under Dashboard Items. 

Property Description

Name Name of the dashboard.

Description Descriptive information about this dashboard.
268 Administrator’s Guide Confidential



6 Reporting
needed. (Widget properties vary depending on the type of item you place on the 
dashboard.)

The following sections provide more detail on placing each type of dashboard item and 
setting appropriate widget properties.

Placing a Report on a Dashboard
The following sections describe in detail how to place and configure reports on dashboards, 
including setting widget properties, report parameters, and dashboard parameters.

To place a report on a dashboard:

1 Under Dashboard Items, click Reports bar to expand the list of available reports.

Figure 6-4 Reports under Dashboard Items

2 If available, select a Reports submenu such as User Reports, Solution Reports, 
and so forth.

Different reports are displayed depending on the submenu you select.

3 Optionally, check (select) Saved Reports checkbox to get a list of saved reports.

4 Select a category to view reports deployed in that category.

5 Click and drag the report to the widget in which you want to place the report. 

Alternatively, click  next to the dashboard item you want to place the item on an 
empty widget.

The report name is displayed in the widget in the Layout area.

6 Set Widget Properties for the report. (See “Widget Properties for Reports” on 
page 270.)

Keep in mind that there are no options available to run reports from a 
Dashboard view; only to view results of previously saved, published reports. 
A refresh or auto-refresh on a dashboard simply updates the dashboard 
display with the most recently published results; it does not run the report.

Therefore, reports on dashboards must be run, saved, and published in order 
for the report data to be viewable on the Dashboard view.

If a report on a dashboard has not been saved or published, its widget will 
display an error message on the Dashboard view the report data is not 
available to the dashboard.
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Widget Properties for Reports

Figure 6-5 Widget Properties for Reports on a Dashboard

The following table describes Widget Properties settings for Reports dashboard items.

Table 6-3 Widget Properties for Reports on a Dashboard

By default, a scroll bar is not available in the Dashboard for external links. To 
include a scroll bar, set the “Show Scrollbar” property to “Yes” in the Widget 
Properties section of “External Links” under Dashboard Items. 

Property Description

Report Name The name of report that occupies this widget.

Refresh Interval (in 
minutes)

This is the time in minutes. Refresh will take place at the 
end of specified number of minutes. For example, if you 
want the report results to refresh every 15 minutes, set the 
Refresh Interval to 15.

Note: Reports must be run and published first in order for 
the results to be accessible on a dashboard view. A refresh 
or auto-refresh on a dashboard simply updates the 
dashboard display with the most recently published results; 
it does not run the report. We suggest using the dashboard 
refresh interval in conjunction with scheduled reports to 
ensure that report results are always published and 
retained long enough to be available to dashboards. (See 
also, “Scheduling Reports” on page 334.)

Format Select the output format in which you want to view the 
report. Available options are:

• HTML

• Acrobat PDF

• Interactive
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Linking Widgets

You can link a widget that contains a report (although, not saved reports) to another 
widget. The widget that is the link target can contain a use case, a report, or external link.

Auto Refresh Enables or disables auto-refresh option.

• Select Yes to refresh the reports as per Refresh 
Interval.

• Select No to view the report generated when dashboard 
was loaded for the first time.

Note: Reports must be run and published first in order for 
the results to be accessible on a dashboard view. A refresh 
or auto-refresh on a dashboard simply updates the 
dashboard display with the most recently published results; 
it does not run the report. We suggest using the dashboard 
refresh interval in conjunction with scheduled reports to 
ensure that report results are always published and 
retained long enough to be available to dashboards. (See 
also, “Scheduling Reports” on page 334.)

Toolbar Specifies Toolbar settings.

• Select Yes to always show toolbar.

• Select No to never show the toolbar.

• Select Multipage to show the toolbar only for multi-
page reports. 

The Multipage setting is applicable to HTML and 
Interactive output formats.

Instance Navigation Sets whether to include a report navigation feature on the 
dashboard.

• Click Yes to provide a drop-down menu that allows 
Dashboard users to select a saved report and view it.

• Click No if you do not want to provide this feature on 
the dashboard.

Link Widgets
Click  to bring up a Link Widget dialog in which you 
can specify a link from any of the charts in the report in this 
widget to another widget.

See “Linking Widgets” on page 271.

Description Description of the widget.

Property Description
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Figure 6-6 Linking Widgets

To link a chart in a report to data in another widget

1 Select a widget in which you want to provide a link. (This widget that is the link 
“source” must contain a report with a chart on it).

2 Under Widget Properties for the selected widget, click  to bring up a Link Widgets 
dialog in which you can specify a link from any of the charts in the report to another 
widget. (The widget that is the target of the link can contain a report, use case or 
external link.)

3 In the Link Widget dialog, select an Item (chart series) from the Item(s) and select 
(link) it to an item in one of the other Widgets.

4 Click  (add button) next to “Series” to get another row to specify another set of link 
information in the same report with a different widget/series combination.

To remove a row, click  (delete button) next to the row you want to remove.

5 Click OK to save the settings and close the dialog.

Placing a Use Case on a Dashboard
The following sections describe in detail how to place and configure use cases on 
dashboards.

To place a use case on a dashboard:

1 Under Dashboard Items, click Use Cases bar to expand the list of available use cases. 

Figure 6-7 Use Cases under Dashboard Items

2 Click and drag a use case to the widget in which you want to place it. Alternatively, 

click  next to the dashboard item you want to place the item on an empty widget.

The use case name is displayed in the widget in the Layout area.

3 Set Widget Properties for the use case. (See “Widget Properties for Use Cases” on 
page 273.)
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Widget Properties for Use Cases

Figure 6-8 Widget Properties for Use Cases on a Dashboard

The following table describes Widget Properties settings for Use Case dashboard items.

Table 6-4 Widget Properties for Use Cases on a Dashboard

The use cases displayed in the list will depend on the permissions associated with your 
user group. Other properties are displayed based on the use case.

Placing an External Link on a Dashboard
The following sections describe in detail how to place and configure an external link on a 
dashboard.

Property Description

 Name The name of use case that occupies this widget.

Refresh Interval (in 
minutes)

This is the time in minutes. The use case page is refreshed 
at the specified interval.

Auto Refresh Enables or disables auto-refresh option.

• Select Yes to refresh the use case as per Refresh 
Interval.

• Select No to execute only once, when the dashboard is 
loaded.

Show Scroll Bar Select Yes to get scroll bar if use case does not fit in widget 
width.

Description Description of the widget.

Category This option appears when Report List, Saved Report List or 
Quick Job List is placed on widget. Select the category to 
carry out respective task (get a list of reports in selected 
category, get a list of saved reports or quick job lists for 
selected report).

Report This option appears when Saved Report List or Quick Job 
List is selected. Select the report for which saved report list 
or quick job list is to be viewed.
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To place a link on a dashboard:

1 Under Dashboard Items, click External Links bar to expand the list.

Figure 6-9 External Link under Dashboard Items

2 Click and drag a External Link URL object to the widget in which you want to place it. 

Alternatively, click  next to the dashboard item you want to place the item on an 
empty widget.

The External Link URL object is displayed in the widget in the Layout area.

3 Set Widget Properties for the URL. (See “Widget Properties for External Links” on 
page 274.)

Widget Properties for External Links

Figure 6-10 Widget Properties for an External Link on a Dashboard

The following table describes Widget Properties settings for External Links dashboard 
items.

Table 6-5 Widget Properties for External Links on a Dashboard

Property Description

 Name The name of use case that occupies this widget.

Refresh Interval (in 
minutes)

This is the time in minutes. The use case page is refreshed 
at the specified interval.

Auto Refresh Enables or disables auto-refresh option.

• Select Yes to refresh the URL as per Refresh Interval.

• Select No to execute only once, when the dashboard is 
loaded.

Show Scroll Bar Select Yes to get scroll bar if external link does not fit in 
widget width.

Description Description of the widget.
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Swapping Items on Widgets
You can swap items placed in widgets. To do this, click and drag the item to the widget 
where you want to place it.

Figure 6-11 Swapping Widgets on a Dashboard Design

In the above example, the Recent Run Reports List item is swapped to the position of the 
External Link URL, which is then swapped to with the Health Monitor item, which will end 
up at the top of the dashboard.

Setting pre-v5.0 Dashboard Preferences
In the Classic Preferences page, you can specify the dashboard to be made available for 
viewing.

URL Specify the URL for this widget.

If you want to add multiple Web pages to the dashboard, 
use a different widget for each URL.

Property Description
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Figure 6-12 Dashboard Preferences

Working with Available Dashboards
The set or subset of dashboards shown under Available Dashboard(s) is based on your user 
group status. For example, it is likely that a user with Administrative status will be able to 
see more or all dashboards than a user with fewer privileges.

Selecting a Dashboard View
Once you have created one or more dashboards, you can select one of them as the default 
display for the Dashboard View page, which also serves as the Reports home page.

To select a default Dashboard View for the Reports home page

1 Navigate to Dashboard > Preferences.

2 Select a dashboard from the Available Dashboard(s) list and click the right arrow 

button  to move it into the Select Dashboard(s) list for display. Only one dashboard 
can occupy the “Selected Dashboard(s)” list at any one time.

3 Click Save to save your preferences and display the selected dashboard.

To remove or change the currently displayed dashboard

1 Return to the Classic Preferences page.

2 Move the currently selected dashboard out of the Select Dashboard(s) list by selecting 

it and clicking the left arrow button .

3 Choose a different one to display if so desired (or none).

4 Click Save to save your preferences.

Running, Viewing, and Publishing Reports
Reports are deployed (made available) under their respective categories. (See “Report 
Explorer” on page 246)

You can run, view, and publish reports you create, as well as reports in categories for which 
the administrator has given you user access rights. You can run up to five reports 
concurrently on a Logger. 

You must have at least one dashboard in order to set a preference for the 
Dashboard View. 

Only one dashboard at a time can be displayed as the default dashboard 
view. You can also set a dashboard as the “Selected Dashboard” (default 
dashboard view) in the Dashboard Designer by enabling the Add to my 
preferred list, as described in Step 5 in “Creating a New Dashboard” on 
page 259.

There are no options available to run reports from a Dashboard viewer. On a 
Dashboard viewer, you can view saved or published reports but not run them.
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You can run, view, customize or publish reports by either of the following ways:

 clicking the Report Explorer link, clicking on a category, selecting the report and 
clicking on a desired button on the button bar. OR

 double-clicking on a category in any explorer, then selecting the report by clicking the 
radio button next to it, and then clicking on a desired button on top of the page.

Best Practices
ArcSight Logger is designed to process events while running a report, but event processing 
has priority. Running a complex report while the event processing system is under load will 
result in report timeout rather than dropped events.

ArcSight recommends using the Scheduled Report feature so that reports are run during 
periods of light load. If an ad hoc report must be run, run it when the system is not under 
load.

For information on working with scheduled reports, see “Scheduling Reports” on page 334.

If you are running a distributed report, also see the best practices discussed in “Selecting 
Device Groups, Storage Groups, Devices, or Peers” on page 281.

Finding Reports
You can find reports on the following pages within the Logger Reports tab:

 Category Explorer

 Report Explorer

 Favorites Explorer (if you have marked the Report as a Favorite)

 Scheduled Reports page (If the report you are looking for is a scheduled report and it’s 
been run and published)

 Recent Reports link on top of any Reports page.

Viewing Recently Run Reports
To view the most recently run reports click the Recent Reports link on top of the Reports 
page.

The Recent Reports box shows you the reports that were most recently run. You can click 

on the radio button next to a report to select it. The Run  and the Re-Run  
buttons appear on the top left corner. You can run the selected report using the same filter 
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options as the original run by clicking on the Run button or you can run the selected report 
using different field values by clicking on the Re-Run button. See “Run Report Parameters” 
on page 282 for details.

Task Options on Available Reports
The following task options are provided for reports in all categories.

See “List of Buttons in the Explorers” on page 249 for buttons that represent various 
actions that can be done on Reports.

The following sections describe details of running and viewing reports, setting report 
parameters on a “Quick Run”, “Run in Background”, or “Run” of a report, and the various 
options for working with report output.

Running and Viewing Reports
To get started running and viewing reports, choose a report category in the Reports 
Explorer, and then choose a report within the category.

About the Pagination of Reports
The default view option for the report results is Multipage. If you uncheck the Multipage 
option in View Options link, your report will be formatted as a single page. ArcSight 
strongly recommends using the Multipage option for all reports. Specifically, if a 
report will result in more than 826 records, using the Multipage option will ensure that the 
generated report is not blank. By default, the reports generated in the PDF format are set 
to use the Multipage option. However, if your PDF format report is blank, ensure that the 
Multipage option is still checked for that report. 

If a report contains more columns than can be displayed horizontally across a screen using 
the default width specified in the report query, the report is paginated horizontally such 

Your access to various reports and report options (view, publish, edit, etc.) 
depends the access rights associated with your user role and Logger Report 
Group affiliation. For example; depending on your access rights, you may 
have privileges to view some reports but not others, to view but not schedule 
or publish a report, or to view and schedule but not edit a report.

Access rights to report options are configured and managed with the 
User/Groups option on the Logger System Admin page.

For more information on Logger Report Group management, see “Setting 
Access Rights on Reports” on page 302.
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that additional columns are displayed on the following pages. For example, if a report 
contains 45 columns and only 5 can be displayed on each screen, the report would be 
paginated such that Page 1 displays columns 1 through 5, Page 2 displays columns 6 
through 10, Page 3 displays columns 11 through 15, and Page 9 displays columns 40 
through 45. Consequently, if the report contained more rows than can be displayed 
vertically in one screen, the second screen of rows would be displayed starting at Page 10.

Currently, Logger limits the number of pages for horizontal pagination to 10. Consequently, 
if a report requires more than 10 pages to display all columns, complete report results may 
not be displayed. To view all columns of such reports, manually set the width of each 
column such that all columns fit in 10 or less pages in the report query (in Query Object 
Editor that can be opened by clicking the Queries link in the left pane).

To run and view a report

Reports can be run from any of the following explorers:

 Category Explorer

Click a category in the Repository column, click Reports, select a report in the Reports 
column and click either Quick run with default options, Run in Background, or Run 
Report buttons. Set the parameters and click Run Now, Run in Background, or Run 
button depending upon what type of run you chose.

 Report Explorer

Click a category in the Reports column, select a report in the next column, and click 
either Quick run with default options, Run in Background, or Run Report buttons. Set 
the parameters and click Run Now, Run in Background, or Run button depending upon 
what type of run you chose.

 Favorites Explorer (if you have marked the Report as a Favorite)

Click on a report in the Favorites column and click either Quick run with default 
options, Run in Background, or Run Report buttons. Set the parameters and click Run 
Now, Run in Background, or Run button depending upon what type of run you chose.

Note: Even if you selected Run Report initially, you can run a report in the background 
after setting the Run Report parameters.

The report output is displayed in the specified format (HTML, PDF, or other).

At this point, the results of this report generation is available as a file for viewing only 
by you. If you close the file without saving or publishing it, the results are no longer 
available.

If you want to make the results of this run available for others, publish it. To do this, 
leave the file open, click the Publish Report button available in the button bar located 
on top of the report, and follow the steps in “Publishing Reports” on page 284.

For information about other delivery options available to you at this point, see “Report 
Delivery Options” on page 285.

Quick Run with default options / Run In Background Report 
Parameters

When you click the Quick Run with default options  button or the Run in 

Background  button for a report, the report will run with the data filters specified in 
the deployed report. You still get options to select additional filters on timeframe and 
constraints—Device Groups, Storage Groups, Devices, and Peers—over which the report 
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runs. Starting with Logger v5.2, you can run a distributed report—a report that also 
includes matching events from the specified peers of a Logger. You select the peers on 
which the report should run in the Peers list, as shown in the following figure. If no peers 
are configured, the Peers list contains only the localhost IP address (127.0.0.1); however, if 
peers are configured, their IP addresses are listed.

Figure 6-13 “Quick Run with default options” / “Run in Background” Report Parameters

The following table describes Quick Run with default options with default options / Run 
in Background report parameters.

Table 6-6 “Quick Run with default options” / “Run in Background” Report Parameters

Option Description

Start Specify the starting point for the data gathering from the 
events database.

By default, the start time is specified with a dynamic data 
expression ($Now - 2h).

You can modify the dynamic expression to specify a 
different dynamic start time, or disable Dynamic and use 
the calender options to specify a fixed start time.

End Specify the ending point for the data gathering that is some 
time after the starting point.

Keep in mind that large time spans can mean large 
amounts of data, which can affect system performance.

By default, the end time is specified with a dynamic data 
expression ($Now).

You can modify the dynamic expression to specify a 
different dynamic end time, or disable Dynamic and use 
the calender options to specify a fixed end time.

Scan Limit Specify the number of events to scan.

When you specify a scan limit, the number of events 
scanned for manually run reports is restricted to the 
specified limit. Doing so results in faster report generation 
and is beneficial in situations when you only want to 
process the latest N number of events in the specified time 
range instead of all the events stored in Logger. 

The scan limit is 100,000 by default. If you set the scan 
limit to 0 (zero), all events are scanned. 

This setting does not apply to the scheduled reports. 
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Selecting Device Groups, Storage Groups, Devices, or Peers
The following figure shows how to select or de-select items on Device Groups, Storage 
Groups, Devices, or Peers as a part of setting Report “Quick Run with default options” and 
“Run in Background” parameters.

Figure 6-14 Selection Model for “Quick Run with default options” or “Run in Background” 
Report Scope of Storage and Devices

 Items with a blue highlight are selected and will be included in the report query when 
the report is run.

 Items that are not highlighted are de-selected and will not be included in the report 
query.

 To select an item, click on it. To select multiple items in a list, use Ctrl-Click.

 To de-select a currently selected item, use Ctrl-Click.

 If none of the storage groups, device groups, or devices are selected, all items are 
included in the report query. However, peers must be explicitly selected to run a report 
query on them; if none of the peers are selected, the query will only run on the local 
Logger.

 The selected items in the Device Groups, the Devices lists, and Peers are ORed in the 
report query, and these items are ANDed with the other selected items such as 
Storage Groups. 

 Follow these guidelines when you run a distributed report (a report on peer Loggers):

 You can run a distributed report in the Quick Run, Run in Background, Run, or 
Scheduled Reports mode. 

Device Groups Select the device group(s) on which to run the report 
query, if any. (See “Selecting Device Groups, Storage 
Groups, Devices, or Peers” on page 281.)

Storage Groups Select the storage group(s) on which to run the report 
query. (See “Selecting Device Groups, Storage Groups, 
Devices, or Peers” on page 281.)

Devices Select the device(s) on which to run the report query. (See 
“Selecting Device Groups, Storage Groups, Devices, or 
Peers” on page 281.)

Peers Select the peer Loggers on which to run the report query. If 
no peers are configured on the Logger, this option only lists 
the localhost IP address (127.0.0.1); however, if peers are 
configured, their IP addresses are listed. (See “Selecting 
Device Groups, Storage Groups, Devices, or Peers” on 
page 281.)

Option Description
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 All Loggers on which you are running the distributed report must be running 
Logger v5.2. Peer Loggers can be of mixed form factors, that is, software and 
appliance based. 

 If peer Loggers do not have identical storage or device group names, the report 
query skips searching for events for those groups on those peers. 

 If you added custom schema fields to your Logger schema, those fields must exist 
on all peers. Otherwise, a query containing those fields will not run (when run 
across peers) and return an error. See “Adding or Importing Schema Fields” on 
page 232.

 A user needs to belong to these user groups with the listed permissions set to run 
distributed reports:

 Logger Search Group with "Search for events on remote peers" user right set 
(checked).

 Logger Rights Group with the "View registered peers" user rights set 
(checked).

 Logger Reports Group with “View, run, and schedule reports” rights set 
(checked) for specific reports or the global permission set to run all reports. 

 If a peer is unavailable when a distributed report is run, an error message is 
displayed and the report is aborted. Similarly, if a peer becomes unavailable while 
a distributed report is running, the report will continue to run and displayed; 
however, the server log will contain exceptions indicating the cause.

 Use the following best practices for optimal performance when running a 
distributed report:

 Avoid running a distributed report on a Wide Area Network (WAN) link.

 If you are running the report on a very large data set and the performance of 
the report is not optimal, reduce the size of the dataset. 

 Ensure that all fields in the report query are indexed on all peer Loggers. The 
report query will run slower on the Logger on which fields are not indexed. 

Run Report Parameters

When you click the Run Report  button for a report, you get additional options 
(beyond what you get for a Quick Run or for Run in Background) to choose a file format, 
specify pagination, and to modify the data filter criteria for only this run of the report.

If you run the report without specifying any override run-time parameters here, the report 
is generated with the defaults specified at design time for this report. You can run a report 
in the background after specifying the Run Report parameters. 

The following table describes “Run” report parameters.
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Table 6-7 Run Report Parameters

When you click Run on this first “Parameters” dialog, you then get the same dialog you get 
for a Quick Run with default option (or Run in Background) report where you can specify 
filters on timeframe and storage groups on which to run the report. (See “Quick Run with 
default options / Run In Background Report Parameters” on page 279 for details on this 
“Additional Filters” dialog. Clicking Run Now on this second dialog runs the report.

Option Description

Report Format Specify a file type or “format” option of the output, and 
toggle on or off the Multipage option to generate a report 
as a multi-page or a single-page document. By default, 
Multipage is checked.

Note: ArcSight strongly recommends using the Multipage 
option for all reports. Specifically, if a report will result in 
more than 826 records, using the Multipage option will 
ensure that the generated report is not blank. By default, 
the reports generated in the PDF format are set to use the 
Multipage option. However, if your PDF format report is 
blank, ensure that the Multipage option is still checked for 
that report. 

For descriptions of report format see “Report File Formats” 
on page 284

Select Filter Criteria Provides options to define filters, or modify default filters if 
any are already built in to the report.

The filter expression is applied when the report runs, 
narrowing the focus of the report to the specified criteria.

For example, you could set the filter criteria on a report on 
Top Password Changes to report only on password changes 
related to specified username(s) or involving specified IP 
address(es).

For details on how to create these filters (with Field, 
Criteria, and Value fields), see “Select Filter Criteria” on 
page 292 in “Designing New Reports” on page 290.

Note: Filter criteria defined at report run time applies only 
to this run of the report. Filters set in this way are not 
saved nor made available to other users. You can also set 
built-in, default filter criteria as a part of designing a report.

Template Select the template to apply to this report. The templates 
drop-down menu shows supplied templates, and any 
custom templates you may have added. These template 
define the look and feel, arrangement, orientation, and so 
on, of the report output. To include the start time, end 
time, scan limit, device group, storage group, and devices 
information (used to run a report) in a report, choose the 
“BlankWithHeader” template.

See “Applying Report Template Styles” on page 332 for 
more information on working with templates.

View Options The default view option for the report results is Multipage. If 
you uncheck the Multipage option, your report will be 
formatted as a single page. ArcSight strongly 
recommends using the Multipage option for all 
reports. You also have the option to download the report 
results as a zipped file. To do so, check the Download Zipped 
option.
Confidential Administrator’s Guide 283



6 Reporting
Report File Formats
Report file formats include:

 HTML (Web page format)

 PDF (Acrobat PDF)

 MS Excel

 Comma Separated (Delimiter separated file. The delimiter is usually a comma.)

 MS Word

 Interactive (iHTML)

 XML

For most formats, you can select Multipage option by clicking on the View Options link. 
ArcSight strongly recommends using this option for all reports. (If this option is 
checked, the report results will be formatted for a multi-page report.)

The report formats made available to you depend on access rights associated with your 
user account. (See “Setting Access Rights on Reports” on page 302 for more information.)

Some report formats require that the workstation have respective Viewers. For example, 
PDF format needs Adobe Reader.

Publishing Reports
If you publish a report after you run it (“Running and Viewing Reports” on page 278), the 
output results for that run of the report are saved for subsequent use.

To publish a report

1 In a generated report output file you get from running a report, click the Publish 

Report  button at the top of the page.

This brings up a Publish Report dialog in which to specify a file name for the report 
output, an expiration time if needed, and public or private status.

2 Specify the details with which to publish the report.

The following table describes the publish report options.

You configure scheduled reports to publish after each scheduled run. The 
publish options for scheduled reports are the same as for on-demand reports 
described here. For more about scheduled reports, see “Scheduling Reports” 
on page 334 and “Scheduling Reports” on page 334 and “Add Report Job 
Settings” on page 336.
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Table 6-8 Publish Report Settings

3 Click Publish.

For information on how to view a published report, see “Viewing the Output of a Published 
Report” on page 288.

Report Delivery Options
When you run a report from the Report Explorer (as described in “Running and Viewing 
Reports” on page 278), many options are available for delivering the generated output.

The most common next step is to publish the resulting report (described in “Publishing 
Reports” on page 284), but you can also save the report output to a file, e-mail it to other 
users, refresh the results, change the output format, and so forth. The following button are 
available from a generated Report representing various actions:

Option Description

Save In Category under which to save the report. If you specify 
a category in the preferences, you can navigate to it. If 
you had not specified a category, the published report 
will be saved in the category in which the report 
resides.

File Name Name for this report on the published reports list.

Expires on Date and time after which the report output discarded 
(and, therefore, unavailable for viewing).

If you do not want the report results to expire (keep 
always available), then leave this field blank (that is; 
do not set an “Expires on” date/time).

Report Format Format of the report

Public or Private Setting this as Public makes this report available to 
everyone.

Setting this as Private makes this report available to 
you only.

Button Description

Add Comment

Refresh Comments

Show Comments

TOC

MS Excel
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Refreshing a Report

To re-run the report and get an updated result set, click  (Refresh).

E-mailing a Report
You can send a report via e-mail as either a Web link or an attachment.

To e-mail a report

In the Report Explorer, after you run a report 

PDF

CSV

MS Word

Export

Email Report

Upload Report

First Page

Previous Page

Next Page

Last Page

Publish Report

Refresh

You can also configure these e-mail options on scheduled reports, as 
described in “Scheduling Reports” on page 334 and “Add Report Job Settings” 
on page 336.

Button Description
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1 Click the  (Email report) button on top of the page.

2 Specify the following information about the e-mail.

Figure 6-15 E-mail Report Settings

The following table describes the e-mail report options.

Table 6-9 E-mail Report Settings

3 Click Send to send the report.

Option Description

Send Report As Choose one of these:

• To provide a link to the report in the body of the e-
mail, select Link.

• To send the report as an attachment to the e-mail, 
click Attachment, and select a format for the 
attachment file.

Email Options Select the following options before attaching a report 
file to an email:

Pagination: Select whether you would like the report to 
appear in a single page, multiple pages and whether 
you want horizontal breaks.

Download Zipped: Zip the file before attaching it with 
the mail

Include comments: Whether you want any comments 
that were added to the report included

Save In You have the option to save the report in a location 
that you can specify here.

To and CC Specify e-mail addresses to which to send the report.

Subject Provide e-mail Subject header.

Message For the body of the e-mail, either use the default 
message provided, modify it, or enter your own 
message.
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Exporting and Saving a Report
You can export a report to a file format of your choice and save it.

To export and save a report

1 Click the Export button or click one of the file format buttons on the published report 

top-level menu bar ( )

2 In the Export Options dialog, specify the Export Format and associated settings you 
want in the Export Options dialog.

Depending on the Export Format you choose, other settings are displayed as 
appropriate. Configure the export, and click Generate.

3 When the report is displayed, you have the option to save it as a file locally or 
elsewhere just as you would any other file.

Viewing the Output of a Published Report
1 Navigate to the report for which you want to view output results. (See “Finding 

Reports” on page 277 if you need help locating a report.)

2 Click the List Published Output button  (Navigate to list of published outputs 
for this report) next to the report you are interested in.

Figure 6-16 List of Published Report Outputs for a Selected Report

In this dialog if you click the radio button next to report run, you can select various options 
on any of the listed reports, including options to:

 View report outputs in various formats (HTML, PDF, CSV, Excel, or 

Word )

 Delete the selected instance of the generated report

Designing Reports
You can use the Logger Report Designer to design simple columnar reports as well as 
mixed reports with embedded charts and matrices. For columnar reports, the Report 
Designer provides options for setting up filters, grouping, totals, and sort order to create a 
full-featured report.
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Opening the Report Designer
To open the Report Designer to create a new report from scratch, click Design | New 
Report on the Reports left menu bar.

To open the Report Designer to edit an existing report, click the Customize Report  
button for a report in a reports list in the Report Explorer. (See “Explorers” on page 245 
and “Task Options on Available Reports” on page 278 for more information on available 
reports and how to get to their task option buttons, respectively.

Figure 6-17 Report Designer

Creating New Reports
If you are new to the Logger Report Designer, we recommend starting with an existing 
report as a basis for a new one, as described in “Quick Start: Base a New Report on an 
Existing One” on page 289.

If you are starting a new report from scratch, or for more details on each of the settings in 
the Report Designer, see “Designing New Reports” on page 290.

Quick Start: Base a New Report on an Existing One
Since Logger ships with a variety of useful, pre-built reports for common security scenarios, 
you can leverage these not only to run as-is but also as templates for building new reports.

If you are just getting started with the Report Designer, a good way to get up-to-speed fast 
is to start with an existing report that has some of the features you want in your new 
report, save the original report under a new name, and then modify it. 

Modifications to reports and other ArcSight-defined content may be overwritten 
without warning when the content is upgraded. It is not a good practice to 
modify ArcSight-defined content directly.

Make modifications to a copy of any ArcSight-defined content as a general 
practice, and subsequent upgrades will not affect the modifications.
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To create a new report based on an existing report

1 Navigate to the report you want to use as a starting point. (Click on a category in the 
Report Explorer to see a list of available reports in that category, then click on the 
report)

2 Click the Customize Report  button for a report in the Report Explorer toolbar. 

This opens the Report Designer with the report’s properties filled in.

Note: Some reports, such as the ones obtained from ArcSight or other custom 
developer sources might not be editable. For such reports, the icon is gray. 

3 Click the Save As button.

This brings up the Save Report Layout As dialog for the selected report (and shows all 
reports stored in the same category as the one you selected).,

Figure 6-18 Save Report Layout As dialog for an Existing Report

4 Provide a Report Name for your new report.

5 Click OPTIONS.

Also select Public (if you want everyone to have access to the report) or Private (to 
make the report available only to you), select System Generated if you do not want 
to enter a custom ID for the report and add a Description, if needed.

6 Click the Save button to save the report.

Click OK on the confirm dialog telling you that the report was saved successfully.

Your new report is now shown under the category in which you saved it.

7 Select the report you just saved and click the Customize Report button to start 
modifying the new report to suit the a specific scenario. (See the next section, 
“Designing New Reports” on page 290.)

Designing New Reports
To access the Report Designer to create a new report from scratch, click Design | New 
Report link in the left panel.

This brings up the Report Designer with a blank template.

The following sections explain how to use the Report Designer.

Report Save, Run, and Template Options
 Click Run to test the current version of the report.
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 Click Preview to preview the report before saving it.

 Click Save to save the report.

 Click Save As to save it under a different name.

 Click Open to open another report in the Report Designer.

General Report Settings
Set your preferences for pagination, layout and report output format as described below.

Table 6-10 General Report Design Settings

Select Display Fields (Base Query and Fields)
Each report is built on a base query. Available queries are provided in the drop-down menu 
on top of the “Select Display Fields” box. When you select a query, the data fields it 
contains are shown in the Available Fields list. You can select which data fields you want to 
use in your report, or use them all. You can edit the selected query by clicking on the 
Query Editor link. (For information on building new queries, see “Setting up Queries” on 
page 302.) 

Enter a meaningful title for the report in the Report Title field and select whether the 
report contents should be Detailed or Summarized in the Report Contents field. The 
report title is the text that appears as the title on top of a report. 

Select the query you want to use for the report from the drop-down list located on top of 
the Select Display fields section. The Available Fields list is populated with the fields defined 
in the selected query.

Option Description

Template Select the template to apply to this report. The templates 
drop-down menu shows supplied templates, and any 
custom templates you may have added. These template 
define the look and feel, arrangement, orientation, and so 
on, of the report output. To include the start time, end 
time, scan limit, device group, storage group, and devices 
information (used to run a report) in a report, choose the 
“BlankWithHeader” template.

See “Applying Report Template Styles” on page 332 for 
more information on working with templates.

Report Format Select the default format for the report.

For information on available formats, see “Report File 
Formats” on page 284.

Report Contents Select whether report should detailed or summarized.

In addition to the fields in the WHERE clause of the query, the fields in the 
SELECT clause also need to be indexed to yield faster report generation. For 
more information about indexing fields, see “Indexing” on page 139.
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Select the fields to use in the report by moving fields from Available Fields into the Selected 

Fields list. 

Select Filter Criteria

Figure 6-19 Report Filter Criteria

You can set filters on the results of the base query with logical expressions to narrow the 
focus of the report results. For example, you could set the filter criteria on a report on Top 
Password Changes to report only on password changes related to specified username(s) or 
involving specified IP address(es).

Also, you can limit the number of rows in a report by defining a Max. Rows value.

Filter criteria defined as part of a report design is built in and saved with the report. When 
other users run the report, they will get the built-in filters by default

• Select a field in Available Fields and click  to move it into the Selected 

Fields list, or click  to add all fields. 

• To “de-select fields” (that you do not want in the report), select a field in 

the Selected Fields list and click  to move it back to the Available Fields 

list, or click  to “de-select” all fields.

• Use the move up  and move down  arrows to order the Selected 
Fields.

For information on how to create query objects for use in reports, see 
“Setting up Queries” on page 302. All available queries, including new queries 
you create, show up in the drop-down menu in the Select Display Fields 
section of the Adhoc Report Designer.

You can also set filter criteria and row limits on an ad-hoc basis when you run 
a report. However, values set at run time are not built in to the report like 
those set at design time. Run-time parameters are only applicable to a 
particular report run and do not persist.

If a report does include default filter criteria, users have the option to run the 
report with the defaults, or modify or remove the built-in filters at run time.

For more information, see “Run Report Parameters” on page 282.

Query designers can build in “mandatory filtering” on a specified field or on 
“any” field, which requires filtering on one or more fields of your choice.

If the query you choose for this report has mandatory filtering, the “Select 
Filter Criteria” panel title and one or more fields are with a red asterisk. For 
more about mandatory filtering, see “Mandatory Filtering” on page 311 under 
“Setting up Queries” on page 302.
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Table 6-11 Select Filter Criteria Options

Option Description

Maximum Rows 
(Max. Rows)

Specify the maximum number of rows in the report output. 
Results that push the number of rows beyond the Max. 
Rows limit you define will not be included in the report.

Notes: 

• If you select set Max. Rows and also specify grouping 
under Set Grouping (as described in “Select Grouping” 
on page 294), you may get a different result than if you 
just specified Max. Rows without grouping.

• Setting this field to 0 returns an unlimited number of 
rows.

• Increasing the maximum rows for report may not 
always increase the number of rows returned by the 
report. If the query invoked by the report limits the 
number of rows returned, increasing the Max. Rows 
setting in the report has no affect. For example, if you 
edit the NIST IR Top 10 High Risk Events report and 
change the value in the Max. Rows column from 10 to 
20, when the report is run report only 10 rows are 
returned. This is because the query invoked by the 
report is returning 10 rows. You can, however, limit the 
number of rows returned by the report to a number less 
than the default value. For example, if the value of the 
Max. Rows field is changed from 10 to 5 for the NIST IR 
Top 10 High Risk Events report, this report returns 5 
rows during run time. 

• You can increase the number of rows returned by 
editing the query and changing the number of rows 
returned by the query and change the number specified 
in the Max. Rows field of the report.
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Select Grouping

Figure 6-20 Grouping Items by Field in a Report

Define group requirements to arrange the report information into logical groups based on 
particular fields you are interested in. You can create multiple groupings for report results.

For example, if the report uses a query that includes a Date field, you can group results by 
date. You could add additional statements to group by “User Name”, “Source Address”, 
“Destination Address”, and so forth, depending on what other fields are available in the 
report query.

Field The Fields will be populated with event data fields specified 
in the base query. (Fields will generally equate to columns 
in reports.)

Select a field on which to filter.

To add another filter (“Field” on which to filter), click  
(Add Filter).

To remove a filter, click  (Remove Filter).

Notes:

• Multiple filters with conditions set on different fields will 
be AND’ed together. Multiple filters with conditions set 
on the same field will be OR’ed together. 

For example, if you want to filter on events to return 
data based on a value/count (of rows or other) between 
90 and 100, use the Between criteria to do this (e.g., 
<Field> Between 90 and 100)

Setting two filters on the same field with criteria 
“Above 90” and the other as “Below 90” would not give 
you the data you are looking for. Only one of these 
filters would be triggered.

• If the query you choose for this report has mandatory 
filtering, the “Select Filter Criteria” panel title and one 
or more fields are marked with a red asterisk. For more 
about mandatory filtering, see “Mandatory Filtering” on 
page 311 under “Setting up Queries” on page 302.

Criteria Select a logical operator. (For example, Is, Is Not, Starts 
With, Ends With, Contains, and so forth.)

Value Select a value to complete the conditional filter expression.

• If you select set Max. Rows under Select Filter Criteria (as described in 
“Select Filter Criteria” on page 292) and also specify grouping, you may 
get a different result than if you just specified Max. Rows without 
grouping.

• A report that has a group defined can only display up to 100,000 lines.

Option Description
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To define a group

1 Select a field by which you want to group (as described in Table 6-20 on page 336).

2 Select the order of arrangement of group (as described in Table 6-20 on page 336).

Table 6-12 Select Grouping Options

3 If you want to set sub-groups, specify details in the “Then By” fields. For example, if 
your report uses a query that reports on password changes and includes a “User 
Name” field, you might want to sub-group the results for each date by “User Name”. 

Use the  (Add Group) and (Remove Group) buttons to add or remove “Then 
By” fields for sub-groups.

The report will generate records organized and grouped in the specified order.

Select Totals

Figure 6-21 Showing Totals on Fields in a Report

You can specify the summary (total) fields. You can apply a summary on any of the 
following levels:

 Report

 Page

 Group

Option Description

Field The Fields will be populated with event data fields specified 
in the base query.

Select a field by which to create a group.

To add another field for a grouping, click  (Add Group).

To remove a group-by field, click  (Remove Group).

Order Select the order of arrangement of group:

• Ascending

• Descending

Ranking Field

Ranking Function

Alternatively, you can specify only a sort order (instead of groups). See also, 
“Sort Order” on page 296.
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To specify summary details

1 From Field, select the field that will be processed to calculate summary information.

2 On the same row, from Function, select the summary function.

3 On the same row, from Level, select the level at which you want the summary.

Sort Order
In case you do not want “grouped” report results (as described in a“Select Grouping” on 
page 294), but you do expect “sorted” results, then specify a Sort Order (instead of 
grouping).

Figure 6-22 Sort Order for Items in a Report

You can have up to three levels of sorting.

To specify a sort order

1 In Field (on the right of Sort By), select the field on which you want to sort the report.

2 In Criteria (in the same row), select the sort criteria.

3 Repeat Step 1 and Step 2 by providing values in the Then By rows to specify more 
sorting criteria.

Highlighting
A report can include multiple levels of “highlighting” for specified fields. Highlighted items 
can serve as visual alerts on generated reports when specified set conditions are satisfied.

Figure 6-23 Highlighting Items in a Report

To set up a highlight

1 In Highlight, select the field that should be highlighted. Select Entire Row to highlight 
entire record. 

2 In Using Style, select the style to be applied to highlight it. 

If a Total is applied to a field that is not already in the Selected Fields list, that 
field is automatically added to the Selected Fields list.

A report that has a sort order defined can only display up to 100,000 lines.
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3 Select Alert check box to receive a visual alert on report viewer. 

4 In Field, select the fields which will be evaluated for highlight (alert). 

5 In Level, select the level at which the selected field should be evaluated:

 DETAIL evaluates each row (record)

 REPORT evaluates at the end of report

 Respective groups evaluate at the end of each group

 PAGE evaluates at the end of the page

6 When REPORT or PAGE is selected in Level, select a Function to be applied. 

7 Select Criteria and specify its Value.

Click  (Remove Condition) on the left of the criteria entry to delete an entry. Click  
(Add Condition) to add another entry.

Create Matrix
You might choose to include a matrix in your report, since it presents a summary of data. 
Make sure that the appropriate query object is selected (under “Select Display Fields”).

Figure 6-24 Adding a Matrix to a Report

To create a matrix

1 To place a field in Row or Column, click the field and drag it to the Row Fields or 
Column Fields boxes.

2 To place a field as a cell (summary), click the field and drag into the Summary Fields 
box.

3 Select a Function from the drop-down menu provided for a field placed in Summary 
Fields.

4 Optionally, for numeric or date fields in columns or rows, specify a Group By function 
in the drop-down menu provided.

5 Optionally, for fields in columns or rows, check Totals checkbox to get total row / 
column. 

Select a field and click  to add that field to the matrix as one of the Column Fields. 

Select a field in Column Fields and click  to remove it from the matrix.
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Select a field and click  to add that field to the matrix as one of the Row Fields. Select 

a field in Row Fields and click  to remove it from the matrix.

Select a field and click  to add that field to the matrix as one of the Summary Fields. 

Select a field in Summary Fields and click  to remove it from the matrix.

To move a field up or down, select the field and click  (Move up) or  (Move down), 
to move the field in the respective direction.

To remove all settings and contents of the current matrix, click Clear Matrix.

Create Chart
For pictorial representation of summary data, you can add a chart on your report. Make 
sure that the appropriate query object is selected (under “Select Display Fields”).

Figure 6-25 Adding a Chart to a Report

For pictorial representation of summary data, you may choose to have a chart on your 
report. Make sure that the right query object is selected (under Select Display Fields).

Chart Placement
Chart Placement is important when the chart is placed on the report along with other 
component. Specify chart placement preference using the Align option:

 Select Top to place the chart above other components.

 Select Bottom to place the chart below other components.

 In Level, select PAGE to plot chart having page level data. Select REPORT to plot 
chart from data that has come from entire report.

 Top(N)

 Field

 N=

 Sort Order
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Chart Type
Select the chart type by clicking button (image) from Select Chart Type area. The image 
corresponding to the chart you select is displayed in the Selected Chart Type box at the 
top. 

Select Point Labels 
Select this setting to show the number of matches for a value of a field in a chart, as shown 
in the following figure.

Set Value Fields (Y-Axis)

1 Click and drag the Field in Value Fields (Y-Axis) box, or use the  button (Add 
field) to add the selected field.

2 Select summary function for the field. 

3 To select a chart type different than the selected one, click the button on the right to 
open a box having chart types. Select the type you need. 

Follow steps 1 through 3 above for each attribute to be placed as series. To re-position 

fields, select a field and click  (Move up) or  (Move down) as needed.

Set Group Fields (X-Axis)

1 Click and drag the field in Group Fields (Y-Axis) box, or use the  button (Add 
field) to add the selected field.

2 Select the method to group (for Numeric or date type).
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You can specify groups in numeric fields. For example, to have groups of 10, specify 10 in 
Groups box.

You can specify groups in date fields. From the drop-down box select from Day, Week 
(Sunday to Saturday), Month, Quarter (Jan-Mar, Apr - Jun, Jul - Sep, Oct - Dec), Year.

To remove all settings and contents of the current chart, click Clear Chart.

Editing a Report
You can use the Report Designer to edit existing user-designed reports. (The supplied 
reports are not editable.) 

To edit an existing report

1 From any Report list in the Report Explorer, select the report and click the Customize 
Report button for the report you want to edit.

This brings up the Report Designer for the selected report.

2 Modify the report as needed (via the settings described in “Creating New Reports” on 
page 289). 

3 (Optional) Before saving the report, you can run it to ensure that the changes you 
expected in the report output suit your needs. To do so, click Run. (For more 
information see, “Adhoc Report Designer” on page 301. 

4 Click Save.

See also “Quick Start: Base a New Report on an Existing One” on page 289.

To remove fields from Value fields (Y-Axis) or Group Fields (X-Axis), drag 

them out of the respective box or use the  button (Remove field) on 
selected fields.

If a user has access rights to “view, run, and schedule all reports”, you can 
create private reports. If you do not have permissions to edit a public report 
that you want to modify but you do have permissions to create private 
reports, then you can save the public report as a private one and edit the 
private report.

For more about publishing a report as “public” or “private”, see Table 6-8 on 
page 285. For more about “access rights” on reports, see “Setting Access 
Rights on Reports” on page 302.
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Adhoc Report Designer
Once you edit a report, you can run it before saving it to ensure that the report output is as 
you expected. When you run a report in this fashion, an Adhoc Report Designer menu bar 
is displayed at the top of the newly run (unsaved) report, as shown in the following figure.

The Adhoc Report Designer is useful in adding formatting and display elements to a report 
definition and viewing the output with those elements before saving the report definition. 
For example, you can specify a sort pattern or add a chart to a report. 

The following table lists the various options available in the Adhoc Report Designer menu 
bar.

Menu Option Description

Select display fields. See “Select Display Fields (Base Query and 
Fields)” on page 291 for more information.

Specify filter criteria. See “Select Filter Criteria” on page 292 for 
more information.

Specify grouping. See “Select Grouping” on page 294 for more 
information.

Specify the summary (total) fields. See “Select Totals” on page 295 
for more information.

Specify sort order. See “Sort Order” on page 296 for more 
information.

Set up highlighting. See “Highlighting” on page 296 for more 
information.

Include a matrix. See “Create Matrix” on page 297 for more 
information.

Create a chart. See “Create Chart” on page 298 for more 
information. 

Expand all of the above listed menu options.
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Setting Access Rights on Reports
Administrators can set access rights on various report categories, reports, and report 
options (view, publish, edit, and so on) based on user roles and Logger Report Group 
affiliation. For example; you can grant users privileges to view some reports but not others, 
to view but not schedule or publish a report, or to view and schedule but not edit a report. 
(This is also noted with regard to user perspective at “Task Options on Available Reports” 
on page 278.)

Access rights on report options are configured and managed with the User/Groups option 
on the Logger System Admin page.

For more information on System Admin User/Group management, see Chapter 7‚ System 
Admin‚ on page 303.

Setting up Queries
Query objects are queries (along with additional metadata) designed and stored as a part 
of the Logger Reporting suite on the Report. Query objects are used as the basis for 
designing reports.

To view and work with Logger Report queries, click Design | Queries on the Reports left 
pane. The contents for the selected query is displayed. To view the contents of a different 
query, click the Open button and expand the category under which the query is stored 

then select a query from the list and click the Select Entity  button.

ArcSight Logger Reporting provides a set of pre-built queries, which are used as the basis 
for the system defined Reports and Solutions Reports to address common security use 
cases (as described in “Explorers” on page 245).

You can use a provided query object “as-is” as the basis for your own reports, or design 
new query objects on the Query Object List page. You can use existing query objects as a 

Some queries may require parameters.

We recommend first designing all needed parameter objects before creating 
the query object that will use those parameter objects.

For information on developing parameter objects, see “Working with 
Parameters” on page 324.
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starting point for new ones. You can search for an existing query, as shown in the following 
figure.

To do so, either

 Enter the first few letters with which the query name begins (if the “Starts With” 
search criteria is selected) in the text box above the list of existing queries, OR

 Enter a word or part of a word that the query name contains (if the “Contains” search 
criteria is selected) in the text box above the list of existing queries. 

This topic explains how to design new query objects (either from scratch or based on 
existing ones).

How Search and Report Queries Differ
Even though a search and a report query perform the same function—finding events that 
match specific conditions—the two queries are distinct in these ways:

 You use Logger’s in-built SQL Editor to create a report query in SQL. (The SQL Editor 
automatically checks the syntax of the query before running it.)

 You use the Logger’s Search UI to create a search query. The query can be specified 
either using plain English keywords, field names, or regular expressions. See 
“Searching for Events on Logger” on page 128 for more information.

However, report queries and field name queries can utilize indexed fields to expedite the 
underlying search.

Overview of Query Design Elements
To create a new query object, you need to specify a query name, define the SQL logic, and 
save it. The data source for Logger Report queries is always the Logger database(s), so 
there is no need to specify this as part of the query object.

Optionally, you can specify formulas, set field properties, define formatting (look-and-feel), 
define field groups, provide hyperlinking, define lookup values, and build mandatory 
filtering into the query.

Modifications to reports and other ArcSight-defined content may be overwritten 
without warning when the content is upgraded. It is not good practice to 
modify ArcSight-defined content directly.

Make modifications to a copy of any ArcSight-defined content as a general 
practice, and subsequent upgrades will not affect the modifications.
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Creating a Copy of an Existing Query

To use an existing query object as the basis for a new one, copy the query object you want 
to start with as follows:

1 In the Query Explorer, click on a category and select the name of the query that you 
want to copy from the query list. 

2 Click the Copy Query Object button, then click the category name under which you 
want to place the copied query, and click the Paste button. 

A temporary version of the new query object is created with the same contents as the 
original and the same name pre-fixed with “Copy of”. 

3 Modify the query name by editing it in the Name field (unless you want to keep the 
default name of “Copy of <OriginalQueryName>” for now).

Designing a New SQL Query
1 In the Query Explorer, click the Create Query Object button. The Query Object 

Editor opens.

2 In Name field, specify a unique name for this query object. 

3 Under SQL, click Edit to design the SQL statement.

The SQL Editor loads in a new window by default, which is generally preferable 
because it allows you to view both the main Query Object List page (query editor) and 

You can search for an existing query. To do so, either

• Enter the first few letters with which the query name begins (if the “Starts 
With” search criteria is selected) in the text box above the list of existing 
queries, OR

• Enter a word or part of a word that the query name contains (if the 
“Contains” search criteria is selected) in the text box above the list of 
existing queries.
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the SQL Editor at the same time. (If you want the SQL to load in the same window, 
click to uncheck this option before clicking the Edit button.)

Figure 6-26 Query SQL Editor

4 Use the SQL Editor to define the query statement. (See “Defining SQL in the Editor” on 
page 317.) Report queries are case insensitive.

5 Click OK to temporarily save the SQL statement for the query.

The SQL you defined is displayed in the SQL box on the main Query Object List page.

Similarly, any fields you defined in the SQL Editor are displayed in the Fields list on the 
Query Object List page. 

6 Click Save button to save your work as part of the query object. 

If a report query uses single quotes (‘ ’) in the SELECT clause, the report 
designer starts refreshing continuously and does not allow you to proceed 
further. Therefore, if a SELECT clause uses quotes, make sure you alias 
those fields. For example: 

Select events.arc_deviceSeverity, 

sum(IF (events.arc_name = 'allow', 1, 0)) as Sum1, 

sum(IF (events.arc_name = 'object', 1, 0)) as Sum2 

From events 

group by events.arc_deviceSeverity 

You must click Save on the main Query Object List page to save updates 
made in the SQL Editor as part of the query. If you navigate away from 
this page without clicking Save, edits you made in the SQL Editor since the 
previous Save will be lost.
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Field Attributes and Properties
To set Field attributes, select a field under Fields and edit the properties associated with 
the that field.

Figure 6-27 Query Field Attributes

You can set the following properties on fields in a query.

Table 6-13 Query Field Attributes

Specifying Output Format for a Field
If you specify the output format for a query field here, at run-time the report output will 
adhere to the specified formatting.

1 From Fields list, click (select) the field for which you want to define an output format. 
(The selected field is bold.)

2 Click  button next to the Output Format field to launch the Data Format dialog.

Option Description

Field Name of field (as received from data source).

Caption The text that will appear as a caption when this field is 
selected for placement on the report.

Width Number of characters for the selected field.

Align Sets alignment for the selected field.

Hidden Hides the associated field so that it is not available to be 
placed on report. This field will also not be available for 
sorting as well as filtering.

Data Type Sets the data type for field from Date, Character or 
Number. This is especially useful when field selected is XML 
type data source and you need to set it as number or date. 
Similarly when a field that is character (having numeric 
value) is supposed to be used in calculation.
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3 Select the appropriate format and provide necessary values for that format.

4 Click OK to accept the changes and close the dialog. 

Characters for the selected format are displayed in the Output Format entry field.

Specifying Input Format for a Field
If you specify the input format for a query field here, at run-time the report containing this 
query will accept data only in the format specified.

1 From Fields list, click (select) the field for which you want to define an input format. 
(The selected field is bold.)

2 Click  button next to the Input Format field to launch the Data Format dialog.

3 Select the appropriate format and provide necessary values for that format.

4 Click OK to accept the changes and close the dialog. 

Characters for the selected format are displayed in the Input Format entry field.

The default date/time in reports does not include the time of day. You must 
choose a date format that includes HH:MM:SS to include the time.
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Grouping Fields
When fields in a query object are grouped, they are displayed within a group header in the 
Report Designer. All fields in the group can be selected or removed from the report with a 
single click. Once groups are created, fields can be assigned to groups. 

To create groups

1 In Group Label drop-down box double-click Select to add group label option which 
is already selected.

2 Enter a group name. 

3 To create more groups, repeat Step 1 and Step 2.

To assign fields to a group

1 From the Fields list, select the field.

2 From the Group Label drop-down box, select a group. 

The selected field will be part of that group.

To remove a group

1 Select the group name in the Fields list.

This automatically populates the Group Label field with the selected group name.

2 Click  (remove button) next to the Group Label field to remove the selected group.

Formula Fields
Formula fields are custom fields you create to address particular scenarios during report 
processing. In a business finance application, a formula field might be used to determine 
“gross salary” or “grand total”. Formula fields and their values are not stored in the Logger 
Report server database; but rather are used during report processing and discarded once 
the report is generated. 

You can embed formula fields query objects. A formula field can include any field or 
formula available to a query object.

To create a formula

1 Click  (Add New) under the  tool palette (next to the Fields list) to get the 
Formula dialog.
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2 Specify the formula and click OK to save the formula and close the dialog. (See 
“Syntax for Formulas” on page 309.)

 In the Name field, specify a unique name to identify the formula. 

 From the Return Type drop-down menu, select the type of the value the 
expression returns. (NUMBER, CHAR, DATE, or BOOLEAN)

 In Details area, specify the formula. (See “Syntax for Formulas” on page 309.)

3 Click OK to save the work and close the dialog box. 

The new formula is listed in the Fields list. Formula names shown in the list are pre-

fixed by .to indicate they are formulas.

Positioning Formulas in Fields List

Select a formula and click  (Move up) or  (Move down) as needed to shift the 
position of the selected formula in the list.

Syntax for Formulas

The general syntax for formula is:

FormulaName = formula

where, FormulaName is the same as specified in the Name field on the Formula dialog.

In general, use JavaScript syntax to create formulas.

A formula can include:

 Field names

 Variables (custom or supplied)

 “if” and “nested if” constructs

Formulas further down in the list can use the formulas above them.

Avoid the opposite; formulas higher in the list should not use the formulas 
below them.
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 logical operators

For formulas that contain multiple statements, use a semicolon “;” as a separator between 
two statements.

Examples

NewForm1 = var a = 5 ; b = 3 ; if (a!=b) { f = a } {NewForm1=f}

TotalAmount = var total ; if (unitprice < 10 ) {total = 
unitprice*quantity} else {total = unitprice} {TotalAmount = total}

Importing Field Attributes
You can import field attributes from other Logger Report queries and apply the imported 
attributes to the currently selected field in your query. Leveraging attributes from existing 
queries can save time and re-work, and also serve as a learning tool.

You can import the following field attributes from one query into another:

 Captions

 Format (including Width, Alignment, Input, and Output formats)

 Data Types

 Hidden properties

 Group Labels

 Hyperlinks

 Lookup Values

You can select a field from which to import attributes from any of the saved query objects 
on the Logger Reporting server. Imported attributes can come from one field in another 
query, or from multiple fields.

To import field attributes

1 Open the query in the Query Object Editor, select the query object into which you want 
to import field attributes (the “local” query you are editing), and click Import to bring 
up the Import Attributes dialog.

Figure 6-28 Importing Attributes from One Query into Another
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2 From the Source Query drop-down menu on the Import dialog, select the query 
object from which you want to import field attributes (the “remote” query with the 
attributes you want to copy).

The Field drop-down menu is populated with the fields in the selected query.

3 In the Source Field drop-down menu, select the field in the remote query whose 
attributes you want to import (copy).

4 Select field attributes to import by clicking (checking) checkboxes for attributes you 
want.

5 From Target Fields drop-down menu, select the target field in your local query to 
which you want to copy the attributes.

6 Click Apply to save current selections and keep the dialog open.

7 To import selected field attributes to another target field, repeat these steps with a 
different target field selected.

To select from different fields in the same query, or different queries, choose different 
options for Query and Field at the top of the dialog.

Mandatory Filtering
You can provide built-in filters for a query when you want users to apply one or more filters 
when designing and running reports that use that query. Building in mandatory filtering at 
the query level can save unnecessary data transfer from the server database during report 
run time.

You can configure mandatory filtering in either of these ways:

 Mandating filtering on any field. Report designers can decide which field to filter on at 
report design time. 

 Mandating filtering on a specific field. Report designers are required to filter on the 
specified fields at report design time.

To configure a query for mandatory filtering

1 Select (check) the Mandatory Filtering checkbox to enable mandatory filtering.

For successful field attribute import, consider the data types of source and 
target fields. For a valid import, data types for source and target fields must 
generally match.

Lookup values will not import if the data type of the target field is NUMBER.

A field attribute import cannot be revoked. Please make sure you are importing 
the right attributes before you click Apply or OK.

Click Cancel to abandon selections made after last Apply button and close the 
dialog. (Clicking Cancel will not revoke changes already applied.)

Click OK to save (apply) current selections and close the dialog.
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2 To specify a field for mandatory filtering, choose the field you want from the On Field 
drop-down menu. If you do not want to specify a field for mandatory filtering now, 
leave it as Any.

3 Click  (Add Filter) to get another row for mandatory filtering, and repeat Step 2 
above. 

To remove a field filter

To remove a mandatory filter field, click  (remove button) next to the row you want to 
remove.

To disable mandatory filters

To disable mandatory filters (but not remove the specified fields), uncheck the Mandatory 
Filtering checkbox. (Click on it if it is enabled to toggle it off.)

Effect of Mandatory Filtering on Report Design

Mandatory filtering comes into play during report design time with regard to selecting filter 
criteria. (See “Select Filter Criteria” on page 292 under “Designing Reports” on page 288.)

When a user working with the Report Designer to create/edit a report selects a query 
object (data source) that has a mandatory filter, both the “Select Filter Criteria” panel title 
and the relevant fields are marked with a red asterisk.

Figure 6-29 Mandatory Filtering on a Field Shown in the Report Designer

The Report Designer “Select Filter Criteria” panel includes one row for each field configured 
for mandatory filtering in the base query (all marked with red asterisks).

For each mandatory field configured with a specified field in the base query, a named 
field is provided in the Report Designer “Select Filter Criteria” with its drop-down menu 
grayed out (disabled). This requires the report designer to build the report so that it filters 
on the specified field.

For each mandatory field with "Any” (any field) as the selected value in the base query, a 
“blank” field is provided in the Report Designer “Select Filter Criteria” with its drop-down 
menu enabled. In this scenario, the report designer is required to build the report to filter 
on a field, but it can be any field provided by the query to the report via the filter criteria 
drop-down list.

So during report design, filters must be provided for all the rows marked with red asterisks, 
but mandatory filtering on “any” field gives the report designer a little more leeway than 
mandatory filtering on a specified field.

Specifying a Hyperlink on a Field
You can make a field a clickable hyperlink which links to a specified URL or report. A report 
based on a query with hyperlinked field(s) will provide links to intranet or external Web 
pages and/or "drill-down" reports.
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To make a field a hyperlink:

1 From Fields list in the query, click (select) the field you want to be the hyperlink. (The 
selected field is bold.)

2 Click  button next to the Hyperlink option to launch the Hyperlink Options dialog.

Figure 6-30 Making a Field in a Report a Hyperlink

3 Depending on the type of hyperlink needed, select either URL or Drill Down…, and 
specify values appropriately.

Link Type Settings

URL • Select URL

• Provide the link address in the box URL box (HTTP or 
HTTPS address, file path, etc.)

• Choose a Target window or frame from the drop-down 
menu, depending on how you want the URL target to be 
displayed (same window, new window, and so on).
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4 Click OK to accept the changes and close the dialog. 

The Hyperlink option for the selected field is now blue to indicate that the field is a 
link. (Query “Fields” list that are hyperlinks always show a blue Hyperlink option when 
they are selected in the list.)

Figure 6-31 Hyperlink Options

System Parameters and Associated Values

You can set the following system parameters to further specify how a target (hyperlinked) 
report is run and published.

Drill Down to 
Another Report

• Select Drill Down to another Report

• Choose a Target window or frame, depending on how 
you want the new report to display

Note: A report may have mandatory parameters. If the 
value of a mandatory parameter is not specified, the 
report run may fail, generate errors or provide invalid 
results.

• If the target report needs system parameters to run, 
specify these along with associated values. Add and 
remove rows in the same way as for report parameters. 
For details, see “System Parameters and Associated 
Values” on page 314.

Even if the target report (the report you are linking to) 
does not need any report parameters to run, specify the 
following parameter in the Report Parameter section. 
This parameter is required for the drill down 
functionality in a report to work:

Report Parameter: REQ_SD

Value Field: <%REQ_SD%>

Click  to add a row or  to delete a row in the 
Report Parameter section.

Parameter Description and Values

Priority • Low

• Medium

• High

Report Format • Choose SYS_REPORT_FORMAT to use the format of the 
report specified where the target report is run

• Or choose one of the other formats on the drop-down 
(described in “Report File Formats” on page 284)

Link Type Settings
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Lookup Values for Text Fields
Lookup values are used to set a filter at report design time as well as run time.

Query objects are generally used by report designers. Query designers can configure 
lookup values for fields on which report designers may decide to set filters at report design 
time or users may want to filter at report run time.

When a report designer sets up a filter on a field, lookup values for the field are listed in a 
drop-down menu. The report designer can select a value and proceed with building the 
report.

Similarly, at run time, a dialog is displayed with the field name and lookup values listed in a 
drop-down menu. The query will run with the filter and specified values.

Lookup values can be defined in any of the following ways:

 Predefined, to specify static values.

 SQL, to get values from the database using SQL (used in the main query or from a 
query setup exclusively). This way you make sure that the user selects valid options. 

 Key Field, from the table used in the main query. Specifying a key field can improve 
performance.

Report Connection 
Name

Report type and database.

We recommend leaving this set to Default.

Save File Name Provide a file name to be used for the target report if the 
report is published as an implicit operation.

Implicit Operation Publish is the recommended default option.

Refresh Data • Select True to run report with latest data. 

• Select False to run report with cached data

Prefetch Drilldown • Select True to enable “prefetch drill-down” and 
generate hyperlinked report at run time, even if user 
has not clicked the hyperlink in the source report.

• Select False to disable prefetch drill-down

Pagination Select a pagination option for the target report:

• Single Page increases page width and length to any 
size

• Multiple Page divides in width, divide in length as per 
need

• Horizontal Breaks divides in length only, increase 
width to any size

• Vertical Breaks divides in width, increase length to 
any size

Show HTML Toolbar If the target report is published or viewed in HTML:

• Set Yes to have HTML Toolbar

• Set No to forego the toolbar

• Set Multipage to provide toolbar only if report extends 
to more than one page.

Parameter Description and Values
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Specifying Predefined Lookup Values

1 From Fields list in the query, click (select) the field to which you want to assign lookup 
values. (The selected field is bold.)

2 If not checked, select (check) the Lookup Values checkbox.

3 Click (check) Predefined link.

Figure 6-32 Setting Predefined Lookup Values in a Query

4 In Display field, specify the value to present to the user or report designer.

5 In Value field, specify the value to be provided when the user selects the value 
specified in “Display”.

6 Click  to add the value set in the list of the lookup values.

7 Repeat the Step 4 through Step 6 to add all the pre-defined lookup values. 

8 Click Save to save your work.

Specifying SQL or XML Lookup Values

1 From Fields list in the query, click (select) the field to which you want to assign lookup 
values. (The selected field is bold.)

2 If not checked, select (check) the Lookup Values checkbox.

3 Click (check) SQL or XML link.

4 Optionally, Check (select) the User Defined SQL or User Defined XML checkbox to 
specify separate SQL for getting lookup values from database. 

Alternatively, keep this checkbox unchecked (clear) to get distinct values using the 
SQL defined for the main query object.

5 Optionally, check Fetch on every use check-box to refresh the list of values at query 
design time, report design time, and report run time. 

Alternatively, keep this checkbox unchecked (clear) to fetch values at query design 
time only. Values will be placed in the query object used at report design time and 
report run time. 

6 From the Display Column drop-down menu, select the column to be used to display 
value to the user (only when SQL/XML is user defined). 

7 From the Value Column drop-down box, select the column to be used in the filter (only 
when SQL/XML is user defined). 

8 Click Save to save your work.
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Modifying a Query Object
Use the Query Object editor to modify existing queries. 

To modify an existing query

1 In the Query Explorer, click the category in the Query Objects column where you 
have stored the query and click the Edit Query Details button.

2 Edit the query as needed (via the settings described in “Setting up Queries” on 
page 302) and click Save.

Deleting a Query Object
You can remove custom queries, but not supplied queries provided with Logger or add-on 
Solution packs.

To remove a query

In the Query Explorer, click the category in the Query Objects column where you have 
stored the query and click the Delete button.

Defining SQL in the Editor
Each report is built on an SQL query of the Logger databases. SQL (Structured Query 
Language) is an ISO based standard programming language for retrieving and updating 
information in a database. ArcSight Logger supports SQL queries, and provides an 
interactive, SQL Editor in which to define SQL statements.

Figure 6-33 Accessing SQL Editor on the Reports | Queries page

We recommend that you not modify queries provided with Logger or add-on 
Solution packs. If you want to use a supplied query as a starting point for 
your own queries, copy them and edit the copies, as described in “Creating a 
Copy of an Existing Query” on page 304.
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Entities and attributes for the selected entity are listed on the left side of the SQL Editor. 
The right side of the SQL Editor provides tabs showing information related to the selected 
statement.

Table 6-14 SQL Editor Tabs

List of Database Objects
The SQL Editor shows the Default Connection to the database that provides the 
database objects list. ArcSight Logger Reporting provides a single type of object or entity, 
which is an events table. When you click on events (under Entities), event fields 
(attributes) are shown under Attributes.

The Attributes list shows a few attributes that are internal to Logger. They 
should not be used in queries because the resulting report will not contain 
expected results. All attributes listed after arc_sourceZoneResource are 
internal, including arc_eventTime, arc_deviceName, arc_rowId, and 
arc_others.

Option Description

Design Graphical SQL query designer. Use options on this tab to 
design relatively simpler queries using drag and drop 
method.

Edit Shows the SQL statements. A query created on the Design 
Tab is represented as an SQL statement on this tab. You 
can also write or paste and SQL directly here.

Results Displays rows received as a result of SQL execution.

Sort Specify sorting preferences.

Filters Add filters to set run-time filter criteria to be included in the 
query.
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Design Tab
You can design simple SQL queries on the Design tab using “drag-and-drop”.

Figure 6-34 SQL Editor: Design Tab

To create an SQL query statement using the Design tab:

1 Under Entities on the left side of the editor, click events to select the “events” entity.

The list of event attributes are shown under Attributes. 

2 Click and drag event attributes from the Attributes list on left side of the editor to the 
Select box on the right. The associated values are automatically displayed in the 
From clause.

3 Repeat these steps to select other attributes from different entities. 

Select

The Select box shows the attributes selected for a given entity.

The Attributes list shows a few attributes that are internal to Logger. 
They should not be used in queries because the resulting report will not 
contain expected results. All attributes listed after 
arc_sourceZoneResource are internal, including arc_eventTime, 
arc_deviceName, arc_rowId, and arc_others.

The events entity must be selected (under Entities on the top left) in 
order for the event attributes to show up under Attributes. If no 
attributes are displayed, make sure you have “events” selected in the 
Entities list on the left side of the SQL Editor.
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Where

The Where area shows the “where” clause for the query.

 To get a row at the top, click  (Insert first condition) in the left-most cell of column 
header.

 To get a row below current row, click  (Add a condition) in the row below which 
you want to add a row for condition. A row in inserted in the row below the respective 
row.

 To remove a condition, click  (Remove this condition) in the row for the condition 
you want to remove.

 To specify a where clause, form a condition by selecting Operand1, Operand2 and 
Operator.

 To join conditions, create two conditions, and select a relation in the right-most 
column of the first condition (of the two being joined). 

 To group conditions, specify opening brace and closing brace in the right row.

Group By

In the Group By clause you can provide grouping criteria for the SQL statement. To place 
an entity in Group By, click the entity in the Entity List and drag it in the box below Group 
By.

Having

To build a “Having” clause, use the same settings as described in the “Where” clause. See 
“Where” on page 320.

Order By

In the Order By clause you can provide sorting (ascending/ descending) criteria for the SQL 
statement. For a report with grouping, the “Order By” clause must have the columns in the 
same order as the respective sections in the Layout Editor.

Be sure to include appropriate summary function in “Select” clause so that it 
can be used in the “Having” clause.

An order-by report query that involves millions of events can fail to run and 
display the following error messages: "The server is too busy, try again 
later”. 

Therefore, ArcSight recommends that you follow these best practices:

• Use the ‘scan limit’ parameter to limit the number of events that will be 
scanned.

• Rewrite the report query to group by name or group by time to reduce the 
granularity of events scanned. 
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Edit Tab
When you switch from the Design tab to Edit tab, the SQL in the Design tab is constructed 
and displayed as a complete SQL statement in the Edit tab. You can use the Edit tab to 
view and write more complex SQL statements that cannot be defined in the Design tab.

Figure 6-35 SQL Editor: Edit Tab

Relationship of Edit and Design Tabs

The SQL Editor manages the SQL statement being constructed to prevent a complex query 
(defined in the Edit tab) from being unintentionally overwritten with changes made 
subsequently on the Design tab.

If you first enter a complex query on the Edit tab, then click back to the Design tab and 
make changes there, then click the Edit tab again. a dialog prompts to ask whether you 
want to overwrite the original statement on the Edit tab with the changes you made on the 
Design tab.

 If you click OK, your changes in the Edit tab are overwritten, because the SQL in the 
Design tab will be reconstructed.

 If you click Cancel, the SQL in the Edit tab remains intact and is used as the final SQL.

The SQL statement as reflected in the Edit tab will be used as the final SQL for compilation.
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Result Tab
The Result tab shows query results based on the currently-specified SQL statements 
(shown in the Edit tab). If the SQL uses a parameter, you will be prompted to provide the 
values to view the query results.

Figure 6-36 SQL Editor: Result Tab

Sort Tab
Click the Sort tab to specify levels of sorting at report run time.

Figure 6-37 SQL Editor: Sort Tab

The following table explains the settings on the Sort Tab.
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Table 6-15 Sort Tab Options

Filters Tab
Click the Filters tab to add filters to a query. This is useful when a report needs to present 
one or more optional parameters at run time and you want the user or report designer to 
select the parameter(s) via a multi-select combo box.

Figure 6-38 SQL Editor: Filters Tab

To get a row at the top

Click  (Add a filter) in the leftmost cell of column header. This inserts a row at the top.

To get a row below current row

Click  (Add a filter) in the row below which you want to add a row for condition. A row 
is inserted below the current row.

To remove a condition

Click  (Remove this filter) next to a condition you want to delete to remove the filter.

Field Description

Prompt Check this box if you want the report to prompt for sort 
order at run time. If Prompt is enabled (checked), at 
report run time a dialog will pop up to prompt the user to 
specify a sort order.

Count Specify the number of levels of sorting you want. 

For example, if you want to sort by Country, then by State 
and then by County, select 3.

Disable Forced Sorting Check this box if you do not want the user to re-order the 
data once it is sent from the database server.
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To specify a filter

Specify field names and associated parameters as described.

Working with Parameters
Reports get data by running pre-built query objects. If a query needs a value at report run 
time, it uses built-in, run-time parameters. At report run time, the user is prompted to 
provide values for run-time parameters as a prerequisite for running the report. The report 
is then generated based on the user-provided values for those parameters.

Parameters are stored on server and so can be used in one or more report and query 
objects.

To view and work with Logger Report parameters, click Design | Parameters in the 
Reports left pane or click Parameter Explorer and click on a category, select a parameter, 
and click the Edit Parameter Details button to open the Parameter Object Editor.

Field Description

Field Field on which to filter.

Type Sets the filter type:

• Select UseParameter to determine compare it 
(equality) with a parameter value that the user specifies 
at run time. 

• Select ADHOC to allow the user to select condition type 
at run time.

Data Type Sets the data type for the parameter:

• CHAR

• NUMBER

• DATE

Parameter In Parameter drop-down box, select the parameter to be 
used with this filter

Fetch Data If Fetch Data is selected (checked), the report server will 
pre-fetch the data, before the parameter form is presented 
to the user at run time.

Criteria

Value 1

Value 2

Mandatory

We recommend first designing all needed parameter objects before creating 
the query object that will use those parameter objects. (For information on 
creating queries, see “Setting up Queries” on page 302.)
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Figure 6-39 Report Parameters Object List

Creating New Parameters
1 In the Parameter Object Editor, click the Add New button located at the top left.

2 Specify values for the new parameter. (Details are given in the topics below.)

3 After providing all required values, click Save.

The parameter is added to the Parameters list.

Setting Parameter Name, Data Type, and Default Values
Specify the parameter unique ID, display name, data type, size, format, and default value 
as described in the table below.

Table 6-16 Parameter Name, Data Type, and Default Values

The parameter name must be unique amongst all parameters in the 
system.

Option Description

Name Provide a name to uniquely identify this parameter. This 
name should be unique amongst all parameters in the 
system.

Prompt Parameter name displayed on-screen to the user at report 
run time.
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Default Value for Date Type Parameter

For a date type parameter, the Default Value field provides an drop-down menu and a 

calendar. Click the calendar  to provide an explicit date, or select one of these dynamic 
variable values from the drop-down menu:

 CURRENT_DATE

 MONTH_START_DATE

 YEAR_START_DATE

You can also set a default date that is relative to any of the above three dynamic variable 
dates. 

For example, to set a default date as 3 days after CURRENT_DATE, specify 
CURRENT_DATE + 3.

To set a default date as 5 days before MONTH_START_DATE, specify MONTH_START_DATE 
- 5 .

To provide a value that is relative to a dynamic variable, select one of the dynamic 
variables, then type a suffix to it in the Default Value field by adding + or - and the number.

At report run time, a parameter with a “Date” format will display with the default date set 
here.

Data Type Specify type of value the user must provide at report run 
time:

• CHAR - Value may include alphabetical characters, 
numbers and special characters.

• NUMBER - Value may include digits and decimal points

• DATE - A date or part of a date, like day, month, or year

• BOOLEAN (For more information, see “To set up a 
BOOLEAN parameter:” on page 327.)

Size Specify number of characters or digits this parameter 
should accept.

Note: This is only applicable to CHAR and NUMBER data 
types, not for Boolean or Date type parameters.

Format Select the appropriate format in which user should provide 

value for this parameter. Click  ton to open a Data 
Format dialog box. Based on the format you have selected, 
a format string will appear in the entry box.

Default Value Specify a default value that is appropriate in most cases to 
provide for this parameter at report run time.

The default value will be automatically selected at report 
run time. The user can change the default value, if needed. 
If the user does not change it, the report will run using the 
default value you specify here for this parameter.

Option Description
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Defining Input Type

Figure 6-40 Parameter Input Type

The parameter input type describes the style of interface provided to users at report run 
time in which to enter a value for this parameter. Choose from Text Box, Combo, or 
Option as described below.

Table 6-17 Input Type

Setting up Boolean Parameters
Parameters that have a Boolean “Data Type” are represented to the user as checkboxes 
(the input type) and have only two states:

 Checked (chosen at run time)

 Unchecked (de-selected at run time)

To set up a BOOLEAN parameter:

1 Select Data Type as BOOLEAN.

2 In the Values area, for Checked specify the value to be passed when the user 
chooses this option at run time (selects/checks the checkbox presented).

In the Reports Designer, changing the parameter type TextBox to another 
type causes an error. If you need to change the parameter type to TextBox, 
do not edit an existing parameter, delete that parameter and add a new one. 

Option Description

Text Box Select “Text Box” input type if you want the user to type 
the value for the parameter.

Combo Select “Combo” if you want the user to select one value or 
multiple values from a drop-down menu. 

Select the Multi Select checkbox so that user can select 
multiple values from the box.

See “Setting Multiple Default Values” on page 329 to 
configure other settings for this option. 

Option Select “Option” if you want the user to select values 
represented as options. 

Select the Multi Select checkbox to have value options in 
the form of checkboxes.

Keep Multi Select checkbox clear to have options in the 
form of radio buttons.
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3 In Unchecked specify value to be passed when the user does not choose this option 
at run time (de-selects/leaves the checkbox unchecked). 

Setting Various Run Time Behaviors
You can specify a variety of options on how the parameter will look and act at report run 
time. These options are generally related to the input type, and further define acceptable 
user input values, whether the parameter will be displayed or hidden, provide searchable 
values, and so forth.

Table 6-18 Parameter Options

Setting the Data Source List
Specify values for Checkbox, Combo and Option input type. Values can be predefined only.

Option Description

Mandatory Select this checkbox if you want to require the user to 
specify a value for this parameter at report run time.

Visible Select this checkbox if you want the parameter to be visible 
(displayed) on the input form at report run time. 

Keep this unchecked (clear) if the value for this parameter 
be populated from another report or if you want the 
parameter to use the default value in all cases.

Restrict to List This setting is applicable for parameters with Input Type 
of Combo. Select (check) the Restrict to List checkbox 
here to force user input of a parameter value from the 
available run-time options only. 

If Restrict to List is not selected in the parameter 
definition you create here, the user can specify a value or 
can select value(s) from available options.

Pass Values Using 
Tables

This setting is applicable for Multi Select. Select this 
checkbox when you want to pass parameter values through 
a table. This is done especially when the number of values 
that can be passed (total number of bytes of selected 
values) as part of the SQL is more than allowed.

Enable

Forced Select this checkbox if you want to restrict parameter 
values to a pre-specified list of values.
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To Set Predefined Values

Figure 6-41 Setting Predefined Values for a Combo Input Parameter

1 In the Display Name field, specify the value to be displayed at run time. (The value 
the user will see.)

2 In the Value field, specify the value to pass (as a filter).

3 Click  (Add) to add the display name to the list.

(To delete an option from the list, select the value and click .)

4 Repeat these steps for each option.

Select the check box Display Parameter if you want to provide the user with the option 
of adding the parameter as a control on a report. In Name, specify a name for the 
parameter.

Setting Multiple Default Values

If you selected Combo Input Type (as described in “Defining Input Type” on page 327), 
you need to define the following settings in the Parameter editor:

The Display Parameter and Name settings have no effect when the 
Parameter Object is used in an ad hoc report.
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 Maximum Selectable Values—Specify the maximum number of values that can be 
selected or provided for a parameter.

 Enclosed By—Specify the character to use to enclose the set of values. This will 
depend on the database.

 Separator—Specify the character to use to separate the two values. This will depend 
on the database.

 Select Default Values—Specify the number of default values to display at report run 
time. You can choose from

 Selected—Only values for the selected parameters are displayed.

 All—Values for all parameters are displayed.

 None—No values are displayed. That is, no default values are defined.

Modifying a Parameter
1 On the Reports right panel menu, click Parameter Explorer to bring up the 

Parameter Object list.

2 In the Parameter Objects list, select the name of parameter that you want to modify 
and click the Edit Parameter Details button.

3 Edit the parameter as needed (via the settings described in “Creating New 
Parameters” on page 325) and click Save.

Only custom parameters can be modified, not supplied parameters, since supplied 
parameters are required for use in system Reports and Solution pack add-ons.

Deleting a Parameter
1 On the Reports left panel, click Parameter Explorer to bring up the Parameters 

Object list.

2 In the Parameters list, select the name of parameter that you want to delete.

3 Click Delete.

Only custom parameters can be removed, not supplied parameters, since supplied 
parameters are required for use in foundation Reports and Solution pack add-ons.

Configuring Parameter Value Groups
Some reports may require users to provide multiple run-time values that would be easier to 
select if they were grouped. For example, a report that requires a user to select more than 
one country name might be a good candidate for parameter value groups. Users might find 
it difficult to select a few country names from a single, long list of countries.

As an alternative, the query designer could create parameter value groups for the 
Americas, Europe, Asia, Africa, and so forth; each with lists of countries belonging to those 
continents or areas. At report run time, when the user selects a group, values belonging to 
the group are pre-selected. Users do not have to manually select countries in, for example, 
Europe or Asia, for every report run. Selections are saved from one report run to the next.

Using parameter value groups as a part of your query design strategy can save users time 
and reduce error at report run time.
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To view and work with Logger Report parameter value groups, click Design | Parameter 
Value Groups on the Reports left panel.

Figure 6-42 Parameter Value Groups

The following table describes the options on the Parameter Value Groups page. 

Table 6-19 Parameter Value Groups

To create a group

1 Click  (Add Group) next to the Value Groups box. A group is created and listed 
under Value Groups with a default name (based on the currently selected parameter in 
Parameters list). 

2 In the Value Groups list, edit the new group name as needed. (Double-click the name 
to edit it, if it is not already in edit mode.) Double-click the name again to set it, or 
click outside the box. 

3 Add the values you want in the group by selecting a value in Available Values list 

and clicking  (Add value to selected group) button. The selected value is added to 
the selected group in the Value Groups list. 

4 Repeat Step 3 for each value you want to add to the group.

Option Description

Parameters Lists all the parameter objects.

Available Values Lists available values for the selected parameter.

Value Groups Lists groups created and the values selected within a group. 
An icon appears on the left of a Private group.

Show All Owners If selected, displays groups created by all users. 

Option buttons Private 
and Public

Select Private to list the groups you have set for you only. 

Select Public if you wish to list the groups you have set for 
everyone.
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If a value that you want to add to a group is not listed in Available Values list, specify the 
value in Additional Value field (under Available Values) press Return key. The custom 
value is added to the currently selected group.

Select an Available Value and click  to add all the values to the selected group in Value 

Groups, click  to remove the selected value from Value Groups, and click  to remove 
all the values from Value Groups box.

Select a group and click up  and down  arrows to move the selected group up or 

down. Select a value and click up  and down  arrows to move the selected value up 
or down (within the group).

Click Save button to save the work.

To create a tree view parameter

To select a value, click the leaf node and click  button.

To select all values in a branch (only for a multi-select parameter), click the respective 

branch and click the  button. All the values under that branch will be selected.

To make changes in name of a group, double-click the group name to make it editable. 
Specify a new name and click outside the box.

To delete a group, click  in the title of group you want to delete.

Click Save button to save the changes.

Applying Report Template Styles
Logger Reports use a style file (.sty) to generate report output per a specified format. 
The style file defines the look and feel, arrangement, orientation, and so on, of the report 
output. 

If the name of a group is changed by a user, the values under that group will 
be removed from the “Selected Values” group of that user's preferences.
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You can modify any of the style files from the Logger Reports Template Styles page or you 
can define a new style to suit your needs.

To view and work with Logger Report template styles, click Design | Template Styles on 
the Reports left menu bar. 

Figure 6-43 Report Template Styles Configuration

Defining a New Template

To define a new template:

1 Click Design | Template Styles on the Reports left menu bar. 

2 Click the  icon in the right panel.

3 Define the Items and Item Properties for the template.

4 If you want to define or change the report layout file, click Edit Layout.

A report layout file (.irl) defines factors like paper size, static controls, 
headers and footers to include in a report, and so on. Starting with Logger 
v4.0, you can define your own layout files. See “Defining a New Template” on 
page 333 for more information.

You can search for an existing template. To do so, either

• Enter the first few letters with which the template name begins (if the 
“Starts With” search criteria is selected) in the text box above the list of 
existing templates, OR

• Enter a word or part of a word that the template name contains (if the 
“Contains” search criteria is selected) in the text box above the list of 
existing templates.

You will need to edit the layout of the report to include a header or 
footer in a report. After clicking Edit Layout, click “Report Header” (to 
include a header) or “Page Footer” (to include a footer) to select that 
section. Click Insert > Layout Control > select an option from the 
sub-menu.
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5 Click Save.

Scheduling Reports
You can schedule reports to run as scheduled “jobs” on a one-time basis in the future, or 
set a frequency schedule (hourly, daily, and weekly). As part of scheduling a report job, you 
can set delivery options to e-mail, save, or publish the resulting reports.

ArcSight recommends using the Scheduled Report feature in lieu of running on-demand 
(ad hoc) reports whenever possible, so that reports are run during periods of light load. For 
more on this see “Best Practices” on page 277.

Make sure you are familiar with the information in “Impact of Daylight Savings Time 
Change on Logger Operations” on page 309 before you schedule reports.

Viewing and Editing Scheduled Reports
Reports that are already scheduled are displayed on the Scheduled Reports page.

To view scheduled reports

Click Scheduled Reports on the Reports page left pane to view a list of currently 
scheduled jobs.

Figure 6-44 Scheduled Reports

To edit a scheduled report

Click  (Edit) next to the scheduled report job you want to edit.

This brings up the Edit Report Job page, which lets you change most of the settings on the 
scheduled job. Modify the settings as needed and click Save.

For details on how to specify these settings, see “Scheduling a Report” on page 335.

To view scheduled reports, a user must belong to a Logger Reports Group, a 
Logger Search Group, and a Logger Rights Group.

The job name is not editable once the scheduled report job is created.

Other settings can be modified with an edit, and work the same way as on 
the Add a Report Job page described in “Scheduling a Report” on page 335.
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To remove a scheduled report

Click  (Delete) next to the scheduled report job you want to remove.

Scheduling a Report
Make sure you are familiar with the information in “Impact of Daylight Savings Time 
Change on Logger Operations” on page 309 before scheduling a report.

To schedule a report

1 Click Scheduled Reports on the Reports page left menu.

The page shows the list of currently scheduled report jobs, if any. (See Figure 6-44.)

2 Click Add to bring up the Add Report Job page.

3 On the Add Report Job page, use the drop-down menu next to Report Name to 
select a report, and click Go to load the report.

4 Choose one or both delivery options under Delivery Option (Email, Publish). By 
default, only Publish is selected. 

If you want to keep the Publish option, enter its associated parameters. Or uncheck it 
to unselect. 

If you also want the Email option, click it and enter its associated parameters. 

Both E-mail and Publish options for scheduled reports are the same as those provided 
after you run a report “on demand”.

 Email - For details on setting e-mail delivery options, see “E-mailing a Report” on 
page 286.

Removing the report from Scheduled Reports list here deletes the scheduled 
job, not the report itself nor any instances of its previously published output.

You must click Go to load the selected report at the Report Name field 
before you save the scheduled report job. Attempting to save the 
scheduled job without first loading the report name will result in an error, 
and the report will not be saved.
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 Publish - For details on setting publishing options, see “Publishing Reports” on 
page 284.

5 Fill in the rest of the fields based on the report you chose, as described in “Add Report 
Job Settings” on page 336.

6 Click Save.

The report you added is scheduled, and now shows on the Scheduled Reports list.

Add Report Job Settings
The following table describes the Add Report Job settings.

Table 6-20 Add Report Job Settings

If you got a batch error when you clicked Save, try clicking Go next to 
the Report Name to reload the report per Step 3. This is the most 
common oversight in terms of specifying the job parameters.

Option Description

Name Provide a name for the report job. This is the name 
that will be displayed on the Scheduled Jobs list.

Schedule Set the frequency for the scheduled run of the report. 

For example, you can specify to run the report on 
specified “Days of the Week” like Sa, Su, M, T, and so 
forth, or “Everyday”.

You can choose to run the report at a certain hour 
every day “Hour of the Day” or “Every” hour so many 
hours.

Report Name Select a report from the list, and click Go to load the 
report.

Note: You must click “Go” to load the selected report 
at the Report Name field before you save the 
scheduled report job. Attempting to save the scheduled 
job without first loading the report name will result in 
an error, and the report will not be saved.
336 Administrator’s Guide Confidential



6 Reporting
Deploying a Report Bundle
You might obtain additional sets of reports from ArcSight to address new security 
scenarios, add packaged solutions, or enhance your current coverage with updated 
reports. You can use the Deploy Report Bundle page to load and deploy packages of 
new reports onto your Logger system.

On the Reports page left panel menu, click the Deploy Repository Bundle link to get 
started.

Figure 6-45 Deploy Report Package

A report package (or “cab” file) can contain several types of reporting resources, including:

 Categories and reports

 Organization information

 Schedules

Delivery Options Depending on which delivery option you choose, the 
associated parameters are displayed. Click to enable 
(check) or disable (uncheck) these options.

Both E-mail and Publish options for scheduled reports 
are the same as those provided after you run a report 
“on demand”.

Select a delivery option:

• Email - For details on setting e-mail delivery 
options, see “E-mailing a Report” on page 286.

• Publish - For details on setting publishing options, 
see “Publishing Reports” on page 284.

• Save In - 

• File Name - 

• Suffix Timestamp Format - 

• Valid Upto - 

• Pagination - 

Report Format Select a report format (Acrobat PDF, HTML, and so 
forth.)

For details on report formats, see “Report File Formats” 
on page 284.

Report Parameters You can either accept the default parameters, or 
modify them here. These are the same parameters 
that can be specified for an on-demand report run.

For information on specifying report parameters, see 
“Quick Run with default options / Run In Background 
Report Parameters” on page 279.

Option Description
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 Portal properties and server properties

 Parameter objects

 Query objects

 Adhoc report templates

 Printer settings

 Database connections

To upload and deploy report package

1 In the entry box provided under Step 1, specify the reports package file name and 
with its full path. Click the Browse button to locate the file.

2 Click Upload.

The content is uploaded and information is displayed about the included categories 
and reports. (A legend is provided below these steps).

3 If you want to create log of the deployment process, click (check) the Create Log 
File option.

4 Click Deploy to continue with the deployment process. 

(Or click Cancel to discontinue with deployment process.)

Status information is displayed about the objects in the package being deployed.

A legend is displayed just below the Deploy button. Information about each of the 
components in the package is displayed in respective tabs.

A log file will be created if the “Create Log File” checkbox was selected.

The contents of the deployed reports package is available on the respective Logger Reports 
pages. Solution Reports will be listed under Solution Reports on the left panel menu. For 
more information about these types of reports, see “Solution Reports” on page 255.

Report Server Administration
ArcSight Logger Reporting provides a default configuration for the report server. If you do 
not modify the report server, reports will run with the default settings.

To view or modify the report server and client configuration, click Report Administration 
on the Reports page left panel menu.

Figure 6-46 Reports Server Configuration

Overwrite behaviors are determined when the package was created.

For example, protocol on whether or not an object in the deployed package 
will overwrite an existing object on the system, and under what 
circumstances, is determined at package creation time. Therefore, these 
settings on package deployment are not available to you at deploy time.
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The following table describes the report server configuration settings.

Table 6-21 Reports Server Configuration

Using Report Category Filters
A Search Group Filter can be optionally assigned to each report category.

Assigning a Search Group Filter to a report category means that all the reports in the 
category will only process events returned by this filter.

Option Description

Database Connection 
Timeout

Time in seconds after which the database connection 
will be closed, if not used for that many seconds. 

Valid values for this timeout is any integer greater than 
zero.

Default: 14400

Example: If DATABASE_CONNECTION_TIMEOUT is set 
to 50, report server will close the connection to a 
database if there is no communication between the 
report server and database server for 50 seconds.

Log Level Sets the level of criticality to be considered for logging. 

Valid values are DEBUG, INFO, WARN, ERROR, FATAL.

Default: ERROR.

Example: LOG_LEVEL = ERROR

Data Source Fetch Size Specifies the number of records to be fetched from the 
data source at one time (in one “read”). 

A valid value is any positive integer.

Default: 50

Example: DATA_SOURCE_FETCH_SIZE=50

E-mail from Address Sets the e-mail address to be displayed as the “from” 
(sender's) address in e-mails originating from the 
Logger Reporting system.

Default: None.

Example: loggeradmin@companyxyz.com

Host URL Host URL (URL to be specified to run the Logger 
application) sent as part of Logger Reporting e-mails. 

Syntax: HOST_URL=[Host URL](String)

Default: https://<logger_hostname>/logger/report

Example: 
HOST_URL=https://loggerA.companyxyz.com/logger/r
eport

SMTP Server Sets the server IP address or domain name (as IP or 
URL) used to e-mail scheduled reports. All e-mail 
communications, such as notifications and report 
delivery, are sent by Logger Reporting via this e-mail 
server. 

Example: SMTP_SERVER=127.0.0.1
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To assign a search group filter to a report category

1 Create the filter that you would like to apply to every report in a given category. See 
“Filters” on page 204 for the details of creating a filter of type Search Group.

2 Click the Reports tab. In the menu, under Administration, click Report Category 
Filters.

3 The new search group filter will appear in the pull-down menu associated with each 
category. Select the desired filter for each category. 

4 Click Save.

To remove a search group filter from a report category

1 Click the Reports tab. In the menu, under Administration, click Report Category 
Filters.

2 In the pull-down menu associated with the report category from which you want to 
remove the filter, select None.

3 Click Save.

Backup and Restore of Report Content
Starting with Logger v3.0, you can backup and restore report content. For more 
information about this feature, see “Configuration Backup and Restore” on page 219.

iPackager
The iPackager is a utility that allows you to package all or selected reports and/or report 
objects residing in Logger. This package can be later imported on a different Logger 
installation at any time. If you own multiple Loggers, you can use the packages created by 
iPackager to configure the reporting feature on them. Set it up at one location and create a 
package using the iPackager, then you can upload the package at other locations. This 
method completely eliminates the need of re-doing all the configuration activities at 
multiple locations.

To access the iPackager, click the iPackager link in the left panel of the Reports page.

Using the iPackager, you can package and distribute:

 Repository objects like folders, reports, query objects, parameter objects, OLAP 
layouts and dashboards (along with access right information)

 Organization, user, user access rights and user mappings

 Schedules

 Data connection information (along with access rights information)

 Print settings

 Web client properties

 Report server configuration files

 Adhoc report templates

The iPackager utility can be used by only the Super Administrator.
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 Java plug-ins

 Approval process details

The iPackager allows you to first create a .conf file in which you can collect (import) the 
references for all the components that you want to include in the package. You can save 
the .conf file and edit it at any time. Once you are satisfied with the contents of the .conf 
file, you can build the package. The package is built into a CAB file. The components 
referenced in the .conf file are actually picked up when building the CAB. Data to be 
packaged in a single CAB can be imported from multiple report servers.

You can open only one .conf file in iPackager at a time. When iPackager opens a .conf file, 
it checks for the availability of the components already imported in the .conf file. If any of 
the components already imported are not found on the report server, it is indicated on the 
tree-view. In such a case, a CAB cannot be built.

The iPackager Page
The iPackager page consists of three panes that are located to the right of the navigation 
pane on the Reports page. The pane to the immediate right of the navigation pane in the 
reports page displays the presently included contents of a .conf file that is open in the 
iPackager. These contents are displayed in a tree view. The Build Properties box displays 
the details of the object selected from the CAB. You can edit what contents you would like 
to include in the CAB file in the Build Properties box using the buttons described below. The 
Messages and Problems tabs display messages, logging details and problems faced while 
creating or editing a package.

Buttons Available from the iPackager
The following buttons available on top of the iPackager page represent the various actions 
that can be performed from within the iPackager:

Buttons Description

New. Create a .conf file

Open. Opens an existing .conf file in iPackager

Save. Save the currently open .conf file

Save As. Save the .conf file that is currently open under a new 
name

Clear Package. Clears the contents of a package that is currently 
open in iPackager

Import Selective Data from Report Server. The data is imported 
as references into the .conf file that is currently open in iPackager. 
You can specify what you would like to import. For example, you can 
choose to import query objects parameter objects and reports only.

Import Complete Data from Report Server. Imports everything 
from the report server.
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When you first open the iPackager page or when you click the New button, you will be 
prompted to enter the following identifying information for the CAB file that you will be 
creating with the currently displayed .conf file:

 Author

 Company

 Version

 Comment

Importing References from the Report Server
You can import references from a report server into a .conf file. Keep in mind that only 
references to those components will be imported into the currently open .conf file in the 
iPackager. The actual components will be picked up during the creation of the CAB.

To import selective data: 

1 Click the Import Selective Data from the Report Server button located on top of 
the iPackager page. You will see the following form:

2 Check whatever components you want to import. 

3 You will prompted to select specific pieces within the component for example, if you 
checked the Reports checkbox, you will further be prompted to select the specific 
reports you want included.

4 Once iPackager completes importing the selected data, you can see the references to 
that data in a tree structure in the left pane of the iPackager page.

5 Click Save or Save As icons to save the .conf file.

Cancel Server Import. Cancels a current import action from the 
report server.

Build CAB. Initiate the process of building a CAB file.

About. Gives you the version number of the iPackager

Since Reports are saved in categories, if you select only a report, its category 
gets automatically selected too.

Buttons Description
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Click the Cancel Server Import button from the toolbar at any point of time to cancel the 
data transfer. In this case, the .conf file state will be restored to the state before the import 
began. None of the data from the current import will be included in the package.

To import everything from the Report server:

1 Click the Import Complete Data from Report Server button. You will see the 
same page as shown above with every checkbox checked for you.

2 You still have the option to uncheck any box against any component if you decide you 
do not want to import it.

3 Click Import.

4 Once iPackager completes importing the selected data, you can see the references to 
that data in a tree structure in the left pane of the iPackager page. 

5 Click Save or Save As icons to save the .conf file.

You can see the status of the import in the Messages tab located below the Build 
Properties box.

Modifying Properties for Imported Objects
You can modify component details as well as delete one or more components in an open 
conf file. To do so, click on the object in the navigation tree in the iPackager page. The 
properties page for the object appears in the upper right pane. All of the following 
properties allow you to choose any of the following deployment action on the target 
chosen:

Replace if present - While importing, if the component is found in the package, replace 
the one in package with the one on the report server.

Add if not present - While importing, if the component is not found in the package, add 
it to the package.

Delete if present - While importing, if the component is found in the package, delete it.

Cascade Delete - For Categories only, delete the folder (category) even if it contains 
reports.

Category Properties
When you click on a Category in the navigation tree of the iPackager page, the following 
property page opens.

The Category box come pre-filled with the category name that is present on the report 
server. You can change the name of the category. If you change the name here, the 
category gets packaged with the new name, but its original name on the report server will 
not change.
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Report Properties
When you click on a report in the navigation tree of the iPackager page, the following 
property page opens.

The Report box come pre-filled with the report name that is present on the report server. 
You can change the name of the report. If you change the name here, the report gets 
packaged with the new name, but its original name on the report server will not change.

Query Properties
When you click on a query in the navigation tree of the iPackager page, the following 
property page opens.

The Query Object box come pre-filled with the query object name that is present on the 
report server. You can change the name of the query object. If you change the name here, 
the query object gets packaged with the new name, but its original name on the report 
server will not change.

Parameter Properties
When you click on a parameter in the navigation tree of the iPackager page, the following 
property page opens.

The Parameter Object box come pre-filled with the parameter object name that is 
present on the report server. You can change the name of the parameter object. If you 
change the name here, the parameter object gets packaged with the new name, but its 
original name on the report server will not change.
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Template Properties
When you click on a template in the navigation tree of the iPackager page, the following 
property page opens.

Opening a .conf File
To open an existing file in iPackager:

1 Click the Open button in the toolbar on top of the iPackager page.

2 Navigate to the saved .conf file and click Open.

Deleting an item from the .conf file
1 Open the .conf file in iPackager.

2 From the iPackager page, navigate to the item and select it. Selected item’s details will 
be displayed on the right pane (properties area).

3 Click the Delete button in the Properties area. A warning dialog will appear.

4 Click Yes to confirm deletion of the selected item.

Clearing the contents in a .conf file
1 Open the .conf file in iPackager.

2 Click the Clear package button in the toolbar.

3 A warning dialog box appears.

4 Click Yes to go ahead with deletion.

Building the CAB
When you issue command to build the cab, the actual objects specified in the references in 
your open .conf file are actually picked up from the respective locations and a CAB file is 
built. This CAB file will contain all the objects.

If any of the information saved in the .conf file is not available at the right source while 
building the CAB, then you will see an error message and the CAB building process will be 
stopped. You will need to fix any errors before rebuilding the CAB file.

To build the cab,

1 Click the Build CAB button on the toolbar. The Build Properties screen appears.

2 Specify the build properties and click the Build Cab button. The Save dialog box 
opens.

3 Specify the credentials and location to save the file.

4 The Cab building process will begin.
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Deploying a CAB file in Logger

To deploy a CAB file in Logger:

1 Click the Deploy Report Bundle link in the left pane of the Reports home page. You 
will see the following page.

2 Click the Browse button to select the CAB file to be uploaded, and click Upload.

3 Click the Deploy button.

When deploying a CAB file from a source Logger to a target Logger, if the 
categories being imported do not have identical names and IDs on both 
Loggers the deployment will fail.

Should you run into this issue, rename the conflicting category in the target 
Logger or the source Logger (you will need to recreate the CAB file if you do 
this on the source Logger) such that the category has a unique name and/or 
ID. Then, redeploy the CAB file.
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Chapter 7

System Admin - Logger Appliance

This chapter describes the System Admin tab that enables you to configure network, 
storage, and security settings for your system.  Additionally, you can create and manage 
users and user groups using this tab. 

The following topics are covered in this chapter: 

System
From the System tab, you can configure system specific settings such as network settings 
(if applicable) and SMTP. 

“System Locale” on page 348

“Reboot” on page 348

“Network” on page 348

“SMTP” on page 352

“License & Update” on page 353

“Process Status” on page 353

“SNMP” on page 354

“SSH Access to the Appliance” on page 355

“Audit Logs” on page 356

“Audit Forwarding” on page 357

“Remote File Systems” on page 358

“RAID Controller/Hard Disk SMART Data” on page 365

“SSL Server Certificate” on page 366

“SSL Client Authentication (CAC Authentication)” on page 368

“FIPS 140-2” on page 371

“Authentication” on page 375

“Login Banner” on page 380

“User Management” on page 381

“Change Password” on page 385

“Forgot Password” on page 386

“Monitoring System Health” on page 386
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System Locale
The Locale setting ensures that the user interface displays information such as date, time, 
numbers, and messages in the format and language appropriate for the selected country.

On a new Logger appliance, Locale is generally configured during the Logger initialization 
process. However, if you skipped this step during the initialization process, you can 
configure it later. Once configured, Locale cannot be changed. 

To view or configure System Locale:

1 Click System Admin from the top-level menu bar.

2 Click System Locale from the System section.

3 To configure System Locale, select the new value.

4 You must reboot Logger for the changes to become effective. See “Reboot” on 
page 348.

Reboot
To reboot your ArcSight System:

1 Click  System Admin from the top-level menu bar.

2 Click Reboot from the System section.

3 Click Start Reboot Now.

Your system will reboot in about 60 seconds. The boot process normally takes 5-10 
minutes, during which time the system is unavailable.

 

Network 
You can configure the DNS, Hosts, NICs, static routes, and system time settings under the 
Network menu.

System DNS 
To change DNS settings:

1 Click  System Admin from the top-level menu bar.

2 Click Network from the System section.

3 In the System DNS tab, enter new values for the IP address of the primary and 
secondary DNS servers, or edit the list of search domains. 

To add a new domain, click the  icon. To remove a domain, click the  icon. To 

change the search order of domains, select a domain name and click the up or down 
arrows until desired order is established.

During reboot, Logger is not able to receive events. Events may be lost 
while the Logger reboots, unless SmartConnectors are used. 
SmartConnectors cache events when destinations like Logger are 
temporarily unavailable.
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4 Click Save to save the changes. Then, click Restart Network Service for changes 
to become effective. 

Hosts
The Hosts tab allows direct editing of your system’s /etc/hosts.txt file. You can enter data 
in the System Hosts text box or import it from a local file.

To change the Hosts information:

1 Click  System Admin from the top-level menu bar.

2 Click Network from the System section.

3 In the Hosts tab, enter hosts information—one host per line—in the System Hosts text 
box in this format:

<IP Address> <hostname1> <hostname2> <hostname3>

If you want to import information from a file, click Import from Local File and locate 
the text file on the computer from which you are accessing your ArcSight system. 

4 Click Save to save the changes. 

NICs
The NICs tab enables you to set the IP addresses for the network interface cards (NICs) on 
your system. Additionally, you can configure the hostname and default gateway for your 
system. 

To set or change the NICs settings:

1 Click  System Admin from the top-level menu bar.

2 Click Network from the System section.

3 In the NICs tab, enter these settings. To edit the IP address, subnet mask, or 
speed/duplex of a NIC, select the NIC and click Edit above the NIC Name list.

Setting Description

Default 
Gateway

The IP address of the default gateway.

Hostname The network host name for this system. Make sure that your 
DNS can resolve the host name you specify to your system’s IP 
address. Performance is significantly affected if DNS cannot 
resolve the host name.

This name must be identical to the domain specified in the 
Certificate Signing Request, described in “Generating a 
Certificate Signing Request” on page 366. 

Note: If you use a CA-signed certificate on this system and you 
are changing its host name, you must generate a new CSR, 
obtain a new certificate for your system, and upload it to ensure 
that the connectors (in FIPS mode) that communicate with your 
system will be able to validate the host name. For more 
information about generating a CSR, see “Generating a 
Certificate Signing Request” on page 366.
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4 Click Save to save the changes. Then, click Restart Network Service for changes 
to become effective.

Static Routes
You can specify static routes for the NICs on your system. 

To add a static route:

1 Click  System Admin from the top-level menu bar.

2 Click Network from the System section.

3 In the Static Routes tab, click Add to add a new static route. To edit or delete an 
existing route, select the route first, then click Edit or Delete. 

When adding or editing a static route, you need to configure these settings.

Automatically 
route 
outbound 
packets 
(interface 
homing)

When this feature is enabled (checked box), the response 
packets are sent back on the same system interface on which 
the request packets had arrived. Doing so can improve 
performance as the routing decisions do not need to be made 
(using the default gateway information and static routes) to 
send packets out from your system. If you have default gateway 
and static routes configured, they are ignored when this feature 
is enabled.

When this feature is disabled (unchecked box), the default 
gateway and static routes (if configured) are used to determine 
the interface through which the response packets should leave 
your system.

If you configure only one network interface, this setting does 
not provide any additional benefit.

IP Address The IP address for each network interface card (NICs) in your 
system. These IP addresses should be on separate subnets to 
avoid confusion and to allow load balancing between receivers 
and forwarders.

Subnet Mask The subnet mask associated with the IP address you entered for 
a NIC. 

Speed/Duplex Choose a speed and duplex mode, or let your system 
automatically determine the network speed:

Auto (recommended)

10 Mbps - Half Duplex

10 Mbps - Full Duplex

100 Mbps - Half Duplex

100 Mbps - Full Duplex

1 Gbps - Full Duplex

Setting Description

NIC The network interface card (NIC) to which the static route 
applies

Type Whether the static route is to a Network or a Host

Destination The IP address for the static route destination

Setting Description
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4 Click Save to save the changes. 

Time/NTP
The Time/NTP tab enables you to configure system time, date, local timezone, and NTP 
servers. ArcSight strongly recommends using an NTP server instead of manually 
configuring time and date on your system. Precise time stamping of events is also critical 
for accurate and reliable log management. The times displayed for Logger operations such 
as searches, reports, and scheduled jobs are in the Logger’s local time zone.

To set or change the system time, date, or timezone manually:

1 Click  System Admin from the top-level menu bar.

2 Click Network from the System section.

3 In the Time/NTP tab, configure these settings.

The Time Zone change requires you to reboot the appliance. However, the Current 
Time change takes affect immediately.

To configure your system as an NTP server or for using an NTP server for your 
system:

1 Click  System Admin from the top-level menu bar.

2 Click Network from the System section.

3 Click the Time/NTP tab.

4 Under NTP Servers, configure these settings.

To add a new NTP server, click the  icon. To remove a server, click the  icon. 

To change the order in which the NTP servers should be used, select a server and click 
the up or down arrow until desired order is established.

Subnet Mask The subnet mask if you specify a network as the destination

Gateway The IP address for the default gateway

Setting Description

Current Time 
Zone

The time zone appropriate to your system’s location. To chnage 
this setting, click Change Time Zone...

Current Time The current date and time at the system’s location. To change 
this setting, click Change Date/Time...

Setting Description

Enable as an 
NTP server

Check this setting if this system should be used as an NTP 
server.

Setting Description
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5 Click Save to save the changes. Then, click Restart NTP Service for changes to 
become effective. 

Impact of Daylight Savings Time Change on Logger Operations
Scheduled operations on Logger such as reports, event archives, and file transfers are 
impacted when system time is adjusted on the Logger at the start and end of the daylight 
saving time period (DST). The operations scheduled for the hour lost at the start of DST 
(for example, on March 8, 2009) are not run on the day of time adjustment. Similarly, 
operations scheduled for the hour gained at the end of the DST (for example, on November 
1, 2009) are run at standard time instead of the DST time. 

Examples:

 A report scheduled to run at 1 a.m. DST on November 1, 2009 will run at 1 a.m. 
standard time, which is an hour later than the DST time on that day. 

 A report scheduled to run at 2 a.m. on November 1, 2009 will run at 2 a.m.; however, 
due to time adjustment, an hour later than it ran on the previous day (October 31, 
2009).

 A report scheduled to run at 2 a.m. on March 8, 2009 will not run. 

SMTP
Your system uses the Simple Mail Transfer Protocol (SMTP) setting to send email 
notifications such as alerts, password reset emails, and so on.

To set or change SMTP settings:

1 Click  System Admin from the top-level menu bar.

2 Click SMTP from the System section and enter these settings.

3 Click Save to save the changes.

NTP Servers Enter the host name of an NTP server. For example, 
time.nist.gov.

ArcSight recommends using at least three NTP servers to 
ensure precise time on your system. To enter multiple NTP 
servers, type one server name per line. 

Once you add servers to this list, you can click the “Click to 
Test” link to verify if the servers you added are reachable from 
your system.

Notes:

• An ArcSight system can serve as an NTP server for any other 
ArcSight system.

• If System A serves as an NTP server for System B, System B 
needs to list System A in its NTP Servers list.

• Use the Test Servers button to verify the status of the 
servers entered into the NTP Servers box.

You may need to scroll down to view the Save button and Restart NTP 
Service. 

Setting Description
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License & Update
You can update your appliance’s software or apply a license to it on this page. This page 
also displays the elapsed time since the appliance was last rebooted, license information, 
and the version of the appliance components. 

Updating the appliance software requires uploading an upgrade file you downloaded from 
the ArcSight Customer Support web site. 

To update an appliance:

1 Download the update file from the ArcSight Download Center at 
https://arcsight.subscribenet.com to the computer from which you are accessing the 
appliance’s user interface. 

2 Connect to the appliance’s user interface.

3 Click  System Admin from the top-level menu bar.

4 Click License & Update from the System section.

5 Click Browse to locate the file.

6 Click Upload Update.

To apply a license file to an appliance:

1 Download the update file from the ArcSight Download Center at 
https://arcsight.subscribenet.com to the computer from which you can connect to the 
appliance. 

2 From the computer to which you downloaded the update file, log in to the appliance’s 
user interface using an account with administrator (upgrade) privileges.

3 Click  System Admin from the top-level menu bar.

4 Click License & Update from the System section.

5 Browse to the license file you downloaded earlier and click Upload Update.

Wait until a the user interface displays a message indicating that the upload was 
successful. You do not need to reboot your system after applying a license file. 

Process Status
The Process Status page lists all processes related to your ArcSight system and enables you 
to view the details of those processes and start, stop, or restart them.

To view the Process Status page:

1 Click  System Admin from the top-level menu bar. 

2 Click Process Status from the System section to display a page similar to the one 
shown in the following figure.

In the process list, processors refers to Forwarders.

System Update will take effect after the next reboot. To update 
immediately, reboot the system after performing a System Update. See 
“Reboot” on page 348. A reboot is not required if you are only updating 
the license.
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To view the details of a process, click the  icon to the left of the process name, as 
shown in the following figure.

To start, stop, or restart a process, select the process and click Start, Stop, or Restart at 
the top of the process list.

SNMP
You can poll system health information from Logger using SNMP version 2 from any 
standard network management system. Refer to your system’s Management Information 
Base (MIB) at 
https://<system_name_or_ip>/platform-service/appliance.mib for the 
events you can poll from your system. The Object IDentifier (OID) 
“.1.3.6.1.4.1.11937.3” identifies those events.

You can only perform the snmp get, getnext, getbulk operations on your system; 
snmp set operations are not allowed.

By default, SNMP polling is enabled and a default, random community string is configured 
on your system. You can update the default community string to suit your needs. By 
default, your system listens on port 161 for SNMP requests. You can also update the port 
number, if needed. 

Enabling or disabling SNMP polling requires you to reboot your system. However, you do 
not need to reboot your system when setting a community string or updating the port 
number.
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To enable or disable SNMP polling:

1 Click System Admin from the top-level menu bar.

2 Click SNMP from the System section.

3 Select Enabled to enable and Disabled to disable SNMP on your system.

4 Click Save.

A system message prompts you to reboot your system for the new setting to take 
effect.

To change SNMP community string or port number:

1 Click System Admin from the top-level menu bar.

2 Click SNMP from the System section.

3 Enter the new community string in the Community String field.

4 Enter the new port number in the Port field.

5 Click Save.

SSH Access to the Appliance
When you report an issue to ArcSight Customer Support that requires them to access your 
appliance for troubleshooting and diagnostics in situations such as an upgrade failure, 
unresponsive appliance, and so on, they will direct you to enable SSH access on it. 

By default, SSH access (known as Support Login in previous releases) to your appliance is 
disabled; however, you can select one of these options in the appliance’s user interface to 
enable it:

 Enabled—SSH access is always enabled.

 Enabled, only for 8 hours—SSH access is automatically disabled eight hours after it 
was enabled.

 Enabled, only during startup/reboot—SSH access is enabled during the time the 
appliance reboots and is starting up. It is disabled once all processes on the appliance 
are up and running. This option provides a minimal period of SSH access for situations 
such as when the appliance does not start successfully after a reboot. 

Enabling or Disabling SSH Access
To enable or disable SSH access to your appliance:

1 Click  System Admin from the top-level menu bar.

2 Click SSH from the System section.

Even if SSH is disabled on your appliance, you can access its console if you 
have it setup for remote access using the HP ProLiant Integrated Lights-Out 
(iLO) Advanced remote management card. For more information about set-
ting up your appliance to access its console remotely, see “Configure Logger 
for Remote Access” on page 35.
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3 Select one of the following options. 

Once you select an option, the user interface displays a message that requires you to 
confirm the action. Once you confirm it, the change takes effect. 

Connecting to Your Appliance Using SSH
Once you have enabled the SSH access, follow these steps to connect to it using SSH:

1 Connect to the appliance as “root” using an SSH client. 

2 When prompted to enter a password, enter any text and press Enter. 

You are prompted to enter a response to the challenge string that is displayed on your 
screen. 

3 Call ArcSight Customer Support to obtain the challenge response string. Enter it at the 
“Enter response:” prompt and press Enter.

If the correct string is entered, you are connected to the appliance for the amount of time 
specific to the option you had selected in “Enabling or Disabling SSH Access” on page 355.

Logs
Your system can generate audit logs at the application and platform levels. Use the Logs 
sub-menu to search audit logs and configure audit forwarding so that the system can send 
audit events to a destination, such as ESM.

Audit Logs
Your ArcSight system’s audit logs are available for viewing. Audit logs, as Common Event 
Format (CEF) audit events, can be sent to ArcSight ESM directly for analysis and 
correlation. For information about forwarding audit events, see “Audit Forwarding” on 
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page 357. For a list of audit events that you can forward, see Appendix E‚ Logger Audit 
Events‚ on page 537.

To view audit logs:

1 Click  System Admin from the top-level menu bar.

2 Click Audit Logs from the Logs section.

3 Select the date and time range for which you want to obtain the log.

4 To refine the audit log search, optionally specify a string in the Description field and 
user name in the User field. When a string is specified, only logs whose Description 
field contains the string are displayed. Similarly, when a user is specified, only logs 
whose User field contains the username are displayed.

5 Click Search.

Audit Forwarding
You can forward audit events to ArcSight ESM for correlation and analysis. For a list of audit 
events that you can forward, see Appendix E‚ Logger Audit Events‚ on page 537.

To forward audit events to specific ESM destinations:

1 Click  System Admin from the top-level menu bar.

2 Click Audit Forwarding from the Logs section. 

3 Select destinations from the Available Destinations list and click the right arrow icon 

( ) to move the selected destination to the Selected Destinations list. You can select 
multiple destinations at the same time and move them over. Or you can move all 

available destinations by clicking the ( ) icon. 

The destinations are ESM destinations that you configure on the ESM Destinations 
page (Configuration > Event Input/Output > ESM Destinations).
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4 Click Save Settings.

Storage
Use the Storage sub-menu to add an NFS mount or a CIFS mount, or SAN (if applicable) 
and to view the status of the hard disk array (RAID) controller and specific system 
processes.

Remote File Systems
Your system can mount Network File System (NFS) and CIFS (Windows) shares. As a 
result, it can read log files and event data from UNIX, Linux, Windows remote hosts, and 
any Network Attached Storage (NAS) solutions based on these operating systems. In 
addition, you can use the NFS and CIFS mounts for archiving data such as events, exported 
filters and alerts, and saved searches. Loggers with Storage Area Network (SAN) capability 
can also interface with a SAN.

Use of NFS for primary storage of Logger events is not recommended. Using a CIFS share 
for primary storage is not supported. 

Your system supports only NFS v3.0.

Managing a Remote File System
Make sure the following requirements are met before you mount a share.

To add a Remote File System mount:

1 Click System Admin from the top-level menu bar.

2 Click Remote File Systems under the Storage section in the left panel. 

File System 
Type

Requirements

CIFS 
(Windows)

• A user account with read-write privileges to the share exists on 
the Windows system.

• The folder to which you are establishing the mount point is 
configured for sharing. 

NFS • Grant your ArcSight system read and write permission on the 
NFS system. 

• The account name is ‘arcsight’, but use numeric ids instead: 
1500 for uid, or 750 for gid.
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3 Click Add from the top left side of the page and enter values for the following fields in 
the resulting form.

Parameter Description

Select File System 
Type

Choose whether you want to mount an NFS or a CIFS 
share.

NFS Settings

Name A meaningful name for the mount point. The name cannot 
contain spaces. This name is used locally on your system to 
refer to the mount point and needs to be specified when 
configuring archive settings for data that will be stored on 
the share.

Hostname / IP 
Address

Host name or IP address of the host to which you are 
creating the mount.

Remote Path (for 
NFS)

The folder on the remote host that will act as the root of the 
network file system mount. For example, 
/public/system_logs.

Make sure that only this system can write to the location 
you specify in this field. If multiple systems (or other 
systems) mount this location and write to it, data on this 
location will be corrupted. 

Mount Options Autofs options. For example, ro for read-only from the 
remote host, rw for read-write, or hard to keep retrying 
until the remote host responds. 

Note: Even if you configure rw permission at your mount 
point, rw permission is not granted to the remote host if the 
host is configured to allow read-only access. 

Description A meaningful description of the mount point. 

CIFS Settings

Name A meaningful name for the mount point. The name cannot 
contain spaces. This name is used locally on your system to 
refer to the mount point and needs to be specified when 
configuring archive settings for data that will be stored on 
the share.

Location Enter the share name in one of the following ways:

• Share name in this format:

IP Address or Hostname: share_name

For example, 198.0.2.160:myshare

This folder needs to be configured for sharing. 
(Typically, to configure a Windows folder for sharing, 
right click on the folder name > Properties > Sharing.)

• UNC path

For example, //198.0.2.160:/public/myshare
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4 Click Add. 

All mount points are created under /opt/mnt. 

To edit a Remote File System mount:

1 Click System Admin from the top-level menu bar.

2 Click Remote File Systems under the Storage section in the left panel. 

3 Select the mount point you want to edit and click Edit from the top left side of the 
page.

4 Change the field values.

5 Click Save. 

To delete a Remote File System mount:

1 Click System Admin from the top-level menu bar.

2 Click Remote File Systems under the Storage section in the left panel. 

3 Select the mount point you want to delete and click Delete from the top left side of 
the page.

Mount Options Autofs options. For example, ro for read-only from the 
remote host, rw for read-write, or hard to keep retrying 
until the remote host responds. 

Note: Even if you configure rw permission at your mount 
point, rw permission is not granted to the remote host if the 
host is configured to allow read-only access. 

Description A meaningful description of the mount point. 

Credentials for CIFS

Username Name of the user account with read-write privileges to the 
Windows share. 

Make sure the username is prefixed with the domain 
information. For example, tahoe/arcsight.

Password Password for the user name specified above. 

You cannot edit a mount point if it is in use. The edit link is not displayed if 
the mount point cannot be edited.

If you rename a mount point, access to the archives that were made using 
the original name is lost until you revert the mount point name to the original 
name.

You cannot delete a mount point that is in use. 

The Delete link is displayed only if the mount point can be deleted.

Parameter Description
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SAN
Some models of Logger appliance include the ability to connect to a Storage Area Network 
(SAN) for various purposes. SANs contain Logical Units (LUNs), identified by their World 
Wide Name. As shown in the figure below, a LUN’s Attachment Status can be ‘available,’ 
‘attached,’ or ‘detached. LUNs in a SAN are in one state at a time. Actions such as “attach” 
change from one state to another.

Destroying a Logical Unit that has been detached puts that LUN into a state in 
which a subsequent attach will erase any data stored on the Logical Unit. If a 
LUN is accidentally destroyed, ArcSight Customer Support may be able to 
recover the data, provided the LUN is not attached.
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The following table summarizes the states and possible actions.

To attach a LUN:

1 Click System Admin from the top-level menu bar.

2 Click SAN under the Storage section in the left panel.

3 Locate and select the LUN in the LUN Name List.

4 Click Attach from the top left of the SAN Configuration page.

Attachment Status Actions Description

available attach Logical Units detected on a SAN are initially available for 
attachment.

attached detach Attached Logical Units can be accessed by Logger.

The detach action is only available if a storage volume has 
not been configured on the LUN. Once a storage volume 
has been configured, you cannot detach the LUN unless 
you follow the factory reset instructions, described in 
Appendix D‚ Restoring Factory Settings‚ on page 529.

detached re-attach
destroy

When an attached Logical Unit is detached, its data is pre-
served, but it cannot be accessed by Logger. To make it 
available again, use the re-attach action. The destroy 
action wipes out the data and releases the Logical Unit 
back to the available state.

Note: When you detach, the only action available immedi-
ately is re-attach. The destroy state takes a few minutes 
to display because it takes a few minutes for the LUN to 
detach on the system. 

• Logger can attach to only one LUN (on SAN) at a time for primary stor-
age. You can add an additional LUN for event archival, configuration 
backup, and export. If multipathing is enabled on your Logger, you cannot 
use an additional LUN for event archival, configuration backup, and 
export. For information about multipathing, see “Multipath” on page 364.

• You can attach a LUN only if the storage volume is not set up on Logger 
yet and the LUN is in “Available” state on Logger. 
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The LUN’s Attachment Status will change to “Attached” when the LUN is ready for use.

Note: If you do not see the Attach menu option, there are no LUNs available that can 
be attached to the Logger at this time. 

To detach a LUN:

1 Click System Admin from the top-level menu bar.

2 Click SAN under the Storage section in the left panel.

3 In the LUN Name List, locate the LUN to be detached. 

4 Click Detach from the top left of the SAN Configuration page.

Note: If you do not see the Detach menu option, there are no LUNs available that can 
be detached from the Logger at this time.

To re-attach a LUN:

1 Click System Admin from the top-level menu bar.

2 Click SAN under the Storage section in the left panel.

3 In the LUN Name List, locate the LUN to be re-attached. The LUN must be in the 
‘detached’ state. 

4 Click Re-attach from the top left of the SAN Configuration page.

Note: If you do not see the Re-attach menu option, there are no LUNs available that 
can be re-attached from the Logger at this time.

To destroy a LUN:

1 Click System Admin from the top-level menu bar.

2 Click SAN under the Storage section in the left panel.

3 In the LUN Name List, locate the LUN to be destroyed. The LUN must be in the 
‘detached’ state. 

4 Click Destroy from the top left of the SAN Configuration page.

Restoring a SAN
To restore a SAN to either the Logger to which it was formerly attached or a new Logger (in 
the case of disaster recovery), follow these steps:

1 With Logger powered off, attach the SAN physically. Turn on Logger.

2 Restore the configuration to Logger. ArcSight recommends backing up the 
configuration regularly so that a backup file will be available for this purpose. If no 
backup file is available, skip this step and manually add receivers, forwarders, users, 
and so on, after SAN has been restored.

3 Enable SSH access to your Logger (see “SSH Access to the Appliance” on page 355). 
Contact ArcSight Customer Support.

4 ArcSight Customer Support will login remotely, stop all Logger processes by issuing 
this command:

You cannot detach a LUN if a storage volume is configured on it. 
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/opt/local/monit/bin/monit stop all

and migrate the internal database to the SAN by creating a symbolic link with the 
command 

ln -s <remote storage path> /opt/local/pgsql/data

When Customer Support has finished these tasks, reboot Logger. 

Multipath
When you multipath a LUN, you create two different network paths to it from the system to 
which the LUN connects. Doing so reduces the possibility of a single point of failure causing 
the LUN to become unavailable. 

By default, the HBA card on your Logger has two ports. Prior to Logger v5.1, you could 
only connect one port to the LUN; however, starting with v5.1 and later, you can connect 
both of those ports to the same LUN. 

Although any SAN vendor that supports multipathing can work with Logger, ArcSight 
specifically tests with EMC Clariion SANs. Logger provides a default multipath configuration 
as a starting point. However, make sure that you consult your SAN documentation for 
information specific to your set up and environment. 

Multipath user interface (UI) is available by default on Logger models that support SAN. 
However, you must connect the LUN to both HBA ports and configure multipath 
configuration in the UI for it to function. Once enabled, multipath cannot be disabled 
on Logger. 

For new Logger installations, you must configure multipathing before attaching the 
LUN.

If you are upgrading from a version prior to Logger v5.1 and want to enable multipath on 
your Logger, see the release notes for this release for information. 

Enabling Multipath
To enable multipath:

1 Ensure that a LUN is not attached to the Logger, as described in “SAN” on page 361.

2 Click System Admin from the top-level menu bar.

3 Click Multipath under the Storage section in the left panel.

4 Select a SAN Multipathing Configuration from the drop-down menu.

5 If you chose Custom or if the displayed configuration does not meet your needs, 
customize the parameters.

6 Click Test to ensure the configuration you chose or the changes you made are valid.

If the test fails, make additional changes or click Reset to start over again. 

• Multipath does not enable you to attach an additional LUN to Logger. Only 
one LUN can be attached at any given time. 

• If multipathing is enabled on your Logger, you cannot use an additional 
LUN for event archival, configuration backup, and export.

• Connecting two LUNs to the HBA card ports without configuring multipath 
will result in unexpected results. 
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7 Click Save to save the configuration.

Restoring Multipath on RMA or Factory Reset Loggers
If your Logger running v5.1 or later has multipath SAN enabled and you encounter one of 
these situations:

 RMA the system to ArcSight and receive a new system that is either running Logger 
v5.0 Patch 3 or earlier

 Factory restore the system to its factory default settings, which resets the Logger 
version to 5.0 Patch 3 or earlier

To restore your Logger to its last working state—running version 5.1 or later, with multipath 
enabled—make sure that you upgrade your system to Logger v5.1 or later before attaching 
the LUN. If you will be restoring the configuration of the Logger from a backup, ensure that 
the Logger is first running the version that matches the backup, perform the restoration, 
then complete the upgrade to the desired version.

RAID Controller/Hard Disk SMART Data
1 Click System Admin from the top-level menu bar.

2 Click RAID Controller under the Storage section in the left panel to display a page 
similar to the one shown in the following figure. 

This information is not needed during normal system operations, but it can be helpful for 
diagnosing specific hardware issues. Due to the redundant nature of RAID storage, unit 

The information displayed depends on the hardware model of your system.
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failure does not disable your system. Instead, performance degrades. Use this report to 
determine whether a performance issue is caused by a disk failure. ArcSight Customer 
Support can use this information to better diagnose problems, as well.

On models C1xxx, C3xxx, C13xx, and C32xx the Hard Disk SMART Data menu item displays 
in the left pane instead of the RAID Controller menu item. Click Hard Disk SMART Data 
from the Storage section in the left pane to display diagnostic information from the hard 
drive.

Security
Security settings enable you to configure SSL Server certificates, enable and disable FIPS 
(Federal Information Processing Standards) mode on your system, and configure SSL client 
authentication for CAC support.

SSL Server Certificate
Your system uses Secure Sockets Layer (SSL) technology to communicate securely over an 
encrypted channel with its clients—users, SmartConnectors when using the 
SmartMessaging technology, and other ArcSight systems. To establish a typical SSL 
session, an SSL certificate is required on the server (ArcSight system, in this case) side and 
a truststore is required on the client side. The truststore contains a list of Certificate 
Authorities (CA) that the client trusts. 

When a client initiates communication with Logger, the Logger sends its SSL certificate to 
the client to authenticate itself. The client checks its truststore to validate the certificate. 
(In addition, the client verifies whether the hostname in the certificate matches the one 
with which it initiated communication, and the current time on the client machine is within 
the validity range specified in the certificate.) If the certificate is validated, a session key is 
exchanged between the client and the Logger. This key is used to encrypt and decrypt data 
exchanged between the Logger and the client.

Your system ships with a self-signed certificate. Although you can use this certificate, 
ArcSight strongly recommends using a CA-signed certificate. 

Even if FIPS is not enabled on your system, it must use a CA-signed certificate if it is a 
destination of a FIPS-enabled container (on a Connector Appliance) or a software-based 
SmartConnector. Additionally, ensure that the root certificate of the CA that signed your 
system’s certificate is trusted on the container or the SmartConnector. If the CA's root 
certificate is not trusted, load it on the container by following instructions in the "Managing 
Certificates on a Container" section in the Connector Appliance Administrator's Guide.

To facilitate obtaining a CA-signed certificate, your system can generate a Certificate 
Signing Request. Once a signed certificate file is available from the CA, it can be uploaded 
to your system for use in subsequent authentication. 

Your system generates an audit event when the installed SSL certificate is going to expire 
in less than 30 days or has expired. The event with Device Event Class ID “platform:407” is 
generated periodically until you replace the certificate with the one that does not expire 
within 30 days. For more details about this event, see the Logger Audit Events  appendix at 
the end of this book. 

Generating a Certificate Signing Request
The first step in configuring an SSL certificate is to generate a Certificate Signing Request 
(CSR). The CSR must be generated on the system for which you are requesting a 
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certificate. That is, you cannot generate a CSR for System A on System B or use a 
third-party utility to generate it. 

The resulting CSR should be sent to a CA, such as VeriSign, which responds with a signed 
certificate file.

To generate a certificate signing request:

1 Click System Admin from the top-level menu bar.

2 Click SSL Server Certificate from the Security section in the left panel to display the 
Generate Certificate Signing Request page.

3 In the Generate CSR tab, enter new values for the following fields:

Parameter Description

Country A two-letter country code, such as ‘US’ for the United 
States.

State / Province State or province name, such as ‘California.’

City / Locality City name, such as ‘Cupertino.’

Organization Name Company name, governmental entity, or similar overall 
organization.

Organizational Unit Division or department within the organization.

Hostname The host name or IP address of this system. 

When specifying the host name, make sure that this name 
matches the name registered in the Domain Name Service 
(DNS) server for the system. Additionally, this name must 
be identical to the host name specified in “NICs” on 
page 349.

Note: If the host name or IP address of this system 
changes in future, you must generate a new CSR, obtain a 
new certificate, and upload it to ensure that the connectors 
(in FIPS mode) that communicate with the Logger will be 
able to validate the host name.

Email Address The email address of the administrator or contact person 
for this CSR.

Private key 
password

The password to secure the private key on the appliance. 
This password is not included in the generated CSR. It is 
stored locally on your system. 
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4 Click Generate CSR to generate a Certificate Signing Request.

Installing a Signed Certificate
After you have obtained a signed certificate, you need to install the signed certificate file on 
your system.

To install a signed certificate:

1 Click System Admin from the top-level menu bar.

2 Click SSL Server Certificate from the Security section in the left panel.

3 On the Install Cert tab, click Browse to find the signed certificate file on your local 
file system.

4 Click Upload and Install to install the specified certificate.

Certain browsers require that you close your current browser and restart it for the new 
certificate to take affect. If you are aware of this requirement for your browser or are 
unsure of it, restart your browser.

Viewing Certificate Installation Results
Click the View Results tab to display the results of the most recently installed certificate.

SSL Client Authentication (CAC Authentication)
Your system supports client authentication using SSL certificates. SSL client authentication 
is a form of two-factor authentication that can be used as an alternate or in addition to 
local (user name and password), RADIUS, and LDAP authentication. As a result, your 
system can be configured for SmartCards, such as Common Access Card (CAC) based 
authentication. CAC is a standard identification card for active duty members of the 
Uniformed Services, Selected Reserve, DOD civilian employees, and eligible contractor 
personnel.

Configuring Logger to Support SSL Client Authentication (CAC)
To configure Logger to support SSL client authentication:

On the Logger

1 If the Logger uses the default signed certificate it shipped with from ArcSight, replace 
it with a FIPS compliant, signed SSL server certificate. Follow instructions at 
“Uploading Trusted Certificates” on page 369 to load the certificate.

Private Key Length Select the length (in bits) of the private key: 1024, 2048, 
or 4096. 

Parameter Description
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2 Enable client certificate authentication, as described in “Client Certificate 
Authentication” on page 377.

3 If the client certificates are CA signed, upload the root certificate of the authority who 
signed the certificates that will be used for authenticating clients, as described in 
“Uploading Trusted Certificates” on page 369. 

If the client certificates used to authenticate with Logger are signed by different CAs, 
make sure you upload root certificates of all CAs.

If the client certificates are self-signed, upload the public portion of the client 
certificate.

4 Configure a user name for each user who will be connecting to the Logger using a 
client certificate, as described in “User Management” on page 381. 

5 (Optional) Upload a certificate revocation list (CRL), as described in “Uploading a 
Certificate Revocation List” on page 370.

6 (Optional) If this Logger is configured to use only SSL Client Authentication, make 
sure this Logger’s Authorization ID and Code are appropriately configured on other 
Loggers that with it. For more information, see “Peer Loggers” on page 215.

On the Client (Web browser)

Configure your browser to provide the SSL client certificate when accessing Logger. That is, 
upload the private key in PKCS 12 format in your web browser. 

Uploading Trusted Certificates
A trusted certificate is used to authenticate users that log in to your system. The certificate 
needs to be in Privacy Enhanced Mail (PEM) format.

To upload a trusted certificate:

1 Click System Admin from the top-level menu bar.

2 Click SSL Client Authentication from the Security section in the left panel.

3 On the Trusted Certificates tab, click Browse to find the trusted certificate on your 
local file system.

4 Click Upload.

All SSL client certificates used for authentication must be FIPS compliant 
(that is, hashed with FIPS compliant algorithms) even if FIPS is not 
enabled on your Logger.
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The trusted certificate is uploaded and listed in the “Certificates in Repository” list on 
the same page where you uploaded it.

To view details about a trusted certificate, click the link displayed in the Certificate Name 
column.

To delete a trusted certificate, select the certificate and click the Delete button.

Uploading a Certificate Revocation List
A certificate revocation list (CRL) is a computer-generated record that identifies certificates 
that have been revoked or suspended before their expiration dates. To support CAC, you 
need to upload a CRL file to your ArcSight system. The CRL file needs to be in PEM format.

To upload a CRL file:

1 Click System Admin from the top-level menu bar.

2 Click SSL Client Authentication from the Security section in the left panel.

3 In the Certificate Revocation List tab, click Browse to find the CRL file on your 
local file system.

4 Click Upload.

The CRL is uploaded and listed in the Certificate Revocation List.

To view details about a CRL, click the link displayed in the Issuer Name column.

To delete a CRL file, select it and click the Delete button.
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Enabling Client Authentication
To enable client certificate authentication, see “Client Certificate Authentication” on 
page 377.

FIPS 140-2
Your system supports the Federal Information Processing Standard 140-2 (FIPS 140-2). 
FIPS 140-2 is a standard published by the National Institute of Standards and Technology 
(NIST) and is used to accredit cryptographic modules in software components. The US 
Federal government requires that all IT products dealing with Sensitive, but Unclassified 
(SBU) information meet these standards. 

If your system needs to be FIPS 140-2 compliant, you can enable FIPS on it. Once you do 
so, the system uses the cryptographic algorithms defined by the NIST for FIPS 140-2 for all 
encrypted communication between its internal and external components.

In a typical deployment, your Logger will communicate with the following components. To 
be fully FIPS-compliant, all of these components should be FIPS enabled:

 SmartConnectors that send events to it

FIPS mode is supported on SmartConnectors running version 4.7.5.5372 and later. 
Follow instructions in “Installing or Updating a SmartConnector to be FIPS-compliant” 
on page 373 to ensure that your connector is FIPS compliant. 

 Logger forwarders, such as ESM Managers to which Logger forwards events and alerts

The system to which your FIPS-compliant Logger forwards events should be 
FIPS-compliant as well. Additionally, you need to import that system’s SSL server 
certificate on the Logger so that Logger can communicate with it. 

If you forward events and alerts to an ESM Manager, it needs to run ESM v4.0 SP2 or 
later to enable FIPS 140-2 on it. For more information, see the ArcSight ESM 
Installation and Configuration Guide for the ESM version you are running. Additionally, 
follow instructions in “ESM Destinations” on page 184 to complete configuration of this 
setup.

 Loggers

Loggers running v4.0 or later automatically use FIPS 140-2 compliant algorithms. 
Therefore, no action is required on such Loggers, except enabling FIPS as described in 
this section.

 Connector Appliance

If your Logger platform includes an integrated Connector Appliance, both products 
operate in FIPS mode when you enable FIPS on the Logger. However, you might need 
to do additional configuration on the Connector Appliance components for FIPS-mode 
operation. See the Connector Appliance Administrator’s Guide for more information. 

A Logger must use a CA-signed certificate if it is a destination of a FIPS-enabled 
container (on a Connector Appliance) or a software-based SmartConnector. 
Additionally, ensure that the root certificate of the CA that signed Logger's certificate is 
trusted on the container or the SmartConnector. If the CA's root certificate is not 

To be fully FIPS 140-2 compliant, all components of your Logger deployment 
need to be in FIPS 140-2 mode. For example, if you enable FIPS 140-2 on 
your Logger but the SmartConnectors that send events to it are not running 
in FIPS 140-2 mode, your deployment is not fully FIPS 140-2 compliant.
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trusted, load it on the container by following instructions in the "Managing Certificates 
on a Container" section in the Connector Appliance Administrator's Guide.

You can enable or disable FIPS mode on Logger to suit your needs; however, you will need 
to reboot the appliance before the new mode will be effective. If your Logger platform has 
an integrated Connector Appliance, make sure you have read the FIPS 140-2 information 
specific to the Connector Appliance in the Connector Appliance Administrator’s Guide 
before disabling FIPS. 

Before you enable FIPS mode on your Logger, make sure:

 Your Logger is set up with a CA-signed SSL certificate. For more information, see “SSL 
Server Certificate” on page 366. A Logger, even when in non-FIPS mode, must use a 
CA-signed certificate if it is a destination of a FIPS-enabled container (on a Connector 
Appliance) or a software-based SmartConnector. Additionally, ensure that the root 
certificate of the CA that signed Logger's certificate is trusted on the container or the 
SmartConnector. If the CA's root certificate is not trusted on the container, load it by 
following instructions in the "Managing Certificates on a Container" section in the 
Connector Appliance Administrator's Guide. If the CA’s root certificate is not trusted on 
the SmartConnector, follow instructions in “Installing or Updating a SmartConnector to 
be FIPS-compliant” on page 373.

 Once FIPS is enabled on your Logger, the SmartMessage receiver (if configured) stops 
receiving events from non-FIPS connectors if those connectors are not running version 
4.7.5.5372 or later.

To enable or disable FIPS mode on Logger:

1 Click System Admin from the top-level menu bar.

2 Click FIPS 140-2 from the Security section in the left panel.

3 Click Enable or Disable for the Select FIPS Mode option.

4 Click the Save button.

5 Reboot your Logger.

The FIPS Status Table shows which processes and components of the Logger are FIPS 
enabled. 

Make sure you are familiar with the configuration requirements on your 
Logger as described in “Before you enable FIPS mode on your Logger, make 
sure:” on page 372.
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Installing or Updating a SmartConnector to be FIPS-compliant 

FIPS mode is supported SmartConnectors running version 4.7.5.5372 or later. 

1 Follow device configuration steps provided in the SmartConnector’s configuration 
guide (available from the ArcSight Download Center at 
https://arcsight.subscribenet.com), then follow the installation procedure through 
installation of the core connector software (SmartConnector Installation step 2).

At Step 3 of the Connector setup, as shown below, click Cancel to exit the setup to 
configure the NSS DB, which is necessary for installing the connector in 
FIPS-compliant mode. You will return to the connector configuration wizard and 
resume SmartConnector configuration, after 

 Enabling FIPS mode on it, and 

 Importing Logger’s certificate

“Step 3: When the installation of ArcSight SmartConnector core 
component software is finished, ...”

2 To enable FIPS Mode on the SmartConnector:

a Create an agent.properties file at the following location if it does not exist 
already:

$ARCSIGHT_HOME\current\user\agent

b Enter the following property, then save and close the file.

fips.enabled=true

3 To import Logger’s Certificate on the SmartConnector:

The information in this section is same as the one contained in the ArcSight 
Installing FIPS-Compliant SmartConnectors document except that the 
information in that document is generally applicable, while information in this 
section is in the context of Logger.

If you are... Then...

Installing a new SmartConnector to send 
events to a Logger in FIPS-compliant 
mode

1 Download a FIPS-supported 
SmartConnector version (version 
4.7.5.5372 or later) from the ArcSight 
Customer Support site. 

2 Go to Step 1 on page 373.

Updating a SmartConnector to be 
FIPS-compliant and the SmartConnector 
is not running version 4.7.5.5372 or later

1 Upgrade the SmartConnector to a 
FIPS-supported version (version 
4.7.5.5372 or later). Follow 
instructions in the SmartConnector 
User’s Guide to upgrade the 
SmartConnector.

2 Only perform Step 2a on page 373.

Updating a SmartConnector to be 
FIPS-compliant and the SmartConnector 
is running version 4.7.5.5372 or later

Only perform Step 2a on page 373.
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a In a DOS prompt window on your SmartConnector machine, from 
$ARCSIGHT_HOME\current\bin, enter the following command to turn off FIPS 
mode. 

arcsight runmodutil -fips false -dbdir 
user/agent/nssdb.client

b Export the Logger certificate file and import it to the SmartConnector’s NSS DB as 
follows:

i Export Logger’s certificate file from the browser you use to connect to it. 
Refer to your browser’s Help for instructions. For example, to export a 
Logger’s certificate file on Firefox, click Tools > Options > Advanced > 
Encryption > View Certificates > Servers > Select your Logger 
appliance > Export. Save the certificate file with a .crt or .cer extension.

ii Copy the certificate file you exported in the previous step (in this example, 
loggercert.crt) to the $ARCSIGHT_HOME\current\bin directory on the 
SmartConnector. From $ARCSIGHT_HOME\current\bin, enter the following:

arcsight runcertutil -A -n mykey -t "CT,C,C" -d 
user/agent/nssdb.client -i bin/loggercert.crt

c Enter the following command to re-enable FIPS mode that you turned off in Step 
1:

arcsight runmodutil -fips true -dbdir 
user/agent/nssdb.client

d Ensure that the SmartConnector can resolve the name specified in the CN value of 
the Logger certificate’s Subject: field. If the name is not resolvable, add it to 
SmartConnector system’s Hosts file.

e If you are updating your SmartConnector to be FIPS-compliant, ensure that the 
connector’s Logger destination host name is same as the CN value in the 
certificate’s Subject: field and exit this procedure.

If you are installing a new SmartConnector, go to the next step.

4 To return to the SmartConnector configuration wizard, enter the following from 
$ARCSIGHT_HOME\current\bin:

arcsight connectorsetup

5 When prompted whether you want to start in Wizard Mode, click Yes.

The Destination selection window is again displayed; return to your SmartConnector 
Configuration Guide, SmartConnector Installation step 4 to continue the 
connector configuration.

Note: When configuring the connector, ensure that the connector’s Logger destination 
host name is same as the CN value in the certificate’s Subject: field.

For the remainder of the configuration process, see the Configuration Guide for the 
SmartConnector you selected to install. The specific configuration guide provides 
information about how to configure the device for event collection, specific installation 
parameters required during the configuration process, and a table of vendor-specific field 
mappings to ArcSight events.
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Users/Groups
Use the Users/Groups sub-menu to configure users and user groups, and to set 
authentication options.

Authentication
The Authentication settings enable you to specify settings and policies for login, password, 
and the authentication mechanism to use.

Login
The Login (Global) Settings page lets you specify the maximum number of simultaneous 
sessions for a single user account.

The form, shown in the following figure, also lets you specify how many seconds of 
inactivity to allow before automatically ending the current session. The default is 900 (15 
minutes).

To change login settings:

1 Click System Admin from the top-level menu bar.

2 Click Authentication from the Users/Groups section.

3 On the Login tab, update the parameters described in the following table.

Parameters Description

Max Simultaneous Logins per User The maximum number of simultaneous 
sessions allowed for a single user account. 

The default is 15.

Session Inactivity Timeout in 
Seconds

The length of time after which an inactive 
session is automatically ended. 

The default is 900 seconds (15 minutes).

Note: This value does not apply to the 
user interface pages accessed through the 
Monitor menu. If a user is on any of the 
Monitor menu pages and the session has 
been inactive for the specified number of 
minutes, the user’s session remains 
active.

Days After Which an Inactive User 
Account is Disabled

The number of days after which an 
inactive account is disabled.

The default value is 0.
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4 Click Save Settings to make the changes, or click another tab to cancel.

Passwords
The Passwords tab enables you to set password policies such as the minimum and 
maximum number of characters and other requirements for passwords. 

To change the password settings:

1 Click System Admin from the top-level menu bar.

2 Click Authentication from the Users/Groups section.

3 In the Passwords tab, update any or all of the parameters listed in the following 
table:

Parameter Description

Enable Password 
Lockout

Choose Yes to enforce the password policy as defined 
by the following three settings. The default is No.

Number of failed 
attempts before lockout

Default is 3.

Maximum time 
between attempts (in 
seconds)

Default is 60, or one minute.

Lockout duration (in 
minutes)

Default is 15.

Enable Password 
Expiration

Choose Yes to expire passwords automatically. The 
default is No.
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4 Click Save Settings to make the changes, or click another tab or sub-menu to cancel. 

Authentication
Besides providing local authentication, your system supports optional RADIUS, LDAP, and 
client certificate authentication. You cannot enable all authentication methods at the same 
time. If any of these methods have the “Allow password fallback” setting set to Yes, local 
authentication is used. 

Client Certificate Authentication
Even if SSL client certificate authentication is enabled on the system, a user name must be 
defined on it for users to connect to it. See “Users” on page 381 for specifics about setting 
up a user name for client certificate authentication.

The default ‘admin’ user is exempt and can log on without a certificate even if client 

certificate authentication is configured on your system.

Days until password 
expires

The default is 90.

Days before expiration 
to notify user

The default is 5.

Enable Password 
Validation

Choose Yes to enforce the length limits and other 
requirements for new passwords. The default is No.

Minimum password 
length

Enter the minimum number of characters in a 
password. The default is 10.

Maximum password 
length

Enter the maximum number of characters in a 
password. The default is 20.

Numeric characters Enter the minimum number of numeric characters 
(0-9) in a valid password. The default is 2.

Uppercase characters Enter the minimum number of uppercase characters 
(A-Z) in a valid password. The default is 0.

Lowercase characters Enter the minimum number of lowercase characters 
(a-z in a valid password. The default is 0.

Non-alphanumeric 
characters

Enter the minimum number of characters that are not 
digits or letters that are required in a valid password. 
The default is 2.

Number of characters 
different from old 
password

The default is 2.

Allow Automated 
Password Reset

Enables the “Forgot Password” link on the Login screen 
that enables users to reset their own password if they 
forget them. The default is No.

All SSL client certificates used for authentication must be FIPS compliant (that 
is, hashed with FIPS compliant algorithms) even if FIPS is not enabled on your 
system.

Parameter Description
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To configure client certificate authentication:

1 Click System Admin from the top-level menu bar.

2 Click Authentication from the Users/Groups section.

3 In the Authentication tab, update any or all of the parameters listed in the following 
table.

4 Click Save Settings.

You must reboot your system for the changes to become effective. See “Reboot” on 
page 348.

RADIUS Authentication
A user name must exist on your system even if RADIUS authentication is enabled. User 
name must match the one that exists for the user on the RADIUS server, although 
passwords can be different. The users must use the RADIUS password to log in.

The default ‘admin’ user is exempt and can log in even if a RADIUS account does not exist. 

To configure RADIUS authentication settings:

1 Click System Admin from the top-level menu bar.

2 Click Authentication from the Users/Groups section.

3 In the Authentication tab, update any or all of the parameters listed in the following 
table.

Parameter Description

Use client certificate Select Yes to enable client certificate authentication. 
Default: No

Require additional 
password

Select Yes to require a password in addition to a client 
certificate for authentication. This is the password 
configured for a user’s name on your system. (See 
“User Management” on page 381 for more 
information.)

Default: No

Allow password fallback Select Yes if a user should be allowed to log in to your 
system using local password when a certificate is not 
available or is invalid. 

Default: No

Parameter Description

Use RADIUS 
authentication

Select Yes to enable RADIUS authentication. 

Default: No

Allow local password 
fallback

Select Yes if a user should be allowed to log in to your 
system using local password when RADIUS 
authentication fails or is not available. 

Default: No

Note: The default ‘admin’ user is exempt and can log in 
even if this option is set to No.
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4 Click Save Settings.

5 Reboot your system for the changes to become effective. See “Reboot” on page 348. 

LDAP/AD Authentication
A user account for each user must exist locally on your system even if LDAP authentication 
is enabled. Although the user name specified locally can be different from the one specified 
on the LDAP server, the Distinguished Name (DN) specified for each user account must 
match the one specified on the LDAP server. 

The default ‘admin’ user is exempt and can log in even if an LDAP account does not exist. 

To configure LDAP authentication settings:

1 Click System Admin from the top-level menu bar.

2 Click Authentication from the Users/Groups section.

3 In the Authentication tab, update any or all of the parameters listed in the following 
table.

RADIUS server 
hostname[:port]

The host name and port of the RADIUS server.

Backup RADIUS server 
hostname[:port]

(Optional) The backup RADIUS server to use if the 
primary server does not respond. This server is not 
tried if an authentication request to the primary server 
fails. 

Use the same format as the primary server to specify 
the host name and port.

Shared authentication 
secret

The RADIUS passphrase.

NAS IP Address The IP address of the Network Access Server (NAS).

Request timeout (in 
seconds)

Length of time to wait for a response from the RADIUS 
server (in seconds). 

Default: 10.

Number of retries Number of times to retry a RADIUS request. 

Default: 1.

Parameter Description

Use LDAP/AD 
authentication

Select Yes to enable LDAP authentication. 

Default: No

Allow local password 
fallback

Select Yes if a user should be allowed to log in to your 
system using local password when LDAP authentication 
fails or is not available. 

Default: No

Note: The default ‘admin’ user is exempt and can log in 
even if this option is set to No. 

LDAP server 
hostname[:port]

The host name or IP address and port of the LDAP 
server in this format:

ldap://<hostname or IP address>:<port>

Parameter Description
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4 Click Save Settings. 

You must reboot your system for the changes to become effective. See “Reboot” on 
page 348. 

Login Banner
You can customize the message on the login screen to suit your needs. The message you 
enter is displayed above the Username and Password fields on the login screen, as shown 
in the following figure. The message can only contain text; you cannot include images in it.

In addition, you can enter a confirmation message that the user must click to enable the 
Username and Password fields. 

You must have the “Configure Login Settings” permission enabled for your user account to 
edit the login banner.

To customize your login banner:

1 Click Setup > System Admin from the top-level menu bar.

2 Click Login Banner from the Users/Groups section.

Backup LDAP Server 
Hostname[:Port]

(Optional) The backup LDAP server to use if the 
primary server does not respond. This server is not 
tried if an authentication request to the primary server 
fails. 

Use the same format as the primary server to specify 
the host name and port.

Request timeout (in 
seconds)

Length of time to wait for a response from the LDAP 
server (in seconds). 

Default: 10.

If the custom message does not appear in the banner or the banner 
continues to display old text after it has been updated, close your browser 
and restart it. 

Parameter Description
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3 Enter the text you want to display as the login banner in the Content field. 

You can only enter unformatted text in this field. However, you can apply standard 
HTML tags to display formatted text. Loading images in this field is not allowed. 

4 (Optional) Enter a confirmation string in the Confirmation field. 

If you enter a string in this field, it inserts a check box that the user must click to 
enable the Username and Password fields. For example, you can enter “Are you sure?”, 
“Do you want to proceed?”, or “I agree” in this field if the users of this system must 
confirm their intent before proceeding further. 

5 Click Save. 

User Management
Use the Users and Groups tabs to manage the users and user groups on your system. User 
groups are a way to enforce access control to various sections of your system.

Users
Use the Users tab to manage the users that can log in to your system. You can add a new 
user, edit user information, or delete a user at any time. You must have the appropriate 
System Admin group rights to perform these functions.

Reset Password
You can also reset the password of a user without knowing their password using the reset 
password feature. Using an SMTP configured server, you can reset a user’s password by 
clicking the Reset Password button. An automated email is sent to the user with the new 
password string. The user must use this temporary string to login within the time specified 
in the email. If the user does not log in within the specified time, an admin user can reset 
their password again to generate another temporary password. The user must be activated 
before resetting the password.

To add a new user:

1 Click System Admin from the top-level menu bar.

2 Click User Management under the Users/Groups section in the left panel.

3 In the Users tab, click Add from the top left side of the page.

4 Enter the following parameters.

Users can be activated by editing and checking the active flag, then saving the 
changes.

Parameter Description

Credentials

Login A login name for the user.

Password A password for the user.

Confirm 
Password

Reenter the password.
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5 Click Save and Close.

To edit a user:

1 Click System Admin from the top-level menu bar.

2 Click User Management under the Users/Groups section in the left panel.

3 In the Users tab, select the user (or users) you want to edit.

4 Click Edit from the top left side of the page.

5 Update the user information as necessary.

6 Click Save User.

To delete a user:

1 Click System Admin from the top-level menu bar.

2 Click User Management under the Users/Groups section in the left panel.

3 In the Users tab, select the user (or users) you want to delete.

Contact Information

Use Client DN If you enabled SSL client authentication or LDAP authentica-
tion, click this link to enter the Distinguished Name (Certifi-
cate Subject) information for the user. Distinguished Name 
should be similar to this format:

/ST=California/C=US/L=Cupertino/O=ArcSight, 
Inc./OU=Engg Team/CN=UserA/D/emailAd-
dress=email@xyz.com

To determine the DN, use this URL to display the certificate:

https://<hostname or IP address>/app/cert

OR

Obtain the DN information for a user from the browser that 
the user will use to connect to the system. For example, on 
Firefox, click Tools > Options > Advanced > Encryption > 
View Certificates > Your Certificates > Select the certifi-
cate > View. 

First Name First name of the user.

Last Name Last name of the user.

Email An email address for the user.

Phone Number Phone number for the user. (Optional)

Assign to Groups

Assign to Groups Select the groups to which this user belongs. This setting con-
trols the privileges a user has on this Logger.

A system admin level user account that has been used to upgrade the system 
cannot be deleted. For example, if system admin user Joe upgrades the sys-
tem, Joe’s user account can not be deleted from the system once the upgrade 
is complete. To remove such a user, disable the user account. To disable a 
user account, edit the user account and disable the “Active” option.

Parameter Description
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4 Click Delete from the top left side of the page.

To reset the password of a user:

1 Click System Admin from the top-level menu bar.

2 Click User Management under the Users/Groups section in the left panel.

3 In the Users tab, select the user (or users) whose passwords you want to reset. 

4 Click Reset Password from the top left side of the page.

Groups
User groups define privileges to specific functions on your ArcSight system and are the way 
to enforce access control to these functions. For example, if you want User A to only run 
searches and not reports, you assign that user to the Search group but not the Reports 
group. User groups are organized by the following types: System Admin, Logger Rights, 
Logger Search, Logger Reports, and Connector Appliance Rights (only on Logger platforms 
with integrated Connector Appliance).

Each type has a pre-defined, default user group in which all privileges for the type are 
enabled. To authorize a subset of the privileges for a specific group type, create a new user 
group and only enable the privileges you want to provide, then assign restricted users to 
the newly created group.

System Admin Groups
The System Admin Group controls the system administration operations for your ArcSight 
system, such as configuring network information, setting storage mounts, installing SSL 
certificates, and user management. 

Read Only System Admin Group

In addition to the default System Admin Group that enables all privileges, a Read Only 
System Admin Group exists on your system. Users assigned to this group can only view the 
System Admin settings, but not change them. 

Refer to your system’s user interface to see a complete list of privileges available in this 
group.

The user group privileges available on a system depend on the Logger model and the 
installed license. For example, SAN-related privileges are only displayed on Logger models 
that support SAN.

Logger Rights Group
The Logger Rights Group controls the Logger application operations for your ArcSight 
system, such as viewing the Logger dashboards and configuring all the settings under the 
Configuration menu (event archives, storage groups, alerts, filters, scheduling tasks, and 
so on).

Refer to your system’s user interface to see a complete list of privileges available in this 
group.

An SMTP server must be configured for the automated email containing the 
temporary password to be sent. If an SMTP server is not configured, the 
password will not be reset because an email cannot be sent. 
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Logger Search
The Logger Search Group controls local and peer searches through the following privileges:

 Search for events

 Search for events on remote peers

If the group is configured to allow users to run local and peer searches, users assigned to 
this group can perform those operations. Conversely, if the group is configured to prevent 
users from running local and peer searches, users assigned to this group cannot perform 
those operations. 

Logger Reports
The Logger Reports group controls all report operations on Logger such as run, edit, 
delete, schedule, view published reports, and so on. 

Refer to your system’s user interface to see a complete list of privileges available in this 
group.

Connector Appliance Rights Groups
The Connector Appliance Rights Group controls the Connector Appliance application 
operations for your ArcSight system, such as viewing the Connector Appliance dashboards 
and backup operations. 

Read Only Connector Appliance Group

In addition to the Default Connector Appliance Rights Group that enables all privileges to 
the Connector Appliance functions, a Read Only Connector Appliance Group exists on your 
system. A read-only user can view the tabs and the operations within the tabs, as well as 
perform certain operations such as refresh, view certificate list, and logfu.

Refer to your system’s user interface to see a complete list of privileges available in this 
group.

Managing a User Group
To create a new user group:

1 Click System Admin from the top-level menu bar.

2 Click User Management under the Users/Groups section in the left panel.

3 Click the Groups tab.

4 Click Add from the top left side of the page.

5 Define the new group:

a In the Group Name field, provide a name for the group.

b In the Description field, provide a description for the group.

c From the Group Type drop-down box, select the group type. 

d Click the down arrow icon ( ) next to the group type name to view and select 
privileges that you want to assign to the users in this group. 

6 Click Save and Close to save the settings of the group. OR click Save and Edit 
Membership to add users to this group.

To edit a user group:
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1 Click System Admin from the top-level menu bar.

2 Click User Management under the Users/Groups section in the left panel.

3 Click the Groups tab.

4 Select the Group that you want to edit and click Edit at the top left side of the page.

5 Update the user group information. 

If you need to edit the group’s membership:

a Click Save and Edit Membership to display the Edit Group Membership page, 
as shown in the following figure. 

b Click Add from the top left of the Edit Group Membership page.

c Select users you want to add. By default, you can only add users who do not 
belong to other groups of the type that you are editing. However, if you want to 
add such users, click Show users that belong to other <group_type> 
groups, as shown in the following figure. When you add a user who belongs to 
another group of the same group type as the one you are updating, that user is 
automatically removed from the previous group. 

d Click OK.

e Click Back to Group List. 

6 Click Save and Close.

To delete a user group:

1 Click System Admin from the top-level menu bar.

2 Click User Management under the Users/Groups section in the left panel.

3 Click the Groups tab.

4 Select the Group (or Groups) that you want to delete.

5 Click Delete at the top left side of the page.

Change Password
Use the Change Password menu to change your password. This feature is available to all 
ArcSight system users for changing their passwords, unlike the Reset Password feature that 
enables a system administrator to reset the password of system users without knowing 
their passwords. 

To change your password:

1 Click System Admin from the top-level menu bar.

2 Click Change Password under the Users/Groups section in the left panel to display 
the Change Password for <User Name> page.

3 Enter the old password, the new password, and enter the new password a second 
time to confirm.

4 Click Change Password.
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Forgot Password
If you forget your system password, use this feature to obtain an email that provides a 
temporary password. The email address can be applied in the user settings for the user 
name you specify for obtaining the temporary password. 

This feature is only available if the “Allow Automated Password Reset” setting on the 
Authentication Settings page (System Admin > Authentication) is set to Yes. By default, 
this setting is set to No. Additionally, an SMTP server must be configured on the system for 
this feature to work successfully. If an SMTP server is not set, you will not be able to reset 
the password because the email containing the temporary password cannot be sent. 

To reset your password:

1 Click the Forgot Password link on the Login screen as shown in the following figure. 

2 Enter the name of a user in the Username field on the Reset Password screen. Click 
Reset Password.

An automated email with a temporary password is sent to the email address specified 
in the user settings of the user you entered. 

Monitoring System Health 
You can monitor your Logger’s health in two ways:

 Using a predefined system filter, as listed in “System Filters/Predefined Filters” on 
page 146. The predefined system health filters are based on the system health events 
listed in “System Health Events” on page 387.

 Searching for system health events in Logger’s Internal Storage Group, as listed in 
“System Health Events” on page 387. If a predefined system health filter does not suit 
your needs, you can create alerts based on the system health events.

To set up notification of system health events

1 Configure the Logger’s SMTP settings (see “SMTP” on page 352) or create an SNMP 
Destination (see “SNMP Destinations” on page 200) or Syslog Destination (see “Syslog 
Destinations” on page 201).

P

Passwords are subject to the password policy specified by the Admin 
user. See “Passwords” on page 376.

The temporary password is only valid until the time specified in the email. If 
you do not login within the specified time, only an administrator can reset the 
password to generate another temporary password. 
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2 Create an Alert that uses one or more System Alert Filters or defining a query that 
searches for the system health events in Logger’s Internal Storage Group, and specify 
match count and threshold (see “Alerts” on page 188). 

3 Enable the new Alert. 

System Health Events
The following table lists the system health events that Logger generates. These events are 
also referred as Logger Internal Events because they are stored in Logger’s Internal 
Storage Group. See Appendix F, Examples of System Health Events‚ on page 151 for 
examples of these events.

The predefined System Filters that provide system health status are based on some of 
these events. If a predefined filter does not suit you needs, create an alert using one of 
these events.

Starting with Logger v5.1, the format in which system health events are generated was 
changed to provide more meaningful information. Some of the changes were:

 Addition of new events. For example, Current and Voltage events.

 Instead of referring to all system health events as Logger Internal Event in the name 
field, meaningful names are used. For example, Fan OK, Temperature OK. 

 Three severity levels for each event have been added to the agentSeverity field—1 
(OK), 5 (Degraded), and 8 (Severe).

 The deviceCustomString and deviceCustomStringLabel field mappings 
have changed. Refer to a specific event to identify changes. 

 Device Event Class ID (deviceEventClassId) and Device Event Category 
(deviceEventCategory) of the events have changed. The updated list is available 
in the following table. 

 All hardware-related events are classified as hardware:nnn events, where nnn is a 
three-digit number that identifies the hardware component. For example, 
hardware:13x identifies the fan events.

If you are upgrading from Logger v5.0 Patch 2 or earlier, any existing filters or queries 
based on earlier events will not work on the events collected after the upgrade. However, 
those filters and queries will continue to work on the events collected prior to the upgrade. 
Note that the predefined System Filters are compatible with the new and the old format. 

• The sensor names in each event are hardware specific; therefore, they 
are not consistent across various Logger platforms. Use the event name 
(Name) and status (CustomString3) fields to determine the status of a 
sensor. The raw status (CustomString4), location (CustomString5), and 
sensor name (CustomString6) fields are for informational use when 
diagnosing a hardware problem and are not consistent across appliance 
types. 

• ArcSight recommends that you develop custom alerts for certain System 
Health Events to prevent from being alerted too often. Some of the 
conditions that your system alerts on may be self-clearing or warnings 
that you do not want to be alerted about until a specific number of 
warnings have been generated.

Group Device Event Category
Device Event 
Class ID

System Health Events for appliance and software Loggers
Confidential Administrator’s Guide 387



7 System Admin - Logger Appliance
CPU /Monitor/CPU/Usage cpu:100

Disk /Monitor/Disk/Read disk:102

/Monitor/Disk/Write disk:103

EPS /Monitor/Receiver/EPS/All eps:100

/Monitor/Receiver/EPS/Individual eps:102

/Monitor/Forwarder/EPS/All eps:101

/Monitor/Forwarder/EPS/Individual eps:103

Memory /Monitor/Memory/Usage/Platform memory:100

Network /Monitor/Network/Usage/In network:100

/Monitor/Network/Usage/Out network:101

Search /Monitor/Search/Performed search:100

Storage Group /Monitor/StorageGroup/Space/Used

Note: The size of the storage group, 
indicated by the “fsize” field is in GB. 

storagegroup:100

System Health Events for appliance Loggers only

Battery /Monitor/Sensor/Battery/OK hardware:121

/Monitor/Sensor/Battery/Degraded hardware:122

/Monitor/Sensor/Battery/Failed hardware:123

Current

(Electrical)

/Monitor/Sensor/Current/OK hardware:101

/Monitor/Sensor/Current/Degraded hardware:102

/Monitor/Sensor/Current/Failed hardware:103

Disk /Monitor/Disk/Space/Remaining/Data disk:101

Fan /Monitor/Sensor/Fan/OK hardware:131

/Monitor/Sensor/Fan/Degraded hardware:132

/Monitor/Sensor/Fan/Failed hardware:133

Power Supply /Monitor/Sensor/PowerSupply/OK hardware:141

/Monitor/Sensor/PowerSupply/Degraded hardware:142

/Monitor/Sensor/PowerSupply/Failed hardware:143

Group Device Event Category
Device Event 
Class ID
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SNMP Polling of System Health Information
You can poll system health information from Logger using SNMP version 2 from any 
standard network management system. See “SNMP” on page 354 for more information.

Refer to your system’s Management Information Base (MIB) at 
https://<system_name_or_ip>/platform-service/appliance.mib for the 
events you can poll from your system. The Object IDentifier (OID) 
“.1.3.6.1.4.1.11937.3” identifies those events.

You can only perform the snmp get, getnext, getbulk operations on your system; 
snmp set operations are not permitted. 

RAID /Monitor/RAID/Controller/OK raid:101

/Monitor/RAID/Controller/Degraded raid:102

/Monitor/RAID/Controller/Failed raid:103

/Monitor/RAID/BBU/OK raid:111

/Monitor/RAID/BBU/Degraded raid:112

/Monitor/RAID/BBU/Failed raid:113

/Monitor/RAID/Disk/OK raid:121

/Monitor/RAID/Disk/Rebuilding raid:122

/Monitor/RAID/Disk/Failed raid:123

Temperature /Monitor/Temperature/OK hardware:151

/Monitor/Temperature/Degraded hardware:152

/Monitor/Temperature/Failed hardware:153

Voltage /Monitor/Sensor/Voltage/OK hardware:111

/Monitor/Sensor/Voltage/Degraded hardware:112

/Monitor/Sensor/Voltage/Failed hardware:113

Group Device Event Category
Device Event 
Class ID
Confidential Administrator’s Guide 389



7 System Admin - Logger Appliance
390 Administrator’s Guide Confidential



Chapter 8

System Admin - Software Logger

This chapter describes the System Admin tab that enables you to configure SMTP and 
other system settings. Additionally, you can create and manage users and user groups 
using this tab. 

The following topics are covered in this chapter: 

System
From the System tab, you can configure system specific settings such as network settings 
(if applicable) and SMTP. 

System Locale
The Locale setting ensures that the user interface displays information such as date, time, 
numbers, and messages in the format and language appropriate for the selected country.

On a new Logger appliance, Locale is generally configured during the Logger initialization 
process. However, if you skipped this step during the initialization process, you can 
configure it later. Once configured, Locale cannot be changed. 

To view or configure System Locale:

1 Click System Admin from the top-level menu bar.

“System Locale” on page 391

“SMTP” on page 392

“Applying a License on the Software Version of Logger” on page 392

“Process Status” on page 392

“Audit Logs” on page 393

“Audit Forwarding” on page 394

“Remote File Systems” on page 395

“FIPS 140-2” on page 398

“Authentication” on page 388

“Using a CA-signed Certificate on Software Version of Logger” on page 402

“User Management” on page 405

“Change Password” on page 408

“Monitoring System Health” on page 408
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2 Click System Locale from the System section.

3 To configure System Locale, select the new value.

4 You must reboot Logger for the changes to become effective. 

SMTP
Your system uses the Simple Mail Transfer Protocol (SMTP) setting to send email 
notifications such as alerts, password reset emails, and so on.

To set or change SMTP settings:

1 Click  System Admin from the top-level menu bar.

2 Click SMTP from the System section and enter these settings.

3 Click Save to save the changes.

  Applying a License on the Software Version of Logger
See “Applying or Updating a License on the Software Version of Logger” on page 54.

Process Status
The Process Status page lists all processes related to your ArcSight system and enables you 
to view the details of those processes and start, stop, or restart them.

To view the Process Status page:

1 Click  System Admin from the top-level menu bar. 

2 Click Process Status from the System section to display a page similar to the one 
shown in the following figure.

In the process list, processors refers to Forwarders.

Setting Description

Primary SMTP 
Server

The IP address or hostname of the SMTP server that will 
process outgoing email.

Backup SMTP 
Server

The IP address or hostname of the SMTP server that will 
process outgoing email in case the primary SMTP server is 
unavailable.

Outgoing Email 
Address

The email address that will appear in the From: field of 
outbound email.
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To view the details of a process, click the  icon to the left of the process name, as 
shown in the following figure.

To start, stop, or restart a process, select the process and click Start, Stop, or Restart at 
the top of the process list.

 Logs
Your system can generate audit logs at the application and platform levels. Use the Logs 
sub-menu to search audit logs and configure audit forwarding so that the system can send 
audit events to a destination, such as ESM.

Audit Logs
Your ArcSight system’s audit logs are available for viewing. Audit logs, as Common Event 
Format (CEF) audit events, can be sent to ArcSight ESM directly for analysis and 
correlation. For information about forwarding audit events, see “Audit Forwarding” on 
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page 394. For a list of audit events that you can forward, see Appendix E‚ Logger Audit 
Events‚ on page 537.

To view audit logs:

1 Click  System Admin from the top-level menu bar.

2 Click Audit Logs from the Logs section.

3 Select the date and time range for which you want to obtain the log.

4 To refine the audit log search, optionally specify a string in the Description field and 
user name in the User field. When a string is specified, only logs whose Description 
field contains the string are displayed. Similarly, when a user is specified, only logs 
whose User field contains the username are displayed.

5 Click Search.

Audit Forwarding
You can forward audit events to ArcSight ESM for correlation and analysis. For a list of audit 
events that you can forward, see Appendix E‚ Logger Audit Events‚ on page 537.

To forward audit events to specific ESM destinations:

1 Click  System Admin from the top-level menu bar.

2 Click Audit Forwarding from the Logs section. 

3 Select destinations from the Available Destinations list and click the right arrow icon 

( ) to move the selected destination to the Selected Destinations list. You can select 
multiple destinations at the same time and move them over. Or you can move all 

available destinations by clicking the ( ) icon. 

The destinations are ESM destinations that you configure on the ESM Destinations 
page (Configuration > Event Input/Output > ESM Destinations).
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4 Click Save Settings.

Storage
Use the Storage sub-menu to add an NFS mount or a CIFS mount, or SAN (if applicable) 
and to view the status of the hard disk array (RAID) controller and specific system 
processes.

Remote File Systems
Your system can mount Network File System (NFS) and CIFS (Windows) shares. As a 
result, it can read log files and event data from UNIX, Linux, Windows remote hosts, and 
any Network Attached Storage (NAS) solutions based on these operating systems. In 
addition, you can use the NFS and CIFS mounts for archiving data such as events, exported 
filters and alerts, and saved searches. Loggers with Storage Area Network (SAN) capability 
can also interface with a SAN.

Use of NFS for primary storage of Logger events is not recommended. Using a CIFS share 
for primary storage is not supported. 

Your system supports only NFS v3.0.

Managing a Remote File System
Make sure the following requirements are met before you mount a share.

To add a Remote File System mount:

1 Click System Admin from the top-level menu bar.

2 Click Remote File Systems under the Storage section in the left panel. 

File System 
Type

Requirements

CIFS 
(Windows)

• A user account with read-write privileges to the share exists on 
the Windows system.

• The folder to which you are establishing the mount point is 
configured for sharing. 

NFS • Grant your ArcSight system read and write permission on the 
NFS system. 

• The account name is ‘arcsight’, but use numeric ids instead: 
1500 for uid, or 750 for gid.
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3 Click Add from the top left side of the page and enter values for the following fields in 
the resulting form.

Parameter Description

Select File System 
Type

Choose whether you want to mount an NFS or a CIFS 
share.

NFS Settings

Name A meaningful name for the mount point. The name cannot 
contain spaces. This name is used locally on your system to 
refer to the mount point and needs to be specified when 
configuring archive settings for data that will be stored on 
the share.

Hostname / IP 
Address

Host name or IP address of the host to which you are 
creating the mount.

Remote Path (for 
NFS)

The folder on the remote host that will act as the root of the 
network file system mount. For example, 
/public/system_logs.

Make sure that only this system can write to the location 
you specify in this field. If multiple systems (or other 
systems) mount this location and write to it, data on this 
location will be corrupted. 

Mount Options Autofs options. For example, ro for read-only from the 
remote host, rw for read-write, or hard to keep retrying 
until the remote host responds. 

Note: Even if you configure rw permission at your mount 
point, rw permission is not granted to the remote host if the 
host is configured to allow read-only access. 

Description A meaningful description of the mount point. 

CIFS Settings

Name A meaningful name for the mount point. The name cannot 
contain spaces. This name is used locally on your system to 
refer to the mount point and needs to be specified when 
configuring archive settings for data that will be stored on 
the share.

Location Enter the share name in one of the following ways:

• Share name in this format:

IP Address or Hostname: share_name

For example, 198.0.2.160:myshare

This folder needs to be configured for sharing. 
(Typically, to configure a Windows folder for sharing, 
right click on the folder name > Properties > Sharing.)

• UNC path

For example, //198.0.2.160:/public/myshare
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4 Click Add. 

All mount points are created under /opt/mnt. 

To edit a Remote File System mount:

1 Click System Admin from the top-level menu bar.

2 Click Remote File Systems under the Storage section in the left panel. 

3 Select the mount point you want to edit and click Edit from the top left side of the 
page.

4 Change the field values.

5 Click Save. 

To delete a Remote File System mount:

1 Click System Admin from the top-level menu bar.

2 Click Remote File Systems under the Storage section in the left panel. 

3 Select the mount point you want to delete and click Delete from the top left side of 
the page.

Mount Options Autofs options. For example, ro for read-only from the 
remote host, rw for read-write, or hard to keep retrying 
until the remote host responds. 

Note: Even if you configure rw permission at your mount 
point, rw permission is not granted to the remote host if the 
host is configured to allow read-only access. 

Description A meaningful description of the mount point. 

Credentials for CIFS

Username Name of the user account with read-write privileges to the 
Windows share. 

Make sure the username is prefixed with the domain 
information. For example, tahoe/arcsight.

Password Password for the user name specified above. 

You cannot edit a mount point if it is in use. The edit link is not displayed if 
the mount point cannot be edited.

If you rename a mount point, access to the archives that were made using 
the original name is lost until you revert the mount point name to the original 
name.

You cannot delete a mount point that is in use. 

The Delete link is displayed only if the mount point can be deleted.

Parameter Description
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Security
You can enable and disable FIPS (Federal Information Processing Standards) mode on your 
Logger under the Security settings.

FIPS 140-2
Your system supports the Federal Information Processing Standard 140-2 (FIPS 140-2). 
FIPS 140-2 is a standard published by the National Institute of Standards and Technology 
(NIST) and is used to accredit cryptographic modules in software components. The US 
Federal government requires that all IT products dealing with Sensitive, but Unclassified 
(SBU) information meet these standards. 

If your system needs to be FIPS 140-2 compliant, you can enable FIPS on it. Once you do 
so, the system uses the cryptographic algorithms defined by the NIST for FIPS 140-2 for all 
encrypted communication between its internal and external components.

In a typical deployment, your Logger will communicate with the following components. To 
be fully FIPS-compliant, all of these components should be FIPS enabled:

 SmartConnectors that send events to it

FIPS mode is supported on SmartConnectors running version 4.7.5.5372 and later. 
Follow instructions in “Installing or Updating a SmartConnector to be FIPS-compliant” 
on page 400 to ensure that your connector is FIPS compliant. 

 Logger forwarders, such as ESM Managers to which Logger forwards events and alerts

The system to which your FIPS-compliant Logger forwards events should be 
FIPS-compliant as well. Additionally, you need to import that system’s SSL server 
certificate on the Logger so that Logger can communicate with it. 

If you forward events and alerts to an ESM Manager, it needs to run ESM v4.0 SP2 or 
later to enable FIPS 140-2 on it. For more information, see the ArcSight ESM 
Installation and Configuration Guide for the ESM version you are running. Additionally, 
follow instructions in “ESM Destinations” on page 184 to complete configuration of this 
setup.

 Loggers

Loggers running v4.0 or later automatically use FIPS 140-2 compliant algorithms. 
Therefore, no action is required on such Loggers, except enabling FIPS as described in 
this section.

When enabling FIPS on a software Logger, make sure that the machine on which 
Logger is installed is used exclusively for Logger, similar to the Logger appliance. Also, 
note that enabling FIPS 140-2 on software Logger does not make the system on which 
it is installed FIPS 140-2 compliant. Consult your system’s documentation to determine 
the requirements for making the entire system FIPS 140-2 compliant. 

You can enable or disable FIPS mode on Logger to suit your needs; however, you will need 
to restart the software Loggerbefore the new mode will be effective. Before you enable 
FIPS mode on your Logger, make sure:

To be fully FIPS 140-2 compliant, all components of your Logger deployment 
need to be in FIPS 140-2 mode. For example, if you enable FIPS 140-2 on 
your Logger but the SmartConnectors that send events to it are not running 
in FIPS 140-2 mode, your deployment is not fully FIPS 140-2 compliant.
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 Your Logger is set up with a CA-signed SSL certificate. For more information, see 
“Using a CA-signed Certificate on Software Version of Logger” on page 402.

 A Logger, even when in non-FIPS mode, must use a CA-signed certificate if it is a 
destination of a FIPS-enabled software-based SmartConnector. Additionally, ensure 
that the root certificate of the CA that signed Logger's certificate is trusted on  the 
SmartConnector.  If the CA’s root certificate is not trusted on the SmartConnector, 
follow instructions in “Installing or Updating a SmartConnector to be FIPS-compliant” 
on page 400.

 Once FIPS is enabled on your Logger, the SmartMessage receiver (if configured) stops 
receiving events from non-FIPS connectors if those connectors are not running version 
4.7.5.5372 or later.

To enable or disable FIPS mode on Logger:

1 Click System Admin from the top-level menu bar.

2 Click FIPS 140-2 from the Security section in the left panel.

3 Click Enable or Disable for the Select FIPS Mode option.

4 Click the Save button.

5 Restart your Logger.

Use the following command to restart your Logger: 

<install_dir>/current/arcsight/logger/bin/loggerd restart

The FIPS Status Table shows which processes and components of the Logger are FIPS 
enabled. 

Make sure you are familiar with the configuration requirements on your 
Logger as described in “You can enable or disable FIPS mode on Logger to 
suit your needs; however, you will need to restart the software Loggerbefore 
the new mode will be effective. Before you enable FIPS mode on your Logger, 
make sure:” on page 398.
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Installing or Updating a SmartConnector to be FIPS-compliant 

FIPS mode is supported SmartConnectors running version 4.7.5.5372 or later. 

1 Follow device configuration steps provided in the SmartConnector’s configuration 
guide (available from the ArcSight Download Center at 
https://arcsight.subscribenet.com), then follow the installation procedure through 
installation of the core connector software (SmartConnector Installation step 2).

At Step 3 of the Connector setup, as shown below, click Cancel to exit the setup to 
configure the NSS DB, which is necessary for installing the connector in 
FIPS-compliant mode. You will return to the connector configuration wizard and 
resume SmartConnector configuration, after 

 Enabling FIPS mode on it, and 

 Importing Logger’s certificate

“Step 3: When the installation of ArcSight SmartConnector core 
component software is finished, ...”

2 To enable FIPS Mode on the SmartConnector:

a Create an agent.properties file at the following location if it does not exist 
already:

$ARCSIGHT_HOME\current\user\agent

b Enter the following property, then save and close the file.

fips.enabled=true

3 To import Logger’s Certificate on the SmartConnector:

The information in this section is same as the one contained in the ArcSight 
Installing FIPS-Compliant SmartConnectors document except that the 
information in that document is generally applicable, while information in this 
section is in the context of Logger.

If you are... Then...

Installing a new SmartConnector to send 
events to a Logger in FIPS-compliant 
mode

1 Download a FIPS-supported 
SmartConnector version (version 
4.7.5.5372 or later) from the ArcSight 
Customer Support site. 

2 Go to Step 1 on page 400.

Updating a SmartConnector to be 
FIPS-compliant and the SmartConnector 
is not running version 4.7.5.5372 or later

1 Upgrade the SmartConnector to a 
FIPS-supported version (version 
4.7.5.5372 or later). Follow 
instructions in the SmartConnector 
User’s Guide to upgrade the 
SmartConnector.

2 Only perform Step 2a on page 400.

Updating a SmartConnector to be 
FIPS-compliant and the SmartConnector 
is running version 4.7.5.5372 or later

Only perform Step 2a on page 400.
400 Administrator’s Guide Confidential



8 System Admin - Software Logger
a In a DOS prompt window on your SmartConnector machine, from 
$ARCSIGHT_HOME\current\bin, enter the following command to turn off FIPS 
mode. 

arcsight runmodutil -fips false -dbdir 
user/agent/nssdb.client

b Export the Logger certificate file and import it to the SmartConnector’s NSS DB as 
follows:

i Export Logger’s certificate file from the browser you use to connect to it. 
Refer to your browser’s Help for instructions. For example, to export a 
Logger’s certificate file on Firefox, click Tools > Options > Advanced > 
Encryption > View Certificates > Servers > Select your Logger 
appliance > Export. Save the certificate file with a .crt or .cer extension.

ii Copy the certificate file you exported in the previous step (in this example, 
loggercert.crt) to the $ARCSIGHT_HOME\current\bin directory on the 
SmartConnector. From $ARCSIGHT_HOME\current\bin, enter the following:

arcsight runcertutil -A -n mykey -t "CT,C,C" -d 
user/agent/nssdb.client -i bin/loggercert.crt

c Enter the following command to re-enable FIPS mode that you turned off in Step 
1:

arcsight runmodutil -fips true -dbdir 
user/agent/nssdb.client

d Ensure that the SmartConnector can resolve the name specified in the CN value of 
the Logger certificate’s Subject: field. If the name is not resolvable, add it to 
SmartConnector system’s Hosts file.

e If you are updating your SmartConnector to be FIPS-compliant, ensure that the 
connector’s Logger destination host name is same as the CN value in the 
certificate’s Subject: field and exit this procedure.

If you are installing a new SmartConnector, go to the next step.

4 To return to the SmartConnector configuration wizard, enter the following from 
$ARCSIGHT_HOME\current\bin:

arcsight connectorsetup

5 When prompted whether you want to start in Wizard Mode, click Yes.

The Destination selection window is again displayed; return to your SmartConnector 
Configuration Guide, SmartConnector Installation step 4 to continue the 
connector configuration.

Note: When configuring the connector, ensure that the connector’s Logger destination 
host name is same as the CN value in the certificate’s Subject: field.

For the remainder of the configuration process, see the Configuration Guide for the 
SmartConnector you selected to install. The specific configuration guide provides 
information about how to configure the device for event collection, specific installation 
parameters required during the configuration process, and a table of vendor-specific field 
mappings to ArcSight events.
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Using a CA-signed Certificate on Software Version of 
Logger

Logger ships with a self-signed certificate. Although you can use this certificate, ArcSight 
strongly recommends using a CA-signed certificate. 

The first step in configuring an SSL certificate is to generate a Certificate Signing Request 
(CSR). The CSR must be generated on the Logger appliance for which you are requesting a 
certificate. The resulting CSR should be sent to a CA, such as VeriSign, which responds 
with a signed certificate file.

To generate a CSR to obtain a CA-signed certificate on software version of Logger:

1 Ensure that you are logged in as “root” on the system on which the software version of 
Logger is installed.

2 Run this command to set the LD_LIBRARY_PATH:

export 
LD_LIBRARY_PATH=<install_dir>/current/local/openssl/lib:$LD_LIB
RARY_PATH

3 Run these commands to create a new private key and a server certificate request:

OPENSSL_FIPS=1 <install_dir>/current/local/openssl/bin/openssl 
req -text -newkey rsa:1024 -keyout server.key -out newreq.csr 
-config <install_dir>/current/local/openssl/ssl/openssl.cnf

You are prompted to enter a password and certificate details. Make sure you note 
down the password and keep it safely. The bit size in the certificate details is set to 
1024 by default. You can increase or decrease the size to suit your needs.

4 Send the generated CSR to a CA. Once you receive the signed certificate from the CA, 
go to the next step.

5 Run this command to archive any previously applied certificate files:

cd <install_dir>/current/local/apache/conf/ssl.crt
mv server.pem server.pem.good
mv server.crt server.crt.good

6 Run this command to install the signed certificate file you obtained from CA in Step 3: 

cp newcertificate.crt 
<install_dir>/current/local/apache/conf/ssl.crt/server.crt

7 Run this command to copy the server key to the Apache directory:

<install_dir>/current/local/openssl/bin/openssl rsa -in 
server.key  -out  <install_dir>/current/local/apache/
conf/ssl.crt/server.pem

8 Stop the Logger service and related processes using this command:

<install_dir>/current/arcsight/logger/bin/loggerd stop

Wait until all processes have stopped, then run this command to start the service and 
processes:

<install_dir>/current/arcsight/logger/bin/loggerd start
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Users/Groups
Use the Users/Groups sub-menu to configure users and user groups, and to set 
authentication options.

Authentication
The authentication settings enable you to specify settings and policies for login and 
password.

Sessions
The Session Settings page lets you specify the maximum number of simultaneous sessions 
for a single user account, and the length of time after which a user session is automatically 
logged out or disabled. By default, a single user account can have 15 simultaneous 
sessions to a single Logger, and a user account is logged out after 15 minutes of inactivity. 

To change sessions settings:

1 Click System Admin from the top-level menu bar.

2 Click Authentication from the Users/Groups section.

3 On the Sessions tab, update the parameters described in the following table.

4 Click Save to make the changes, or click another tab to cancel.

Parameters Description

Max Simultaneous Logins/User The maximum number of simultaneous 
sessions allowed for a single user account.

The default is 15.

Logout Inactive Session After The length of time after which an inactive 
session is automatically ended. The 
default is 15 minutes.

Note: This value does not apply to the 
user interface pages accessed through the 
Monitor menu. If a user is on any of the 
Monitor menu pages and the session has 
been inactive for the specified number of 
minutes, the user’s session remains 
active.

Disable Inactive Account After The number of days after which an 
inactive user account is disabled.

The default value is 0.
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Passwords
The Passwords tab enables you to set password policies such as the minimum and 
maximum number of characters and other requirements for passwords. 

To change the password settings:

1 Click System Admin from the top-level menu bar.

2 Click Authentication from the Users/Groups section.

3 In the Passwords tab, update the parameters described in the following table.

Parameter Description

Enable Account 
Lockout

Click the checkbox to allow user accounts to be locked 
out as defined by the following settings. By default, the 
checkbox is unchecked.

Lockout Account After Number of failed login tries after which a user account 
is locked out. Default is 3.

Remember Failed 
Attempts For

The length of time for which a failed login attempt is 
remembered. Default is one minute.

Lockout Account For The length of time for which a locked out account 
cannot be unlocked. Default is 15.

Enforce Password 
Strength

Click the checkbox to enforce password policy as 
defined by the following settings. By default, the 
checkbox is unchecked.

Minimum Length Minimum number of characters that a password must 
contain. The default is 10.

Maximum Length Maximum number of characters that a password can 
contain. The default is 20.

Password Character 
Rules

Password character rules define additional character 
requirements for a password to ensure password 
strength.
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4 Click Save to save the changes, or another tab to cancel.

User Management
Use the Users and Groups tabs to manage the users and user groups on your system. User 
groups are a way to enforce access control to various sections of your system.

Users
Use the Users tab to manage the users that can log in to your system. You can add a new 
user, edit user information, or delete a user at any time. You must have the appropriate 
System Admin group rights to perform these functions.

To add a new user:

1 Click System Admin from the top-level menu bar.

2 Click User Management under the Users/Groups section in the left panel.

3 In the Users tab, click Add from the top left side of the page.

4 Enter the following parameters.

Numeric Minimum number of numeric characters (0-9) in a 
password. The default is 2.

Uppercase Minimum number of uppercase characters (A-Z) in a 
password. The default is 0.

Special Minimum number of non-digit and non-letter 
characters that are required in a password. The default 
is 2.

Lowercase Minimum number of lowercase characters (a-z) in a 
password. The default is 0.

Password Must be At 
Least N Characters 
Different From Old 
Password

Minimum number of characters that the new password 
must differ by from the previous one. The default is 2.

Credentials

Login A login name for the user.

Password A password for the user.

Confirm 
Password

Reenter the password.

Contact Information

First Name First name of the user.

Last Name Last name of the user.

Email An email address for the user.

Phone Number Phone number for the user. (Optional)

Assign to Groups

Parameter Description
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5 Click Save and Close.

To edit a user:

1 Click System Admin from the top-level menu bar.

2 Click User Management under the Users/Groups section in the left panel.

3 In the Users tab, select the user (or users) you want to edit.

4 Click Edit from the top left side of the page.

5 Update the user information as necessary.

6 Click Save User.

To delete a user:

1 Click System Admin from the top-level menu bar.

2 Click User Management under the Users/Groups section in the left panel.

3 In the Users tab, select the user (or users) you want to delete.

4 Click Delete from the top left side of the page.

Groups
User groups define privileges to specific functions on your ArcSight system and are the way 
to enforce access control to these functions. For example, if you want User A to only run 
searches and not reports, you assign that user to the Search group but not the Reports 
group. User groups are organized by the following types: System Admin, Logger Rights, 
Logger Search, Logger Reports, and Connector Appliance Rights (only on Logger platforms 
with integrated Connector Appliance).

Each type has a pre-defined, default user group in which all privileges for the type are 
enabled. To authorize a subset of the privileges for a specific group type, create a new user 
group and only enable the privileges you want to provide, then assign restricted users to 
the newly created group.

System Admin Groups
The System Admin Group controls the system administration operations for your ArcSight 
system, such as configuring network information, setting storage mounts, installing SSL 
certificates, and user management. 

Read Only System Admin Group

In addition to the default System Admin Group that enables all privileges, a Read Only 
System Admin Group exists on your system. Users assigned to this group can only view the 
System Admin settings, but not change them. 

Assign to Groups Select the groups to which this user belongs. This setting con-
trols the privileges a user has on this Logger.

A system admin level user account that has been used to upgrade the system 
cannot be deleted. For example, if system admin user Joe upgrades the sys-
tem, Joe’s user account can not be deleted from the system once the upgrade 
is complete. To remove such a user, disable the user account. To disable a 
user account, edit the user account and disable the “Active” option.
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Refer to your system’s user interface to see a complete list of privileges available in this 
group.

Logger Rights Group
The Logger Rights Group controls the Logger application operations for your ArcSight 
system, such as viewing the Logger dashboards and configuring all the settings under the 
Configuration menu (event archives, storage groups, alerts, filters, scheduling tasks, and 
so on).

Refer to your system’s user interface to see a complete list of privileges available in this 
group.

Logger Search
The Logger Search Group controls local and peer searches through the following privileges:

 Search for events

 Search for events on remote peers

If the group is configured to allow users to run local and peer searches, users assigned to 
this group can perform those operations. Conversely, if the group is configured to prevent 
users from running local and peer searches, users assigned to this group cannot perform 
those operations. 

Logger Reports
The Logger Reports group controls all report operations on Logger such as run, edit, 
delete, schedule, view published reports, and so on. 

Refer to your system’s user interface to see a complete list of privileges available in this 
group.

Managing a User Group
To create a new user group:

1 Click System Admin from the top-level menu bar.

2 Click User Management under the Users/Groups section in the left panel.

3 Click the Groups tab.

4 Click Add from the top left side of the page.

5 Define the new group:

a In the Group Name field, provide a name for the group.

b In the Description field, provide a description for the group.

c From the Group Type drop-down box, select the group type. 

d Click the down arrow icon ( ) next to the group type name to view and select 
privileges that you want to assign to the users in this group. 

6 Click Save and Close to save the settings of the group. OR click Save and Edit 
Membership to add users to this group.

To edit a user group:

1 Click System Admin from the top-level menu bar.

2 Click User Management under the Users/Groups section in the left panel.
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3 Click the Groups tab.

4 Select the Group that you want to edit and click Edit at the top left side of the page.

5 Update the user group information. 

If you need to edit the group’s membership:

a Click Save and Edit Membership to display the Edit Group Membership page, 
as shown in the following figure. 

b Click Add from the top left of the Edit Group Membership page.

c Select users you want to add. By default, you can only add users who do not 
belong to other groups of the type that you are editing. However, if you want to 
add such users, click Show users that belong to other <group_type> 
groups, as shown in the following figure. When you add a user who belongs to 
another group of the same group type as the one you are updating, that user is 
automatically removed from the previous group. 

d Click OK.

e Click Back to Group List. 

6 Click Save and Close.

To delete a user group:

1 Click System Admin from the top-level menu bar.

2 Click User Management under the Users/Groups section in the left panel.

3 Click the Groups tab.

4 Select the Group (or Groups) that you want to delete.

5 Click Delete at the top left side of the page.

Change Password
Use the Change Password menu to change your password. To change your password:

1 Click System Admin from the top-level menu bar.

2 Click Change Password under the Users/Groups section in the left panel to display 
the Change Password for <User Name> page.

3 Enter the old password, the new password, and enter the new password a second 
time to confirm.

4 Click Change Password.

Monitoring System Health 
You can monitor your Logger’s health in two ways:

 Using a predefined system filter, as listed in “System Filters/Predefined Filters” on 
page 146. The predefined system health filters are based on the system health events 
listed in “System Health Events” on page 409.

 Searching for system health events in Logger’s Internal Storage Group, as listed in 
“System Health Events” on page 409. If a predefined system health filter does not suit 
your needs, you can create alerts based on the system health events.
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To set up notification of system health events

1 Configure the Logger’s SMTP settings (see “SMTP” on page 392) or create an SNMP 
Destination (see “SNMP Destinations” on page 200) or Syslog Destination (see “Syslog 
Destinations” on page 201).

2 Create an Alert that uses one or more System Alert Filters or defining a query that 
searches for the system health events in Logger’s Internal Storage Group, and specify 
match count and threshold (see “Alerts” on page 188). 

3 Enable the new Alert. 

System Health Events
The following table lists the system health events that Logger generates. These events are 
also referred as Logger Internal Events because they are stored in Logger’s Internal 
Storage Group. See Appendix F, Examples of System Health Events‚ on page 151 for 
examples of these events.

The predefined System Filters that provide system health status are based on some of 
these events. If a predefined filter does not suit you needs, create an alert using one of 
these events.

Starting with Logger v5.1, the format in which system health events are generated was 
changed to provide more meaningful information. Some of the changes were:

 Addition of new events. For example, Current and Voltage events.

 Instead of referring to all system health events as Logger Internal Event in the name 
field, meaningful names are used. For example, Fan OK, Temperature OK. 

 Three severity levels for each event have been added to the agentSeverity field—1 
(OK), 5 (Degraded), and 8 (Severe).

 The deviceCustomString and deviceCustomStringLabel field mappings 
have changed. Refer to a specific event to identify changes. 

 Device Event Class ID (deviceEventClassId) and Device Event Category 
(deviceEventCategory) of the events have changed. The updated list is available 
in the following table. 

 All hardware-related events are classified as hardware:nnn events, where nnn is a 
three-digit number that identifies the hardware component. For example, 
hardware:13x identifies the fan events.

If you are upgrading from Logger v5.0 Patch 2 or earlier, any existing filters or queries 
based on earlier events will not work on the events collected after the upgrade. However, 
those filters and queries will continue to work on the events collected prior to the upgrade. 
Note that the predefined System Filters are compatible with the new and the old format. 

Group Device Event Category
Device Event 
Class ID

System Health Events for appliance and software Loggers

CPU /Monitor/CPU/Usage cpu:100

Disk /Monitor/Disk/Read disk:102

/Monitor/Disk/Write disk:103
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EPS /Monitor/Receiver/EPS/All eps:100

/Monitor/Receiver/EPS/Individual eps:102

/Monitor/Forwarder/EPS/All eps:101

/Monitor/Forwarder/EPS/Individual eps:103

Memory /Monitor/Memory/Usage/Platform memory:100

Network /Monitor/Network/Usage/In network:100

/Monitor/Network/Usage/Out network:101

Search /Monitor/Search/Performed search:100

Storage Group /Monitor/StorageGroup/Space/Used

Note: The size of the storage group, 
indicated by the “fsize” field is in GB. 

storagegroup:100

Group Device Event Category
Device Event 
Class ID
410 Administrator’s Guide Confidential



Chapter 9

Managing Connectors

The following topics are discussed here.

“Connector Overview” on page 412

“Navigating the Manage Connectors Tab” on page 413

“Locations” on page 415

“Hosts” on page 419

“Containers” on page 426

“Connectors” on page 444

“Configuration Suggestions for Connector Types” on page 478
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Connector Overview
You can manage the configuration of these kinds of connectors:

 Local (on-board) connectors: Pre-installed connectors on the  Logger appliance 
running Connector Manager. Connector Manager (software edition) ships with no 
pre-installed connectors.

 Remote Connector Appliance connectors: Pre-installed connectors on a 
remotely-managed Connector Appliance.

 Software-based connectors: Software-based connectors installed manually on a 
remote host.

A connector configuration consists of properties such as name and type, and a set of 
parameters that customize how the connector works in a specific environment. Parameters 
vary based on the type of connector; for example, a connector for a firewall has different 
parameters than a connector that reads an intrusion detection system database.

You can manage connectors of many types, including syslog, Simple Network Management 
Protocol (SNMP), BlueCoat SmartConnector via FTP, specific Intrusion Detection Systems 
(IDS), log files, vulnerability scanners, and operating system-specific security events. You 
can view the list of supported types in the drop-down menu when you configure a new 
connector.

Individual software-based connectors are described in ArcSight documents specific to those 
connectors, including the connector-specific configuration guides available with each 
connector. You can also find general connector information in the SmartConnector User’s 
Guide. All of these documents are available from the ArcSight Customer Support site.

The connectors you manage are configured automatically to run as services 
or daemons.
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Navigating the Manage Connectors Tab
The Manage Connectors tab enables you to configure and organize connectors. This 
section describes the user interface elements and explains how to use them effectively. 

Figure 9-1 Managing Connectors

The Connector tree (the left panel of the window shown in Figure 9-1) organizes 
connectors into a hierarchy as follows: 

Each connector you manage belongs to a container; each container belongs to a host; each 
host belongs to a location; and, all locations belong to root of the System.

When you click on an upper-level user interface element in the left panel, the interface 
displays elements lower in the hierarchy to it on the right panel. You can also perform 
management operations on the elements displayed on the right side. 

For example, System provides the root (top-level) view. When you click System, all 
configured locations are listed in the left panel, as well as under the Locations tab in the 
right panel. You can perform various management tasks, such as editing, deleting, or 
adding a host, on those locations. In addition, all hosts, containers, and connectors on this 
system are displayed in specific tabs in the right panel. Click the Hosts tab to view all hosts 
on the system, and click Containers and Connectors to view the respective elements 
and perform management operations on them. Similarly, if you select a host (from the left 
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panel), all containers and connectors configured on that host are displayed on the right 
panel, as shown in the following figure. 

On any user interface, you can perform three kinds of operations:

 A global operation—Listed on top of a user interface page; for example, you can 
upload a CSV file of locations.

 A localized operation—An operation on a single element displayed on the user 
interface page; for example, you can add a connector to a container by clicking the 

 icon in the Action column in the container’s row.

 A bulk operation—A single operation performed on multiple elements on the user 
interface page; for example, you can upgrade multiple containers by selecting the 
containers (click the box to the left of the container to select it) and clicking Upgrade 
at the bottom of the page.

When a container is down or a host is unreachable, the system waits for it 
to come online. There might be a delay of several minutes before the 
connector tree (in the left panel) and the Container tab (in the right panel) 
display. 

• The  icon refreshes a UI screen. This icon is available on the UI pages 

when relevant.

• Click the column filter icon ( ) to display drop down lists of values on 
which to filter each table column. Click the check box in the table header 
to check or uncheck all check boxes in a single column.

• When processing user provided data, Connector Appliance wizards 
“escape” some HTML-specific characters. Any other entered characters 
are not “escaped” (or validated) and are used as entered. 
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Locations
Location is a logical grouping of hosts. The grouping can be based on any suitable 
abstraction—geographical, organizational, and so on. For example, you can group all hosts 
in New York separately from hosts in San Francisco and label them as such. Similarly, you 
can group a few machines under Sales and others under Marketing.

A location can contain any number of hosts. Default location is provided on a new 
Connector Appliance or on a Logger appliance running Connector Manager. Default 
location is not provided on the Connector Manager (software edition).

You can view all locations on the system and view hosts, containers, and connectors in a 
location. You can add, edit, and delete a location. You can also add hosts to a location. All 
these procedures are described below.

Viewing All Locations
You can see all the locations that exist on the system.

To view all locations:

1 Click Configuration > Manage Connectors.

2 Click System in the left panel. 

All existing locations display on the Locations tab in the right panel.

Viewing Hosts, Containers, and Connectors in a Location
You can see all the hosts, containers, and connectors that exist in a location.

To view hosts, containers, and connectors in a location:

1 Click Configuration > Manage Connectors.

2 Click the location (listed under System) from the left panel.

The hosts, containers, and connectors in the location display in the right panel, under 
specific tabs, as shown below.

ArcSight recommends that you do not delete the location Default.
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Adding a Location
Before adding hosts, you need to add a location, which is a logical grouping of hosts.

To add a location:

1 Click Configuration > Manage Connectors.

2 Click System in the left panel.

3 Click  (on top of the page) in the right panel.

4 Enter the name of the new location and click Next.

5 Click Done.

Exporting and Importing Remote Management Configuration
You can create a backup of the complete remote management configuration settings on 
the Connector Appliance (all remote software connectors and remote Connector Appliances 
that are managed by the appliance) and import the configuration on another appliance. 

The remote management configuration is saved in AUP format in the Remote Management 
AUP repository so you can download it to your local computer. 

You cannot manage the same connectors using two appliances at the same time. Before 
importing the remote management configuration to another Connector Appliance, you 
need to shut down the appliance from which you exported the configuration.

To export the remote management configuration:

1 Click Configuration > Manage Connectors.

2 Click System in the left panel.

3 Click  (on top of the page) in the right panel.

4 Follow the instructions in the * to export the configuration. The remote host 
configuration is saved in AUP format in the Remote Management AUP repository.

After you export the remote management configuration, you need to download it to your 
local computer from the Remote Management AUP repository.

You can also add locations in bulk using a comma-separated values (CSV) 
file. For more information see, Adding Locations and Hosts from a File, 
below.

You can import the remote management configuration only on the same 
appliance model as the one from which the configuration is exported. 
416 Administrator’s Guide Confidential



9 Managing Connectors
After you have exported the remote management configuration and have downloaded it to 
your local computer, you can import the configuration to another appliance. 

To import the remote management configuration:

1 On the appliance where you want to copy the remote management configuration, click 
Configuration > Manage Connectors.

2 Click System in the left panel.

3 Click  (on top of the page) in the right panel.

4 Follow the instructions in the wizard. When selecting the type of upload, choose Full 
remote management (AUP format).

Adding Locations and Hosts from a File
To add hosts (and consequently, containers and connectors) in bulk, you can use a 
comma-separated values (CSV) file. When you add a host, the containers (and connectors) 
on the system are scanned automatically and the CA certificates from the containers that 
reside on the host are retrieved. You can manage the containers on the hosts only if it can 
authenticate using the certificates and the credentials. When the certificates are retrieved, 
you are prompted to import them. 

The CSV file needs to be in the format shown in the following example. Also, ensure that 
an end-of-line character is included in the last line of the CSV file if the file was created on 
a Windows system. However, an end-of-line character is not required if the file was created 
on a Linux system.

To add locations and hosts from a CSV file:

1 Click Configuration > Manage Connectors.

2 Click System in the left panel.

3 Click  (on top of the page) in the right panel to open the wizard.

Importing the remote management configuration overwrites the current 
remote management configuration on the appliance.

If there are no valid CA certificates for any connectors in the 
configuration, you see a question mark (?) next to the container that 
contains the connectors in the left panel. Refer to “Resolving Invalid 
Certificate Errors” on page 439.

A host is not added if:

• Any containers on the host are down.

• If you choose not to import the certificates that are retrieved.

• Authentication fails on any of the containers.
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4 Select Remote hosts (CSV format) and click Next. Follow the instructions in the 
wizard to upload the file. 

5 Connector certificates are retrieved automatically so that the system can communicate 
with each connector in a container. The Upload CSV wizard lists the certificates. (To 
see certificate details, hover your mouse over the certificate.)

 Select Import the certificates to Connector Appliance from the 
containers, then click Next to import the certificates and continue.

 Select Do not import the certificates to Connector Appliance from the 
containers and click Next if you do not want to import the certificates. The 
Upload CSV wizard does not complete the upload CSV process.

Editing a Location
You can edit the name of a location from the System-level page or from a specific Location 
page.

To edit a location:

1 Click Configuration > Manage Connectors.

2 From the System-level page: 

Click System (left panel) > Locations tab (right panel) >  in the Action column.

From a specific Location page:

Click System (left panel) > Location >  (on top of the page, in the right panel).

3 Enter the new name of the location and click Next.

4 Click Done.

Deleting a Location
When you delete a location, the hosts, containers, and connectors that it contains are also 
deleted.

To delete a location:

1 Click Configuration > Manage Connectors.

2 Click System in the left panel.

3 Select the location you want to delete. You can select multiple locations. 

4 Click Delete at the bottom of the page, in the right panel.

Adding Hosts to a Location
See “Adding a Host” on page 420.

The Upload CSV wizard does not complete the upload if certificate download 
failed for any of the connectors in a container or if any of the certificates 
failed to import into the trust store on the system.
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Hosts
A host is a computer on a network, associated with an IP address, on which connectors are 
installed. A host can be of three types:

 The Localhost (the local Connector Appliance or the Logger appliance running 
Connector Manager). By default, Localhost exists on a brand new Connector 
Appliance or Logger appliance running Connector Manager; it contains a default 
number of containers, which are empty.

Connector Manager (software edition) does not ship with Localhost.

 A remotely-managed Connector Appliance. 

 A Software-type host (a Windows, Linux, or UNIX system running software-based 
connectors from ArcSight). A software-type host can contain up to 20 containers. 

You can view all hosts on the system, and view containers and connectors in a host. You 
can add, scan, delete, and edit a host. You can move a host to a different location and 
upgrade a host remotely. You can also add a container to a host. All these procedures are 
described below.

Viewing All Hosts
You can see all the hosts you are managing.

To view all hosts:

1 Click Configuration > Manage Connectors.

2 Click System in the left pane. All hosts display on the Hosts tab in the right panel.

Viewing Containers and Connectors in a Host
You can see all the containers and connectors that exist on a host.

To view containers and connectors on a host:

1 Click Configuration > Manage Connectors.

2 In the left panel, click the location (under System) in which the host exists.

3 In the left panel, click the host to view the containers and connectors.

All containers display on the Containers tab and all connectors display on the 
Connectors tab in the right panel.
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Adding a Host
By default, a local host Localhost exists on your Connector Appliance or Logger appliance 
running Connector Manager. However, Connector Appliance can manage connectors 
installed on other Connector Appliances and other systems such as Windows, UNIX, or 
Linux. To manage remote connectors, you need to add the hosts on which those 
connectors are running. 

When you add a host, the system also attempts to retrieve the CA certificates from the 
containers that reside on the host. Containers on the remote host can be managed only if 
the system can authenticate using the certificates and the credentials. When the 
certificates are retrieved, you are prompted to import them. 

You can add hosts from the System-level page or from a specific Location page.

When you add a remote software-type host, it is scanned automatically for the 
currently-running containers and the connectors associated with them. If additional 
containers are added to the remote host after it has been added to the system, you need 
to scan the host manually to detect the new containers. For information about scanning 
hosts, see “Scanning a Host” on page 422. 

To add a host:

1 Click Configuration > Manage Connectors.

2 From the System-level page, click System (left panel) > Locations tab (right panel) 

>  in the Action column.

From a specific Location page, click System (left panel) > Location (under which the 

host exists) >  (on top of the page, in the right panel).

Connector Manager (software edition) does not ship with the default 
Localhost. You need to add the hosts that contain the connectors you want to 
manage.

A host is not added if:

• Any containers on the host are down.

• If you choose not to import the certificates that are retrieved.

• Authentication fails on any of the containers.

You can also add locations and hosts using a comma-separated values 
(CSV) file. For more information see, “Adding Locations and Hosts from a 
File” on page 417.
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3 On the Host Wizard form, shown below, enter values for the parameters listed in the 
following table and then click Next.

Parameter Description

Hostname The hostname or IP address of the actual host.

Starting Port Each container on a host listens on a port. Specify the starting 
port number. Subsequent containers will use subsequent ports.

User The user name that the system uses to connect to the host.

Ending Port By default, Connector Appliance scans port 9001 to port 9020 
when adding a host. If you select software in the Hardware 
Type field, you can specify the ending port number (for 
example, 9003) to speed up the add host process. 

Password The password for the user name you specify.

Comment A meaningful description for the host you are adding.
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4 Connector certificates are retrieved automatically so that the system can communicate 
with each connector in a container. The Add Host wizard lists the certificates. (To see 
certificate details, hover your mouse over the certificate.)

 Select Import the certificates to Connector Appliance from the 
containers, then click Next to import the certificates and add the host.

 Select Do not import the certificates to Connector Appliance from the 
containers and click Next if you do not want to import the certificates. 
Connector Appliance does not add the host.

Scanning a Host
Scanning a host enables the system to detect new or removed containers from a remote 
software-type host. When a software-type host is added for the first time, it is scanned 
automatically for containers running at that time; however, to keep this information 
up-to-date, you need to scan the host manually whenever you add connectors to the 
remote host. 

You can scan a host from the System-level page, a specific Location page, or a specific 
Host page.

When you scan a host, the CA certificates from the containers that reside on the host are 
retrieved. The containers on the remote host can be managed only if the system can 

Hardware Type • If you want to manage connectors that reside on a remote 
Connector Appliance, select the number of containers on 
that host. A host can have up to 8 containers. 

For the number of connectors applicable to each model type 
and container specifics, see the ArcSight Appliance 
Specifications document. This document is available on the 
ArcSight Customer Support site at 
http://www.arcsight.com/supportportal.

• If you want to remotely manage connectors running on a 
Windows, UNIX, or Linux system, select Software. 

The system can detect the presence of software-based 
connectors on remote hosts using the Starting Port value 
you specified earlier. The system scans up to 20 configurable 
ports from the starting port to find the “listening” 
connectors.

Any found connectors are added into the host. For more 
information, see “Scanning a Host” on page 422. 

The Add Host wizard does not add the host if the certificate download failed 
for any of the connectors in a container or if any of the certificates failed to 
import into the trust store.

• You can scan only software-type hosts. See “Hosts” on page 419 for 
information about software-type hosts.

• The connectors on a software-type host need to be configured for 
remote management.

• A maximum of 20 connectors are scanned on port 9001 through 9020.

Parameter Description
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authenticate using the certificates and the credentials. When the certificates are retrieved, 
you are prompted to import them. 

To scan a host:

1 Click Configuration > Manage Connectors.

2 From the System-level page, click System (left panel) > Locations tab (right panel).

From a specific Location page, click System (left panel) > Location (under which the 
host exists).

From a specific Host page, click System (left panel) > Location (under which the host 
exists) > Host.

3 Click  in the Action column for the host that you want to scan.

4 Click Next in the Host Scan wizard.

5 Enter values for the parameters in the following table, then click Next.

6 Connector certificates are retrieved automatically so that the system can communicate 
with each connector in a container. The Host Scan wizard lists the certificates. (To see 
certificate details, hover your mouse over the certificate.)

 Select Import the certificates to Connector Appliance from the 
containers, then click Next to import the certificates and continue.

 Select Do not import the certificates to Connector Appliance from the 
containers and click Next if you do not want to import the certificates. The Host 
Scan wizard does not continue the scan.

A host cannot be scanned (the scan fails) if:

• Any containers on the host are down.

• If you choose not to import the certificates that are retrieved.

• Authentication fails on any of the containers.

Parameter Description

Starting Port The port number on the host on which Connector Appliance 
starts scanning for containers.

Ending Port The port number on the host on which Connector Appliance 
ends scanning for containers.

User The user name that the system uses to authenticate with the 
host.

Password The password for the user name you provide.

The scan is not completed if the certificate download failed for any of 
the connectors in a container or if any of the certificates failed to import 
into the trust store.
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Deleting a Host
When you delete a host, the containers and connectors that it contains are also deleted 
from the system that is managing the host. You can delete a host from the System-level 
page or from a specific Location page.

To delete a host:

1 Click Configuration > Manage Connectors.

2 From the System-level page, click System (left panel) > Hosts tab (right panel).

From a specific Location page, click System (left panel) > Location (under which the 
host exists).

3 Select the host you want to delete. You can select multiple hosts. 

4 Click Delete on the bottom of the page.

Moving a Host to a Different Location
When you move a host, the containers and connectors that it contains are also moved. You 
can move a host from the System-level page or from a specific Location page.

To move a host:

1 Click Configuration > Manage Connectors.

2 From the System-level page, click System (left panel) > Hosts tab (right panel).

From a specific Location page, click System (left panel) > Location (under which the 
host exists).

3 Select the host you want to move. You can select multiple hosts. 

4 Click Move at the bottom of the page.

5 Follow the instructions in the Hosts Move wizard.

Editing a Host
You cannot edit a host, however, you can delete an existing host and add a new one (as 
described in “Adding Hosts to a Location” on page 418) or move an existing host (as 
described in “Moving a Host to a Different Location” on page 424).

Upgrading a Host Remotely

You can upgrade a single remotely-managed Connector Appliance or several 
remotely-managed Connector Appliances at the same time (in bulk). Follow these 
guidelines:

 The containers of the appliance being upgraded need to be managed on the system 
from which you will initiate the upgrade. 

Remotely upgrading a Connector Appliance is a two-step process.

The following instructions only apply to upgrading a remotely-managed 
Connector Appliance.
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To upgrade a Connector Appliance remotely:

1 Upload a Connector Appliance .aup upgrade file from the ArcSight Customer Support 
site to the  AUP repository. 

This step is only required if the version that you want to upgrade does not already 
exist in the repository. 

2 Push the .aup upgrade file to the remote Connector Appliances, as follows: 

a Click Configuration > Manage Connectors.

b From the System-level page, click System (left panel) > Hosts tab (right panel).

From a specific Location page, click System (left panel) > Location (under which 
the host exists).

c Select the host you want to upgrade. You can select multiple hosts. 

d Click Upgrade at the bottom of the page.

e Follow the instructions in the upgrade wizard.

Adding a Container to a Host
See “Adding a Container” on page 427.
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Containers
A container is a single Java Virtual Machine (JVM) that can run up to four connectors. The 
following illustration depicts Container 1 and the connectors it runs. 

A default number of containers exist on each Connector Appliance. The number depends 
on the Connector Appliance hardware platform. Each container is identified with a label 
(Container Name) and an associated port number (9001 or higher).

Connector Manager on a Logger appliance contains one default container in the default 
host Localhost. You cannot delete this container. Connector Manager (software edition) 
does not contain any default containers.

You can perform many operations on containers. You can view all containers on the system 
and view the connectors in a container. You can add, delete, and edit a container. You can 
update container properties and change container credentials. You can manage certificates 
on a container, run a command on a container, and upgrade a container to a specific 
connector version. You can also view and delete container logs and run the Logfu utility. All 
these procedures are described below.

If you see a question mark (?) next to a container in the left panel, as shown below, the 
connectors in the container cannot be authenticated. The CA certificates for the connectors 
might be no longer valid. Refer to “Resolving Invalid Certificate Errors” on page 439.

Viewing All Containers
You can see all the containers you are managing.

To view all containers:

1 Click Configuration > Manage Connectors.

2 Click System in the left panel. All containers display on the Containers tab in the right 
panel.
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Viewing Connectors in a Container
You can see all the connectors in a container.

To view connectors in a container:

1 Click Configuration > Manage Connectors.

2 In the left panel, click the Location > Host (under which the container exists) > 
Container (whose connectors you want to view). The connectors are listed on the right 
panel. 

Adding a Container
You do not need to add a container as containers are added automatically when a new host 
is added to the system. 

When you add a software-type host, it is scanned automatically for containers (and 
connectors) as described in “Scanning a Host” on page 422. If you add connectors to such 
a host at a later date, you need to scan it manually.

Adding a Connector to a Container
See “Adding a Connector” on page 444.

Editing a Container
The default names for containers are numerical, but you can change them. 

To edit a container:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

User Interface Options Path

From the System-level page Click System (left panel) > 
Containers tab (right panel).

From the location in which the 
container exists

Click System (left panel) > Location 
(left panel) > Containers tab (right 
panel).

From the host on which the container 
exists

Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Containers tab (right panel).
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3 Click  in the Action column of the container whose name you want to change.

If you are on the specific Container page,  is at the top of the page.

4 Enter the new name in the Name field and click Next.

5 Click Done. 

Deleting a Container
You can delete containers from software-type hosts only. All other hosts (for example, a 
remotely-managed Connector Appliance) have a fixed number of containers. 

When you delete a container, the connectors that it contains are also deleted. 

To delete a container:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Select the container you want to delete. You can select multiple containers. 

4 Click Delete.

Updating Container Properties
You can update existing container properties (located in the agent.properties file), 
delete them, or add new ones.

To update container properties:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

From the Containers page Click System (left panel) > Location 
(left panel) > Host (left panel).

User Interface Options Path

From the System-level page Click System (left panel) > Containers 
tab (right panel).

From the location in which the 
container exists

Click System (left panel) > Location (left 
panel) > Containers tab (right panel).

From the host on which the 
container exists

Click System (left panel) > Location (left 
panel) > Host (left panel) > Containers 
tab (right panel).

User Interface Options Path

From the System-level page Click System (left panel) > 
Containers tab (right panel).

User Interface Options Path
428 Administrator’s Guide Confidential



9 Managing Connectors
3 Select the container whose properties you want to update. You can select multiple 
containers. 

4 Click Properties.

5 Follow the instructions in the wizard to update connector properties.

Changing Container Credentials
Each container has a user name and password associated with it. The default user name is 
connector_user and the default password is change_me. For security reasons, it is 
important to change these values before deploying the system in production.

To change container credentials:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Select the container whose credentials you want to update. You can select multiple 
containers.

4 Click Credentials.

5 Follow the instructions in the wizard to update connector credentials.

From the location in which the 
container exists

Click System (left panel) > Location 
(left panel) > Containers tab (right 
panel).

From the host on which the container 
exists

Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Containers tab (right panel).

When a property is removed, it is still visible until the container is 
restarted.

User Interface Options Path

From the System-level page Click System (left panel) > 
Containers tab (right panel).

From the location in which the 
container exists

Click System (left panel) > Location 
(left panel) > Containers tab (right 
panel).

From the host on which the container 
exists

Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Containers tab (right panel).

This feature does not apply for containers managed by another Connector 
Appliance, as that appliance will not be notified of the changes. If the local 
system tries to communicate with the remote Connector Appliance, a 
credentials error occurs. 

User Interface Options Path
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Enabling and Disabling FIPS on a Container
You can enable or disable FIPS mode on a container. When FIPS mode is enabled for a 
container, all the connectors in that container are in FIPS mode.

FIPS mode is supported on local, remote, and software connectors running version 4.7.5 or 
later. Certain connectors do not support FIPS mode. For information about which 
connectors do not support FIPS mode, contact ArcSight Customer Support.

To enable or disable FIPS mode on a container:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Select the container on which you want to enable or disable FIPS mode. You can select 
multiple containers.

4 Click FIPS, then click Next to run the FIPS Management wizard.

5 Click Enable FIPS Mode or Disable FIPS Mode, then click Next.

Before enabling FIPS on a container that contains software connectors 
running as a service, review the caveats listed in document Installing 
FIPS-Compliant SmartConnectors, available from ArcSight Customer 
Support.

After you enable or disable FIPS mode on a container, check that the 
appropriate CA certificates are in the trust store of the connectors so that 
they can validate their configured destinations successfully. If the 
appropriate CA certificates are not present, you need to add them (refer to 
“Managing Certificates on a Container” on page 431).

User Interface Options Path

From the System-level page Click System (left panel) > Containers tab 
(right panel).

From the location in which the 
container exists

Click System (left panel) > Location (left 
panel) > Containers tab (right panel).

From the host on which the 
container exists

Click System (left panel) > Location (left 
panel) > Host (left panel) > Containers tab 
(right panel).
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If FIPS mode is already enabled or disabled on the container, the FIPS Management 
wizard indicates this on the Summary page.

6 Check that the appropriate CA certificates are in the trust store so that the connectors 
in the container can validate their configured destinations successfully. If necessary, 
add the appropriate certificates to the container. Refer to Managing Certificates on a 
Container.

Managing Certificates on a Container
Connectors require a Certificate Authority (CA) issued or self-signed SSL certificate to 
communicate securely with a destination. The Certificate Management wizard, available 
from the Containers tab, helps you add and remove certificates on a container. Using the 
wizard, you can:

 Enable or disable a demo certificate on a container. 
You can enable a demo certificate on a container that is in non-FIPS mode only.

 Add a certificate on a container.

 Add a CA Certs file on a container. 
You can add a CA Certs file on a container that is in non-FIPS mode only.

 Remove a certificate from a container.

From the Containers tab and the Connectors tab, you can view details about the certificates 
applied to a container. See “Viewing Certificates on a Container” on page 437.

For information about resolving invalid certificates, see “Resolving Invalid Certificate Errors” 
on page 439.

Adding CA Certificates on a Container
You can add a single CA certificate on a container that is in FIPS mode or non-FIPS mode.

Before you follow the following procedure, make sure that the certificate you want to apply 
is loaded in the CA Certs repository.

To apply a single CA certificate on a container:

1 Click Configuration > Manage Connectors.

Whenever you enable or disable FIPS mode on a container, check that the 
required certificates are present in the trust store and add them if 
necessary.

Hover your mouse over a container name to see the type of certificate 

applied to it. Click the  icon to display a list of the certificates available 

on the container.
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2 Use one of these navigation paths:

3 Select the container to which you want to add the certificate. You can select multiple 
containers. 

4 Click Certificates, then click Next to run the Certificate Management wizard.

5 Click Add Certificate to add a certificate.

6 Follow the instructions in the wizard.

If a container is down or a connector is running an older build, the wizard reports 
errors in the progress bar and on the Summary page.

User Interface Options Path

From the System-level page Click System (left panel) > Containers 
tab (right panel).

From the location in which the 
container exists

Click System (left panel) > Location (left 
panel) > Containers tab (right panel).

From the host on which the 
container exists

Click System (left panel) > Location (left 
panel) > Host (left panel) > Containers 
tab (right panel).
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Removing CA Certificates from a Container
You can remove CA certificates from a container when they are no longer needed. When 
you remove a CA certificate, the certificate is removed from the container’s trust store; but 
it is not deleted from the repository.

To remove CA certificates from a container:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Select the container from which you want to remove the CA certificates. You can select 
multiple containers. 

4 Click Certificate, then click Next to run the wizard.

5 Click Remove certificate and click Next.

6 Select one or more certificates from the certificate list and click Next.

The certificates are removed from the list of certificates and no longer used. When you 
remove a certificate from a container in FIPS mode, the container restarts 
automatically.

Use caution when deleting certificates. When you delete a certificate on a 
container but the connector destination is still using that certificate, the 
connector can no longer communicate with the destination.

User Interface Options Path

From the System-level page Click System (left panel) > Containers 
tab (right panel).

From the location in which the 
container exists

Click System (left panel) > Location (left 
panel) > Containers tab (right panel).

From the host on which the 
container exists

Click System (left panel) > Location (left 
panel) > Host (left panel) > Containers 
tab (right panel).
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The Certificate Management wizard displays the certificates that are removed 
successfully in a comma-separated list. Certificates that cannot be removed are shown 
in a comma-separated list together with a reason why the certificate removal failed.

Adding a CA Certs File on a Container
You can add a CA Certs file on any container that is in non-FIPS mode.

Before you follow the procedure below, make sure that the CA Certs file you want to add is 
loaded in the CA Certs repository.

To add a CA Certs file on a container:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Select the container to which you want to add the CA Certs file. You can select multiple 
containers. 

4 Click Certificates, then click Next to run the wizard.

When you apply a CA Certs file, the entire trust store on the container is 
overwritten. All previously-added certificates are overwritten.

User Interface Options Path

From the System-level page Click System (left panel) > Containers 
tab (right panel).

From the location in which the 
container exists

Click System (left panel) > Location (left 
panel) > Containers tab (right panel).

From the host on which the 
container exists

Click System (left panel) > Location (left 
panel) > Host (left panel) > Containers 
tab (right panel).
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5 Click CA Cert (Legacy). You can add a CA Certs file to a container only if it is in 
non-FIPS mode.

6 Follow the instructions in the wizard.

After the CA Certs file has been added to a container, the container restarts 
automatically.

Enabling or Disabling a Demo Certificate on a Container
You can use the demo certificate on a container for testing purposes. By default, the demo 
certificate on a container is disabled. You can enable the demo certificate temporarily for 
testing purposes on a container that is non-FIPS mode.

To enable or disable a demo certificate on a container:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Select the container to which you want to apply the demo certificate. You can select 
multiple containers. All the containers need to be in non-FIPS mode.

4 Click Certificates, then click Next to run the Certificate Management wizard.

• Enable a demo certificate on a container in non-FIPS mode for testing 
purposes only. Using a demo certificate in a production environment is 
a serious security issue because the demo certificate is not unique.

• Hover your mouse over a container name to see the type of certificate 
applied to it.

User Interface Options Path

From the System-level page Click System (left panel) > 
Containers tab (right panel).

From the location in which the 
container exists

Click System (left panel) > Location 
(left panel) > Containers tab (right 
panel).

From the host on which the container 
exists

Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Containers tab (right panel).
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5 Click Demo CA (Legacy), then click Next.

6 Follow the instructions in the Certificate Management wizard.

After you add the demo certificate on a container, the container restarts automatically.

Adding Multiple Destination Certificates to a Container
You can add multiple destination certificates to a container that is in FIPS mode or 
non-FIPS mode.

To apply multiple destination certificates to a container:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Select the container to which you want to add the certificates. You can select multiple 
containers. 

4 Click Certificates, then click Next to run the Certificate Management wizard.

Whenever you enable or disable FIPS mode on a container, check that the 
required certificates are present in the trust store and add them if 
necessary.

Click the  icon to display a list of the certificates available on the 

container.

User Interface Options Path

From the System-level page Click System (left panel) > Containers 
tab (right panel).

From the location in which the 
container exists

Click System (left panel) > Location (left 
panel) > Containers tab (right panel).

From the host on which the 
container exists

Click System (left panel) > Location (left 
panel) > Host (left panel) > Containers 
tab (right panel).
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5 Click Import destination certificates to add a certificate.

6 Follow the instructions in the wizard.

Viewing Certificates on a Container
From the Containers tab or the Connectors tab, you can display a list of the CA certificates 
applied to a container and view the details for a particular certificate in the list.

 On the Containers tab, click the  icon in the Action column for the container 
whose certificates you want to view.
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 On the Connectors tab, select the  icon at the top of the page. 

The Certificate List wizard displays the certificates applied to a container. To see details 
about a certificate, select the certificate and click Next at the bottom of the page.
438 Administrator’s Guide Confidential



9 Managing Connectors
Resolving Invalid Certificate Errors
If no valid CA certificates exist for the connectors in the container, you see a question mark 
(?) next to the container in the left panel, as shown below.

To resolve the invalid certificate error:

1 Click the container name in the left pane to view the certificate error on the 
Connectors tab. 

2 Click the  icon to run the Certificate Download wizard.

3 Follow the instructions in the wizard to import the valid certificates.

Running a Command on a Container
You can run commands on a container to configure memory settings, pull an OPSEC 
certificate, or restart the container. 

To run a command on a container:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Click  in the Action column of the container.

If you are on the specific Container page,  is at the top of the page.

4 Select the command you want to run and click Next.

5 Enter values for the parameters that the user interface displays and click Done.

User Interface Options Path

From the System-level page Click System (left panel) > 
Containers tab (right panel).

From the location in which the 
container exists

Click System (left panel) > Location 
(left panel) > Containers tab (right 
panel).

From the host on which the container 
exists

Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Containers tab (right panel).

From the Container page Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Container.
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Upgrading a Container to a Specific Connector Version
All connectors in a container are upgraded to the version you select. 

To upgrade a container to a specific connector version:

1 Upload a connector build AUP from the ArcSight Customer Support site to the AUP 
(Upgrade) repository. 

This step is only required if the build does not already exist in the AUP (Upgrade) 
repository.

2 Apply the connector build to a container, as follows:

a Click Configuration > Manage Connectors.

b Use one of these navigation paths:

c Select the container that you want to upgrade. You can select multiple containers 
for a bulk upgrade.

d Click Upgrade.

e Select the version to which you want to upgrade the selected containers and click 
Next.

You can’t upgrade the same container more than once within a short period 
of time. After you upgrade a container, wait at least 15 minutes before 
upgrading it again.

User Interface Options Path

From the System-level page Click System (left panel) > 
Containers tab (right panel).

From the location in which the 
container exists

Click System (left panel) > Location 
(left panel) > Containers tab (right 
panel).

From the host on which the 
container exists

Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Containers tab (right panel).

• On a slow network or when the system is under a particularly 
heavy load, the upgrade might be interrupted by a session 
timeout. To prevent this interruption, you can upload the .aup 
file to a higher-performance system if one is available, then push 
the result to the lower-performance system.

• If you are upgrading an empty container, the system creates a 
temporary connector during the upgrade process. You can safely 
ignore this temporary connector; it is deleted shortly after being 
created.

• Empty connectors can be upgraded from versions 5.1.2 and 
after. Upgrading empty connectors is not supported in previous 
versions. 
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Viewing Container Logs
You can retrieve and view the log files for a container. The log files are in .zip format.

To view container logs:

1 Load the logs to the Logs repository.

If the logs that you want to view are already in the Logs repository, skip this step.

a Click Configuration > Manage Connectors.

b Use one of these navigation paths:

c Select the container whose logs you want to view. You can select multiple 
containers.

d Click Logs.

The logs are loaded to the Logs repository. If you selected multiple containers, a 
log file for each container is loaded.

2 Retrieve and view the logs:

a Click Configuration > Repositories from the top-level menu bar.

b Click Logs. 

c Click  to retrieve the log files (in .zip format) you want to view. 

Deleting Container Logs
To delete a container log file, click Configuration > Repositories > Logs >from the 

top-level menu bar. In the right panel, click  next to the log files you want to delete.

User Interface Options Path

From the System-level page Click System (left panel) > 
Containers tab (right panel).

From the location in which the 
container exists

Click System (left panel) > Location 
(left panel) > Containers tab (right 
panel).

From the host on which the container 
exists

Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Containers tab (right panel).
Confidential Administrator’s Guide 441



9 Managing Connectors
Running Logfu on a Container
The Logfu utility is a diagnostic tool that parses ArcSight logs to generate an interactive 
visual representation of the information contained within the logs. 

When event flow problems occur (with a connector or the connected device), it is useful to 
have a visual representation of what happened over time. You can use Logfu to analyze 
this behavior.

To run Logfu on a container:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Click  in the Action column of the container. A separate window is displayed. If you 

are on the specific Container page,  is at the top of the page.

The system proceeds to retrieve and analyze system data logs. After this process is 
complete, a group of panels appear in the window.

4 From the Group box, choose which type of data you would like to view. The Group 
box lists all connectors within the chosen container, plus many other types of data 
such as memory usage, and transport rates and logs. 

Choose one of the Group box data points. Depending on which data point you chose, 
a list of fields appears in the Field box below. 

5 Choose a field to view. A graphic chart appears in the Chart box, providing rate and 
time information. The key at the bottom of the Chart box defines the data points 
mapped in the chart.

6 If you need to choose a different data point for analysis, click Reset Data.

User Interface Options Path

From the System-level page Click System (left panel) > 
Containers tab (right panel).

From the location in which the 
container exists

Click System (left panel) > Location 
(left panel) > Containers tab (right 
panel).

From the host on which the container 
exists

Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Containers tab (right panel).

From the Container page Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Container (left panel). 
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Running Diagnostics on a Container
You can run certain diagnostics on a local or remote container. Currently, the Edit a File 
diagnostic action only is available:

To run diagnostics on a container:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 To open the Container Diagnostics wizard:

 From the Container tab, click  in the Action column. 

 From the Connectors tab, click  at the top of the page.

4 Follow the steps in the wizard:

a Select the action you want to take on the selected container:

 Select Edit a configuration file to edit a file in the user/agent folder on 
the container with the extension .properties, .csv or .conf.

 Select Edit a user file to edit any file (except binary files, such as .zip, 
.jar, or .exe) in the user/agent folder on the container.

b From the list of available files, select the file you want to edit. The file displays in 
the Edit File panel. Make your edits, then click Next to save your edits and restart 
the container.

c Click Done to close the Diagnostics wizard.

User Interface Options Path

From the System-level page Click System (left panel) > Containers 
tab (right panel).

From the location in which the 
container exists

Click System (left panel) > Location (left 
panel) > Containers tab (right panel).

From the host on which the 
container exists

Click System (left panel) > Location (left 
panel) > Host (left panel) > Containers 
tab (right panel).

From the Container page Click System (left panel) > Location (left 
panel) > Host (left panel) > Container (left 
panel). The Connectors tab displays.

On Mozilla Firefox, if the text is underlined with red lines, right click 
on the text area and uncheck Check Spelling.

When you click Next, Connector Appliance saves the updated file 
in the user/agent folder on the container; the original file is 
overwritten.
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Connectors
A connector (also known as a SmartConnector) is an ArcSight software component that 
collects events and logs from various sources on your network. A connector can be 
configured on a Logger appliance running Connector Manager, on a Connector Appliance, 
or can be installed on a computer on your network and managed remotely. For a complete 
list of supported connectors, go to the ArcSight Customer Support site.

You can perform many operations on connectors. You can view all the connectors you are 
managing and add, remove, and edit a connector. You can update connector and table 
parameters, add and remove connector destinations, and edit destination parameters and 
runtime parameters. You can send a command to a connector or a destination, and run the 
Logfu utility. All these procedures are described below.

Viewing all Connectors
You can see all the connectors you are managing.

To view all connectors:

1 Click Configuration > Manage Connectors.

2 Click System in the left panel. The connectors display on the Connectors tab in the 
right panel.

Adding a Connector
Before you add a connector, review the following important information.

 Make sure that the container, host, and location to which you want to add the 
connector exist on the system. If any of these elements do not exist, first create them 
using procedures described in “Adding a Location” on page 416, “Adding a Host” on 
page 420, and “Adding a Container” on page 427.

 Follow the configuration best practices described in “Configuration Suggestions for 
Connector Types” on page 478.

If you are configuring the Check Point OPSEC NG Connector, see “Configuring the 
Check Point OPSEC NG Connector” on page 479 and refer to the SmartConnector 
Configuration Guide for Check Point OPSEC NG.

If you are configuring a database connector that requires the MS SQL Server Driver for 
JDBC, follow instructions in “Adding the MS SQL Server JDBC Driver” on page 482.

 If you are adding a software-based connector, make sure that the username and 
password for the connector match the username and password for the container to 
which you are adding the connector. Refer to “Changing Container Credentials” on 
page 429.

Whenever applicable, the above listed operations can be performed on more 
than one connector at a time. Each procedure described in this section 
indicates if multiple connectors can be selected when performing a 
procedure. 

This connector type has special requirements concerning JDBC and 
authentication setup. It is important that you refer to the 
SmartConnector Configuration Guide for Microsoft SQL Server Multiple 
Instance Audit DB for this important information before installing the 
connector. 
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 File-based connectors use the Network File System (NFS) or the Common Internet File 
System (CIFS). 

For the file-based connectors on a Windows system, a CIFS share needs to be 
configured before you add those connectors. For information on creating a CIFS 
Mount, see “Remote File Systems” on page 365.

For all other connectors, an NFS Mount needs to be established before the connector 
can be added. For information on creating an NFS Mount, see “Remote File Systems” 
on page 365.

 For file-based FlexConnectors, make sure that an NFS Mount is established and a 
repository is created on the system before you add the connector. In addition, when 
entering the connector parameters, type the configuration file name without an 
extension in the Configuration File field. The extension 
.sdkrfilereader.properties is appended automatically.

To add a Connector:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Click  in the Action column of the container to run the wizard to configure a 
connector. 

If you are on the specific Container page,  is at the top of the page.

4 Select a connector type from the pull-down list of available types. Click Next.

If you are adding a connector for the Check Point FW-1/VPN-1 system, see a 
more detailed procedure in “Configuring the Check Point OPSEC NG 
Connector” on page 479.

User Interface Options Path

From the System-level page Click System (left panel) > 
Containers tab (right panel).

From the location in which the 
container exists

Click System (left panel) > Location 
(left panel) > Containers tab (right 
panel).

From the host on which the container 
exists

Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Containers tab (right panel).

From the Container page Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Container (left panel).
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5 Enter basic parameters for the connector. Parameters vary based on the connector 
type. You can hover the mouse pointer over a field for more information. When all 
fields have been entered, click Next.

For file-based connectors on Windows systems, specify the name of the CIFS mount 
point you created for the connector, as shown in the following example. (You need to 
specify /opt/mnt/CIFS_share_name.)

Some connectors include table parameters. For example, the Microsoft Windows Event 
Log includes parameters for each host in the domain and one or more log types 
(security, application, system, directory service, DNS, file replication, and so on). You 
can import table parameters from a CSV file. See “Adding Locations and Hosts from a 
File” on page 417 for the file format. You can import a CSV file that was exported from 
another connector as long as you export and import the CSV file from the same 
container. If the CSV file was exported from a different container, you need to change 
the secret parameters, such as the password, which appear in obfuscated format in 
the CSV file to plain text before you import the CSV file.  

When entering parameters that include a file path, enter the path in 
POSTIX format (for example, /folder/filename). If you enter the path 
in DOS/NTFS format (for example, \folder\filename), the backslash 
(\) is included as part of the file name and the path will be incorrect.

For connectors that query Microsoft Active Directory to detect devices 
(for example, Microsoft Windows Event Log - Unified), if the “Network 
Security: LDAP Server Signing Requirements” policy is set to “Signing 
Required” on the Domain Controller, Connector Appliance will be unable 
to connect to the Active Directory or browse for devices. You see an error 
when selecting Windows Host Browser as the connector device 
browser type.

For detailed information about individual connector parameters, refer to 
the specific ArcSight SmartConnector Configuration Guide for the type of 
connector chosen. The configuration guide also describes how to set up 
the source device for use with the connector.
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6 Choose a primary destination for the connector and enter destination-specific 
parameters on the following page(s), then click Next. Destinations can be:

 ArcSight Logger SmartMessage (encrypted)

 ArcSight Manager (encrypted)

 CEF Syslog (cleartext, that is, unencrypted)

7 Enter connector details:

8 Click Done.

For containers running v5.1.2.5823 and later, Connector Appliance 
retrieves the certificate for the destination automatically and displays 
the certificate summary. To see certificate details, hover your mouse 
over the certificate.

• Select Import the certificate to the connector from the 
destination, then click Next to import the certificate and continue.

• Select Do not import the certificate to the connector from the 
destination and click Next if you do not want to import the 
certificate. The destination will not be added.

For containers running v5.1.2 and earlier, upload the certificate on the 
container and then add the destination.

Note: FIPS Suite B mode is not supported. Connector Appliance cannot 
download a manager certificate in Suite B mode.

Parameter Description

Name A descriptive name for this connector.

Location The location of the connector (such as the hostname).

Device Location The location of the device that sends events to the connector.

Comment Additional comments.

Configuring a connector can take some time; the connector might 
initially display Down while it is restarting.
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Editing Connector Parameters
ArcSight supports a large number of connector types to gather security events from a 
variety of sources, including syslog, log files, relational databases, and proprietary devices. 
Accordingly, configuration parameters vary widely depending on the type of connector 
being configured.

You can edit parameters (simple and table) for a specific connector or for multiple 
connectors at the same time. 

Updating Simple Parameters for a Specific Connector
The following procedure describes how to update simple parameters for a specific 
connector. To update table parameters for a specific connector, see “Updating Table 
Parameters for a Specific Connector” on page 450. To update both simple and table 
parameters for multiple connectors at the same time, see “Updating Simple and Table 
Parameters for Multiple Connectors” on page 451.

To update parameters for a specific connector:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

User Interface Options Path

From the System-level page Click System (left panel) > Connectors 
tab (right panel) > Name of the Connector 
(right panel).

From the location in which the 
connector exists

Click System (left panel) > Location (left 
panel) > Connectors tab (right panel) > 
Name of the Connector (right panel).

From the host on which the 
connector exists

Click System (left panel) > Location (left 
panel) > Host (left panel) > Connectors 
tab (right panel) > Name of the Connector 
(right panel).

From the Connector page Click System (left panel) > Location (left 
panel) > Host (left panel) > Container > 
Name of the Connector (left panel).
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3 Click ( ) next to the Connector Parameters link. 

4 Modify parameters as necessary and click Next. 

5 Click Done when complete. 

The updated parameters display in the Connector Parameters section of the Connector 
page.

Clicking the heading Connector Parameters toggles between displaying 
and hiding the information in the Connector Parameters section.

• Configuration parameters depend on the type of connector being 
configured.

• When editing parameters that include a file path, enter the path in 
POSTIX format (for example, /folder/filename). If you enter the 
path in DOS/NTFS format (for example, \folder\filename), the 
backslash (\) is included as part of the file name and the path will be 
incorrect.
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Updating Table Parameters for a Specific Connector
Certain connectors, such as the Microsoft Windows Event connector, have table 
parameters. You can update the table parameters for a specific connector when necessary.

To update table parameters for a specific connector:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Click ( ) next to the Table Parameters link.

4 Modify parameters as necessary and then click Next.

 To add more rows of parameter information, click the Add Row link.

 You can use an Excel-compatible program to prepare a comma-separated values 
text file with the information and click the Import File button to load the entire 
table at once. The file needs to be in the same format as the rows shown on the 
Update Table Parameters page and needs to include a header row with parameter 

User Interface Options Path

From the System-level page Click System (left panel) > 
Connectors tab (right panel) > Name 
of the Connector (right panel).

From the location in which the 
connector exists

Click System (left panel) > Location 
(left panel) > Connectors tab (right 
panel) > Name of the Connector (right 
panel).

From the host on which the connector 
exists

Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Connectors tab (right panel) > Name 
of the Connector (right panel).

From the Connector page Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Container > Name of the Connector 
(left panel).

Clicking the heading Table Parameters toggles between displaying and 
hiding the information in the Table Parameters section.
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labels in the order shown on that page. For fields that require checkbox values, 
enter True or False as the value. An example is shown below.

 To export the table parameters to a CSV file for use as a backup or to import on 
another Connector Appliance, click the Export File button.

5 Click Done when complete.

The updated table parameters display in the Table Parameters section of the 
Connector page.

Updating Simple and Table Parameters for Multiple Connectors
If you have multiple connectors of the same type, you can change the simple and table 
parameters for all the connectors at the same time. 

To edit parameters for multiple connectors at once:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Select the connectors whose parameters you want to update.

4 Click Parameters.

5 Follow the instructions in the wizard. 

You can import a CSV file that was exported from another connector 
as long as you export and import the CSV file from the same 
container. If the CSV file was exported from a different container, you 
need to change the secret parameters, such as the password, which 
appear in obfuscated format in the CSV file to plain text before you 
import the CSV file.

User Interface Options Path

From the System-level page Click System (left panel) > Connectors tab 
(right panel).

From the location in which the 
connector exists

Click System (left panel) > Location (left 
panel) > Connectors tab (right panel).

From the host on which the 
connector exists

Click System (left panel) > Location (left 
panel) > Host (left panel) > Connectors tab 
(right panel).

From the Connectors page Click System (left panel) > Location (left 
panel) > Host (left panel) > Container (left 
panel).

The connectors must be the same type; for example, you can change the 
parameters for several syslog connectors at the same time; however, 
you cannot change the parameters for several syslog and several SNMP 
connectors at the same time.
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 You can choose to modify the simple parameters for all the selected connectors at 
once or modify the simple parameters per connector. 

 If the connectors have table parameters, the table parameters are displayed so 
that you can modify them. If you have many table parameters to modify for 
multiple connectors, you can import the parameters from a CSV file (for 
information about adding rows and CSV file format, see Step 3 on page 450). You 
can also export the table parameters to a CSV file for use as a backup or to import 
on another Connector Appliance.

Managing Destinations
Connectors can forward events to more than one destination, such as ArcSight ESM 
Manager and ArcSight Logger. You can assign one or more destinations per connector. You 
can assign multiple destinations to a connector and specify a failover (alternate) 
destination in the event that the primary destination fails.

The following procedures describe how to perform these actions on a specific connector or 
for multiple connectors at the same time:

 Add a primary or failover destination

 Edit destination parameters and destination runtime parameters

 Remove destinations

 Re-register destinations

 Manage alternate configurations for a destination

 Send a command to a destination

Adding a Primary Destination to a Specific Connector
When you add a primary destination to a connector, you need to enter details for the 
destination, such as the destination hostname and port used.

To add a primary destination to a connector:

1 Click Configuration > Manage Connectors.

When you update parameters for connectors that are of different 
versions, the newer connectors might have additional parameters. In 
this case, only the parameters that are the same for all connectors are 
displayed for updating.

• You cannot configure two connectors with the same ESM Manager 
destination if the destination (connector) name and location used for 
configuration is the same.

• Logger receivers do not support encrypted data.

• You cannot use the Edit button ( ) to change or add a connector 
destination. Its purpose is to change destination parameters. To add a 

new destination, remove the unwanted destination configuration ( ) 

and create a new one ( ).
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2 Use one of these navigation paths:

3 Click ( ) next to the Destinations link.  

4 Follow the steps in the wizard.

User Interface Options Path

From the System-level page Click System (left panel) > Connectors 
tab (right panel) > Name of the Connector 
(right panel).

From the location in which the 
connector exists

Click System (left panel) > Location (left 
panel) > Connectors tab (right panel) > 
Name of the Connector (right panel).

From the host on which the 
connector exists

Click System (left panel) > Location (left 
panel) > Host (left panel) > Connectors 
tab (right panel) > Name of the Connector 
(right panel).

From the Connector page Click System (left panel) > Location (left 
panel) > Host (left panel) > Container > 
Name of the Connector (left panel).

Clicking the Destinations heading toggles between displaying and hiding 
the information in the Destinations section.
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You can either select an existing destination or add a new destination. If you are 
adding a new destination, select the destination type and enter parameters for the 
destination.

5 Click Done when complete.

For containers running v5.1.2.5823 and later, Connector Appliance 
retrieves the certificate for the destination automatically and displays 
the certificate summary. To see certificate details, hover your mouse 
over the certificate.

• Select Import the certificate to the connector from the 
destination, then click Next to import the certificate and continue.

• Select Do not import the certificate to the connector from the 
destination and click Next if you do not want to import the 
certificate. The destination will not be added.

For containers running v5.1.2 and earlier, upload the certificate on the 
container and then add the destination.

Note: FIPS Suite B mode is not supported. Connector Appliance cannot 
download a manager certificate in Suite B mode.
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Adding a Failover Destination to a Specific Connector
Each destination can have a failover destination that is used if the connection with the 
primary destination fails.  

To add a failover destination:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Click ( ) in the Destinations section to display the Add Connector Destination 
wizard. 

4 Follow the steps in the wizard to select from available destinations and enter the 
destination details.

UDP connections cannot detect transmission failure; use Raw TCP for CEF 
Syslog destinations.

User Interface Options Path

From the System-level page Click System (left panel) > Connectors 
tab (right panel) > Name of the Connector 
(right panel).

From the location in which the 
connector exists

Click System (left panel) > Location (left 
panel) > Connectors tab (right panel) > 
Name of the Connector (right panel).

From the host on which the 
connector exists

Click System (left panel) > Location (left 
panel) > Host (left panel) > Connectors 
tab (right panel) > Name of the Connector 
(right panel).

From the Connector page Click System (left panel) > Location (left 
panel) > Host (left panel) > Container > 
Name of the Connector (left panel).

For containers running v5.1.2.5823 and later, Connector Appliance 
retrieves the certificate for the destination automatically and displays 
the certificate summary. To see certificate details, hover your mouse 
over the certificate.

• Select Import the certificate to the connector from the 
destination, then click Next to import the certificate and continue.

• Select Do not import the certificate to the connector from the 
destination and click Next if you do not want to import the 
certificate. The destination will not be added.

For containers running v5.1.2 and earlier, upload the certificate on the 
container and then add the destination.

Note: FIPS Suite B mode is not supported. Connector Appliance cannot 
download a manager certificate in Suite B mode.
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Adding a Primary or Failover Destination to Multiple Connectors
You can add a primary or failover destination to several connectors at the same time.

To add a primary or failover destination to more than one connector:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Select all connectors to which you want to assign a destination.

4 Click Add Destinations at the bottom of the page to open the wizard.

5 Select Add a destination and click Next.

6 Choose between a creating a new destination or selecting an existing destination, then 
click Next.

If you choose to create a new destination, select the destination type and then 
provide the destination parameters. 

If you choose to select an existing destination, select a destination from the list.

7 Define the destination function by choosing between a primary or failover destination.

If you choose Primary destination, click Next to update the configuration. 

If you choose Failover destination:

a Select the primary destination that applies to your failover. 

b Click the check box in the table header to modify all of the displayed connectors. 

User Interface Options Path

From the System-level page Click System (left panel) > 
Connectors tab (right panel).

From the location in which the 
connector exists

Click System (left panel) > Location 
(left panel) > Connectors tab (right 
panel).

From the host on which the connector 
exists

Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Connectors tab (right panel).

From the Connectors page Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Container (left panel).

Connector Appliance retrieves the certificate for the destination 
automatically and displays the certificate summary. To see certificate 
details, hover your mouse over the certificate.

• Select Import the certificate to the connector from 
destination, then click Next to import the certificate and continue.

• Select Do not import the certificate to the connector from the 
destination and click Next if you do not want to import the 
certificate. The destination will not be added.

Note: FIPS Suite B mode is not supported. Connector Appliance cannot 
download a manager certificate in Suite B mode.
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c Click Next to update the configuration.

8 Click Done when complete.

Removing Destinations
You can remove a destination from a connector at any time. The following procedures 
describe how to remove a single destination from a specific connector and how to remove 
multiple destinations from one or more connector.

To remove a single destination from a specific connector:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 In the Destinations section, click  for the destination you want to remove.

4 When prompted, confirm the removal.

To remove multiple destinations from one or more connector:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

User Interface Options Path

From the System-level page Click System (left panel) > Connectors 
tab (right panel) > Name of the Connector 
(right panel).

From the location in which the 
connector exists

Click System (left panel) > Location (left 
panel) > Connectors tab (right panel) > 
Name of the Connector (right panel).

From the host on which the 
connector exists

Click System (left panel) > Location (left 
panel) > Host (left panel) > Connectors 
tab (right panel) > Name of the Connector 
(right panel).

From the Connector page Click System (left panel) > Location (left 
panel) > Host (left panel) > Container > 
Name of the Connector (left panel).

The  shows in the Destinations table only if more than one destination 
is listed.

User Interface Options Path

From the System-level page Click System (left panel) > Connectors 
tab (right panel).

From the location in which the 
connector exists

Click System (left panel) > Location (left 
panel) > Connectors tab (right panel).

From the host on which the 
connector exists

Click System (left panel) > Location (left 
panel) > Host (left panel) > Connectors 
tab (right panel).
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3 Select the connectors whose destinations you want to remove.

4 Click the Destinations button to open the wizard.

5 Select Remove destinations and click Next. 

6 Follow the instructions in the wizard and click Done when complete.

Re-Registering Destinations
At certain times, you might need to re-register the destinations for one or more connector; 
for example, after you upgrade ESM, or if a Logger appliance or ESM appliance becomes 
unresponsive.

To re-register destinations for one or more connector:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Select the connectors whose destinations you want to re-register.

4 Click the Destinations button to open the wizard.

5 Select Re-register destinations and click Next. 

6 Follow the instructions in the wizard and click Done when complete.

From the Connectors page Click System (left panel) > Location (left 
panel) > Host (left panel) > Container 
(left panel).

User Interface Options Path

From the System-level page Click System (left panel) > 
Connectors tab (right panel).

From the location in which the 
connector exists

Click System (left panel) > Location 
(left panel) > Connectors tab (right 
panel).

From the host on which the connector 
exists

Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Connectors tab (right panel).

From the Connectors page Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Container (left panel).

User Interface Options Path
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Editing Destination Parameters
The following procedures describe how to edit destination parameters for a specific 
connector and how to edit destination parameters for multiple connectors at the same 
time.

To edit destination parameters for a specificconnector:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

You cannot change the connector type; however, you can remove the 
unwanted connector configuration and create a new one.

User Interface Options Path

From the System-level page Click System (left panel) > Connectors 
tab (right panel) > Name of the Connector 
(right panel).

From the location in which the 
connector exists

Click System (left panel) > Location (left 
panel) > Connectors tab (right panel) > 
Name of the Connector (right panel).

From the host on which the 
connector exists

Click System (left panel) > Location (left 
panel) > Host (left panel) > Connectors 
tab (right panel) > Name of the Connector 
(right panel).

From the Connector page Click System (left panel) > Location (left 
panel) > Host (left panel) > Container > 
Name of the Connector (left panel).
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3 In the Destinations section, click ( ) next to the destination you want to edit to 
display the Edit Destination Parameters page.

4 Make your changes and click Next. 

5 Click Done when complete.

To edit destination parameters for multiple connectors: 

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Select the connectors whose destination parameters you want to edit.

4 Click Destinations to open the wizard.

5 Select Edit a destination and click Next. 

6 Follow the instructions in the wizard and click Done when complete.

You cannot use the Edit button ( ) to change or add a connector 
destination. Its purpose is to change destination parameters. To add a 

new destination, remove the unwanted destination ( ) and create a 

new one ( ).

User Interface Options Path

From the System-level page Click System (left panel) > Connectors 
tab (right panel).

From the location in which the 
connector exists

Click System (left panel) > Location (left 
panel) > Connectors tab (right panel).

From the host on which the 
connector exists

Click System (left panel) > Location (left 
panel) > Host (left panel) > Connectors 
tab (right panel).

From the Connectors page Click System (left panel) > Location (left 
panel) > Host (left panel) > Container (left 
panel).
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Editing Destination Runtime Parameters
The runtime parameters for a destination enable you to specify advanced processing 
options such as batching, time correction, and bandwidth control. The parameters you can 
configure are listed in Appendix G‚ Destination Runtime Parameters‚ on page 565. All the 
parameters listed in that table are not available for all destinations. The user interface 
automatically displays the parameters valid for a destination.

The following procedures describe how to edit the runtime parameters for a specific 
connector and how to edit the runtime parameters for multiple connectors at the same 
time.

To edit destination runtime parameters for a specific connector:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 In the Destinations section, click  next to the destination whose runtime 
parameters you want to edit. 

4 Click  next to the alternate configuration that you want to edit.

If you have not set up alternate configurations, click  next to the Default. For more 
information about alternate configurations, see “Managing Alternate Configurations” 
on page 463.

5 Specify or update values for the listed parameters and click Save. 

User Interface Options Path

From the System-level page Click System (left panel) > Connectors 
tab (right panel) > Name of the Connector 
(right panel).

From the location in which the 
connector exists

Click System (left panel) > Location (left 
panel) > Connectors tab (right panel) > 
Name of the Connector (right panel).

From the host on which the 
connector exists

Click System (left panel) > Location (left 
panel) > Host (left panel) > Connectors 
tab (right panel) > Name of the Connector 
(right panel).

From the Connector page Click System (left panel) > Location (left 
panel) > Host (left panel) > Container > 
Name of the Connector (left panel).
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To edit destination runtime parameters for multiple connectors at the same time: 

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Select the connectors whose destination runtime parameters you want to edit.

4 Click Runtime Parameters to open the wizard.

5 Follow these steps in the wizard to edit the runtime parameters:

a Select the destinations whose runtime parameters you want to modify.

b Select the configurations to be affected (default or alternate configurations).

c Select the group of parameters you want to modify (for example, batching, cache, 
network, processing).

d Modify the parameters.

User Interface Options Path

From the System-level page Click System (left panel) > Connectors tab 
(right panel).

From the location in which the 
connector exists

Click System (left panel) > Location (left 
panel) > Connectors tab (right panel).

From the host on which the 
connector exists

Click System (left panel) > Location (left 
panel) > Host (left panel) > Connectors tab 
(right panel).

From the Connectors page Click System (left panel) > Location (left 
panel) > Host (left panel) > Container (left 
panel).
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Managing Alternate Configurations 
An alternate configuration is a set of runtime parameters that is used instead of the default 
configuration during a specified portion of every day. For example, you might want to 
specify different batching schemes (by severity or size) for different times of a day. You can 
define more than one alternate configuration per destination and apply them to the 
destination for different time ranges during the day. For example, you can define a 
configuration for 8 am to 5 pm time range and another configuration for the 5 pm to 8 am 
time range. 

By default, a configuration labeled Default exists and is applied to a destination. Any 
subsequent configurations you define are labeled Alternate#1, Alternate#2, and so on. 
The default configuration is used if the time ranges specified for other alternate 
configurations do not span 24 hours. For example, if you specify an alternate configuration, 
Alternate#1 that is effective from 7 am to 8 pm, the Default configuration will be used 
from 8 pm to 7 am (assuming that there are no other alternate configurations defined on 
this system). 

If you need to apply the same alternate configuration for multiple destinations, you need to 
define an alternate configuration (with the same settings) for each of those destinations.

Defining a New Alternate Configuration
The process of defining a new alternate configuration includes first defining the 
configuration, and then editing it to specify the time range for which that configuration is 
effective. 

To define an alternate configuration:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

User Interface Options Path

From the System-level page Click System (left panel) > 
Connectors tab (right panel) > Name 
of the Connector (right panel).

From the location in which the 
connector exists

Click System (left panel) > Location 
(left panel) > Connectors tab (right 
panel) > Name of the Connector (right 
panel).

From the host on which the connector 
exists

Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Connectors tab (right panel) > Name 
of the Connector (right panel).
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3 Click ( ) in the Destinations section.

4 Click Add.

5 Specify or update values for the listed parameters.

6 Scroll down to the end of the page and click Save. 

If this is the first alternate configuration you defined, it is saved as Alternate#1. 
Subsequent configurations are saved as Alternate#2, Alternate#3, and so on. 

To specify the time range for which the configuration you just defined is effective, edit 
the configuration you just defined using the following procedure Editing an Alternate 
Configuration. 

Editing an Alternate Configuration
In addition to editing an alternate configuration to change parameter values, you can edit it 
to specify the time range for which it is effective.

To edit an alternate configuration:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Click ( ) in the Destinations section.

4 Select the alternate configuration that you want to edit and click ( ).

5 Specify or update values for the listed parameters, including the time range in the 
From Hour/To Hour. 

6 Scroll down to the end of the page and click Save.

From the Connector page Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Container > Name of the Connector 
(left panel).

User Interface Options Path

From the System-level page Click System (left panel) > 
Connectors tab (right panel) > Name 
of the Connector (right panel).

From the location in which the 
connector exists

Click System (left panel) > Location 
(left panel) > Connectors tab (right 
panel) > Name of the Connector (right 
panel).

From the host on which the connector 
exists

Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Connectors tab (right panel) > Name 
of the Connector (right panel).

From the Connector page Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Container > Name of the Connector 
(left panel).

User Interface Options Path
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Specifying a Time Range for an Alternate Configuration
See “Editing an Alternate Configuration” on page 464.

Editing Alternate Configurations in Bulk
If you need to update the same parameters in multiple alternate configurations, follow the 
procedure described in “Editing Destination Runtime Parameters” on page 461. 

Sending a Command to a Destination
You can send a command to a connector destination.

To send a command to a destination on a connector:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Click ( ) in the Destinations section. 

4 Select the command you want to run and click Next.

5 Enter values for the parameters that the user interface displays and click Finish.

User Interface Options Path

From the System-level page Click System (left panel) > 
Connectors tab (right panel) > Name 
of the Connector (right panel).

From the location in which the 
connector exists

Click System (left panel) > Location 
(left panel) > Connectors tab (right 
panel) > Name of the Connector (right 
panel).

From the host on which the connector 
exists

Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Connectors tab (right panel) > Name 
of the Connector (right panel).

From the Connector page Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Container > Name of the Connector 
(left panel).
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Removing a Connector

To remove a Connector:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Select the connectors you want to delete. You can select multiple connectors. 

4 Click Delete at the bottom of the page.

5 Reboot the system.

After removing a connector, you need to reboot the system; otherwise, the 
removed connector continues to forward events to its destination.

User Interface Options Path

From the System-level page Click System (left panel) > 
Connectors tab (right panel).

From the location in which the 
connector exists

Click System (left panel) > Location 
(left panel) > Connectors tab (right 
panel).

From the host on which the connector 
exists

Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Connectors tab (right panel).

You can also delete a specific connector from its details page: Click System 
(left panel) > Location (left panel) > Host (left panel) > Container > 
Connector >  at the top of the page.
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Sending a Command to a Connector
You can send a command to a connector.

To send a command to a connector:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Click  in the Action column for the connector.

If you are on a specific Connector page,  is on top of the page.

4 From the Command Type drop-down list, select the command you want to send to 
the connector.

5 Click Next.

User Interface Options Path

From the System-level page Click System (left panel) > 
Connectors tab (right panel) > Name 
of the Connector (right panel).

From the location in which the 
connector exists

Click System (left panel) > Location 
(left panel) > Connectors tab (right 
panel) > Name of the Connector (right 
panel).

From the host on which the connector 
exists

Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Connectors tab (right panel) > Name 
of the Connector (right panel).

From the Connector page Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Container > Name of the Connector 
(left panel).
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Running Logfu on a Connector
Run Logfu on a connector to parse ArcSight logs and generate an interactive visual 
representation of the information contained within the logs.

To run Logfu on a connector:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Click ( ) on top of the page. A separate window displays.

The system proceeds to retrieve and analyze system data logs. After this process is 
complete, a group of panels appears in the window.

4 From the Group box, choose which type of data you would like to view. The Group 
box lists all connectors within the chosen container, plus many other types of data 
such as memory usage, and transport rates and logs. 

Choose one of the Group box data points. Depending on which data point you 
choose, a list of fields appears in the Field box below. 

5 Choose a field to view. A graphic chart appears in the Chart box, providing rate and 
time information. The key at the bottom of the Chart box defines the data points 
mapped in the chart.

6 If you need to choose a different data point for analysis, click Reset Data.

Changing the Network Interface Address for Events
Connector Appliance has multiple network interfaces. By default, the connector determines 
which network interface address is used for events displayed in the ESM console or Logger, 
but typically uses eth0.

To use a specific network interface address for events, add the parameter 
connector.network.interface.name to the Connector’s agent.properties file. 
For example, to use the IP address for eth1, specify the following parameter:

connector.network.interface.name=eth1

User Interface Options Path

From the System-level page Click System (left panel) > 
Connectors tab (right panel) > Name 
of the Connector (right panel).

From the location in which the 
connector exists

Click System (left panel) > Location 
(left panel) > Connectors tab (right 
panel) > Name of the Connector (right 
panel).

From the host on which the connector 
exists

Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Connectors tab (right panel) > Name 
of the Connector (right panel).

From the Connector page Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Container > Name of the Connector 
(left panel).
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Developing FlexConnectors
FlexConnectors are custom SmartConnectors that can read and parse information from 
third-party devices and map that information to ArcSight’s event schema. 

Connector Appliance provides a FlexConnector Development wizard that lets you quickly 
and easily develop a FlexConnector by creating a parser file, and enables you to test and 
package your new FlexConnector before deploying it. The wizard generates regular 
expressions and provides event field mapping suggestions automatically so you do not 
need to be an expert in regular expression authoring, parser syntax, or ArcSight event 
schema. 

Use the FlexConnector Development wizard to develop FlexConnectors for simple log files. 
For complex log files, use the FlexConnector SDK (available from the ArcSight Customer 
Support site).

To develop a FlexConnector:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths to go to the Containers tab:

3 Click  in the Action column of the container to which you want to add the 
FlexConnector. When the FlexConnector Development wizard opens, click Next.

4 Provide the vendor and product name of the device for which you are creating a 
FlexConnector, then click Next. 

Currently, the FlexConnector Development wizard supports Regex Files, 
Folder Follower, and Syslog (Daemon, File, Pipe) FlexConnectors only.

The FlexConnector Development wizard does not support the extra 
processors property or multiple sub messages. If you need these features, 
use the FlexConnector SDK to create your FlexConnector.

A FlexConnector that you develop with the FlexConnector Development 
wizard might perform more slowly than an ArcSight SmartConnector.

User Interface Options Path

From the System-level page Click System (left panel) > Containers tab 
(right panel).

From the location in which the 
container exists

Click System (left panel) > Location (left 
panel) > Containers tab (right panel).

From the host on which the 
container exists

Click System (left panel) > Location (left 
panel) > Host (left panel) > Containers tab 
(right panel).

The device vendor and product name are required.
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5 Select the data source type, then click Next:

 Select Syslog to create a Syslog FlexConnector to read events from Syslog 
messages.

 Select File to create a FlexConnector to parse variable-format log files using 
regular expressions (ArcSight FlexConnector Regex File) or to parse 
variable-format log files in batch mode (ArcSight FlexConnector Folder Follower).

6 Upload a sample log file for the data source type you selected in the previous step, 
then click Next.

7 The wizard finds the first unparsed line in the log file, generates a regular expression 
to match and extract tokens from that line, and displays the suggested field mappings 
for each extracted token in the Mappings table. 

 To change the regular expression in the Regex box and recalculate the 
mappings, edit the expression and then click the Recalculate button. For 
information about regular expressions, see Appendix B‚ Regular Expressions‚ on 
page 515. You can set the regular expression back to the suggested value by 
clicking the Reset button.

 Field mappings that do not correspond directly to the extracted tokens in the 
unparsed line of the log file are displayed in the Extra Mappings table. You can 
change the Event Field and provide a token operation. To add a new Event Field, 
click Add Row.

You can use extra mappings to:

 Remap an extracted token to a different Event Field in addition to the existing 
mapping. For example, you can add an Event Field with the value $3 where 
$3 is the third token in the list of suggested mappings.

 Map a modified token or combination of tokens to an Event Field. For 
example, you can add an Event Field with the value __operation($1,$3).

The mappings are displayed in descending order of probability (based 
on ArcSight training data). You can change the mappings by selecting 
from the list.

The percentage of parsed lines in the file is shown in the top right of 
the panel. You can use this percentage to estimate where you are in 
the log file. The percentage of unparsed lines skipped in the file is 
also shown in the top right of the panel.
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 Map an Event Field to a constant string or integer. For example, you can add 
an Event Field with the value __stringConstant(constant).

For a list of the token operations used when tokens are mapped to ArcSight event 
fields, refer to the FlexConnector Developer’s Guide (available from the ArcSight 
Customer Support site).

8 Click Next to save the mapping to the parser file and display the next unparsed line in 
the log file.

After all unparsed lines in the log file have corresponding regular expressions and 
mappings, the wizard displays the parser file for review.

9 Review the parser file and make changes, if necessary, directly in the Review Parser 
File panel.

10 Click Next to save and package the parser file.

The wizard always contains an extra mapping for the Event Field 
name, which maps all the words in the input log line. ArcSight 
strongly recommends that you do not simply delete the name 
Event Field but map it in either the Mappings or the Extra Mappings 
table.

Click the Skip Line button to go to the next unparsed line in the log file 
without saving the mapping.

Click the Skip to End button to go to the end of the log file without 
processing any other lines and display the parser file for review.

Click the Previous button to go back to the previous line in the log file 
and make changes if necessary. If you configured any mappings for the 
previous line, the Previous button displays the configured mappings, 
not the default mappings.

In Mozilla Firefox, if certain text in the Review Parser File panel is 
underlined in red, you can disable Spell Check; Right-click in the panel 
and click Check Spelling to remove the check mark.
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11 Choose how you want to deploy the FlexConnector:

 Select Deploy parser to existing connector in container and click Next to 
use the parser file with an existing connector. Click Done to close the 
FlexConnector wizard and redisplay the Container tab.

 Select Add new connector to container and click Next to add the parser as a 
new connector. Follow the steps to add the connector to the container. 

You can share FlexConnectors with other users. See “Sharing Connectors (ArcExchange)” 
on page 473.

Editing FlexConnectors
After you have developed a FlexConnector with the FlexConnector wizard and have 
deployed it in a container, you can edit the FlexConnector to make changes to the parser 
file when needed.

The FlexConnector Edit wizard is available on the Connectors tab in the Action column. 

Click  in the Action column for the FlexConnector to open the wizard. To edit the 
parser file, follow Step 6 through Step 11 in “Developing FlexConnectors” on page 469.

The Deploy parser to existing connector in container option 
displays only if the container already contains a connector of the 
same type.

After deploying your FlexConnector, you can edit it any time from the 
Connectors tab. See “Editing FlexConnectors” on page 472.

Only edit a FlexConnector that is created with the FlexConnector wizard. 
Editing manually-created FlexConnectors might produce unpredictable 
results.

In addition to the FlexConnector Edit wizard, you can also use the Edit a File 
action in the Container Diagnostics wizard to edit your FlexConnector. Refer 
to “Running Diagnostics on a Container” on page 443.
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Sharing Connectors (ArcExchange)
You can share FlexConnectors and parser overrides with other users.

A FlexConnector is a custom connector that you define to gather security events from log 
files, databases, and other software and devices. You can share the following 
FlexConnector types:

 Syslog FlexConnectors (to read events from syslog messages)

 Log File FlexConnectors (to read fixed-format log files)

 Regular Expression Log File FlexConnectors (to read variable-format log files)

 Regular Expression Folder Follower FlexConnectors (to read variable-format log files 
recursively in a folder)

 Regular Expression Multiple Folder Follower FlexConnectors (to read events in real 
time or batch mode from multiple folders)

 XML FlexConnectors (to read events recursively from XML-based files in a folder)

A parser override is a file provided by ArcSight used to resolve an issue with the parser for 
a specific connector, or to support a newer version of a supported device where the log file 
format changed slightly or new event types were added. You can share parser overrides for 
all connector types that use a parser.

To share a FlexConnector or parser override, you need to package and upload it to 
ArcExchange on the ArcSight online community (Protect 724) or to your local machine. You 
can also download a FlexConnector or parser override that you need from ArcExchange or 
from your local machine and add it to a container.

Packaging and Uploading Connectors
Before uploading your FlexConnector or parser override to Protect 724 or to your local 
computer, you need to package it into a zip file, (called an AUP package) using the upload 
wizard.

A FlexConnector AUP package contains the connector properties file, categorization file, 
connector parameters, and a manifest file with all the metadata on the package required 
for successful deployment. Metadata includes information about the AUP package, such as 
the package type, connector type, connector description, and so on. You can create only 
one AUP package per connector per device type. You can package a FlexConnector in Basic 
or Advanced mode. In Basic mode:

 The wizard packages the FlexConnector properties file automatically. If the wizard 
finds more than one properties file, you are prompted to select the file you want to 
package. 

 The wizard packages the categorization file automatically only if it can be determined 
based on the device vendor and product information found in the properties file. 

 The wizard does not package connector parameters. You are prompted to configure 
the connector when it is downloaded and deployed.
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In Advanced mode: 

 The wizard packages the FlexConnector properties file automatically. If the wizard 
finds more than one properties file, you are prompted to select the file you want to 
package. (This is same as Basic mode.) 

 The wizard packages the categorization file automatically if it can be determined based 
on the device vendor and product information found in the properties file. If the 
categorization file cannot be determined, you are prompted to select the 
categorization file you want to package from the list of files found in the container. 

 The wizard displays connector parameters so you can configure the parameters you 
want to display and set the default values you want to provide during connector 
deployment (download). The parameters you do not configure for display are 
preconfigured with the current values and will not be displayed during connector 
deployment.

A parser override package contains the parser override properties file and the manifest file 
only.

Follow the steps below to package and upload a FlexConnector or parser override.

To package and upload a FlexConnector or parser override:

1 Click Configuration > Manage Connectors.

2 Use one of these navigation paths:

3 Click  at the top of the Connector page to open the upload wizard. (From the 

Connectors page, select the connector in the right panel and click  in the Action 
column.)

• To upload to ArcExchange, you must have a valid username and 
password for Protect 724.

• Make sure that you have configured Connector Appliance network 
settings under Setup > System Admin > Network and that the appliance 
can communicate with the Protect 724 server.

User Interface Options Path

From the System-level page Click System (left panel) > 
Connectors tab (right panel) > Name 
of the Connector (right panel).

From the location in which the 
connector exists

Click System (left panel) > Location 
(left panel) > Connectors tab (right 
panel) > Name of the Connector (right 
panel).

From the host on which the connector 
exists

Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Connectors tab (right panel) > Name 
of the Connector (right panel).

From the Connector page Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Container > Name of the Connector 
(left panel).
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4 Click Next and follow the steps in the wizard to:

a Select the type of AUP package you want to create for the selected connector.

Connector Appliance scans the container and displays the relevant files that can 
be packaged. 

b For a FlexConnector, select Basic to create a default package or select Advanced 
to customize the package to meet your needs. For a description of Basic and 
Advanced mode, refer to “Packaging and Uploading Connectors” on page 473.

c If the connector contains several properties files, you are prompted to select the 
properties file you want to package. Certain connectors, for example, syslog 
connectors, can have more than one parser override folder, in this case, you are 
prompted to select the folder you want to package.

d If you selected Advanced mode for a FlexConnector in Step b and the 
categorization file cannot be determined, you are prompted to select the 
categorization file you want to package from a list of files found in the container.

e If you selected Advanced mode for a FlexConnector in Step b, select the 
configuration parameters you want to display when the connector is deployed and 
then provide default values for these parameters. Parameters you do not select 
are pre-configured with the current values.

If any advanced connector parameters were previously modified from their 
defaults, the wizard displays these parameters so that you can select which ones 
you want to be configured automatically during deployment.

f Provide a description of the AUP package and instructions on how configure the 
device used by the connector.

g Provide the vendor, product, and version of the device used by the connector. 

If the wizard can determine the vendor, product, and version of the device, the 
information is displayed in the fields provided. You can change the information to 
meet your needs.

h Upload the created AUP package to ArcExchange or to your local machine.

Categorization files are not packaged for parser overrides.

Configuration parameters are not displayed for parser overrides.

If the connector has table parameters, they are not displayed 
during packaging. However, when the connector is downloaded to a 
container, you will be prompted to provide values for all the table 
parameters.

To upload the AUP package to ArcExchange, you must have a valid 
username and password for Protect 724.
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Downloading Connectors
You can download a FlexConnector or parser override that is available from ArcExchange 
on Protect 724 or from your local computer. You download a FlexConnector or parser 
override directly to a container.

You can download only one FlexConnector per container using the download wizard. 
However, there is no limit to the number of parser overrides you can download to a 
container.

Follow the steps below to download a FlexConnector or parser override to a container.

To download to ArcExchange, you must have a valid username and password for Protect 
724. Also, make sure that you have configured Connector Appliance network settings under 
Setup > System Admin > Network and that the appliance can communicate with the 
Protect 724 server.

To download a FlexConnector or parser override:

1 Click Configuration > Manage Connectors.

2 Go to the Containers page. Use one of these navigation paths:

3 In the right panel, select the container into which you want to download the 

connector, and then click  in the Action column to open the download wizard. 

• When downloading a parser override to a container, the download 
wizard overwrites any existing parser override with the same name in 
the container without prompting for confirmation. To avoid overwriting 
an existing parser override, send a Get Status command to the 
existing parser override to check the parser information before you 
download a new parser override. For information on sending a Get 
Status command, refer to “Sending a Command to a Connector” on 
page 467.

• ArcSight recommends that you back up the container to the Backup 
Files repository before downloading a connector or parser override so 
you can revert to the previous configuration if the download produces 
unexpected results.

User Interface Options Path

From the System-level page Click System (left panel) > 
Containers tab (right panel).

From the location in which the 
container exists

Click System (left panel) > Location 
(left panel) > Containers tab (right 
panel).

From the host on which the container 
exists

Click System (left panel) > Location 
(left panel) > Host (left panel) > 
Containers tab (right panel).
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4 Click Next and follow the steps in the wizard to:

a Select whether you want to download the connector from ArcExchange on Protect 
724 or from your local computer.

b Select the AUP package you want to download.

On Protect 724, you can search for a parser override or FlexConnector AUP 
package using a keyword or a combination of keywords.

c For a FlexConnector, provide connector configuration parameters, if needed. 

Preconfigured and advanced parameters are deployed automatically with the 
values that were packaged; you are not prompted to configure these parameters. 
The configurable parameters are displayed with suggested defaults, which you 
can modify if necessary. The table parameters are displayed with no configured 
values, you have to provide the values manually, as needed.

d Add or select a destination for the connector.

If you are downloading the connector to a container that has an existing 
connector of the same type, you are not prompted for a destination.

The wizard copies the properties and categorization files to the appropriate locations and 
also installs the zip file for the AUP package in the user/agent/deployedaups folder on 
the Connector Appliance to keep track of the deployment history. 

After a successful download, the container is restarted automatically. 

You can only download a parser override package to a container 
that has a connector of the same type as the package.

You can download only one FlexConnector per container using the 
download wizard. If the container already contains a FlexConnector 
of the same type as the one you want to download, you can replace 
the existing FlexConnector with the one you are downloading, but 
you cannot create a new one.

To use memory efficiently, parser overrides for the Windows Unified 
connector only load when the first event is received.
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Configuration Suggestions for Connector Types
The following table provides configuration suggestions for different types of connectors.

Connector Type Effects of Limited Usage

Syslog connectors Due to the nature of UDP (the transport protocol typically used 
by Syslog), these connectors can potentially lose events if the 
configurable event rate is exceeded. This is because the 
connector delays processing to match the event rate configured, 
and while in this state, the UDP cache might fill and the 
operating system drop UDP messages. 

Note: ArcSight recommends that you do not use the Limit CPU 
Usage option with these connectors because of the possibility 
of event loss.

SNMP connectors Similar to Syslog connectors, when the event rate is limited on 
SNMP connectors, they potentially lose events. SNMP is also 
typically UDP-based and has the same issues as Syslog.

Database 
connectors

Because connectors follow the database tables, limiting the 
event rate for database connectors can slow the operation of 
other connectors. The result can be an event backlog sufficient 
to delay the reporting of alerts by as much as minutes or hours. 
However, no events will be lost, unless the database tables are 
truncated. After the event burst is over, the connector might 
eventually catch up with the database if the event rate does not 
exceed the configured limit.

File connectors Similar to database connectors, file-based connectors follow 
files and limiting their event rates causes an event backlog. This 
can eventually force the connector to fall behind by as much as 
minutes or hours, depending on the actual event rate. The 
connectors might catch up if the event rate does not exceed the 
configured rate.

Asset Scanner 
connectors

All connectors on Connector Appliance run as a service (not as 
an application). Therefore, asset scanner connectors running on 
Connector Appliance are not supported in Interactive mode.

To run the asset scanner connector in Interactive mode, install 
the connector on a standalone system and manage it as a 
software-based connector.

Proprietary API 
connectors

The behavior of these connectors depends on the particular API, 
(for example, OPSEC behaves differently than PostOffice and 
RDEP). But in most cases, there will be no event loss unless the 
internal buffers and queues of the API implementation fill up. 
These connectors work much like database or file connectors.
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Deploying FlexConnectors
FlexConnectors are custom connectors that are user-defined. FlexConnectors can be 
hosted on the system if they are compatible with a Linux platform. Connector Appliance 
ships with several prototype FlexConnectors, including:

 ArcSight FlexConnector File

 ArcSight FlexConnector ID-based Database

 ArcSight FlexConnector Multiple Database

 ArcSight FlexConnector Regular Expression File

 ArcSight FlexConnector Regular Expression Folder File

 ArcSight FlexConnector Simple Network Management Protocol (SNMP)

 ArcSight FlexConnector Time-based Database

 ArcSight FlexConnector XML File

You can create and manage FlexConnectors using repositories. You can share 
FlexConnectors with other Connector Appliance users. Refer to “Sharing Connectors 
(ArcExchange)” on page 473.

For more information, consult the FlexConnector Developer’s Guide, available from ArcSight 
Customer Support.

Configuring the Check Point OPSEC NG Connector
The Check Point FW-1/VPN-1 OPSEC NG connector can operate in clear channel or sslca 

mode.

To configure a connector to operate in sslca mode

On the Check Point SmartDashboard:

1 Create an OPSEC Application Object using the Check Point SmartDashboard. You need 
to provide these parameters when creating the application object. 

• This procedure is supported only for ArcSight connector release 4.6.2 or 
later.

• A hostname is called an Application Object Name on Check Point. A 
password is a Communication Activation Key on Check Point.

Parameter Description

Name A meaningful name for the application object you 
are creating; for example, ArcSightLea-1.

This name is used to pull the OPSEC certificate in 
the system.

Host The hostname of the system managing the 
connector.

Client Entities Select LEA.
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After the object is created, note down the following information, which you will need 
to provide when continuing configuration.

 SIC Name—DN string that you obtain after initializing communication as described 
below.

 SIC Entity Name—Double-click the Check Point Gateway name in the 
SmartDashboard to view its general properties. The SIC Entity Name is the SIC 
string configured in the general properties window.

 Check Point IP address or hostname.

2 Pull the Check Point certificate.

To do so, run the Pull OPSEC Certificate command on the container to which 
you will be adding the connector. For detailed information about running a command 
on a container, see “Running a Command on a Container” on page 439. You need to 
provide this information when running the command:

If the certificate is pulled successfully, a message similar to this is displayed:

OPSEC SIC name (CN=ArcSightLea-1,0=cpfw1..5ad8cn) was retrieved 
and stored in /opt/arcsight/<container 
name>/current/user/agent/checkpoint/<name>. Certificate was 
created successfully and written to "/opt/arcsight/<container 
name>/current/user/agent/checkpoint/ArcSightLea-1.opsec.p12".

Secure Internal 
Communication

If a DN string is not present, initialize the 
communication by providing an activation key. The 
activation key is used when the certificate is 
pulled. This is the SIC Name.

Click Communication > Initialize.

Parameter Description

Server 
hostname or 
IP address

The name or IP address of the Check Point server.

Application 
object name

The OPSEC Application object name you specified in the 
previous step. This parameter is case sensitive.

Password The activation key you entered when creating the OPSEC 
application object in the previous step. 

Parameter Description
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Note down the OPSEC SIC Name (CN=ArcSightLea-1,0=cpfw1..5ad8cn in the 
above example) and the file name (ArcSightLea-1.opsec.p12 in the above 
example).

3 Install Policy on the LEA client for the Check Point Gateway using the SmartDashboard. 

On the Connector Appliance:

4 Add a Check Point connector by following instructions described in “Adding a 
Connector” on page 444. You need to provide the following information.

5 An error similar to the following is displayed.

-1:[X] Unable to connect to the Lea Server[10.0.101.185] -1:1 
connection test failed! 

Click the Ignore warnings check box. Click Next.

6 Continue to configure the rest of the connector. Go to Step 6 in “Adding a Connector” 
on page 444. 

If the certificate is not pulled successfully, check to ensure that the 
Application object name you specified is correct (including the case) and 
the container on which you are running the command is up and 
running.

Parameters Values to input

Type Check Point FW-1/VPN-1 OPSEC NG

Connection 
Type

SSLCA

Connector 
Table 
Parameters

Server IP: The IP address of the Check Point server.

Server Port: The port on the server that listens for SSLCA 
connections. Use the default value 18184.

OPSEC SIC Name: The name you noted in Step 1.

OPSEC SSLCA File: The name you noted after pulling the 
certificate in Step 2.

OPSEC Entity SIC Name: The name you noted in Step 1.
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Adding the MS SQL Server JDBC Driver 
When you install and configure database connectors that use Microsoft SQL Server as the 
database, a JDBC driver is required. This driver does not ship pre-installed on the system; 
you need to install it before configuring database connectors on the appliance.

To install a JDBC Driver:

1 Download the MS SQL Server 2005 JDBC Driver 1.2 to a computer that can access 
Connector Appliance. You can download the driver from Microsoft at:

http://www.microsoft.com/downloads/details.aspx?FamilyId= 
C47053EB-3B64-4794-950D-81E1EC91C1BA&displaylang=en

2 Run the setup program to install the driver.

3 Follow the instructions in “Uploading Files to a Repository” on page 497 to add the 
sqljdbc.jar file.

The new driver file is added to the repository, as shown in the following example.

After you have installed the JDBC driver, you need to upload the driver file to the 
containers that will contain the SQL Server database Connectors. Follow the 
instructions in “Uploading a File from the Repository” on page 499.

After the driver file has been uploaded to a container, follow the instructions in “Adding 
a Connector” on page 444 to add a connector that requires a JDBC driver.
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Chapter 10 

Managing Repositories

The following topics are discussed here.

“Overview” on page 484

“Logs Repository” on page 486

“CA Certs Repository” on page 487

“UpgradeAUP Repository” on page 489

“Content AUP Repository” on page 490

“Remote Management AUP Repository” on page 492

“Emergency Restore” on page 494

“User-Defined Repositories” on page 495 

“Pre-Defined Repositories” on page 500
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Overview
Certain management operations require a specific upgrade or content update (.enc) file, 
or a certificate. Other operations such as viewing the logs require you to load the logs to a 
Log repository. You can also maintain centralized repositories for files needed for connector 
configuration and management. 

Figure 10-1 Repository Functions

By default, a number of pre-defined repositories are provided. However, you can create 
more repositories to suit your needs. The repositories you create are referred to as 
user-defined repositories.

The following specific terms are used for repository functions.

 Retrieve Container Files copies a file from one or more connectors to the 
repository. 

 Upload to Repository sends a file from your local computer (the computer running 
the browser) or a network host accessible from your local computer to the repository. 

 Retrieve  downloads a file from the repository to your local computer network.
484 Administrator’s Guide ArcSight Confidential



10 Managing Repositories
 Upload  copies a file from the repository to one or more connectors.

You can perform these operations using repositories:

 Manage logs in the Logs repository

 Manage CA certificates in the CA Certs repository

 Upgrade a connector using an upgrade file available in the Upgrade repository

 Apply a Content ArcSight Update Pack (AUP) on one or more connector

 Manage remote management configuration AUP files in the Remote Management AUP 
repository

 Restore a container when it is damaged and irrecoverable

 Maintain centralized repositories of files for connector configuration and management
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Logs Repository
When you want to view connector logs, you need to first Load the logs of the container 
that contains the connector to the Logs repository, then Retrieve the logs to view them.

For information on loading, retrieving, and deleting the logs, see “Viewing Container Logs” 
on page 441.

Uploading a File to the Logs Repository
Uploading a file into the Log repository is useful for sharing annotated log or other files 
with other users. The file needs to be in .zip format.

To upload a file:

1 Click Configuration > Repositories.

2 Click Logs from the left panel. 

3 Click Upload from the right panel.

4 Enter the local file path or click Browse to select the file.

5 Click Submit to add the specified file to the repository or Cancel to quit.

If a container contains more than one connector, logs for all connectors are 
retrieved.
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CA Certs Repository
Connectors require a Certificate Authority (CA) issued or self-signed SSL certificate to 
communicate securely with a destination. The CA Certs repository (shown below) enables 
you to store CA Certs files (that contain one or multiple certificates) and single CA 
certificates. When certificates are stored in the CA Certs repository, you can add the 
certificates to a container so that the connectors in the container can validate their 
configured destinations successfully. 

To associate a CA certificate to a connector, you need to:

 Upload the CA certificate or CA Certs file to the CA Certs repository, as described 
below.

 Add a CA certificate from the CA Certs repository to the container that contains the 
connector, as described in “Managing Certificates on a Container” on page 431.

You can add a single certificate to a container that is in FIPS or non-FIPS 
mode. You can only add a CA Certs file to a container that is in non-FIPS 
mode.
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Uploading CA Certificates to the Repository
You can upload a CA Certs file or a single certificate to the CA Certs repository. 

To upload certificates to the repository:

1 Click Configuration > Repositories.

2 Click CA Certs in the left panel.

3 Click Upload in the right panel.

4 Enter the local path for the CA Certs file or the certificate, or click Browse to select it.

5 Click Submit to add the specified CA Certs file or the certificate to the repository, or 
Cancel to quit.

The CA Certs Repositories tab shows all the CA Certs files and single certificates that have 
been uploaded. The Type column shows CERTIFICATE for a single certificate and CACERT 
for a CA Certs file.

Removing CA Certificates from the Repository
You can delete a CA Certs file or a single certificate from the repository. When you delete a 
CA Certs file or a single certificate from the repository, it is deleted from the system.

To remove a certificate from the repository:

1 Click Configuration > Repositories.

2 Click CA Certs in the left panel.

3 Identify the certificate or the CA Certs file you want to remove and click its associated 

Remove button ( ).

Before you upload a single CA certificate, change the name of the certificate 
on the local computer to a name that you can recognize easily. This helps 
you distinguish the certificate when it is displayed in the Certificate 
Management wizard.

When you delete a CA Certs file or a single certificate from the CA Certs 
repository, containers are not affected; the connectors continue to use the 
certificates, which are located in a trust store after being added to a 
container. For information about adding a CA certificate to a container, see 
“Managing Certificates on a Container” on page 431.
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UpgradeAUP Repository
The Upgrade AUP repository enables you to maintain a number of connector AUP 
(upgrade) files. You can apply any of these AUP upgrade files to containers when you need 
to upgrade to a specific version. As a result, all connectors in a container are upgraded to 
the version you apply to the container. 

This repository can also maintain upgrade files for upgrading remotely-managed Connector 
Appliances.

About the AUP Upgrade Process

To upgrade a connector or to upgrade a remotely-managed Connector Appliance, you need 
to:

 Upload the appropriate .aup upgrade file to the Upgrade AUP repository, as described 
below.

 Apply the .aup upgrade file from the Upgrade AUP repository to the container (see 
“Upgrading a Container to a Specific Connector Version” on page 440) or to a remote 
Connector Appliance (see “Upgrading a Host Remotely” on page 424).

Uploading an AUP Upgrade File to the Repository
To upload AUP upgrade files to the repository:

1 Download the upgrade AUP file for the connector or the remote Connector Appliance 
from the ArcSight Customer Support site at http://www.arcsight.com/supportportal to 
the computer that you use to connect to the browser-based interface.

2 From the computer to which you downloaded the upgrade file, log in to the 
browser-based interface.

3 Click Configuration > Repositories from the top-level menu bar.

4 Click UpgradeAUP from the left panel.

5 Click Upload from the right panel.

6 Click Browse and select the file you downloaded earlier.

7 Click Submit to add the specified file to the repository or click Cancel to quit.

8 If you want to apply this upgrade file, follow these instructions:

 For a container upgrade, see “Upgrading a Container to a Specific Connector 
Version” on page 440.

 For a remotely-managed Connector Appliance upgrade, see “Upgrading a Host 
Remotely” on page 424.

The process discussed in this section only applies to upgrading connectors 
and to upgrading a remotely-managed Connector Appliance.
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Removing a Connector Upgrade from the Repository
You can remove a connector upgrade file from the repository when you no longer need it. 
When you remove a connector upgrade file from the repository, it is deleted from the 
system.

To remove a Connector upgrade from the repository:

1 Click Configuration > Repositories from the top-level menu bar.

2 Click UpgradeAUP from the left panel.

3 Locate the upgrade file that you want to delete and click the associated  icon.

Content AUP Repository
ArcSight continuously develops new connector event categorization mappings, often called 
content. This content is packaged in ArcSight Update Packs (AUP) files. All existing content 
is included with major product releases, but it is possible to stay completely current by 
receiving up-to-date, regular content updates through ArcSight announcements and the 
Customer Support site. The AUP files are located under Content Subscription Downloads. 

The ArcSight Content AUP feature enables you to apply an AUP file to applicable connector 
destinations that you are managing. Only the event categorization information can be 
applied to the connectors using this feature.

You can maintain a number of Content AUP files in the Content AUP repository. When an 
AUP file with a version number higher than the ones already in the repository is loaded, it 
is automatically pushed out to the connector destinations being managed. However, these 
connectors or connector destinations are skipped:

 Connectors that are unavailable at the time of the AUP file push

 Connectors whose current version does not fall in the range of versions that the 
Content AUP supports

 The ESM destination on a connector

 All destinations of a connector that have an ESM destination with the AUP Master flag 
set to Yes 

Also, when a new connector is added, the highest number Content AUP is pushed 
automatically to its destinations.
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Applying a New Content AUP
You can add a new content AUP file to the repository and push it automatically to all 
applicable connectors

To apply a new Content AUP:

1 Download the new Content AUP version from ArcSight Customer Support site at 
http://www.arcsight.com/supportportal to the computer that you use to connect to the 
browser-based interface.

2 From the computer to which you downloaded the AUP file, log in to the browser-based 
interface.

3 Click Configuration > Repositories from the top-level menu bar.

4 Click Content AUP from the left panel.

5 Click Upload from the right panel.

6 Click Browse and select the file you downloaded earlier.

7 Click Submit to add the specified file to the repository and push it automatically to all 
applicable connectors, or Cancel to quit.

You can verify the current Content AUP version on a connector by performing either of 
these steps:

 Run the GetStatus command on the connector destination and check that the value 
for aup[acp].version is the same as the AUP version you applied. For information 
about running a command on a connector destination, see “Sending a Command to a 
Destination” on page 465.

 Hover your mouse over a connector name to see the AUP version applied to all 
destinations of that connector.

Applying an Older Content AUP 
If you need to apply an older Content AUP from the Content AUP repository, delete all 
versions newer than the one you want to apply in the repository. The latest version (of the 
remaining AUP files) is pushed automatically to all applicable connectors.

To delete a Content AUP from the Content AUP repository:

1 Click Configuration > Repositories from the top-level menu bar.

2 Click Content AUP from the left panel.
ArcSight Confidential Administrator’s Guide 491



10 Managing Repositories
3 Locate the AUP file that you want to delete and click the associated  icon. Repeat 
for multiple files.

Remote Management AUP Repository
The Remote Management AUP repository stores AUP files that contain the remote 
management configuration of an appliance (a snapshot of all the remote software 
connectors and remote Connector Appliances that the appliance manages). 

From the Remote Management AUP repository, you can:

 Download a Remote Management AUP file to your local computer (or network host 
accessible from the local computer) so that you can import the remote management 
configuration on another appliance.

 Upload Remote Management AUP files from your local computer (or network host 
accessible from the local computer) to the repository for storage.

 Delete Remote Management AUP files you no longer need.

The following example shows the Remote Management AUP repository.

Downloading Remote Management AUP Files
After you export the remote management configuration of a Connector Appliance, you can 
download the AUP file that contains the configuration to your local computer (or network 
host accessible from the local computer) so that it can be imported on another appliance.

For information on exporting and importing the remote management configuration of an 
appliance, refer to “Exporting and Importing Remote Management Configuration” on 
page 416.

To download a Remote Management AUP file to your local computer:

1 Click Configuration > Repositories from the top-level menu bar.

2 Click Remote Management AUP from the left panel.

3 Locate the AUP file in the table and click  next to the file to download it to your 

local computer.
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Uploading Remote Management AUP Files
You can upload remote management AUP files to the Remote Management AUP repository 
for storage.

To upload a Remote Management AUP file to the repository:

1 Click Configuration > Repositories from the top-level menu bar.

2 Click Remote Management AUP from the left panel.

3 Click the Upload button at the top of the page.

4 Click Browse and select the file you want to upload from the local computer (or 
network host accessible from the local computer).

5 Click Submit to add the specified file to the repository.

Deleting Remote Management AUP Files
When a remote management AUP file is no longer up-to-date or needed, you can remove it 
from the repository.

To delete a Remote Management AUP file:

1 Click Configuration > Repositories from the top-level menu bar.

2 Click Remote Management AUP from the left panel.

3 Locate the AUP file that you want to delete and click the associated  icon. Repeat 
for multiple files.
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Emergency Restore
The Container Restore wizard guides you through the process of restoring a modified 
container. This feature is supported only for connectors and containers on the local host.

To restore a container:

1 Click Configuration > Repositories from the top-level menu bar.

2 Click Emergency Restore from the left panel.

3 Follow the instructions in the Container Restore wizard.

4 Re-import the SSL certificate for the container. On the Manage tab, click the container 

name in the left panel. On the Connectors tab in the right panel, click the  icon to 

run the Certificate Download wizard and import the valid certificate.

ArcSight recommends that you use this process only when a container is 
severely damaged and is no longer available. The Emergency Restore process 
deletes all information about that container and renders it empty. The 
connector is restored to the AUP version that you select.
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User-Defined Repositories
A user-defined repository is a user-named collection of settings that control upload and 
download of particular files from connectors to the repository. Each repository uses a 
specified path, relative to $ARCSIGHT_HOME/user/agent, for files to be uploaded or for 
locations to download files. ArcSight connectors use a standard directory structure, so map 
files, for example, are always found in $ARCSIGHT_HOME/user/agent, (that is, the root 
directory, $ARCSIGHT_HOME, of the connector installation) in a folder called map/.

After they are created, user-defined repositories are listed on the left-side menu, under the 
New Repository heading, and appear with the user-specified display name.

User-defined repositories are expected to be grouped by file type and purpose, such as log 
files, certificate files, or map files. Each user-defined repository has a name, a display 
name, and an item display name, which are defined under the Settings tab that appears 
for user- or pre-defined repositories (for details about pre-defined repositories, see 
“Pre-Defined Repositories” on page 500).

Files viewed in the user-defined repository can be bulk processed with specified connectors 
and can be exchanged with the user’s browser host.

Creating a User-Defined Repository
You can create a new repository at any time.

To create a new user-defined repository:

1 Click Configuration > Repositories from the top-level menu bar.

2 Click New Repository under the Repositories section in the left panel.

3 For the new repository, enter the parameters listed in the following table.

The repository requires correct directory paths. Your file will be applied to 
the wrong directory if the entered path contains errors, such as extra 
spaces or incorrect spellings. You can verify your directory paths by 
accessing the Directory.txt file, which lists the directory structure for 
every entered path. View the Directory.txt file by accessing your 
container logs and finding the Directory.txt file.

Parameter Description

Name A unique name for the repository, typically based on the 
type of files it contains.

Display Name The name that will be displayed on the left-side menu and 
for tabs: Process names, View names, Settings for names. 
Typically plural.

Item Display Name The name used to describe a single item.

Recursive Check to include sub-folders.

Sort Priority -1 by default

Restart Connector 
Process

Check to restart the connector process after file operations.
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4 Click Save at the bottom of the page. 

The new repository displays under the New Repository heading in the left-side 
window panel.

Filename Prefix An identifying word that is included in the names of 
retrieved files. For example, map files are identified by Map 
in the file name: 
localhost_Container_-1.Map-2009-04-06_12-22-25-607
.zip

Relative path 
(Download)

The path for download, relative to $ARCSIGHT_HOME, for 
example, user/agent/map or user/agent/flexagent. 
Leave this field blank to specify files in $ARCSIGHT_HOME.

Note: The relative path is used for download only.

Include Regular 
Expression

A description of filenames to include. Use .* to specify all 
files. The following example selects properties files that 
consist of map. followed by one or more digits, followed by 
.properties:

map\.[0-9]+\.properties$

Exclude Regular 
Expression

A description of filenames to exclude. The following 
example excludes all files with a certain prefix or in the 
agentdata folder.

(agentdata/|cwsapi_fileset_).*$

Delete Before Upload Check to delete earlier copies before upload.

CAUTION: If you check Delete Before Upload and do not 
specify a Relative path (Upload), all files and folders in 
current/user/agent will be deleted.

Delete Groups Whether to delete folders recursively in 
$ARCSIGHT_HOME/user/agent/map directory.

Relative path (Upload) The path for upload, relative to 
$ARCSIGHT_HOME/current/user/agent/flexagent/
<connectorname>

Delete Relative Path Whether the directory specified in Relative Path (Upload) 
and its contents should be removed when a file is uploaded 
from the repository.

Delete Include Regular 
Expression

Typically the same as the Include Regular Expression.

Delete Exclude Regular 
Expression

Typically the same as the Exclude Regular Expression.

Parameter Description
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Retrieving Container Files
The Retrieve Container Files button copies a file from one or more connectors to a 
repository. The specific files that are retrieved depend on the settings of a repository.   

To retrieve a container file:

1 Click Configuration > Repositories from the top-level menu bar.

2 In the left panel, click the name of the repository to which you want to copy connector 
files.

3 Click Retrieve Container Files in the right panel.

4 Follow the instructions in the Retrieve Container Files wizard. 

Uploading Files to a Repository
The upload process copies files from your local computer to a repository.

To upload files to a repository:

1 Click Configuration > Repositories from the top-level menu bar.

2 In the left panel, click the name of the repository to which you want to upload files.

3 Click Upload To Repository from the right panel.

4 Follow the instructions in the Repository File Creation wizard.

Although you can select Repository zip file in the Select the type of file that you 
want to upload page of the Repository File Creation wizard, ArcSight recommends 
that you select Individual files to create a zip file with appropriate path information.

Be sure not to change the default sub-folder name lib in the Enter the sub folder 
where the files will be uploaded page of the Repository File Creation wizard.

Deleting a Repository
You can delete user-defined repositories only. 

To delete a repository:

1 Click Configuration > Repositories from the top-level menu bar.

2 From the left panel, click the name of the repository you want to delete.

3 Click Remove Repository from the right panel.
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Updating Repository Settings
The Settings tab displays the settings associated with the current repository. An example is 
shown below. Most settings for pre-defined repositories are read-only; however, you can 
update settings for user-defined repositories.

To update settings of a repository:

1 Click Configuration > Repositories from the top-level menu bar.

2 In the left panel, click the name of the repository whose settings you want to update.

3 Click the Settings for Repository_Name tab from the right panel.

4 Update the settings.

5 Click Save at the bottom of the page.
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Managing Files in a Repository
You can retrieve files in a repository (download files to your local computer network), 

upload files to a repository, or remove files from a repository. 

Retrieving a File from the Repository

To retrieve a file from the repository:

1 Click Configuration > Repositories from the top-level menu bar.

2 From the left panel, click the name of the repository in which the file exists.

3 Click  from the right panel for the file that you want to retrieve.

4 Follow the file download instructions to copy the file to your local computer.

Uploading a File from the Repository

To upload a file from the repository:

1 Click Configuration > Repositories from the top-level menu bar. 

2 In the left panel, click the name of the repository in which the file exists.

3 In the right panel, click  next for the file that you want to upload.

4 Follow the Upload Container Files wizard instructions to upload the file to the 
containers of your choice. 

5 Verify that the file was uploaded correctly:

 If you have SSH access to the connectors, connect to them and check the file 
structure.

 Obtain the connector logs and check the contents of the Directory.txt file for 
each connector.

Removing a File from the Repository

To remove a file from the repository: 

1 Click Configuration > Repositories from the top-level menu bar. 

2 In the left panel, click the name of the repository in which the file exists.

3 In the right panel, click  for the file that you want to delete.

Connectors require correct properties and proper files. Applying incorrect files, 
including empty files or files with binary content, can prevent a connector 
from functioning correctly.

It is possible to upload files with incorrect content, such as an empty .map 
file. The system does not check or warn against such files. To ensure a 
successful result, only upload known, correct files.
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Pre-Defined Repositories 
You can define repositories for any connector-related files. As a convenience, the following 
repositories are pre-defined.

 Backup Files: connector cloning (see “Cloning Container Configuration” on 
page 506).

 Map Files: enrich event data

 Parser Overrides: customize the parser (see “Adding Parser Overrides” on page 507)

 Flex Connector Files: user-designed connector deployment

 Connector Properties: agent.properties; subset of cloning

 JDBC Drivers: database connectors

To view the settings for a pre-defined repository, click the name of the repository and then 
click the Settings tab in the right panel.

The following tables lists the settings for each pre-defined repository.

Settings for Backup Files 

Table 10-1 Pre-Defined Settings for Backup Files

The settings for pre-defined repositories are read-only; to modify the 
settings, click New Repository in the left panel to create a user-defined 
repository and provide the settings you want to use.

Name Default Setting

Name backup

Display Name Backup Files

Item Display Name Backup File

Recursive Checked (Yes)

Sort Priority 0

Restart Connector Process Checked (Yes)

Filename Prefix ConnectorBackup

Download Relative Path

Download Include regular expression

Download Exclude regular expression (agentdata/|cwsapi_fileset_).*$

Delete before upload Checked (Yes)

Delete groups Checked (Yes)

Upload Relative Path

Delete Relative Path

Delete Include regular expression

Delete Exclude regular expression (agentdata/|cwsapi_fileset_).*$
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Settings for Map Files 

Table 10-2 Pre-Defined Settings for Map Files

Name Default Setting

Name map

Display Name Map Files

Item Display Name Map File

Recursive Un-checked (No)

Sort Priority 5

Restart Connector Process Un-checked (No)

Filename Prefix Map

Download Relative Path map

Download Include regular expression map\.[0-9]+\.properties$

Download Exclude regular expression

Delete before upload Checked (Yes)

Delete groups Un-checked (No)

Upload Relative Path

Delete Relative Path map

Delete Include regular expression map\.[0-9]+\.properties$

Delete Exclude regular expression
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Settings for Parser Overrides 

Table 10-3 Pre-Defined Settings for Parser Overrides

Name Default Setting

Name parseroverrides

Display Name Parser Overrides

Item Display Name Parser Override

Recursive Checked (Yes)

Sort Priority 10

Restart Connector Process Checked (Yes)

Filename Prefix Parsers

Download Relative Path fcp

Download Include regular expression .*

Download Exclude regular expression

Delete before upload Checked (Yes)

Delete groups Checked (Yes)

Upload Relative Path

Delete Relative Path fcp

Delete Include regular expression .*

Delete Exclude regular expression
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Settings for FlexConnector Files 

Table 10-4 Pre-Defined Settings for FlexConnector Files

Name Default Setting

Name flexconnectors

Display Name Flex Connector Files

Item Display Name Flex Connector File

Recursive Checked (Yes)

Sort Priority 15

Restart Connector Process Checked (Yes)

Filename Prefix FlexConnector

Download Relative Path flexagent

Download Include regular expression .*

Download Exclude regular expression

Delete before upload Checked (Yes)

Delete groups Checked (Yes)

Upload Relative Path

Delete Relative Path flexagent

Delete Include regular expression .*

Delete Exclude regular expression
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Settings for Connector Properties 

Table 10-5 Pre-Defined Settings for Connector Properties

Name Default Setting

Name connectorproperties

Display Name Connector Properties

Item Display Name Connector Property File

Recursive Un-checked (No)

Sort Priority 20

Restart Connector Process Checked (Yes)

Filename Prefix ConnectorProperties

Download Relative Path

Download Include regular expression agent\..*

Download Exclude regular expression

Delete before upload Un-checked (No)

Delete groups Un-checked (No)

Upload Relative Path

Delete Relative Path

Delete Include regular expression agent\..*

Delete Exclude regular expression
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Settings for JDBC Drivers 

Table 10-6 Pre-Defined Settings for JDBC Drivers

Name Default Setting

Name jdbcdrivers

Display Name JDBC Drivers

Item Display Name Connector JDBC Driver File

Recursive Un-checked (No)

Sort Priority 25

Restart Connector Process Checked (Yes)

Filename Prefix

Download Relative Path lib

Download Include regular expression

Download Exclude regular expression

Delete before upload Un-checked (No)

Delete groups Un-checked (No)

Upload Relative Path

Delete Relative Path lib

Delete Include regular expression

Delete Exclude regular expression
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Cloning Container Configuration 
Using the Backup Files repository, you can quickly copy a container to other containers. 
As a result, all connectors in the source container are copied to the destination container. 
This process is called cloning a container configuration. You can clone a container to 
several containers at once. The contents of the source container are appended to the 

existing contents of the destination container.

To clone a container:

1 Click Configuration > Manage Connectors to list the containers and determine the 
source and destination for cloning.

2 Click Configuration > Repositories from the top-level menu bar.

3 Click Backup Files under the Repositories section in the right panel.

4 If the backup file that you need to use for cloning exists in the repository, go to the 
next step. Otherwise, follow the instructions in “Retrieving a File from the Repository” 
on page 499 to retrieve the container’s backup file to the Backup repository.

The retrieved file is named in <connector name> ConnectorBackup <date> format.

5 Follow the instructions in “Uploading a File from the Repository” on page 499 to 
upload the backup file to one or more containers.

The destination containers are unavailable while the backup file is applied and the 
connectors are restarted. 

Do not clone older, software-based connectors (such as build 4.0.8.4964) to 
containers with newer connector builds (such as 4.0.8.4976 or later). 

Cloning a connector using the Backup repository only works if the connector 
version numbers are the same.

The backup file does not include the container certificates. You have to 
re-apply the certificates to the container after you upload the backup file. 

After applying the certificates, check the status of the destination container 
to make sure it is available.
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Adding Parser Overrides
A parser override is a file provided by ArcSight used to resolve an issue with the parser for 
a specific connector, or to support a newer version of a supported device where the log file 
format changed slightly or new event types were added. 

To use parser overrides, you need to:

 Upload a parser override file to the pre-defined Parser Overrides repository.

 Download the parser override file to the container that contains the connector that will 
use the parser override. 

Follow the steps below.

To upload a parser override file:

1 Click Configuration > Repositories from the top-level menu bar.

2 Click Parser Overrides under the Repositories section in the right panel.

3 On the Parser Overrides tab, click the Upload To Repository button.

4 Follow the wizard to upload the file. When prompted by the wizard, make sure you:

 Select the Individual Files option from the Select the type of file that you 
want to upload field.

 Add a slash (/) after fcp before adding the folder name in the Enter the sub 
folder where the files will be uploaded field. For example, 
fcp/multisqlserver_audit_db.

When upload is complete, the parser override file is listed in the table on the Parser 
Overrides tab.

To download the parser override file to a container:

1 Click Configuration > Repositories from the top-level menu bar.

2 Click Parser Overrides under the Repositories section in the right panel.

3 In the table on the Parser Overrides tab, locate the parser override file you want to 
download and click the up arrow next to the file.

4 Follow the wizard to select the container to which you want to add the parser 
overrides.

When the wizard completes, the parser overrides will be deployed in the selected 
container.

To verify that the parser override has been applied successfully, issue a Get Status 
command to the connector. See “Sending a Command to a Destination” on page 465. In 
the report that appears, check for the line starting with the text 
ContentInputStreamOverrides.

You can download a parser override file from ArcExchange. For more 
information, refer to “Sharing Connectors (ArcExchange)” on page 473.
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Appendix A

Common Event Format

Common Event Format (CEF) is an industry standard for the interoperability of event- or 
log-generating devices. The myriad of formats used for event reporting, especially in the 
security world, greatly complicates integration. Each vendor has its own format for 
reporting event information, but these formats often lack key information necessary to 
integrate the events from their devices.

The CEF standard aims to improve the interoperability of infrastructure devices by better 
aligning the logging output from participating technology vendors. Vendors implementing 
the CEF standard log events in a format that is both useful, and more importantly, parse-
able by ArcSight or any vendor following the standard. Further, this standard assures that 
an event and its semantics contain all necessary information.

Common Exchange Format
This specification defines a simple event format that can be readily adopted by vendors of 
both security and non-security devices. This format is intended to contain the most 
relevant information and make it easy for event consumers to parse and use events.

To simplify integration, we use syslog as a transport mechanism. This applies a common 
prefix to each message, containing the date and hostname:

Jan 18 11:07:53 zurich message

If an event producer is unable to write syslog messages, it is still possible to write the 
events to a file. In this case, omit the syslog header and start the message with the format 
defined below.

It is important to note that this part of the message need not be explicitly generated by the 
event producer. The remainder of the message is formatted using a common prefix 
composed of fields delimited by a bar ("|") character. The prefix is mandatory and all 
specified fields need to be present. Additional fields are specified in the Extension. The 
format is:

CEF:Version|Device Vendor|Device Product|Device Version|Device 
Event Class ID|Name|Severity|Extension

The Extension part of the message is a placeholder for additional fields. Those fields are 
documented in the Event Dictionary below and are logged as key-value pairs.

Here are definitions for the prefix fields:

Version is an integer and identifies the version of the CEF format. Event consumers use 
this information to determine what the following fields represent. Currently only version 0 
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(zero) is established in the above format. Experience may show that other fields need to be 
added to the "prefix" and therefore require a version number change. Adding new formats 
is handled through the standards body.

Device Vendor, Device Product and Device Version are strings that uniquely identify 
the type of sending device. No two products may use the same device-vendor and 
deviceproduct pair. There is no central authority managing these pairs. Event producers 
have to ensure that they assign unique name pairs.

Device Event Class ID is a unique identifier per event-type. This can be a string or an 
integer. Device Event Class ID identifies the type of event reported. In the intrusion 
detection system (IDS) world, each signature or rule that detects certain activity has a 
unique identifier assigned. This is a requirement for other types of devices as well, and 
helps correlation engines deal with the events.

Name is a string representing a human-readable and understandable description of the 
event. The event name should not contain information that is specifically mentioned in 
other fields. For example: "Port scan from 10.0.0.1 targeting 20.1.1.1" is not a good event 
name. It should be: “Port scan.” The other information is redundant and can be picked up 
from the other fields.

Severity is an integer and reflects the importance of the event. Only numbers from 0 to 
10 are allowed, where 10 indicates the most important event.

Extension is a collection of key-value pairs. The keys are part of a predefined set. The 
standard allows for including additional keys as outlined later. An event can contain any 
number of key-value pairs in any order, separated by spaces (" "). If a field contains a 
space, such as a file name, this is okay and can be logged in exactly that manner. For 
example: fileName=c:\Program Files\ArcSight is a valid token.

Here is a sample message to illustrate appearance:

Sep 19 08:26:10 zurich CEF:0|security|threatmanager|1.0|100|worm 
successfully stopped|10|src=10.0.0.1 dst=2.1.2.2 spt=1232

Here are further details about character encoding:

The entire message has to be UTF-8 encoded.

If a pipe (|) is used in the prefix, it has to be escaped with a backslash (\). But note that 
pipes in the extension do not need escaping. Here is an example message:

Sep 19 08:26:10 zurich 
CEF:0|security|threatmanager|1.0|100|detected a \| in 
message|10|src=10.0.0.1 act=blocked a | dst=1.1.1.1

If a backslash (\) is used in the prefix, it has to be escaped with another backslash (\). 
Again, note that backslashes in the extension do not need escaping. Here is an example:

Sep 19 08:26:10 zurich 
CEF:0|security|threatmanager|1.0|100|detected a \\ in 
packet|10|src=10.0.0.1 action=blocked a \ dst=1.1.1.1

If an equal sign (=) is used in the extensions, it has to be escaped with a backslash (\). 
Equal signs in the prefix need no escaping. For example:
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Sep 19 08:26:10 zurich 
CEF:0|security|threatmanager|1.0|100|detected a = in 
message|10|src=10.0.0.1 action=blocked a \= dst=1.1.1.1

Multi-line fields can be sent by Common Event Format (CEF) by encoding the newline 
character as \n or \r. Note that multiple lines are only allowed in the value part of the 
extensions. See this example:

Sep 19 08:26:10 zurich 
CEF:0|security|threatmanager|1.0|100|Detected a threat. No action 
needed.|10|src=10.0.0.1 message=Detected a threat.\nNo action 
needed.

Common Extension Dictionary
The following table contains predefined keys that establish usages for both event 
producers and consumers. The standard allows for defining additional keys, with the 
understanding that those fields may not be interpreted by other event consumers.

The table below contains key names as well as the full name for each key. The key name is 
the one that is required in events.

Key Name Full Name Data Type Meaning

act deviceAction String Action mentioned in the event.

app applicationProtocol String Application level protocol. Example 
values include: HTTP, HTTPS, SSHv2, 
Telnet, POP, IMAP, IMAPS.

in bytesIn Integer Number of bytes transferred 
inbound. Inbound relative to the 
source to destination relationship, 
meaning that data was flowing from 
source to destination.

out bytesOut Integer Number of bytes transferred 
outbound. Outbound relative to the 
source to destination relationship, 
meaning that data was flowing from 
destination to source.

dst destinationAddress IPv4 Address Identifies destination that the event 
refers to in an IP network. The 
format is an IPv4 address, such as 
“192.168.10.1”.

dhost destinationHostName FQDN Identifies the destination that the 
event refers to in an IP network. The 
format is a fully qualified domain 
name (FQDN) associated with the 
destination node, such as 
“zurich.domain.com”.

dmac destinationMacAddress String Six colon-separated hexadecimal 
numbers, such as 
“00:0D:60:AF:1B:61”

dntdom destinationNtDomain String The Windows domain name of the 
destination address.
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dpt destinationPort Integer The valid port numbers are between 
0 and 65535.

dproc destination 
ProcessName

String The name of the process which is the 
event’s destination, such as “telnetd” 
or “sshd”.

duid destinationUserId String Identifies the destination user by ID. 
For example, in Unix, the root user is 
generally associated with ID 0.

dpriv destination 
UserPrivileges

String The allowed values are: 
“Administrator”, “User”, and “Guest”. 
This identifies the destination user’s 
privileges. In Unix, for example, 
activity executed on the root user 
would be identified with 
destinationUserPrivileges of 
“Administrator”.

duser destinationUserName String Identifies the destination user by 
name. This is the user associated 
with the event’s destination. E-mail 
addresses are also mapped into the 
UserName fields. The recipient is a 
candidate to put into 
destinationUserName.

end endTime TimeStamp The time at which the activity related 
to the event ended. The format is 
MMM dd yyyy HH:mm:ss or 
milliseconds since epoch (January 1, 
1970). An example would be 
reporting the end of a session.

fname fileName String Name of the file.

fsize fileSize Integer Size of the file.

msg message String An arbitrary message giving more 
details about the event. Multi-line 
entries can be produced by using ‘\n’ 
as the newline separator.

rt receiptTime TimeStamp The time at which the event related 
to the activity was received. The 
format is MMM dd yyyy HH:mm:ss or 
milliseconds since epoch (January 1, 
1970).

request requestURL String In the case of an HTTP request, this 
field contains the URL accessed. The 
URL should contain the protocol as 
well, such as 
“http://www.security.com”.

src sourceAddress IPv4 Address Identifies the source that the event 
refers to in an IP network. The 
format is an IPv4 address, such as 
“192.168.10.1”.

Key Name Full Name Data Type Meaning
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shost sourceHostName FQDN Identifies the source that the event 
refers to in an IP network. The 
format is a fully qualified domain 
name (FQDN) associated with the 
source node, such as 
“zurich.domain.com”.

smac sourceMacAddress String Six colon-separated hexadecimal 
numbers, such as 
“00:0D:60:AF:1B:61”

sntdom sourceNtDomain String The Windows domain name of the 
source address.

spt sourcePort Integer The valid port numbers are between 
0 and 65535.

suid sourceUserId String Identifies the source user by ID. This 
is the user associated with the 
source of the event. For example, in 
Unix, the root user is generally 
associated with ID 0.

spriv sourceUserPrivileges String The allowed values are: 
“Administrator”, “User”, and “Guest”. 
This identifies the source user’s 
privileges. In Unix, for example, 
activity executed on the root user 
would be identified with 
sourceUserPrivileges of 
“Administrator”.

This is an idealized and simplified 
view of privileges and can be 
extended in the future.

suser sourceUserName String Identifies the source user by name. 
E-mail addresses are also mapped 
into the UserName fields. The sender 
is a candidate to put into 
sourceUserName.

start startTime TimeStamp The time when the activity the event 
referred to started. The format is 
MMM dd yyyy HH:mm:ss or 
milliseconds since epoch (January 1, 
1970).

proto transportProtocol String Identifies the Layer-4 protocol used. 
The possible values are protocol 
names such as TCP or UDP.

Key Name Full Name Data Type Meaning
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Appendix B

Regular Expressions

Regular String Search expressions (Perl Regex) are used to compose Logger filters. The 
following describes the syntax of regular expressions in Perl.

Regex Overview
A regular expression is a string of characters which tells the searcher which string (or 
strings) you are looking for. The following explains the format of regular expressions in 
detail. If you are familiar with Perl, you already know the syntax. If you are familiar with 
Unix, you should know that there are subtle differences between Perl's regular expressions 
and Unix' regular expressions.

The following is a list of the characters used in a regular expression syntax and their 
meaning. 

Predefined Character Classes:
. Any character (may or may not match line terminators) 

\d A digit: [0-9] 

\D A non-digit: [^0-9] 

\s A whitespace character: [ \t\n\x0B\f\r] 

\S A non-whitespace character: [^\s] 

\w A word character: [a-zA-Z_0-9] 

\W A non-word character: [^\w] 

Standard quantifiers include '?' (zero or one), '+' (one or more), '*' (zero or more), {n} 
(exactly n), and {n,m} (at least n, but no more than m).

Boundary Matchers:
^ The beginning of a line 

$ The end of a line 

\b A word boundary 

\B A non-word boundary 

\A The beginning of an event 

\G The end of the previous match 

\Z The end of an event 
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Simple Regular Expressions
In its simplest form, a regular expression is just a word or phrase to search for. For 
example, 

gauss

would match any event with the string "gauss" in it, or which mentioned the word "gauss.” 
Thus, events with "gauss", "gaussian" or "degauss" would all be matched, as would an 
event containing the phrases "de-gauss the monitor" or "gaussian elimination." Here are 
some more examples:

carbon

Finds any event with the string "carbon" in it, or which mentions carbon (or carbonization 
or hydrocarbons or carbon-based life forms) in the event.

hydro

Finds any event with the string "hydro" in it. Events with "hydro", "hydrogen" or 
"hydrodynamics" are found, as well as events containing the words "hydroplane" or 
"hydroelectric".

oxy

Finds any event with the string "oxy" in it. This could be used to find event on oxygen, 
boxy houses or oxymorons.

top ten

Note that spaces may be part of the regular expression. The above expression could be 
used to find top ten lists. (Note that they would also find articles on how to stop tension.)

Metacharacters
Some characters have a special meaning to the searcher. These characters are called 
metacharacters. Although they may seem confusing at first, they add a great deal of 
flexibility and convenience to the searcher.

The period (.) is a commonly used metacharacter. It matches exactly one character, 
regardless of what the character is. For example, the regular expression:

2,.-Dimethylbutane

will match "2,2-Dimethylbutane" and "2,3-Dimethylbutane". Note that the period matches 
exactly one character-- it will not match a string of characters, nor will it match the null 
string. Thus, "2,200-Dimethylbutane" and "2,-Dimenthylbutane" will not be matched by 
the above regular expression.

But what if you wanted to search for a string containing a period? For example, suppose 
we wished to search for references to pi. The following regular expression would not work:

3.14 (THIS IS WRONG!)

This would indeed match "3.14", but it would also match "3514", "3f14", or even "3+14". 
In short, any string of the form "3x14", where x is any character, would be matched by the 
regular expression above.
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To get around this, we introduce a second metacharacter, the backslash (\). The 
backslash can be used to indicate that the character immediately to its right is to be taken 
literally. Thus, to search for the string "3.14", we would use:

3\.14 (This will work.)

This is called "quoting". We would say that the period in the regular expression above has 
been quoted. In general, whenever the backslash is placed before a metacharacter, the 
searcher treats the metacharacter literally rather than invoking its special meaning.

(Unfortunately, the backslash is used for other things besides quoting metacharacters. 
Many "normal" characters take on special meanings when preceded by a backslash. The 
rule of thumb is, quoting a metacharacter turns it into a normal character, and quoting a 
normal character may turn it into a metacharacter.)

Let's look at some more common metacharacters. We consider first the question mark 
(?). The question mark indicates that the character immediately preceding it either zero 
times or one time. Thus 

m?ethane

would match either "ethane" or "methane". Similarly,

comm?a

would match either "coma" or "comma".

Another metacharacter is the star (*). This indicates that the character immediately to its 
left may be repeated any number of times, including zero. Thus

ab*c

would match "ac", "abc", "abbc", "abbbc", "abbbbbbbbc", and any string that starts with an 
"a", is followed by a sequence of "b"'s, and ends with a "c".

The plus (+) metacharacter indicates that the character immediately preceding it may be 
repeated one or more times. It is just like the star metacharacter, except it doesn't match 
the null string. Thus

ab+c

would not match "ac", but it would match "abc", "abbc", "abbbc", "abbbbbbbbc" and so 
on.

Metacharacters may be combined. A common combination includes the period and star 
metacharacters, with the star immediately following the period. This is used to match an 
arbitrary string of any length, including the null string. For example:

cyclo.*ane

would match "cyclodecane", "cyclohexane" and even "cyclones drive me insane." Any 
string that starts with "cyclo", is followed by an arbitrary string, and ends with "ane" will be 
matched. Note that the null string will be matched by the period-star pair; thus, "cycloane" 
would be matche by the above expression.

If you wanted to search for articles on cyclodecane and cyclohexane, but didn't want to 
match articles about how cyclones drive one insane, you could string together three 
periods, as follows:
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cyclo...ane

This would match "cyclodecane" and "cyclohexane", but would not match "cyclones drive 
me insane." Only strings eleven characters long which start with "cyclo" and end with "ane" 
will be matched. (Note that "cyclopentane" would not be matched, however, since 
cyclopentane has twelve characters, not eleven.)

Here are some more examples. These involve the backslash. Note that the placement of 
backslash is important.

a\.*z

Matches any string starting with "a", followed by a series of periods (including the "series" 
of length zero), and terminated by "z". Thus, "az", "a.z", "a..z", "a...z" and so forth are all 
matched.

a.\*z

(Note that the backslash and period are reversed in this regular expression.)

Matches any string starting with an "a", followed by one arbitrary character, and terminated 
with "*z". Thus, "ag*z", "a5*z" and "a@*z" are all matched. Only strings of length four, 
where the first character is "a", the third "*", and the fourth "z", are matched.

a\++z

Matches any string starting with "a", followed by a series of plus signs, and terminated by 
"z". There must be at least one plus sign between the "a" and the "z". Thus, "az" is not 
matched, but "a+z", "a++z", "a+++z", etc. will be matched.

a\+\+z

Matches only the string "a++z".

a+\+z

Matches any string starting with a series of "a"'s, followed by a single plus sign and ending 
with a "z". There must be at least one "a" at the start of the string. Thus "a+z", "aa+z", 
"aaa+z" and so on will match, but "+z" will not.

a.?e

Matches "ace", "ale", "axe" and any other three-character string beginning with "a" and 
ending with "e"; will also match "ae".

a\.?e

Matches "ae" and "a.e". No other string is matched.

a.\?e

Matches any four-character string starting with "a" and ending with "?e". Thus, "ad?e", 
"a1?e" and "a%?e" will all be matched.

a\.\?e

Matches only "a.?e" and nothing else.

Earlier it was mentioned that the backslash can turn ordinary characters into 
metacharacters, as well as the other way around. One such use of this is the digit 
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metacharacter, which is invoked by following a backslash with a lower-case "d", like this: 
"\d". The "d" must be lower case, for reasons explained later. The digit metacharacter 
matches exactly one digit; that is, exactly one occurence of "0", "1", "2", "3", "4", "5", "6", 
"7", "8" or "9". For example, the regular expression:

2,\d-Dimethylbutane

would match "2,2-Dimethylbutane", "2,3-Dimethylbutane" and so forth. Similarly,

1\.\d\d\d\d\d

would match any six-digit floating-point number from 1.00000 to 1.99999 inclusive. We 
could combine the digit metacharacter with other metacharacters; for instance,

a\d+z

matches any string starting with "a", followed by a string of numbers, followed by a "z". 
(Note that the plus is used, and thus "az" is not matched.)

The letter "d" in the string "\d" must be lower-case. This is because there is another 
metacharacter, the non-digit metacharacter, which uses the uppercase "D". The non-digit 
metacharacter looks like "\D" and matches any character except a digit. Thus, 

a\Dz

would match "abz", "aTz" or "a%z", but would not match "a2z", "a5z" or "a9z". Similarly,

\D+

Matches any non-null string which contains no numeric characters.

Notice that in changing the "d" from lower-case to upper-case, we have reversed the 
meaning of the digit metacharacter. This holds true for most other metacharacters of the 
format backslash-letter.

There are three other metacharacters in the backslash-letter format. The first is the word 
metacharacter, which matches exactly one letter, one number, or the underscore character 
(_). It is written as "\w". It's opposite, "\W", matches any one character except a letter, a 
number or the underscore. Thus,

a\wz

would match "abz", "aTz", "a5z", "a_z", or any three-character string starting with "a", 
ending with "z", and whose second character was either a letter (upper- or lower-case), a 
number, or the underscore. Similarly,

a\Wz

would not match "abz", "aTz", "a5z", or "a_z". It would match "a%z", "a{z", "a?z" or any 
three-character string starting with "a" and ending with "z" and whose second character 
was not a letter, number, or underscore. (This means the second character must either be 
a symbol or a whitespace character.)

The whitespace metacharacter matches exactly one character of whitespace. 
(Whitespace is defined as spaces, tabs, newlines, or any character which would not use ink 
if printed on a printer.) The whitespace metacharacter looks like this: "\s". It's opposite, 
which matches any character that is not whitespace, looks like this: "\S". Thus,

a\sz
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would match any three-character string starting with "a" and ending with "z" and whose 
second character was a space, tab, or newline. Likewise,

a\Sz

would match any three-character string starting with "a" and ending with "z" whose second 
character was not a space, tab or newline. (Thus, the second character could be a letter, 
number or symbol.)

The word boundary metacharacter matches the boundaries of words; that is, it matches 
whitespace, punctuation and the very beginning and end of the text. It looks like "\b". It's 
opposite searches for a character that is not a word boundary. Thus:

\bcomput

will match "computer" or "computing", but not "supercomputer" since there is no spaces or 
punctuation between "super" and "computer". Similarly,

\Bcomput

will not match "computer" or "computing", unless it is part of a bigger word such as 
"supercomputer" or "recomputing".

Note that the underscore (_) is considered a "word" character. Thus,

super\bcomputer

will not match "super_computer".

There is one other metacharacter starting with a backslash, the octal metacharacter. The 
octal metacharacter looks like this: "\nnn", where "n" is a number from zero to seven. This 
is used for specifying control characters that have no typed equivalent. For example,

\007

would find all events with an embedded ASCII "bell" character. (The bell is specified by an 
ASCII value of 7.) You will rarely need to use the octal metacharacter.

There are three other metacharacters that may be of use. The first is the braces 
metacharacter. This metacharacter follows a normal character and contains two number 
separated by a comma (,) and surrounded by braces ({}). It is like the star metacharacter, 
except the length of the string it matches must be within the minimum and maximum 
length specified by the two numbers in braces. Thus,

ab{3,5}c

will match "abbbc", "abbbbc" or "abbbbbc". No other string is matched. Likewise,

.{3,5}pentane

will match "cyclopentane", "isopentane" or "neopentane", but not "n-pentane", since "n-" is 
only two characters long.

The alternative metacharacter is represented by a vertical bar (|). It indicates an either/or 
behavior by separating two or more possible choices. For example:

isopentane|cyclopentane

will match any event containing the strings "isopentane" or "cyclopentane" or both. 
However, it will not match "pentane" or "n-pentane" or "neopentane." The last 
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metacharacter is the brackets metacharacter. The bracket metacharacter matches one 
occurence of any character inside the brackets ([]). For example,

\s[cmt]an\s

will match "can", "man" and "tan", but not "ban", "fan" or "pan". Similarly,

2,[23]-dimethylbutane

will match "2,2-dimethylbutane" or "2,3-dimethylbutane", but not "2,4-dimethylbutane", 
"2,23-dimethylbutane" or "2,-dimethybutane". Ranges of characters can be used by using 
the dash (-) within the brackets. For example,

a[a-d]z

will match "aaz", "abz", "acz" or "adz", and nothing else. Likewise,

textfile0[3-5]

will match "textfile03", "textfile04", or "textfile05" and nothing else.

If you wish to include a dash within brackets as one of the characters to match, instead of 
to denote a range, put the dash immediately before the right bracket. Thus:

a[1234-]z

and

a[1-4-]z

both do the same thing. They both match "a1z", "a2z", "a3z", "a4z" or "a-z", and nothing 
else.

The bracket metacharacter can also be inverted by placing a caret (^) immediately after 
the left bracket. Thus,

textfile0[^02468]

matches any ten-character string starting with "textfile0" and ending with anything except 
an even number. Inversion and ranges can be combined, so that

\W[^f-h]ood\W

matches any four letter word ending in "ood" except for "food", "good" or "hood". (Thus 
"mood" and "wood" would both be matched.)

Note that within brackets, ordinary quoting rules do not apply and other metacharacters 
are not available. The only characters that can be quoted in brackets are "[", "]", and "\". 
Thus,

[\[\\\]]abc

matches any four letter string ending with "abc" and starting with "[", "]", or "\".

Forbidden Characters
Because of the way the searcher works, the following metacharacters should not be used, 
even though they are valid Perl metacharacters. They are:

 $ (allowed within brackets)
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 \n

 \r

 \t

 \f

 \b

 ( ) (allowed within brackets. Note that if you wish to search for parentheses within text 
outside of brackets, you should quote the parentheses.)

 \1, \2 ... \9

 \B

 :

 !

Things To Remember
Here are some other things you should know about regular expressions.

Because regular expressions can be complex, it can be more work mastering a search than 
just sifting through a long list of matches (unless you're already familiar with regular 
expressions).

The search is case insensitive; thus

mopac

and

Mopac

and

MOPAC

all search for the same set of strings. Each will match "mopac", "MOPAC", "Mopac", 
"mopaC", "MoPaC", "mOpAc" and so forth. Thus you need not worry about capitalization. 
(Note, however, that metacharacters must still have the proper case. This is especially 
important for metacharacters whose case determines whether their meaning is reversed or 
not.)

Outside of the brackets metacharacter, you must quote parentheses, brackets and braces 
to get the searcher to take them literally.
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Using the Rex Operator

This appendix describes the rex search operator in detail.

The rex operator is a powerful operator that enables you to extract information that 
matches a specified regular expression and assigns it to a field, whose field name you 
specify.  You can also specify an optional start point and an end point in the rex expression 
between which the information matching the regular expression is searched.  

When a rex expression is included in a search query, it must be preceded by a basic search 
query that finds events from which the rex expression will extract information. For 
example: 
failed | rex "(?<srcip>[^ ]\d{1,3}\.\d{1,3}\.\d{1,3}\.\d{1,3})"

Syntax of the rex Operator
| rex “text1(?<field1>text2regex)”

text1—The text or point in the event AFTER which information extraction begins. The 
default is the beginning of the event. 

text2—The text or point in the event at which information extraction ends.

field1—The name of the field to which the extracted information is assigned.

regex—The pattern (regular expression) used for matching information to be extracted 
between text1 and text2.

Understanding the rex Operator Syntax
Extract all information AFTER text1 and upto text2 that matches the specified regex 
(regular expression) and assign TO field1. 

Notes:

 text1 and [text2] can be any points in an event—start and end of an event, specific 
string in an event (even if the string is in the middle of a word in the event), a specific 
number of characters from the start or end of an event, or a pattern.

 To specify the next space in the event as text2, enter [^ ].

If you are an experienced regular expression user, see the Note in the next 
section for a quick understanding of how rex enables you to capture named 
input and reference it for further processing. 
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This is interpreted as “not space.” Therefore, entering a “not” results in the capture to 
stop at the point where the specified character is found in the event. In this case, a 
space.

 To specify [text2] to be the end of the line, enter [^$].

This is interpreted as “not end of line.” Therefore, when an end-of-line in an event is 
encountered, the capture will stop at that point. The [^$] usage only captures one 
character if it is not an end-of-line character. However, by specifying [^$]* in a rex 
expression, the usage captures all characters until end-of-line. 

You can also specify .* to capture all characters in an event instead of [^$]. Examples 
in this document, however, use [^$].

 Any extra spaces within the double quotes of the rex expression are treated literally. 

 The characters that need to be escaped for rex expressions are the same as the ones 
for regular expressions. Refer to a regular expressions document of your choice to 
obtain a complete list of such characters.

 Information captured by a rex expression can be used for further processing in a 
subsequent rex expression as illustrated in the following example in which an IP 
address is captured by the first rex expression and the network ID (assuming the first 
three bytes of the IP address represent it) to which the IP address belongs is extracted 
from the captured IP address:

logger | rex "(?<srcip>[^ ]\d{1,3}\.\d{1,3}\.\d{1,3}\.\d{1,3})" 

| rex field=srcip "(?<netid>\d{1,3}\.\d{1,3}\.\d{1,3})"

Ways to Create a rex Expression
You can create a rex expression in two ways:

 Manually—Follow the syntax and guidelines described in this appendix to create a rex 
expression to suit your needs.

 Regex Helper—Use the Regex Helper tool, as described in “Regex Helper Tool” on 
page 126. This tool not only simplifies the process, it also makes it less error prone 
and more efficient.

Creating a rex Expression Manually
Start with a simple search that finds the events that contains the information in which you 
are interested. Once the events are displayed, identify a common starting point in those 
events that precedes the information. 

For example, you are interested in extracting the client IP address, which always appears 
after the word “[client ” in the following event.

If you are an experienced regular expression user, you can interpret the rex 
expression syntax as follows:

rex “(?<field1>regex)”

where the entire expression in the parentheses specifies a named capture. 
That is, the captured group is assigned a name, which can be referenced later 
for further processing. For example, in the following expression “srcip” is the 
name assigned to the capture. 

failed | rex "(?<srcip>[^ ]\d{1,3}\.\d{1,3}\.\d{1,3}\.\d{1,3})"

Once named, use “srcip” for further processing as follows:

failed | rex "(?<srcip>[^ ]\d{1,3}\.\d{1,3}\.\d{1,3}\.\d{1,3})" | 
top srcip
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[Thu Jul 30 01:20:06 2009] [error] [client 69.63.180.245] PHP 
Warning:  memcache_pconnect() [<a href='function.memcache-
pconnect'>function.memcache-pconnect</a>]: Can't connect to 
10.4.31.4:11211

Therefore, “[client” is the starting point. A good end point is the “]” after the last byte of 
the client IP address. Now, we need to define the regular expression that will extract the IP 
address. Because in this example, only the client IP address appears after the word 
“client”, we use “*” as the regular expression, which means “extract everything”.  (We 
could be more specific and use \d{1,3}\.\d{1,3}\.\d{1,3}\.\d{1,3} for the IP 
address.) We assign the extracted IP address to a field name “clientIP”. We are almost 
ready to create a rex expression, except that we need to escape the “[“ and “]” characters 
in the expression. The escape character to use is “\”. 

Now, we are ready to create the rex expression to extract the IP address that appears 
after the word “client” in the event shown above.

| rex “\[client(?<clientip>[^\]]*)”

Samples of rex Expressions
This sections contains several sample examples for extracting different types of information 
from an event. The specificity of the information extracted increases with each example. 
Use these examples as a starting point for creating rex expressions to suit your needs. 
Also, use the Regex Helper tool that simplifies rex expression creation.

This event is used as an example to illustrate the information the following rex expressions 
will extract:

 Capture matching events from the left of the pipeline and assign them to the field, 
message. The entire event is assigned to the “message” field.

| rex "(?<message>[^$]*)"

This expression extracts the entire event (as shown above), starting at the word 
“CEF:0”. 

 Specifying the starting point as number of characters from the start of an event 
instead of a specific character or word

| rex "[a-zA-Z0-9:\.\s]{16}(?<message>[^$]*)"

This expression starts extracting after 16 consecutive occurrences of the characters 
specified for text1—alphanumeric characters, colons, periods, or spaces. Although the 
first 16 characters of the first event are “CEF:0|ArcSight|L”, the extraction does not 
begin at “ogger|4.5.0...” because the pipeline character is not part of the characters 
we are matching, but this character is part of the beginning of the event. Therefore, 
the first 16 consecutive occurrences are “Logger Internal “. As a result, information 
starting at the word “Event”, is extracted from our example event.

 Extract a specified number of characters instead of specifying an end point such as the 
next space or the end of the line

| rex "[a-zA-Z0-9:\.\s]{16}(?<message>[^$]{5})"
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This expression only extracts the word “Event”. (See the previous sample rex 
expression for a detailed explanation of the reason extraction begins at the word 
“Event”.)

 Extract everything after “CEF:0|” into a field, message. Then, pipe events for which 
the message field is not null through another rex expression to extract the IP address 
contained in the matching events and assign the IP addresses to another field, msgip. 
Only display events where msgip is not null.

| rex "CEF:0\|(?<message>[^$]*)" | where message is not null | 
rex "dvc=(?<msgip>[^ ]\d{1,3}\.\d{1,3}\.\d{1,3}\.\d{1,3})" | 
where msgip is not null

Note: The “: and =” characters do not need to be escaped; however, “|” must be 
escaped. The characters that need to be escaped for rex expressions are the same as 
the ones for regular expressions. Refer to a regular expressions document of your 
choice to obtain a complete list of such characters. 

This expression extracts the device IP address from the event. 

The following rex examples use this event for illustration:

 Extract the first two IP addresses from an event and assign them to two different 
fields, IP1 and IP2.

| rex "(?<IP1>[^$]\d{1,3}\.\d{1,3}\.\d{1,3}\.\d{1,3})" | rex 
"\d{1,3}\.\d{1,3}\.\d{1,3}\.\d{1,3}(?<IP2>[^$]\d{1,3}\.\d{1,3}\
.\d{1,3}\.\d{1,3})"

This expression extracts the first and second IP addresses in the above event. 

Note: Because the two IP addresses are right after one another in this event, you can 
also specify the extraction of the two IP addresses in a single rex expression as 
follows:

| rex 
"(?<IP1>[^$]\d{1,3}\.\d{1,3}\.\d{1,3}\.\d{1,3})(?<IP2>[^$]\d{1,
3}\.\d{1,3}\.\d{1,3}\.\d{1,3})"

Note: Do not specify a space in the above expression.

 Building on the previous example, add a new field called Ignore. Assign the value “Y” 
to this field if the two IP addresses extracted in the previous example are the same 
and assign the value “N” if the two IP addresses are different. Then, list the top IP1 
and IP2 combinations for events for which Ignore field is “N”. 

| rex "(?<IP1>[^$]\d{1,3}\.\d{1,3}\.\d{1,3}\.\d{1,3})" | rex 
"\d{1,3}\.\d{1,3}\.\d{1,3}\.\d{1,3}(?<IP2>[^$]\d{1,3}\.\d{1,3}\
.\d{1,3}\.\d{1,3})" | eval Ignore=if(IP1==IP2,"Y","N") | where 
Ignore="N" | top IP1 IP2

Note: The eval command uses double ==  to equate the two fields.

 Information captured by a rex expression can be used for further processing in a 
subsequent rex expression as illustrated in the following example. The first IP address 
is captured by the first rex expression and the network ID (assuming the first three 
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bytes of the IP address represent it) to which the IP address belongs is extracted from 
the captured IP address:

logger | rex "(?<srcip>[^ ]\d{1,3}\.\d{1,3}\.\d{1,3}\.\d{1,3})" 
| rex field=srcip "(?<netid>\d{1,3}\.\d{1,3}\.\d{1,3})

The following rex example uses this event for illustration:

 Extract all URLs from events and generate a chart of the URL counts, excluding blank 
URLs

| rex "http://(?<customURL>[^ ]*)" | where customURL is not null 
| chart count by customURL | sort - customURL

Notes pertinent to this example: 

 The events contain the URL string in “http://” format. 

 Meta character / needs to be enclosed in square brackets [] to be treated literally.

The following rex example uses this event for illustration:

 Extract the first word after the word “user ” (one space after the word) or “user=”. The 
word “user” is case-insensitive in this case and must be preceded by a space character. 
That is, words such as “ruser” and “suser” should not be matched.

| rex “\s[u|U][s|S][e|E][r|R][\s|=](?<CustomUser>[^ ]*)”
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Restoring Factory Settings

ArcSight Logger can be restored to its original factory settings using built-in Acronis True 
Image software. 

Before Restoring Factory Settings
You must remember the following cautions and guidelines before you restore to factory 
settings:

 Restoring Logger to factory settings will irrevocably delete all event data and 
configuration settings.

 The screens shown here are examples only. Your Logger partitions might vary, and the 
overall capacity might be different.

 If your Logger running v5.1 or later has multipath SAN enabled and you encounter one 
of these situations:

 RMA the system to ArcSight and receive a new system that is either running 
Logger v5.0 Patch 3 or earlier

 Factory restore the system to its factory default settings, which resets the Logger 
version to 5.0 Patch 3 or earlier

To restore your Logger to its last working state—running version 5.1 or later, with 
multipath enabled—make sure that you upgrade your system to Logger v5.1 or later 
before attaching the LUN. If you will be restoring the configuration of the Logger from 
a backup, ensure that the Logger is first running the version that matches the backup, 
perform the restoration, then complete the upgrade to the desired version.

Restoring to Factory Settings
To restore factory settings:

1 Attach a keyboard, monitor, and mouse directly to the ArcSight Logger appliance or, if 
your Logger is configured for DRAC, use that functionality to access the Logger 
Console. See “Configure Logger for Remote Access” on page 35 for information about 
DRAC.

2 Reboot Logger from the web interface by clicking the  System Admin tab, the 
System Reboot command in the sub-menu, and the Start Reboot Now button. 

3 Once the following message appears on the screen, press any key on your keyboard. 
This message is displayed for a very short time, therefore, make sure you press a key 
on your keyboard quickly; otherwise, the Logger will continue to boot normally.

Press any key to enter the menu

Booting Red Hat Enterprise Linux Server in 2 seconds...
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4 A screen similar to the following is displayed on the attached monitor. Use the mouse 
or arrow keys to select System Restore and press the Enter key on your keyboard.

5 On the Pick a Task list, as shown in the following figure, choose Recovery. On the 
next page (Welcome to the Restore Data Wizard), click Next to continue.
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6 Select the Acronis Secure Zone, as shown in the following figure, and click Next. You 
will have a chance to review the choices you make on this page and the wizard pages 
that follow before initiating the restore process.

7 Select Restore disks or partitions and click Next. Only choose other options if 
specifically directed to do so by ArcSight Customer Support.
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8 Select the entire drive, labeled ‘c0d0’ in the following figure. Click Next to continue.

9 Select the way in which the NT signature for the restored disk should be processed 
and click Next.
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10 Choose the drive to restore (‘c0d0’) and click Next.

11 Select, “Yes, I want to delete all partitions on the destination hard disk drive before 
restoring”, as shown in the following figure.
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12 Because there are no other partitions or disks to restore, choose “No, I do not,” on the 
Next Selection page of the wizard. Click Next.

13 Validating the archive before restoring is optional. Check the box to validate the 
archive or leave it unchecked to skip this step. Check the box labeled “Reboot the 
computer automatically after the restoration is finished” to automatically reboot. Click 
Next.
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14 Review the checklist of operations to be performed, as shown in the following figure, 
and click Proceed to begin the restore process, or click Back to revisit previous 
wizard pages.

15 The progress bars (shown in the following figure) display the status of the current and 
total operations. When the restoration is complete, an alert is displayed that says 
“Data was successfully restored.” Click OK.

If you specified automatic reboot in Step 13, Logger will reboot when the restore is 
complete. Otherwise, reboot manually.

Do not interrupt or power-down Logger during the restore process. 
Interrupting the restore process may force the system into a state from which 
it cannot be recovered.
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Logger Audit Events

You can forward the Logger audit events, which are in Common Event Format (CEF), to 
ArcSight ESM directly for analysis and correlation. Use the Audit Forwarding feature (as 
described in “Audit Forwarding” on page 364) to forward the events. For a detailed 
understanding of the format of CEF events, see Appendix A‚ Common Event Format‚ on 
page 509. 

The following events are logged and available for Audit Forwarding to ArcSight ESM.

Types of Audit Events
Two types of audit events are generated on Logger:

 Platform Events—related to the Logger hardware/system

 Logger Application Events—related to Logger functions and configuration changes on 
it

Both types of events are stored in the Logger Internal Storage group. As a result, these 
events can be searched using the Logger Search UI. For example, you can search for the 
this platform event:

“/Platform/Authentication/Failure/Password”

In addition to these events, a Logger appliance that has an ArcSight Connector Appliance 
installed on it generates Connector Appliance audit events. For a list of Connector 
Appliance audit events, see the Administrator’s Guide for Connector Appliance for the 
version that applies to you.

Information in an Audit Event
A Logger audit event (in CEF format) contains information about the following prefix fields:

 Device Event Class ID

 Device Severity

 Message

 Device Event Category—(key name for this CEF extension is “cat”)

“Platform Events” on page 538 

“Logger Application Events” on page 545
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For example:

Sep 19 08:26:10 zurich 
CEF:0|ArcSight|Logger|3.5.0.13412.0|logger:500|Filter added|2|  
cat=/Logger/Resource/Filter/Configuration/Add msg=Filter [Regex 
Query Test] has been added

Platform Events
The following table lists the information contained in audit events related to the Logger 
platform. All events include the following fields. 

 duser—User name

 duid—User ID

 src—IP address of client

 dst—IP address of appliance

 cat—Device Event Category

 cn1—Session number

 cn1label—Session

In addition, additional fields (if applicable) are listed in the following table.  

Device Event 
Class ID

Seve
rity

 Message
Device Event 
Category (cat)

Additional Fields 
(listed only if 
applicable)

platform:200 7 Failed password 
change

/Platform/
Authentication/Failure/
Password

platform:201 7 Failed login attempt /Platform/
Authentication/Failure/L
ogin

platform:202 5 Password changed /Platform/
Authentication/
Password

platform:203 7 Login attempt by 
inactive user

/Platform/
Authentication/InactiveU
ser/Failure

platform:205 5 Access enabled for 
support personnel

/Platform/Authorization/
Support/Enable

platform:206 1 Access disabled for 
support personnel

/Platform/Authorization/
Support/Disable

platform:210

(appliance only; 
see platform:530 
for software 
Logger)

3 Global login 
settings modified

/Platform/Configuration/
Global/Login
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platform:211

(appliance only; 
see 
platform:540, 
560 for software 
Logger)

3 Password policy 
modified

/Platform/Configuration/
Global/Policy

platform:212 5  Authentication 
settings modified      

/Platform/Configuration/
Global/RADIUS

cs1=server IP:port 
cs1label=RADIUS 
server

platform:213 7 Audit forwarding 
modified 

/Platform/Configuration/
Global/AuditEvents

platform:221 7 Certificate 
mismatch failure      

/Platform/Certificate/
Mismatch

platform:222 1 Created certificate 
signing request       

/Platform/Certificate/
Request

platform:223 5 Certificate request 
expired          

/Platform/Certificate/
Expired

platform:225    7 Uploaded file 
damaged or corrupt                     

/Platform/Update/
Failure/CorruptFile

fname=filename 
fsize=size

platform:226 7 Uploaded package 
damaged or corrupt 

/Platform/Update/
Failure/CorruptPackage

cs1=corrupt 
checksum 
cs1label=Error 
cs2=time 
cs2label=Unpack 
time 
fname=filename 
fsize=size

platform:227   5 Applied appliance 
update           

/Platform/Update/
Applied

cs1=flag 
cs1label=Reboot 
required cs2=time 
cs2label=Unpack 
time cs3=time 
cs3label=Install 
time 
fname=filename 
fsize=size

platform:228 5 Failed to install 
package

/Platform/Update
/Failure/Installation

cs2=time 
cs2label=Unpack 
time cs3=time 
cs3label=Install 
time 
fname=filename 
fsize=size

platform:230 5 Successful login    /Platform/
Authentication/Login

cs1label=Radius 
Server 
cs1value=server_ip:
port

Device Event 
Class ID

Seve
rity

 Message
Device Event 
Category (cat)

Additional Fields 
(listed only if 
applicable)
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platform:231 5 Successful login 
(RADIUS)

/Platform/
Authentication/Login/
RADIUS

cs1label=Radius 
Server 
cs1value=server_ip:
port

platform:232 7 Failed login attempt 
(BADUSER)       

/Platform/
Authentication/Failure/B
ADUSER

cs1label=Radius 
Server 
cs1value=server_ip:
port

platform:233 7 Failed login attempt 
(BADPASS)         

/Platform/
Authentication/Failure/B
ADPASS

cs1label=Radius 
Server 
cs1value=server_ip:
port

platform:234 7 Failed login attempt 
(LOCKED)             

/Platform/
Authentication/Failure/L
OCKED

cs1label=Radius 
Server 
cs1value=server_ip:
port

platform:235 7 Failed login attempt 
(INTERNAL)    

/Platform/
Authentication/Failure
/INTERNAL

cs1label=Radius 
Server 
cs1value=server_ip:
port

platform:236 7 Failed login attempt 
(EBADAUTH)           

/Platform/
Authentication/Failure
/EBADAUTH

cs1label=Radius 
Server 
cs1value=server_ip:
port

platform:237 7 Failed login attempt 
(ETIMEOUT)       

/Platform/
Authentication/Failure
/ETIMEOUT

cs1label=Radius 
Server 
cs1value=server_ip:
port

platform:238 7 Failed login attempt 
(NOACCESS)           

/Platform/
Authentication/Failure
/NOACCESS

cs1label=Radius 
Server 
cs1value=server_ip:
port

platform:239 1 User logout    /Platform/
Authentication/Logout

platform:240 3 Added user group                          /Platform/Groups/Add fileID=ID 
fileType=type 
fname=filename

platform:241 3 Updated user group            /Platform/Groups/
Update

fileID=ID 
fileType=type 
fname=filename

platform:242 3 Removed all 
members from 
group          

/Platform/Groups/
Membership/Remove

fileID=ID 
fileType=type 
fname=filename

platform:243 3 Modified user group 
membership            

/Platform/Groups/
Membership/Update

fileID=ID 
fileType=type 
fname=filename

platform:244 3 Deleted user group                        /Platform/Groups/
Remove

fileID=ID 
fileType=type 
fname=filename

Device Event 
Class ID

Seve
rity

 Message
Device Event 
Category (cat)

Additional Fields 
(listed only if 
applicable)
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platform:245 3 Added user          /Platform/Users/Add fileID=ID 
fname=filename

platform:246 3 Updated user                /Platform/Users/Update fileID=ID 
fname=filename

platform:247     3 Deleted user              /Platform/Users/Delete fileID=ID 
fname=filename

platform:248 3 Session Expired /Platform/Authentication
/Logout/SessionExpirati
on

platform:250 5 Added remote 
mount point      

/Platform/Storage/RFS/
Add

cs1=IP_address 
cs1label=Server 
cs2=remote_directo
ry_Path 
cs2label=Remote 
directory 
cs3=mount_point 
cs3label=Mount 
point cs4=type 
cs4label=Mount 
type 
cs5=permission 
cs5label=Username

platform:251 5 Edited remote 
mount point            

/Platform/Storage/RFS/
Edit

cs1=IP_address 
cs1label=Server 
cs2=remote_directo
ry_path 
cs2label=Remote 
directory 
cs3=mount_point 
cs3label=Mount 
point cs4=type 
cs4label=Mount 
type

platform:252 7 Failed to create 
remote mount point       

/Platform/Storage/RFS/F
ailure

cs1=IP_address 
cs1label=Server 
cs2=remote_directo
ry_path 
cs2label=Remote 
directory 
cs3=mount_point 
cs3label=Mount 
point cs4=type 
cs4label=Mount 
type 
cs5=permission 
cs5label=Username

Device Event 
Class ID

Seve
rity

 Message
Device Event 
Category (cat)

Additional Fields 
(listed only if 
applicable)
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platform:253 5 Removed remote 
mount point           

/Platform/Storage/RFS/
Remove

cs1=IP_address 
cs1label=Server 
cs2=fileserver 
cs2label=Remote 
directory 
cs3=trump 
cs3label=Mount 
point cs4=type 
cs4label=Mount 
type

platform:254 5 Destroyed SAN 
Logical Unit            

/Platform/Storage/SAN/
Destroy

cs1=WWW_device 
cs1label=Device 
cs2=WWN_number 
cs2label=WWN 
cs3=WWW_label 
cs3label=Label

platform:255 5 Attached SAN 
Logical Unit            

/Platform/Storage/SAN/
Attach

cs1=WWW_device 
cs1label=Device 
cs2=WWN_number 
cs2label=WWN 
cs3=WWW_label 
cs3label=Label

platform:256 7 Detached SAN 
Logical Unit 

 
/Platform/Storage/SAN/
Detach

cs1=WWW_device 
cs1label=Device 
cs2=WWN_number 
cs2label=WWN 
cs3=WWW_label 
cs3label=Label

platform:257 5 Removed SAN 
Logical Unit       

/Platform/Storage/SAN/
Remove

cs1=WWW_device 
cs1label=Device 
cs2=WWN_number 
cs2label=WWN 
cs3=WWW_label 
cs3label=Label

platform:259 5 Reattached SAN 
Logical Units           

/Platform/Storage/SAN/
Reattach

cs1=WWW_device 
cs1label=Device 
cs2=WWN_number 
cs2label=WWN 
cs3=WWW_label 
cs3label=Label

platform:284 5 Enabled SAN 
Multipathing

/Platform/Storage/Multi
pathing/Enable

platform:285 5 Disabled SAN 
Multipathing

/Platform/Storage/Multi
pathing/Disable

Device Event 
Class ID

Seve
rity

 Message
Device Event 
Category (cat)

Additional Fields 
(listed only if 
applicable)
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platform:260 5 Static route     
modified 

/Platform/Configuration/
Network/Route
/Update

cn2=route_ID 
cn2label=Route ID 
cs1=int_name 
cs1label=Interface 
cs2=dest_IP 
cs2label=Destinatio
n cs3=subnet_mask 
cs3label=Subnet 
cs4=gateway_IP 
cs4label=Gateway

platform:261 5 Static  route  
deleted

/Platform/Configuration/
Network/Routes/
Remove

cn2=route_ID 
cn2label=Route ID 
cs1=int_name 
cs1label=Interface 
cs2=dest_IP 
cs2label=Destinatio
n cs3=subnet_mask 
cs3label=Subnet 
cs4=gateway_IP 
cs4label=Gateway

platform:262 5 Appliance time 
modified

/Platform/Configuration/
Time

platform:263 5 Network settings 
modified       

/Platform/Configuration/
Network

cs1=NIC0_IP_mask 
cs1label=NIC0 
cs2=NIC12_IP_mas
k cs2label=NIC1 
cs4=default_gatewa
y cs4label=Default 
gateway cs5=flag 
cs5label=Multi-
homing

platform:264 5 NTP server settings 
modified              

/Platform/Configuration/
Network/NTP

platform:265 5 DNS settings 
modified       

/Platform/Configuration/
Network/DNS

platform:266 5 Hosts file modified          /Platform/Configuration/
Network/Hosts

platform:267 5 SMTP   settings 
modified           

/Platform/Configuration/
SMTP

cs1=SMTP_IP 
cs1label=SMTP 
Server 
cs2=outgoing_addr
ess 
cs2label=Outgoing 
Address

Device Event 
Class ID

Seve
rity

 Message
Device Event 
Category (cat)

Additional Fields 
(listed only if 
applicable)
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platform:268 5 Static route added            /Platform/Configuration/
Network/Route/Add

cn2=ID 
cn2label=Route ID 
cs1=interface_nam
e cs1label=Interface 
cs2label=Destinatio
n cs3=subnet_mask 
cs3label=Subnet 
cs4=default_gatewa
y 
cs4label=Gateway

platform:270 9 Stopped process 
'<process>'          

/Platform/Process/
Control/Stop

dproc=nullmailer

platform:271 7 Restarted process 
'<process>'       

/Platform/Process/
Control/Restart

dproc=nullmailer

platform:272 5 Started process 
'<process>'          

/Platform/Process/
Control/Start

dproc=nullmailer

platform:280 7 Appliance reboot 
initiated      

/Appliance/State/
Reboot/Initiate

platform:281 3 Appliance reboot 
canceled       

/Appliance/State/
Reboot/Cancel

platform:282 9 Appliance poweroff 
initiated     

/Appliance/State/
Shutdown

platform:300 5 Installed certificate    /Platform/Certificate/
Install

platform:301 5 Installed certificate 
revocation list

/Platform/Certificate/Re
vocation/Install 

platform:302 5 Deleted trusted 
certificate

/Platform/Certificate/Del
ete

platform:303 5 Deleted certificate 
revocation list

/Platform/Certificate/Re
vocation/Delete 

platform:304 7 Failed installing 
trusted certificate

/Platform/Certificate/Ins
tall/Failure

platform:305 7 Failed installing 
certificate 
revocation list

/Platform/Certificate/Re
vocation/Install/Failure

platform:407 7 SSL certificate 
expiration warning

/Platform/Certificate/
SSL/Expiration

deviceCustomDate1
=Expiry_date_time 
deviceCustomDate1
label=Expiration 
Date

platform:306 5 Start process /Platform/Process/Start 

platform:307 5 Stop process /Platform/Process/Stop 

platform:308 5 Restart process /Platform/Process/
Restart 

platform:310 5 Enabled FIPS mode /Platform/Configuration/
FIPS/Enable

Device Event 
Class ID

Seve
rity

 Message
Device Event 
Category (cat)

Additional Fields 
(listed only if 
applicable)
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Logger Application Events
The following table lists the information contained in audit events related to various Logger 
functions and configuration changes on it. The Severity for all Logger application events is 
2.

platform:311 7 Disabled FIPS mode /Platform/Configuration/
FIPS/Disable 

platform:408 5 Appliance startup 
completed

/Appliance/State/
Startup 

platform:530

(software Logger 
only)

5 Authentication 
Session settings 
successfully 
changed

/Platform/Configuration/
Authentication/Sessions/
Success

cs1Label=Paramete
r Changed
cs1=parameter
cn1Label=New 
Value
cn1=newValue
cn2Lable=Old Value
cn2=oldValue

platform:540

(software Logger 
only)

5 Password Lockout 
settings 
successfully 
updated

/Platform/Configuration/
Authentication/Password
/Lockout/Success

cs1Label=Paramete
r Changed
cs1=parameter
cs2Label or 
cn1Label=New 
Value
cs2 or 
cn1=newValue
cs3Label or 
cn2Label=Old Value
cs3 or cn2=oldValue

platform:560

(software Logger 
only)

5 Password Validation 
settings 
successfully 
updated

/Platform/Configuration/
Authentication/Password
/Validation/Success

cs1Label=Paramete
r Changed
cs1=parameter
cs2Label or 
cn1Label=New 
Value
cs2 or 
cn1=newValue
cs3Label or 
cn2Label=Old Value
cs3 or cn2=oldValue

Device Event 
Class ID

Message
Device Event Category 
(cat)

Additional Fields

Filters

logger:500 Filter [filterName] 
has been added

/Logger/Resource/Filter/
Configuration/Add

fname=filterName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=Filter fileId=filterId

Device Event 
Class ID

Seve
rity

 Message
Device Event 
Category (cat)

Additional Fields 
(listed only if 
applicable)
Confidential Administrator’s Guide 545



E Logger Audit Events
logger:501 Filter [filterName] 
has been deleted

/Logger/Resource/Filter/
Configuration/Delete

fname=filterName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=Filter fileId=filterId

logger:502 Filter [filterName] 
has been updated

/Logger/Resource/Filter/
Configuration/Update

fname=filterName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=Filter fileId=filterId

Devices

logger:510 Device 
[deviceName] has 
been added

/Logger/Resource/Device/
Configuration/Add

fname=deviceName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=Device 
fileId=deviceId

logger:511 Device 
[deviceName] has 
been deleted

/Logger/Resource/Device/
Configuration/Delete

fname=deviceName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=Device 
fileId=deviceId

logger:512 Device 
[deviceName] has 
been updated

/Logger/Resource/Device/
Configuration/Update

fname=deviceName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=Device 
fileId=deviceId

Groups

logger:513 Group 
[groupName] has 
been added

/Logger/Resource/Group/
Configuration/Add

fname=groupName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=Group 
fileId=groupId

logger:514 Group 
[groupName] has 
been deleted

/Logger/Resource/Group/
Configuration/Delete

fname=groupName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=Group 
fileId=groupId

Device Event 
Class ID

Message
Device Event Category 
(cat)

Additional Fields
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logger:515 Group 
[groupName] has 
been updated

/Logger/Resource/Group/
Configuration/Update

fname=groupName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=Group 
fileId=groupId

Archives

logger:520 Archive 
[archiveName] has 
been added

/Logger/Resource/Archive/
Configuration/Add

fname=archiveName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=EventArchive 
fileId=archiveId

logger:521 Archive 
[archiveName] has 
been deleted

/Logger/Resource/Archive/
Configuration/Delete

fname=archiveName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=EventArchive 
fileId=archiveId

logger:523 Archive 
[archiveName] has 
been loaded

/Logger/Resource/Archive/
Configuration/Load

fname=archiveName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=EventArchive 
fileId=archiveId

logger:524 Archive 
[archiveName] has 
been unloaded

/Logger/Resource/Archive/
Configuration/Unload

fname=archiveName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=EventArchive 
fileId=archiveId

logger:525 Archive 
[archiveName] has 
been archived

/Logger/Resource/Archive/
Configuration/Archive

fname=archiveName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=EventArchive 
fileId=archiveId

logger:526 Event archive 
settings added

/Logger/Resource/Archive/
Add

fname=archiveName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=EventArchive 
fileId=archiveId

Device Event 
Class ID

Message
Device Event Category 
(cat)

Additional Fields
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logger:527 Daily archive task 
settings updated

/Logger/Resource/Archive/
Update

fname=archiveName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=EventArchive 
fileId=archiveId

logger:528 Event archive 
failed

/Logger/Resource/Archive/
Failed

fname=archiveName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=EventArchive 
fileId=archiveId

Storage Groups

logger:530 Storage group 
[storageGroupNam
e] has been added

/Logger/Resource/
StorageGroup/Configuration
/Add

fname=storageGroupName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=Storage Group 
fileId=storageGroupId

logger:532 Storage group 
[storageGroupNam
e] has been 
updated

/Logger/Resource/
StorageGroup/Configuration
/Update

fname=storageGroupName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=Storage Group 
fileId=storageGroupId

Storage Rule

logger:533 Storage rule 
[name] has been 
added

/Logger/Resource/
StorageRule/Configuration/
Add

fname=storageRuleName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=Storage Rule

logger:535 Storage rule 
[name] has been 
updated

/Logger/Resource/
StorageRule/Configuration/
Update

fname=storageRuleName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=Storage Rule

Storage Volume

logger:536 Storage volume 
[name] has been 
added

/Logger/Resource/
StorageVolume/
Configuration/Add

fname=storageVolumeNam
e duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=Storage Volume 
fileId=storageVolumeId

Device Event 
Class ID

Message
Device Event Category 
(cat)

Additional Fields
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Saved Search

logger:540 Saved search 
[name] has been 
added

/Logger/Resource/
SavedSearch/Configuration/
Add

fname=savedSearchName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=Saved Search 
fileId=savedSearchId

logger:541 Saved search 
[name] has been 
deleted

/Logger/Resource/
SavedSearch/Configuration/
Delete

fname=savedSearchName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=Saved Search 
fileId=savedSearchId

logger:542 Saved search 
[name] has been 
updated

/Logger/Resource/
SavedSearch/Configuration/
Update

fname=savedSearchName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=Saved Search 
fileId=savedSearchId

 Loggers

logger:550  Logger [name] 
has been added

/Logger/Resource/
Logger/Configuration
/Add

fname=Name 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType= Logger 
fileId=LoggerId

logger:551  Logger [name] 
has been deleted

/Logger/Resource/
Logger/Configuration/
Delete

fname=Name 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType= Logger 
fileId=LoggerId

logger:570  Logger 
authorization 
[name] has been 
added

/Logger/Resource/
Logger/Authorizations/Confi
guration/Add

fname=Name 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType= Logger 
Authorization

logger:571  Logger 
authorization 
[name] has been 
deleted

/Logger/Resource/
Logger/Authorizations/Confi
guration/Delete

fname=Name 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType= Logger 
Authorization 
fileId=LoggerId

Device Event 
Class ID

Message
Device Event Category 
(cat)

Additional Fields
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Event Input/Output

logger:600 Receiver [name] 
has been added

/Logger/Component/
Receiver/Configuration/Add

fname=receiverName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=receiverType 
dvc=receiverIpAddr 
dvchost=receiverHostName 
cn1Label=Receiver Port 
cn1=receiverPort

logger:601 Receiver [name] 
has been deleted

/Logger/Component/
Receiver/Configuration/
Delete

fname=receiverName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=receiverType 
dvc=receiverIpAddr 
dvchost=receiverHostName 
cn1Label=Receiver Port 
cn1=receiverPort

logger:602 Receiver [name] 
has been updated

/Logger/Component/
Receiver/Configuration/
Update

fname=receiverName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=receiverType 
dvc=receiverIpAddr 
dvchost=receiverHostName 
cn1Label=Receiver Port 
cn1=receiverPort

logger:603 Receiver [name] 
has been enabled

/Logger/Component/
Receiver/Configuration/
Enable

fname=receiverName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=receiverType 
dvc=receiverIpAddr 
dvchost=receiverHostName 
cn1Label=Receiver Port 
cn1=receiverPort

logger:604 Receiver [name] 
has been disabled

/Logger/Component/
Receiver/Configuration/
Disable

fname=receiverName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=receiverType 
dvc=receiverIpAddr 
dvchost=receiverHostName 
cn1Label=Receiver Port 
cn1=receiverPort

Device Event 
Class ID

Message
Device Event Category 
(cat)

Additional Fields
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logger:605 Forwarder [name] 
has been added

/Logger/Component
/Forwarder/Configuration/
Add

fname=forwarderName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=forwarderType 
dvc=forwarderIpAddr 
dvchost=forwarderHostNam
e cn1Label=Forwarder Port 
cn1=forwarderPort 
cs1Label=Forwarder Filter 
cs1=forwarderFilter

logger:606 Forwarder [name] 
has been deleted

/Logger/Component/
Forwarder/Configuration/
Delete

fname=forwarderName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=forwarderType 
dvc=forwarderIpAddr 
dvchost=forwarderHostNam
e cn1Label=Forwarder Port 
cn1=forwarderPort 
cs1Label=Forwarder Filter 
cs1=forwarderFilter

logger:607 Forwarder [name] 
has been updated

/Logger/Component/
Forwarder/Configuration/
Update

fname=forwarderName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=forwarderType 
dvc=forwarderIpAddr 
dvchost=forwarderHostNam
e cn1Label=Forwarder Port 
cn1=forwarderPort 
cs1Label=Forwarder Filter 
cs1=forwarderFilter

logger:608 Forwarder [name] 
has been enabled

/Logger/Component/
Forwarder/Configuration/
Enable

fname=forwarderName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=forwarderType 
dvc=forwarderIpAddr 
dvchost=forwarderHostNam
e cn1Label=Forwarder Port 
cn1=forwarderPort 
cs1Label=Forwarder Filter 
cs1=forwarderFilter

Device Event 
Class ID

Message
Device Event Category 
(cat)

Additional Fields
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logger:609 Forwarder [name] 
has been disabled

/Logger/Component/
Forwarder/Configuration/
Disable

fname=forwarderName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=forwarderType 
dvc=forwarderIpAddr 
dvchost=forwarderHostNam
e cn1Label=Forwarder Port 
cn1=forwarderPort 
cs1Label=Forwarder Filter 
cs1=forwarderFilter

logger:663 Forwarder [name] 
has been paused

/Logger/Component/
Forwarder/Configuration/
Pause

fname=forwarderName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=forwarderType 
dvc=forwarderIpAddr 
dvchost=forwarderHostNam
e cn1Label=Forwarder Port 
cn1=forwarderPort 
cs1Label=Forwarder Filter 
cs1=forwarderFilter

logger:664 Forwarder [name] 
has been resumed

/Logger/Component/
Forwarder/Configuration/
Resume

fname=forwarderName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=forwarderType 
dvc=forwarderIpAddr 
dvchost=forwarderHostNam
e cn1Label=Forwarder Port 
cn1=forwarderPort 
cs1Label=Forwarder Filter 
cs1=forwarderFilter

logger:640 ESM destination 
[name] has been 
added

/Logger/Component/
EsmDestination/
Configuration/Add

fname=esmDestinationNam
e duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=ESM Destination 
fileId=esmDestinationId 
dvc=esmDestinationIp 
dvchost=esmDestinationHo
st cn1Label=ESM 
Destination Port 
cn1=esmDestinationPort 
cs1Label=Connector Name 
cs1=connectorName 
cs2Label=Connector 
Location 
cs2=connectorLocation 
cs3Label=Logger Location 
cs3=loggerLocation

Device Event 
Class ID

Message
Device Event Category 
(cat)

Additional Fields
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logger:641 ESM destination 
[name] has been  
deleted

/Logger/Component/
EsmDestination/
Configuration/Delete

fname=esmDestinationNam
e duser=username 
duid=userId cs4=sessionId 
file cs4Label=Session ID 
fileType=ESM Destination 
fileId=esmDestinationId 
dvc=esmDestinationIp 
dvchost=esmDestinationHo
st cn1Label=ESM 
Destination Port 
cn1=esmDestinationPort 
cs1Label=Connector Name 
cs1=connectorName 
cs2Label=Connector 
Location 
cs2=connectorLocation 
cs3Label=Logger Location 
cs3=loggerLocation

logger:643 Certificate [name] 
has been added

/Logger/Component/
Certificate/Configuration/
Add

fname=alias 
duser=username 
duid=userId cs4=sessionId 
cs4Label=Session ID 
fileType=Certificate

logger:650 Certificate [name] 
has been deleted

/Logger/Component/
Certificate/Configuration/
Delete

fname=alias 
duser=username 
duid=userId cs4=sessionId 
cs4Label=Session ID 
fileType=Certificate

logger:651 Certificate [name] 
has been updated

/Logger/Component/
Certificate/Configuration/
Update

fname=alias 
duser=username 
duid=userId cs4=sessionId 
cs4Label=Session ID 
fileType=Certificate

logger:644 SNMP destination 
[name] has been 
added

/Logger/Component/
SnmpDestination/
Configuration/Add

fname=snmpDestinationNa
me duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=SNMP Destination 
fileId=snmpDestinationId 
dvc=snmpDestinationIp 
dvchost=snmpDestinationH
ost cn1Label=SNMP 
Destination Port 
cn1=snmpDestinationPort 
cs1Label=Connector Name 
cs1=connectorName 
cs2Label=Connector 
Location 
cs2=connectorLocation 
cs3Label=Logger Location 
cs3=loggerLocation

Device Event 
Class ID

Message
Device Event Category 
(cat)

Additional Fields
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logger:645 SNMP destination 
[name] has been  
deleted

/Logger/Component/
SnmpDestination/
Configuration/Delete

fname=snmpDestinationNa
me duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=SNMP Destination 
fileId=snmpDestinationId 
dvc=snmpDestinationIp 
dvchost=snmpDestinationH
ost cn1Label=SNMP 
Destination Port 
cn1=snmpDestinationPort 
cs1Label=Connector Name 
cs1=connectorName 
cs2Label=Connector 
Location 
cs2=connectorLocation 
cs3Label=Logger Location 
cs3=loggerLocation

logger:647 Syslog destination 
[name] has been 
added

/Logger/Resource/
SyslogDestination/
Configuration/Add

fname=syslogDestinationNa
me duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=Syslog Destination 
fileId=syslogDestinationId 
dvc=syslogDestinationIp 
dvchost=syslogDestination
Host cn1Label=Syslog 
Destination Port 
cn1=syslogDestinationPort

logger:648 Syslog destination 
[name] has been 
deleted

/Logger/Component/
SyslogDestination/
Configuration/Delete

fname=syslogDestinationNa
me duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=Syslog Destination 
fileId=syslogDestinationId 
dvc=syslogDestinationIp 
dvchost=syslogDestination
Host cn1Label=Syslog 
Destination Port 
cn1=syslogDestinationPort

logger:649 Syslog destination 
[name] has been 
updated

/Logger/Component/Syslog
Destination/Configuration/
Update

fname=syslogDestinationNa
me duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=Syslog Destination 
fileId=syslogDestinationId 
dvc=syslogDestinationIp 
dvchost=syslogDestination
Host cn1Label=Syslog 
Destination Port 
cn1=syslogDestinationPort

Device Event 
Class ID

Message
Device Event Category 
(cat)

Additional Fields
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Alerts

logger:610 Alert [name] has 
been added

/Logger/Component/Alert/
Configuration/Add

fname=alertName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=forwarderType 
dvc=syslogOrSnmpIpAddr 
dvchost=syslogOrSnmpHost
Name cn1Label=Syslogor 
SNMP Destination Port 
cn1=syslogOrSnmpPort 
cs1Label=Filter cs1=filter 
cs2Label=Email 
Destination(s) 
cs2=emailAddresses

logger:611 Alert [name] has 
been deleted

/Logger/Component/Alert/
Configuration/Delete

fname=alertName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=forwarderType 
dvc=syslogOrSnmpIpAddr 
dvchost=syslogOrSnmpHost
Name cn1Label=Syslogor 
SNMP Destination Port 
cn1=syslogOrSnmpPort 
cs1Label=Filter cs1=filter 
cs2Label=Email 
Destination(s) 
cs2=emailAddresses

logger:612 Alert [name] has 
been updated

/Logger/Component/Alert/
Configuration/Update

fname=alertName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=forwarderType 
dvc=syslogOrSnmpIpAddr 
dvchost=syslogOrSnmpHost
Name cn1Label=Syslogor 
SNMP Destination Port 
cn1=syslogOrSnmpPort 
cs1Label=Filter cs1=filter 
cs2Label=Email 
Destination(s) 
cs2=emailAddresses

Device Event 
Class ID

Message
Device Event Category 
(cat)

Additional Fields
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logger:613 Alert [name] has 
been enabled

/Logger/Component/Alert/
Configuration/Enable

fname=alertName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=forwarderType 
dvc=syslogOrSnmpIpAddr 
dvchost=syslogOrSnmpHost
Name cn1Label=Syslogor 
SNMP Destination Port 
cn1=syslogOrSnmpPort 
cs1Label=Filter cs1=filter 
cs2Label=Email 
Destination(s) 
cs2=emailAddresses

logger:614 Alert [name] has 
been disabled

/Logger/Component/Alert/
Configuration/Disable

fname=alertName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=forwarderType 
dvc=syslogOrSnmpIpAddr 
dvchost=syslogOrSnmpHost
Name cn1Label=Syslogor 
SNMP Destination Port 
cn1=syslogOrSnmpPort 
cs1Label=Filter cs1=filter 
cs2Label=Email 
Destination(s) 
cs2=emailAddresses

logger:615 Alert [name] has 
been sent

/Logger/Component/Alert/
Configuration/Sent

fname=alertName 
duser=username 
duid=userId 
cs4=sessionIdfile 
cs4Label=Session ID 
fileType=forwarderType 
dvc=syslogOrSnmpIpAddr 
dvchost=syslogOrSnmpOrE
smHostName 
cn1Label=SyslogoOrSnmpO
rEsmDestination Port 
cn1=syslogOrSnmpOrEsmP
ort cs1Label=Filter 
cs1=filter cs2Label=Email 
Destination(s) 
cs2=emailAddresses

Configuration Backup

logger:660 Configuration 
backup has been 
updated

/Logger/Component/
ConfigBackup/Configuration
/Update

fname=Configuration 
Backup duser=username 
duid=userId cs4=sessionId 
cs4Label=Session ID 
fileType=Configuration 
Backup

Device Event 
Class ID

Message
Device Event Category 
(cat)

Additional Fields
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logger:661 Configuration 
backup has been 
enabled

/Logger/Component/
ConfigBackup/Configuration
/Enable

fname=Configuration 
Backup duser=username 
duid=userId cs4=sessionId 
cs4Label=Session ID 
fileType=Configuration 
Backup

logger:662 Configuration 
backup has been 
disabled

/Logger/Component/
ConfigBackup/Configuration
/Disable

fname=Configuration 
Backup duser=username 
duid=userId cs4=sessionId 
cs4Label=Session ID 
fileType=Configuration 
Backup

Search

logger:680 Search indices 
have been added

OR

Search index has 
been added

/Logger/Search/Index/
Update

logger:690 Search options 
have been updated

/Logger/Search/Options/
Update

Maintenance Mode

logger:700 Maintenance mode 
entered

/Logger/Server/
MaintenanceMode/
Enter

fname=Maintenance Mode 
duser=username 
duid=userId cs4=sessionId 
cs4Label=Session ID 
fileType=Maintenance Mode

Device Event 
Class ID

Message
Device Event Category 
(cat)

Additional Fields
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Appendix F

Examples of System Health Events

The following table provides examples of system health events generated on Logger. These 
examples are intended to help you understand the format and various fields of the 
generated events.

Device Event 
Class ID

Example

hardware:101 CEF:0|ArcSight|Logger|5.1.0.5784.0|hardware:101|Electrical (Current) 
OK|1| cat=/Monitor/Sensor/Current/Ok cs1=0.80 Amps cs1Label=Raw Value 
cs2=CurrentValue cs2Label=timeframe cs3=Ok cs3Label=Status cs4=ok 
cs4Label=Raw Status cs5=10.2 (Power Supply) cs5Label=Location 
cs6=Current 2 cs6Label=Sensor Name dst=192.168.36.5 dvc=192.168.36.5 
end=1303937520837 rt=1303937520837

hardware:102 CEF:0|ArcSight|Logger|5.1.0.5776.0|hardware:102|Electrical (Current) 
Degraded|5| cat=/Monitor/Sensor/Current/Degraded cs1=126 Watts 
cs1Label=Raw Value cs2=CurrentValue cs2Label=timeframe cs3=Degraded 
cs3Label=Status cs4=lnc cs4Label=Raw Status cs5Label=Location 
cs6=Power Meter cs6Label=Sensor Name dst=192.168.36.37 
dvc=192.168.36.37 end=1302817019262 rt=1302817019262 

hardware:103 CEF:0|ArcSight|Logger|5.1.0.5776.0|hardware:103|Electrical (Current) 
Failed|8| cat=/Monitor/Sensor/Current/Failed cs1=126 Watts cs1Label=Raw 
Value cs2=CurrentValue cs2Label=timeframe cs3=Failed cs3Label=Status 
cs4=lcr cs4Label=Raw Status cs5Label=Location cs6=Power Meter 
cs6Label=Sensor Name dst=192.168.36.37 dvc=192.168.36.37 
end=1302817019262 rt=1302817019262 

hardware:111 CEF:0|ArcSight|Logger|5.1.0.5780.0|hardware:111|Electrical (Voltage) 
OK|1| cat=/Monitor/Sensor/Voltage/Ok cs1=State Deasserted cs1Label=Raw 
Value cs2=CurrentValue cs2Label=timeframe cs3=Ok cs3Label=Status 
cs4=ok cs4Label=Raw Status cs5=3.1 (Processor) cs5Label=Location 
cs6=VCORE cs6Label=Sensor Name dst=192.168.35.115 
dvc=192.168.35.115 end=1302819047959 rt=1302819047959

hardware:112 CEF:0|ArcSight|Logger|5.1.0.5780.0|hardware:112|Electrical (Voltage) 
Degraded|5| cat=/Monitor/Sensor/Voltage/Degraded cs1=State Deasserted 
cs1Label=Raw Value cs2=CurrentValue cs2Label=timeframe cs3=Degraded 
cs3Label=Status cs4=lnc cs4Label=Raw Status cs5=3.1 (Processor) 
cs5Label=Location cs6=VCORE cs6Label=Sensor Name dst=192.168.35.115 
dvc=192.168.35.115 end=1302819047959 rt=1302819047959

hardware:113 CEF:0|ArcSight|Logger|5.1.0.5780.0|hardware:113|Electrical (Voltage) 
Failed|8| cat=/Monitor/Sensor/Voltage/Failed cs1=State Deasserted 
cs1Label=Raw Value cs2=CurrentValue cs2Label=timeframe cs3=Failed 
cs3Label=Status cs4=lcr cs4Label=Raw Status cs5=3.1 (Processor) 
cs5Label=Location cs6=VCORE cs6Label=Sensor Name dst=192.168.35.115 
dvc=192.168.35.115 end=1302819047959 rt=1302819047959
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hardware:121 CEF:0|ArcSight|Logger|5.1.0.5803.0|hardware:121|Battery OK|1| 
cat=/Monitor/Sensor/Battery/Ok cs1= cs1Label=Raw Value 
cs2=CurrentValue cs2Label=timeframe cs3=Ok cs3Label=Status cs4=ok 
cs4Label=Raw Status cs5=7.1 (System Board) cs5Label=Location cs6=CMOS 
Battery cs6Label=Sensor Name dst=192.168.35.115 dvc=192.168.35.115 
end=1303937972008 rt=1303937972008

hardware:122 CEF:0|ArcSight|Logger|5.1.0.5803.0|hardware:122|Battery Degraded|5| 
cat=/Monitor/Sensor/Battery/Degraded cs1= cs1Label=Raw Value 
cs2=CurrentValue cs2Label=timeframe cs3=Degraded cs3Label=Status 
cs4=lnc cs4Label=Raw Status cs5=7.1 (System Board) cs5Label=Location 
cs6=CMOS Battery cs6Label=Sensor Name dst=192.168.35.115 
dvc=192.168.35.115 end=1303937972008 rt=1303937972008

hardware:123 CEF:0|ArcSight|Logger|5.1.0.5803.0|hardware:123|Battery Failed|8| 
cat=/Monitor/Sensor/Battery/Degraded cs1= cs1Label=Raw Value 
cs2=CurrentValue cs2Label=timeframe cs3=Failed cs3Label=Status cs4=lcr 
cs4Label=Raw Status cs5=7.1 (System Board) cs5Label=Location cs6=CMOS 
Battery cs6Label=Sensor Name dst=192.168.35.115 dvc=192.168.35.115 
end=1303937972008 rt=1303937972008

hardware:131 CEF:0|ArcSight|Logger|5.1.0.5780.0|hardware:131|Fan OK|1| 
cat=/Monitor/Sensor/Fan/Ok cs1=29.01 unspecified cs1Label=Raw Value 
cs2=CurrentValue cs2Label=timeframe cs3=Ok cs3Label=Status cs4=lnc 
cs4Label=Raw Status cs5=7.1 (System Board) cs5Label=Location cs6=Fan 
Block 1 cs6Label=Sensor Name dst=192.168.37.21 dvc=192.168.37.21 
end=1302823237825 rt=1302823237825

hardware:132

hardware:133 CEF:0|ArcSight|Logger|5.1.0.5780.0|hardware:133|Fan Failure|8| 
cat=/Monitor/Sensor/Fan/Failed cs1=29.01 unspecified cs1Label=Raw Value 
cs2=CurrentValue cs2Label=timeframe cs3=Failed cs3Label=Status cs4=lcr 
cs4Label=Raw Status cs5=7.1 (System Board) cs5Label=Location cs6=Fan 
Block 1 cs6Label=Sensor Name dst=192.168.37.21 dvc=192.168.37.21 
end=1302823237825 rt=1302823237825

hardware:141 CEF:0|ArcSight|Logger|5.1.0.5803.0|hardware:141|Power Supply OK|1| 
cat=/Monitor/Sensor/PowerSupply/Ok cs1= cs1Label=Raw Value 
cs2=CurrentValue cs2Label=timeframe cs3=Ok cs3Label=Status cs4=ok 
cs4Label=Raw Status cs5=10.1 (Power Supply) cs5Label=Location 
cs6=Status cs6Label=Sensor Name dst=192.168.35.115 
dvc=192.168.35.115 end=1303938572149 rt=1303938572149

hardware:142

hardware:143 CEF:0|ArcSight|Logger|5.1.0.5776.0|hardware:143|Power Supply Failed|8| 
cat=/Monitor/Sensor/PowerSupply/Failed cs1=0 Watts cs1Label=Raw Value 
cs2=CurrentValue cs2Label=timeframe cs3=Failed cs3Label=Status cs4=lcr 
cs4Label=Raw Status cs5=10.2 (Power Supply) cs5Label=Location 
cs6=Power Supply 2 cs6Label=Sensor Name dst=192.168.36.37 
dvc=192.168.36.37 end=1302817019263 rt=1302817019263

hardware:151 CEF:0|ArcSight|Logger|5.1.0.5776.0|hardware:151|Temperature OK|1| 
cat=/Monitor/Sensor/Temperature/Ok cs1=17 degrees C cs1Label=Raw 
Value cs2=CurrentValue cs2Label=timeframe cs3=Ok cs3Label=Status 
cs4=ok cs4Label=Raw Status cs5=64.1 (Unknown (0x40)) 
cs5Label=Location cs6=Temp 1 cs6Label=Sensor Name dst=192.168.36.37 
dvc=192.168.36.37 end=1302823560051 rt=1302823560051

hardware:152

hardware:153

Device Event 
Class ID

Example
560 Administrator’s Guide Confidential



F Examples of System Health Events
raid:101 CEF:0|ArcSight|Logger|5.1.0.5780.0|raid:101|RAID Controller OK|1| 
cat=/Monitor/RAID/Controller/Ok cs1=Type: RAID-5 cs1Label=Raw Value 
cs2=CurrentValue cs2Label=timeframe cs3=Ok cs3Label=Status 
cs4=Optimal cs4Label=Raw Status cs5=RAIDController/Configuration 
cs5Label=Location cs6=RAIDController/Configuration cs6Label=Sensor Name 
dst=192.168.35.115 dvc=192.168.35.115 end=1302886250104 
rt=1302886250104

raid:102 CEF:0|ArcSight|Logger|5.1.0.5780.0|raid:102|RAID Controller Degraded|5| 
cat=/Monitor/RAID/ControllerDegraded cs1=Type: RAID-5 Critical Disks: 0  
Failed Disks: 0  cs1Label=Raw Value cs2=CurrentValue cs2Label=timeframe 
cs3=Degraded cs3Label=Status cs4=Degraded cs4Label=Raw Status 
cs5=RAIDController/Configuration cs5Label=Location 
cs6=RAIDController/Configuration cs6Label=Sensor Name 
dst=192.168.35.115 dvc=192.168.35.115 end=1302826128482 
rt=1302826128482

raid:103

raid:111 CEF:0|ArcSight|Logger|5.1.0.5776.0|raid:111|RAID BBU OK|1| 
cat=/Monitor/RAID/BBU/Ok cs1=Battery/Capacitor Count: 1 cs1Label=Raw 
Value cs2=CurrentValue cs2Label=timeframe cs3=Ok cs3Label=Status 
cs4=OK cs4Label=Raw Status cs5=RAIDController/Battery/bbu 
cs5Label=Location cs6=RAIDController/Battery/bbu cs6Label=Sensor Name 
dst=192.168.36.37 dvc=192.168.36.37 end=1302890169285 
rt=1302890169285

raid:112 CEF:0|ArcSight|Logger|5.1.0.5780.0|raid:112|RAID BBU Degraded|5| 
cat=/Monitor/RAID/BBU/Degraded cs1=Fully Charged: false Remaining Time 
Alarm: false Remaining Capacity Alarm: false Over Charged: false 
isSOHGood: true cs1Label=Raw Value cs2=CurrentValue 
cs2Label=timeframe cs3=Degraded cs3Label=Status cs4=Degraded 
cs4Label=Raw Status cs5=RAIDController/Battery/bbu cs5Label=Location 
cs6=RAIDController/Battery/bbu cs6Label=Sensor Name 
dst=192.168.35.115 dvc=192.168.35.115 end=1302820608015 
rt=1302820608015

raid:113

raid:121 CEF:0|ArcSight|Logger|5.1.0.5780.0|raid:121|RAID Disk OK|1| 
cat=/Monitor/RAID/DISK/Ok cs1=Port: 1I Box: 1 Bay: 1 Size: 500 GB Serial 
Number: 9SP24JD5 cs1Label=Raw Value cs2=CurrentValue 
cs2Label=timeframe cs3=Ok cs3Label=Status cs4=OK cs4Label=Raw Status 
cs5=Port: 1I Box: 1 Bay: 1 Serial Number: 9SP24JD5 cs5Label=Location 
cs6=RAIDController/Port/p0 cs6Label=Sensor Name dst=192.168.37.21 
dvc=192.168.37.21 end=1302849041777 rt=1302849041777

raid:122 CEF:0|ArcSight|Logger|5.1.0.5776.0|raid:122|RAID Disk Rebuilding|5| 
cat=/Monitor/RAID/DISK/Rebuilding cs1=Port: 2I Box: 1 Bay: 1 Size: 1 TB 
Serial Number: WMATV6348517 cs1Label=Raw Value cs2=CurrentValue 
cs2Label=timeframe cs3=Rebuilding cs3Label=Status cs4=Rebuilding 
cs4Label=Raw Status cs5=Port: 2I Box: 1 Bay: 1 Serial Number: 
WMATV6348517 cs5Label=Location cs6=RAIDController/Port/p0 
cs6Label=Sensor Name dst=192.168.36.37 dvc=192.168.36.37 
end=1302826980530 rt=1302826980530

Device Event 
Class ID

Example
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raid:123 CEF:0|ArcSight|Logger|5.1.0.5780.0|raid:123|RAID Disk Failed|8| 
cat=/Monitor/RAID/DISK/Failed cs1=Port: 1I Box: 1 Bay: 2 Size: 500 GB 
Serial Number: 9SP23M08 cs1Label=Raw Value cs2=CurrentValue 
cs2Label=timeframe cs3=Failed cs3Label=Status cs4=Failed cs4Label=Raw 
Status cs5=Port: 1I Box: 1 Bay: 2 Serial Number: 9SP23M08 
cs5Label=Location cs6=RAIDController/Port/p1 cs6Label=Sensor Name 
dst=192.168.37.21 dvc=192.168.37.21 end=1302826358346 
rt=1302826358346

network:100 CEF:0|ArcSight|Logger|5.1.0.5780.0|network:100|Network Usage - 
Inbound|1| cat=/Monitor/Network/Usage/In cn1=41837428 cn1Label=Bytes 
Received cs2=SinceStartup cs2Label=timeframe cs6=eth0 
cs6Label=Interface Name dst=192.168.35.115 dvc=192.168.35.115 
end=1302733620026 rt=1302733620026

network:101 CEF:0|ArcSight|Logger|5.1.0.5780.0|network:101|Network Usage - 
Outbound|1| cat=/Monitor/Network/Usage/Out cn1=158442791 
cn1Label=Bytes Sent cs2=SinceStartup cs2Label=timeframe cs6=eth0 
cs6Label=Interface Name dst=192.168.35.115 dvc=192.168.35.115 
end=1302733620028 rt=1302733620028

memory:100 CEF:0|ArcSight|Logger|5.1.0.5780.0|memory:100|Platform Memory 
Usage|1| cat=/Monitor/Memory/Usage/Platform cn1=2757 cn1Label=MB 
Used cs2=CurrentValue cs2Label=timeframe dst=192.168.35.115 
dvc=192.168.35.115 end=1302797940018 rt=1302797940018

cpu:100 CEF:0|ArcSight|Logger|5.1.0.5780.0|cpu:100|CPU Usage|1| 
cat=/Monitor/CPU/Usage cn1=3 cn1Label=Percent Usage cs2=CurrentValue 
cs2Label=timeframe dst=192.168.35.115 dvc=192.168.35.115 
end=1302739080014 rt=1302739080014

disk:101 CEF:0|ArcSight|Logger|5.1.0.5803.0|disk:101|Root Disk Space 
Remaining|1| cat=/Monitor/Disk/Space/Remaining/Root cn1=99 
cn1Label=Percent Available cs2=CurrentValue cs2Label=timeframe cs3=Ok 
cs3Label=Status cs4=Ok cs4Label=Raw Status cs5=Root cs5Label=Location 
cs6=Disk/Space/Remaining/Root cs6Label=Sensor Name 
dst=192.168.35.115 dvc=192.168.35.115 end=1303927171790 
rt=1303927171790

disk:102 CEF:0|ArcSight|Logger|5.1.0.5780.0|disk:102|Disk bytes read|1| 
cat=/Monitor/Disk/Read cn1=373524 cn1Label=Kb Read cs2=SinceStartup 
cs2Label=timeframe cs6=c0d0 cs6Label=Partition Name 
dst=192.168.35.115 dvc=192.168.35.115 end=1302743760036 
rt=1302743760036

disk:103 CEF:0|ArcSight|Logger|5.1.0.5780.0|disk:103|Disk bytes written|1| 
cat=/Monitor/Disk/Write cn1=24474998 cn1Label=Kb Written 
cs2=SinceStartup cs2Label=timeframe cs6=c0d0 cs6Label=Partition Name 
dst=192.168.35.115 dvc=192.168.35.115 end=1302743760038 
rt=1302743760038

eps:100 CEF:0|ArcSight|Logger|5.1.0.5780.0|eps:100|Overall Receiver EPS|1| 
cat=/Monitor/Receiver/All/EPS cn1=0 cn1Label=EPS 
cs2=SinceLastMonitorEvent cs2Label=timeframe dst=192.168.35.115 
dvc=192.168.35.115 end=1302733680034 rt=1302733680034

eps:101 CEF:0|ArcSight|Logger|5.1.0.5780.0|eps:101|Overall Forwarder EPS|1| 
cat=/Monitor/Forwarder/All/EPS cn1=0 cn1Label=EPS 
cs2=SinceLastMonitorEvent cs2Label=timeframe dst=192.168.35.115 
dvc=192.168.35.115 

Device Event 
Class ID

Example
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eps:102 CEF:0|ArcSight|Logger|5.1.0.5803.0|eps:102|Individual Receiver EPS|1| 
cat=/Monitor/Receiver/EPS/Individual cn1=0 cn1Label=EPS cs1=N/A 
cs1Label=Receiver Type cs2=SinceLastMonitorEvent cs2Label=timeframe 
cs6=udp514 cs6Label=name dst=192.168.35.115 dvc=192.168.35.115 
end=1303927500046 rt=1303927500046

eps:103 CEF:0|ArcSight|Logger|5.1.0.5780.0|eps:103|Individual Forwarder EPS|1| 
cat=/Monitor/Forwarder/One/EPS cn1=0 cn1Label=EPS cs1=N/A 
cs1Label=Forwarder Type cs2=SinceLastMonitorEvent cs2Label=timeframe 
cs6=esm cs6Label=name dst=192.168.35.115 dvc=192.168.35.115 
end=1302733080052 rt=1302733080052

search:100 CEF:0|ArcSight|Logger|5.1.0.5780.0|search:100|Number of Searches 
Performed|1| cat=/Monitor/Search cn1=0 cn1Label=Number of Searches 
cs2=SinceStartup cs2Label=timeframe dst=192.168.35.115 
dvc=192.168.35.115 end=1302741300026 rt=1302741300026

storagegroup:
100

CEF:0|ArcSight|Logger|5.1.0.5803.0|storagegroup:100|Storage Group 
Space Used|1| cat=/Monitor/StorageGroup/Space/Used cn1=1 
cn1Label=Percent Used cn2=7 cn2Label=retention period (days) cn3=1024 
cn3Label=used (MB) cs2=CurrentValue cs2Label=timeframe 
dst=192.168.35.115 dvc=192.168.35.115 end=1303928072008 
fileType=storageGroup fname=Default Storage Group fsize=1534 
rt=1303928072008

Device Event 
Class ID

Example
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Appendix G

Destination Runtime Parameters 

The following table describes the destination parameters you can configure. The 
parameters listed in the table are not available for all destinations. The user interface 
automatically displays the parameters valid for a destination. For step-by-step instructions 
on updating the runtime parameters of a destination, see “Editing Destination Parameters” 

on page 459. 

Name Fields Value Fields

Batching Connectors can batch events to increase performance and optimize 
network bandwidth. When activated, connectors create blocks of 
events and send them when they either (1) reach a certain size or 
(2) the time window expires, whichever occurs first. You can also 
prioritize batches by severity, forcing the connector to send the 
highest-severity event batches first and the lowest-severity event 
batches later.

Enable Batching (per event) Create batches of events of this specified size (5, 10, 20, 50, 100, 
200, 300 events).

Enable Batching (in 
seconds)

The connector sends the events if this time window expires (1, 5, 
10, 15, 30, 60).

Batch By This is Time Based if the connector should send batches as they 
arrive (the default) or Severity Based if the connector should send 
batches based on severity (batches of Highest Severity events sent 
first).

Time Correction The values you set for these fields establish forward and backward 
time limits, that if exceeded, cause the connector to automatically 
correct the time reported by the device.

Use Connector Time as 
Device Time

Override the time the device reports and instead use the time at 
which the connector received the event. This option assumes that 
the connector will be more likely to report the correct time. (No | 
Yes)

Enable Device Time 
Correction (in seconds)

The connector can adjust the time reported by the device Detect 
Time, using this setting. This is useful when a remote device's clock 
isn't synchronized with the ArcSight ESM Manager. This should be a 
temporary setting. The recommended way to synchronize clocks 
between Manager and devices is the NTP protocol. The default is 0.

Enable Connector Time 
Correction (in seconds)

The connector can also adjust the time reported by the connector 
itself, using this setting. This is for informational purposes only and 
allows you to modify the local time on the connector. This should be 
a temporary setting. The recommended way to synchronize clocks 
between Manager and connectors is the NTP protocol. The default is 
0.
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Set Device Time Zone To Ordinarily, it is presumed that the original device is reporting its time 
zone along with its time. And if not, it is then presumed that the 
connector is doing so. If this is not true, or the device isn't reporting 
correctly, you can switch this option from Disabled to GMT or to a 
particular world time zone. That zone is then applied to the time 
reported. Default: Disabled.

Device Time Auto-
correction

Future Threshold The connector sends the internal alert if the detect time is greater 
than the connector time by Past Threshold seconds.

Past Threshold The connector sends the internal alert if the detect time is earlier 
than the connector time by Past Threshold seconds.

Device List A comma-separated list of the devices to which the thresholds apply. 
The default, (ALL), means all devices.

Time Checking These are the time span and frequency factors for doing device-time 
auto-correction.

Future Threshold The number of seconds by which to extend the connector's forward 
threshold for time checking. The default is 5 minutes (300 
seconds).

Past Threshold The number of seconds by which to extend the connector's rear 
threshold for time checking. Default is 1 hour (3,600 seconds).

Frequency The connector checks its future and past thresholds at intervals 
specified by this number of seconds. Default is 1 minute (60 
seconds).

Cache Changing these settings will not affect the events cached, it will only 
affect new events sent to the cache.  

Cache Size Connectors use a compressed disk cache to hold large volumes of 
events when the ArcSight ESM Manager is down or when the 
connector receives bursts of events. This parameter specifies the 
disk space to use. The default is 1 GB which, depending on the 
connector, can hold about 15 million events, but it also can go down 
to 5 MB. When this disk space is full, the connector drops the oldest 
events to free up disk cache space. (5 MB, 50 MB, 100 MB, 150 MB, 
200 MB, 250 MB, 500 MB, 1 GB, 2.5 GB, 5 GB, 10 GB, 50 GB.) 

Notification Threshold The size of the cache's contents at which to trigger a notification. 
Default is 10,000.

Notification Frequency How often to send notifications after the Notification Threshold is 
reached. (1 minute, 5 minutes, 10 minutes, 30 minutes, 60 
minutes.)

Network

Heartbeat Frequency This setting controls how often the connector sends a heartbeat 
message to the destination. The default is 10 seconds, but it can go 
from 5 seconds to 10 minutes. Note that the heartbeat is also 
used to communicate with the connector; therefore, if its frequency 
is set to 10 minutes, then it could take as much as 10 minutes to 
send any configuration information or commands back to the 
connector.

Enable Name Resolution The connector tries to resolve IP addresses to hostnames, and 
hostnames to IP addresses, if required and if the event rate allows. 
This setting controls this functionality. The Source, Target and 
Device IP addresses and Hostnames might also be affected by this 
setting. By default, name resolution is enabled (Yes).
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Name Resolution Host 
Name Only

Default: Yes.

Name Resolution Domain 
From E-mail

Default: Yes.

Clear Host Names Same as 
IP Addresses

Default: Yes.

Don’t Resolve Host Names 
Matching

NA

Don’t Reverse-Resolve IP 
Ranges

NA

Limit Bandwidth To A list of bandwidth options you can use to constrain the connector's 
output over the network. (Disabled, 1 kbit/sec to 100 Mbits/sec.)

Transport Mode You can configure the connector to cache to disk all the processed 
events it receives. This is equivalent to pausing the connector. 
However, you can use this setting to delay event-sending during 
particular time periods. For example, you could use this setting to 
cache events during the day and send them at night. You can also 
set the connector to cache all events, except for those marked with 
a very-high severity, during business hours, and send the rest at 
night. (Normal | Cache | Cache (but send Very High severity 
events).

Address-based Zone 
Population Defaults Enabled

This field applies to v3.0 ArcSight ESM Managers. This field is not 
relevant in ESM v3.5 because the system has integral zone mapping. 
Default: Yes.

Address-based Zone 
Population

This field applies to v3.0 ArcSight ESM Managers. This field is not 
relevant in ESM v3.5 because the system has integral zone mapping.

Customer URI Applies the given customer URI to events emanating from the 
connector. Provided the customer resource exists, all customer fields 
are populated on the ArcSight ESM Manager. If this particular 
connector is reporting data that might apply to more than one 
customer, you can use Velocity templates in this field to conditionally 
identify those customers.

Source Zone URI When populated, this field shows the URI of the zone associated with 
the connector's source address. This field is present for ESM v3.0 
compatibility. It is not relevant in ESM v3.5 because of integral zone 
mapping. 

Source Translated Zone URI When populated, this field shows the URI of the zone associated with 
the connector's translated source address. The translation is 
presumed to be NAT (network address translation). This field is 
present for ESM v3.0 compatibility. It is not relevant in ESM v3.5 
because of integral zone mapping. 

Destination Zone URI When populated, this field shows the URI of the zone associated with 
the connector's destination address. This field is present for ESM 
v3.0 compatibility. It is not relevant in ESM v3.5 because of integral 
zone mapping. 

Destination Translated Zone 
URI

When populated, this field shows the URI of the zone associated with 
the connector's translated destination address. The translation is 
presumed to be NAT (network address translation). This field is 
present for ESM v3.0 compatibility. It is not relevant in ESM v3.5 
because of integral zone mapping.
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Connector Zone URI When populated, this field shows the URI of the zone associated with 
the connector's address. This field is present for ESM v3.0 
compatibility. It is not relevant in ESM v3.5 because of integral zone 
mapping.

Connector Translated Zone 
URI

When populated, this field shows the URI of the zone associated with 
the connector's translated address. The translation is presumed to 
be NAT (network address translation). This field is present for ESM 
v3.0 compatibility. It is not relevant in ESM v3.5 because of integral 
zone mapping.

Device Zone URI When populated, this field shows the URI of the zone associated with 
the device's address. This field is present for ESM v3.0 compatibility. 
It is not relevant in ESM v3.5 because of integral zone mapping.

Device Translated Zone URI When populated, this field shows the URI of the zone associated with 
the device's translated address. The translation is presumed to be 
NAT (network address translation). This field is present for ESM v3.0 
compatibility. It is not relevant in ESM v3.5 because of integral zone 
mapping.

Field Based Aggregation This feature is an extension of basic connector aggregation. Basic 
aggregation aggregates two events if, and only if, all the fields of the 
two events are the same (the only difference being the detect time). 
However, field-based aggregation implements a less strict 
aggregation mechanism; two events are aggregated if only the 
selected fields are the same for both alerts. It is important to note 
that field-based aggregation creates a new alert that contains only 
the fields that were specified, so the rest of the fields are ignored.

Connector aggregation significantly reduces the amount of data 
received, and should be applied only when you use less than the 
total amount of information the event offers. For example, you could 
enable field-based aggregation to aggregate “accepts” and “rejects” 
in a firewall, but you should use it only if you are interested in the 
count of these events, instead of all the information provided by the 
firewall.

Time Interval Choose a time interval, if applicable, to use as a basis for 
aggregating the events the connector collects. It is exclusive of 
Event Threshold. (Disabled, 1 sec, 5 sec, and so on, up to 1 hour.)

Event Threshold Choose a number of events, if applicable, to use as a basis for 
aggregating the events the connector collects. This is the maximum 
count of events that can be aggregated; for example, if 150 events 
were found to be the same within the time interval selected (i.e., 
contained the same selected fields) and you select an event 
threshold of 100, you will then receive two events, one of count 100 
and another of count 50. This option is exclusive of Time Interval. 
(Disabled, 10 events, 50 events, and so on, up to 10,000 events.)

Field Names Enter one or more fields, if applicable, to use as the basis for 
aggregating the events the connector collects. The result is a 
comma-separated list of fields to monitor. For example, 
"eventName,deviceHostName" would aggregate events if they have 
the same event- and device-hostnames. Names can contain no 
spaces and the first letter should not be capitalized.

Fields to Sum Enter one or more fields, if applicable, to use as the basis for 
aggregating the events the connector collects.

Preserve Common Fields Choosing Yes adds fields to the aggregated event if they have the 
same values for each event. Choosing No, the default, ignores non-
aggregated fields in aggregated events.
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Filter Aggregation Filter Aggregation is a way of capturing aggregated event data from 
events that would otherwise be discarded due to an agent filter. Only 
events that would be filtered out are considered for filter 
aggregation (unlike Field-based aggregation, which looks at all 
events).

Connector aggregation significantly reduces the amount of data 
received, and should be applied only when you use less than the 
total amount of information the event offers. 

Time Interval Choose a time interval, if applicable, to use as a basis for 
aggregating the events the connector collects. It is exclusive of 
Event Threshold. (Disabled, 1 sec, 5 sec, and so on, up to 1 hour.)

Event Threshold Choose a number of events, if applicable, to use as a basis for 
aggregating the events the connector collects. This is the maximum 
count of events that can be aggregated; for example, if 150 events 
were found to be the same within the time interval selected (i.e., 
contained the same selected fields) and you select an event 
threshold of 100, you will then receive two events, one of count 100 
and another of count 50. This option is exclusive of Time Interval. 
(Disabled, 10 events, 50 events, and so on, up to 10,000 events.)

Fields to Sum (Optional) Choose one or more fields, if applicable, to use as the 
basis for aggregating the events the connector collects.

Processing

Preserve Raw Event For some devices, a raw event can be captured as part of the 
generated alert. If that is not the case, most connectors can also 
produce a serialized version of the data stream that was 
parsed/processed to generate the ArcSight event. This feature 
allows the connector to preserve this serialized "raw event" as a 
field. This feature is disabled by default since using raw data 
increases the event size and therefore requires more database 
storage space. You can enable this by changing the Preserve Raw 
Event setting. The default is No. If you choose Yes, the serialized 
representation of the "Raw Event" is sent to the destination and 
preserved in the Raw Event field.
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Turbo Mode If your configuration, reporting, and analytic usage permits, you can 
greatly accelerate the transfer of a sensor's event information 
through connectors by choosing one of two “turbo” (narrower data 
bandwidth) modes. The default transfer mode is called Complete, 
which passes all the data arriving from the device, including any 
additional data (custom, or vendor-specific).

Complete mode does indeed use all the database performance 
advances of ArcSight ESM v3.x.

The first level of Turbo acceleration is called Faster and drops just 
additional data, while retaining all other information. The Fastest 
mode eliminates all but a core set of event attributes, in order to 
achieve the best throughput. Consider the possible effects such a 
restricted data set might have from a given device (e.g., on reports, 
rules, threat resolution) before selecting it.

The specific event attributes that apply to these modes in your 
enterprise are defined in the self-documented 
$ARCSIGHT_HOME/config/connector/agent.properties file 
for the ArcSight ESM Manager. Because these properties might have 
been adjusted for your needs, you should refer to this file for 
definitive lists. Only scanner connectors need to run in Complete 
mode, to capture the additional data. 

Note: Connector Turbo Modes are superseded by the Turbo Mode in 
use by the ArcSight ESM Managers processing their events. For 
example, a Manager set to Faster will not pass all the data possible 
for a connector that is set for the default of Complete.
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Enable Aggregation (in 
seconds)

When enabled, aggregates two or more events on the basis of the 
selected time value. (Disabled, 1, 2, 3, 4, 5, 10, 30, 60)

The aggregation is performed on one or more matches for a fixed 
subset of fields:

• Agent ID

• Name

• Device event category

• Agent severity

• Destination address

• Destination user ID

• Destination port

• Request URL

• Source address

• Source user ID

• Source port

• Destination process name

• Transport protocol

• Application protocol

• Device inbound interface

• Device outbound interface

• Additional data (if any)

• Base event IDs (if any)

The aggregated event shows the event count (how many events 
were aggregated into the displayed event) and event type. The rest 
of the fields in the aggregated event take the values of the first 
event in the set of aggregated events.

Limit Event Processing Rate You can moderate the connector's burden on the CPU by reducing its 
processing rate. This can also be a means of dealing with the effects 
of event bursts.

The choices range from Disabled (no limitation on CPU demand) to 
1 eps (pass just one event per second, making the smallest demand 
on the CPU).

Note: The effect of this option varies with the category of connector 
in use, as described in the connector Processing Categories table 
below. 

Fields to Obfuscate

Store Original Time in Disabled or Flex Date 1.

Enable Port-Service 
Mapping

Default: No.

Enable User Name Splitting Default: No.

Split File Name into Path 
and Name

Default: No.

Event Integrity Algorithm Disabled, SHA-1, SHA-256, SHA-512, or MD5.

Generate Unparsed Events Default: No.
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Preserve System Health 
Events

Yes, No, or Disabled.

Enable Device Status 
Monitoring (in minutes)

Disabled or 1, 2, 3, 4, 5, 10, 30, 60, or 120 minutes.

Filters

Filter Out NA

“Very High Severity” Event 
Definition

NA

“High Severity” Event 
Definition

NA

“Medium Severity” Event 
Definition

NA

“Low Severity” Event 
Definition

NA

“Unknown Severity” Event 
Definition

NA

Payload Sampling (When available.)

Max. Length Discard, 128 bytes, 256 bytes, 512 bytes, 1 kbyte

Mask Non-Printable 
Characters

Default: False.
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Event Field Name Mappings

The nomenclature for field names depends on the function area of the Logger. The 
following table provides the mapping between those names. 

Database Name Search Results
Actual Events (CEF 
Key)

Reports

arc_deviceVendor deviceVendor Device Vendor Device Vendor

arc_deviceProduct deviceProduct Device Product Device Product

arc_deviceVersion deviceVersion Device Version Device Version

arc_deviceEventClassId deviceEventClassId Signature ID Signature Id

arc_name name Name Name

arc_agentSeverity agentSeverity Severity Severity

arc_agentAddress agentAddress agt Agent Address

arc_agentHostName agentHostName ahost Agent Host Name

arc_agentNtDomain agentNtDomain agentNtDomain Agent NT Domain

arc_agentType agentType at Agent Type

arc_agentZoneURI agentZoneURI agentZoneURI Agent Zone URI

arc_applicationProtocol applicationProtocol app Application 
Protocol

arc_baseEventCount baseEventCount cnt Base Event Count

arc_bytesIn bytesIn in Bytes In

arc_bytesOut bytesOut out Bytes Out

arc_categoryBehavior categoryBehavior categoryBehavior Category Behavior

arc_categoryDeviceGro
up

categoryDeviceGroup categoryDeviceGroup Category Device 
Group

arc_categoryObject categoryObject categoryObject Category Object

arc_categoryOutcome categoryOutcome categoryOutcome Category Outcome

arc_categorySignificanc
e

categorySignificance categorySignificance Category 
Significance

arc_categoryTechnique categoryTechnique categoryTechnique Category 
Technique
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arc_destinationAddress destinationAddress dst Destination 
Address

arc_destinationDnsDo
main

destinationDnsDomain destinationDnsDomain Destination DNS 
Domain

arc_destinationHostNa
me

destinationHostName dhost Destination Host 
Name

arc_destinationNtDoma
in

destinationNtDomain dntdom Destination NT 
Domain

arc_destinationPort destinationPort dpt Destination Port

arc_destinationProcess
Name

destinationProcessNam
e

dproc Destination 
Process Name

arc_destinationService
Name

destinationServiceNam
e

destinationServiceNam
e

Destination Service 
Name

arc_destinationUserId destinationUserId duid Destination User 
ID

arc_destinationUserNa
me

destinationUserName duser Destination User 
Name

arc_destinationZoneUR
I

destinationZoneURI destinationZoneURI Destination Zone 
URI

arc_deviceAction deviceAction act Device Action

arc_deviceAddress deviceAddress dvc Device Address

arc_deviceCustomDate
1

deviceCustomDate1 deviceCustomDate1 Device Custom 
Date 1

arc_deviceCustomDate
1Label

deviceCustomDate1Lab
el

deviceCustomDate1Lab
el

Device Custom 
Date 1 Label

arc_deviceCustomDate
2

deviceCustomDate2 deviceCustomDate2 Device Custom 
Date 2

arc_deviceCustomDate
2Label

deviceCustomDate2Lab
el

deviceCustomDate2Lab
el

Device Custom 
Date 2 Label

arc_deviceCustomNum
ber1

deviceCustomNumber1 cn1 Device Custom 
Number 1

arc_deviceCustomNum
ber1Label

deviceCustomNumber1
Label

cn1Label Device Custom 
Number 1 Label

arc_deviceCustomNum
ber2

deviceCustomNumber2 cn2 Device Custom 
Number 2

arc_deviceCustomNum
ber2Label

deviceCustomNumber2
Label

cn2Label Device Custom 
Number 2 Label

arc_deviceCustomNum
ber3

deviceCustomNumber3 cn3 Device Custom 
Number 3

arc_deviceCustomNum
ber3Label

deviceCustomNumber3
Label

cn3Label Device Custom 
Number 3 Label

arc_deviceCustomStrin
g1

deviceCustomString1 cs1 Device Custom 
String 1

Database Name Search Results
Actual Events (CEF 
Key)

Reports
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arc_deviceCustomStrin
g1Label

deviceCustomString1La
bel

cs1Label Device Custom 
String 1 Label

arc_deviceCustomStrin
g2

deviceCustomString2 cs2 Device Custom 
String 2

arc_deviceCustomStrin
g2Label

deviceCustomString2La
bel

cs2Label Device Custom 
String 2 Label

arc_deviceCustomStrin
g3

deviceCustomString3 cs3 Device Custom 
String 3

arc_deviceCustomStrin
g3Label

deviceCustomString3La
bel

cs3Label Device Custom 
String 3 Label

arc_deviceCustomStrin
g4

deviceCustomString4 cs4 Device Custom 
String 4

arc_deviceCustomStrin
g4Label

deviceCustomString4La
bel

cs4Label Device Custom 
String 4 Label

arc_deviceCustomStrin
g5

deviceCustomString5 cs5 Device Custom 
String 5

arc_deviceCustomStrin
g5Label

deviceCustomString5La
bel

cs5Label Device Custom 
String 5 Label

arc_deviceCustomStrin
g6

deviceCustomString6 cs6 Device Custom 
String 6

arc_deviceCustomStrin
g6Label

deviceCustomString6La
bel

cs6Label Device Custom 
String 6 Label

arc_deviceEventCatego
ry

deviceEventCategory cat Device Event 
Category

arc_deviceExternalId deviceExternalId deviceExternalId Device External Id

arc_deviceHostName deviceHostName dvchost Device Host Name

arc_deviceInboundInte
rface

deviceInboundInterface deviceInboundInterface Device Inbound 
Interface

arc_deviceOutboundInt
erface

deviceOutboundInterfa
ce

deviceOutboundInterfa
ce

Device Outbound 
Interface

arc_deviceReceiptTime deviceReceiptTime rt Device Receipt 
Time

arc_deviceSeverity deviceSeverity deviceSeverity Device Severity

arc_deviceZoneURI deviceZoneURI deviceZoneURI Device Zone URI

arc_endTime endTime deviceEndTime End Time

arc_eventId eventId eventId Event Id

arc_externalId externalId externalId External Id

arc_fileName fileName fname File Name

arc_filePath filePath filePath File Path

arc_flexNumber1 flexNumber1 flexNumber1 Flex Number1

Database Name Search Results
Actual Events (CEF 
Key)

Reports
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arc_flexNumber1Label flexNumber1Label flexNumber1Label Flex Number 1 
Label

arc_flexNumber2 flexNumber2 flexNumber2 Flex Number 2

arc_flexNumber2Label flexNumber2Label flexNumber2Label Flex Number 2 
Label

arc_flexString1 flexString1 flexString1 Flex String 1

arc_flexString1Label flexString1Label flexString1Label Flex String 1 Label

arc_flexString2 flexString2 flexString2 Flex String 2

arc_flexString2Label flexString2Label flexString2Label Flex String 2 Label

arc_message message msg Message

arc_priority priority priority Priority

arc_sourceAddress sourceAddress src Source Address

arc_sourceHostName sourceHostName shost Source Host Name

arc_sourceNtDomain sourceNtDomain sntdom Source NT Domain

arc_sourcePort sourcePort spt Source Port

arc_sourceProcessNam
e

sourceProcessName sproc Source Process 
Name

arc_sourceServiceNam
e

sourceServiceName sourceServiceName Source Service 
Name

arc_sourceUserId sourceUserId suid Source User Id

arc_sourceUserName sourceUserName suser Source User Name

arc_sourceZoneURI sourceZoneURI sourceZoneURI Source Zone URI

arc_startTime startTime start Start Time

arc_transportProtocol transportProtocol proto Transport Protocol

arc_type type type Type

arc_vulnerabilityExtern
alID

vulnerabilityExternalID vulnerabilityExternalID Vulnerability 
External Id

arc_vulnerabilityURI vulnerabilityURI vulnerabilityURI Vulnerability URI

arc_agentZone agentZone agentZone Agent Zone

arc_agentZoneName agentZoneName agentZoneName Agent Zone Name

arc_agentZoneResourc
e

agentZoneResource agentZoneResource Agent Zone 
Resource

arc_destinationZone destinationZone destinationZone Destination Zone

arc_destinationZoneNa
me

destinationZoneName destinationZoneName Destination Zone 
Name

arc_destinationZoneRe
source

destinationZoneResour
ce

destinationZoneResour
ce

Destination Zone 
Resource

Database Name Search Results
Actual Events (CEF 
Key)

Reports
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arc_deviceZone deviceZone deviceZone Device Zone

arc_deviceZoneName deviceZoneName deviceZoneName Device Zone Name

arc_deviceZoneResourc
e

deviceZoneResource deviceZoneResource Device Zone 
Resource

arc_sourceZone sourceZone sourceZone Source Zone

arc_sourceZoneName sourceZoneName sourceZoneName Source Zone Name

arc_sourceZoneResourc
e

sourceZoneResource sourceZoneResource Source Zone 
Resource

Database Name Search Results
Actual Events (CEF 
Key)

Reports
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Appendix I

Logger Search From An ESM Console

If you have ArcSight Logger and ArcSight ESM deployed in your network infrastructure, you 
can perform a Logger search operation directly from your ESM Console. 

Starting with Logger v5.1, this functionality is also available on software Logger.

Understanding the Integrated Search Functionality
There are two ways to perform a search operation on Logger from an ESM Console:

 Search—a regular search operation in which you can specify search options.

 Quick search—a search operation based on field and value you select in an ESM 
Console active channel;  you are not prompted for any search options. 

To run a Logger search, right click on an event in an active channel of the ESM Console to 
display a menu to select a search method—Logger Search or Logger Quick Search. 

If you select Logger Search, you need to select search options such as Event Name, 
Destination, Source, and so on, and the Logger appliances on which the search should be 
run (if there are multiple Logger appliances). If you select Logger Quick Search, you are 
not prompted to specify any search options because the search is run on the field you had 
clicked on.
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The search results are displayed in the ESM Console, as shown in the following figure:

Before you can run a search operation on Logger from ESM Console, you need to set up 
parameters in the ESM Console that are used to authenticate the user who performs the 
search. Prior to Logger v5.1, only basic authentication (user name and password) was 
available; however, starting with Logger v5.1, a One Time Password (OTP) option is 
available. This option makes the user authentication between Logger and ESM Console 
highly secure. For OTP option to work, Logger must be running v5.1 or later, and the ESM 
Console must be running ESM v5.0 SP1 Patch 2 or later, as described in “Prerequisites” on 
page 580. 

By default, a Logger search from the ESM Console uses the OTP method to authenticate. 
However, if Logger or ESM Console is not running a release that supports the OTP option, 
an error message is displayed and basic authentication is used. 

Prerequisites
The following table lists the minimum and recommended versions that Logger and ESM 
Console must be running.

Option Requirement

Recommended Logger v5.1 (appliance and software)

ESM v5.0 SP1 Patch 2

By default, OTP authentication is used. These release versions 
must be installed for OTP authentication to work.

Minimum Logger v4.0 or later (on appliance only)

ESM v4.5 SP1 Patch 2 or later

Basic authentication is used. 
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Setup and Configuration

ESM
Follow these instructions to set up and configure ArcSight ESM Manager to run integrated 
search operations:

1 Ensure that the ESM Manager is running one of the recommended versions. (See 
“Prerequisites” on page 580.)

2 Follow instructions in the ArcSight ESM User’s Guide to set up ESM Console for 
integrated searches on Logger. When setting up a user for Logger access (as described 
in the “Set Up Users for Logger Access” section of the User’s Guide), specify the 
following integration parameters, also shown in the figure below.

The ArcSight ESM User’s Guide is available from the ArcSight Download Center at 
http://www.arcsight.com/supportportal. 

Logger
Make sure:

1 Your Logger appliance is running a version listed in “Prerequisites” on page 580.

Parameter Description

LoggerUser The Logger user account to use when accessing a Logger

target.

For software Logger, this parameter is not applicable. Only 
OTP method is supported.

LoggerPassword The password for that Logger account.

For software Logger, this parameter is not applicable. Only 
OTP method is supported.

LoggerHost The IP address of the Logger host.

OTPUser The Logger user account to use with the OTP 
authentication. This account must exist on the Logger.

OTPPassword The password to use for the OTPUser specified above.

LoggerPort For OTP, you must specify the port number for the Logger.

For a Logger appliance, the port number is 443. 

For software Logger, specify the port you configured on it 
during installation.
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2 A Logger user name that you specified when creating an integration parameter on 
ESM Console (Step 2 of ESM in “Setup and Configuration” on page 581) exists on the 
Logger. 

Supported Search Options
You can select from the following search options when running a Logger search (not Quick 
Search) from the ESM Console:

 By Destination

 By Event Name

 By Source

 By Source and Destination

 By User

 By Vendor and Product

Additionally, if multiple Loggers are configured on your ESM Console, you can select the 
one on which the integrated search should be run. 

Guidelines
Make sure you are aware of the following guidelines about Logger Search when it is run 
from ESM Console:

 A field-based search query is used to perform search on the Logger.

 A search operation only from an active channel of an ESM Console is supported; 
search operation from other ESM resources is not supported.

 Multiple search options (see “Supported Search Options” on page 582) cannot be 
specified for one search operation. That is, you cannot select by Event Name and By 
Destination for one search operation. 

 You can run the search operation on only one Logger at a time. That is, you cannot 
select multiple Loggers from the menu list on ESM Console. 

Additionally, even if a Logger peers with other Loggers, integrated search runs only on 
the local Logger that you select from the menu list on ESM Console. 

 The One-Time Password (OTP) authentication is available for use only when Logger is 
running v5.1 or later and ESM Console is running v5.0 SP1 Patch 2 or later.  If OTP 
cannot be used, the searches run from the ESM Console display a message that a 
single-use session token could not be negotiated thus regular authentication will be 
used. Click OK in that message window so the LoggerUser and LoggerPassword is 
used to authenticate. 

Searching on Logger From ESM Console
 To run a Quick Search on Logger (as described in “Understanding the Integrated 

Search Functionality” on page 579):

a Right click on the event field in an active channel of the ESM Console.
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b From the menu list, select Integration Commands > Logger Quick Search, 
as shown in the following figure. 

OR

 To run a regular Search (in which you specify search options):

a Right click on any field of an event in an active channel of the ESM Console.

b From the menu list, select Integration Commands > Logger Search > Select 
Search Options, as shown in the following figure.
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c Click OK to run the search or Cancel to quit.

d If Logger or ESM Console is not running a release that supports the OTP option, 
an error message is displayed indicating that a single-use session token was not 
negotiated and basic authentication will be used instead. 

When such a message is displayed, click OK to proceed.

The search results are displayed in the ESM Console Web Viewer.
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Symbols
.aup file for content update 490

Numerics
65746

H1
Receiving Alerts for Events 389

A
accounts, user. See User.
Acronis True Image Server 529
advanced mode, packaging connectors 474
agents. See SmartConnectors
Alerts

about 188
adding 192
disable 193, 200
enable 193, 200
remove 194

ArcExchange 473
archive, scheduled 163
ArcSight ESM 18, 22, 23, 58, 61, 178, 188
ArcSight Logger Streaming SmartConnector 179
ArcSight Manager 24, 58, 61, 178, 186
ArcSight SmartConnectors 23, 59
Audit forwarding 537
Audit Log 537
AUP upgrade process 489
authentication, RADIUS 377
automatic timeout 375

B
backup, configuration 219
basic mode, packaging connectors 473
batching 565
browser requirements 64
bulk copy (see cloning) 506

C
CA certificate

applying on container 431, 436
demo 435
invalid errors 439
managing 431
removing from container 433
viewing list 437

CAC support 368
CACERTS for ESM Destination 187

canonical equality check 67
cases 478
case-sensitive search 67
Categories 251
Categories tab 571
category

adding a new category 255
deleting an existing one 257
placing a system defined object in 257

CEF 146, 509
CEF event filters 146
certificate revocation list 370
Certificate Signing Request 366
Certificate, installation 368
changing container credentials 429
character encoding 174
CIFS, configuring 445
CLI 27

command table 28
cloning connectors 506
Comma Separated Values file, uploading 417
command line interface (CLI) 27
Common Event Format (CEF) 146, 509
Common Extension Dictionary 511
Configuration Backup 219
configuration monitoring, reports for 252
Configuration tab 155
Connector Appliance

remote upgrade 489
Connector Forwarder 179
connectors supported 444
connectors. See SmartConnectors
constraints, search 84
containers

adding 427
changing credentials 429
definition 426
deleting 428
editing 427
running commands 439
updating properties 428
upgrading 440
viewing all 426
viewing logs 441

content AUP 490
copying (see cloning) 506
CSR

generating a certificate signing request 367
CSV file information 417
custom connector 473
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D
dashboard

reports 257, 266
reports, preference for display 275

date/time format 178
Default Storage Group 18, 34
demo certificate 435
deploying

report package 337
Device 155

delete 157
edit 156
pre-defining 156

Device Group 157
creating 157
deleting 158
editing 158

device group
maximum number 157

devices
maximum number 156

dynamic search 110

E
e-mailing

reports 286
encoding 174
ESM (ArcSight Enterprise Security Manager) 18, 22, 23, 
58, 61, 178
ESM Destination 184

creating 185
deleting 186
updating CACERTS 187

eth0 468
Event Archive 158, 161

adding 162
deleting 162
loading 165
settings 163
unloading 165

event archive, scheduled 163
Event Input/Output 171
event storage, remote 169
events

search 84
Explorers 245

Category Explorer 245
Favorites Explorer 248
Icons 249
Parameter Explorer 248
Query Explorer 247
Report Explorer 246

export
search results 139

exporting remote management configuration 416

F
factory settings, restoring 529
field query

indexing fields 140
field set, search 84
fields, indexing 140
File events to ESM 188

Filter 204
copying 205
creating 204
deleting 206
editing 205

Filter, Report Category 339
filter, search 84
filtering information on UI page 414
filters, system 146
find, events 84
FIPS 140-2

enabling on Connector Appliance 371, 398
enabling on container 430

Firefox (web browser) 64
Forwarder 178

creating 180
deleting 183
editing 183

forwarding file events to ESM 188
function tabs 65

G
gauge range 67
gauges 65

H
health, system 386, 408
help 65
hosts

adding 420
definition 419
deleting 424
editing 424
moving to different location 424
scanned 420
scanning 422
software-type 419
upgrading remotely 424
viewing all 419

I
i18n options 67
importing remote management configuration 417
indexing fields 140
initialization 26
Internal Storage Group 18, 165
Internet Explorer (web browser) 64
intrusion monitoring, reports for 253
invalid certificate errors 439
IP addresses

assigning 26

L
LDAP 368, 377, 379, 446
Localhost 419
locations

adding 416
definition 415
deleting 418
editing 418
viewing all 415
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Logfu utility 442
Logger

rebooting 348
login 63
login banner 380
Login Settings 375

changing 375
logout 65, 68
logout, automatic 69
logs, internal 238

retrieving 238

M
maintenance mode 222
Manager 24, 58, 61, 178, 186
Monitor tab 77

N
navigation 65
network interfaces 468
NFS, configuring 445

O
online help 65
options 65, 67

P
packaging connectors

advanced mode 474
basic mode 473

parameter value groups, in reports 330
parameters

in report queries 324
quick run report 279
run reports 282

parser override 473
Password

Reset 377
Password policy

changing 376
Password Reset 386
Password, changing 385, 408
PCI Storage Group 18, 165
Peer Logger 215

adding 217
deleting 218

peer Logger, searching 129
predefined filters 146
Protect 724 473

Q
queries

in reports 302
query

events 84
query controls 65

R
RADIUS authentication 377
RAID controller status 353, 365, 392

range, gauge 67
rebooting Logger 348
Receiver 171

creating 173
deleting 174
editing 173
types 171, 174

refreshing UI screen 414
regular expressions (regex)

predefined 146
tutorial 516

Remote Authentication Dial-In User Service (RADIUS)
377
remote event storage 169
remote file system mount

adding 362
editing 363

remote management configuration 416
exporting 416
importing 417

remote upgrade 489
Report Category Filter 339
reports 209

access rights 302
administration 338
configuration monitoring 252
creating new 289
dashboard 257, 266
delivery options 285
designing 288
editing 300
e-mailing 286
exporting 288
file formats 284
intrusion monitoring 253
iPackager 340
navigating to 243
parameter value groups 330
PCI solution add-on 255
publishing 284
query parameters 324
quick run parameters 279
recently run 277
remove scheduled 335
run parameters 282
running 276
SANS Top 5 253
saving 288
scheduling 334
solution add-ons 255
template styles 332
viewing published 288
viewing, editing schedules 334

repositories, user-defined 495
reset to factory settings 529
restore to factory settings 529
restoring a SAN 363
Retrieve Logs 238

S
safety precautions 25
SAN, restore 363
SANS Top 5, reports for 253
saved
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filter 143
search 143

Saved Search 207
adding 207
deleting 208
editing 208

Saved Search Files 212
Saved Search Job 209

adding 209
deleting 212
editing 211

scan a host 420, 422
scheduled event archive 163
Scheduled Task 203

currently running 204
finished 204

scheduling
export of search results 129
reports 334

SCP file receiver 174
search

constraints 84
events 84
exporting results 139
field set 84
filter 84, 143
peer Loggers 129
query, defining a 84
results, scheduling export of 129
saved 143
system filters 146
time range 84

Search Group Filter
associating with user group 207
report category filter 339

Search Group Filters 206
Search Results tab 130
severity level 565, 567, 571
SFTP file receiver 174
SmartConnectors 23, 59, 565, 567

batching 565
defined 444
scanner 570
zones 567

SmartMessage 171
SNMP 386, 389, 409, 412, 451, 478
software-type host 419
solutions

reports 255
SSL 366

Certificate Signing Request 366
statistics 65
status

3Ware RAID Controller 353, 365, 392
Storage 165
Storage Group 165

adding 166
Default 34
editing 166

Storage Group, default 18, 34
Storage Group, internal 18, 165
Storage Group, PCI 18, 165
Storage Rule 34, 167

adding 168
deleting 169
editing 168

Storage Settings 169
Storage Volume 169

settings 169
streaming SmartConnector 179
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